FluidSIM is a teaching tool for simulating pneumatics, hydraulics, electrics/electronics and digital technique. It can be used in combination with the Festo Didactic GmbH & Co. KG training hardware, but also independently. FluidSIM was developed as a joint venture between the University of Paderborn, Festo Didactic GmbH & Co. KG, Denkendorf, and Art Systems Software GmbH, Paderborn.
Contents

1. Welcome! 13

2. Installation 15
   2.1 Technical Requirements 15
   2.2 Installation and Online Activation 15
   2.2.1 Import Online Activation Notes 16
   2.3 Installation with license connector 16
   2.4 FluidSIM Full Version: Installation from DVD 17

3. First steps 18
   3.1 Create a new circuit diagram 18
   3.2 Organize symbols, libraries and circuit diagrams 21
   3.3 Insert symbol from menu 22
   3.4 Symbol libraries 24
   3.4.1 Create user library 25
   3.5 Circuit files 26

4. Library and project window 27
   4.1 Change window position 27
   4.2 Automatic show and hide 27

5. Edit circuit 29
   5.1 Insert and arrange symbols 29
   5.2 Using the Festo product catalogue with FluidSIM 29
   5.3 Connect connectors / ports 33
   5.4 Automatically connect connectors 35
   5.5 Insert T distributor 36
   5.6 Move lines 39
   5.7 Define the characteristics of lines 42
   5.8 Delete line 44
5.9 Set the properties of the connectors 44
5.10 Define component connector / set T distributor 46
5.11 Delete component connector 47
5.12 Configure a way valve 47
5.13 Configure cylinder 49
5.14 Group symbols 51
5.15 Create macro objects 51
5.16 Delete symbol groups and macro objects 52
5.17 Align symbols 52
5.18 Mirror symbols 52
5.19 Rotate symbols 53
5.20 Scale symbols 54

6. Drawing frame 56
   6.1 Editable labels 56
   6.2 Use a drawing frame 57
   6.3 Page dividers 61

7. Additional tools for creating drawings 64
   7.1 Drawing tools 64
      7.1.1 Grid 64
      7.1.2 Alignment lines 64
      7.1.3 Object snap 65
      7.1.4 Rulers 66
   7.2 Drawing levels 66
   7.3 Cross-references 68
      7.3.1 Create cross-references from symbols 70
      7.3.2 Cross-reference representation 70
      7.3.3 Manage cross-references 71
   7.4 Drawing functions and graphical elements 72
      7.4.1 Interruption/Potential 74
      7.4.2 Conduction line 76
      7.4.3 Line 78
      7.4.4 Polyline (set of connected lines) 80
      7.4.5 Rectangle 81
7.4.6 Circle
7.4.7 Ellipse
7.4.8 Text
7.4.9 Image
7.5 Check drawing

8.   GRAFCET

8.1 Steps 89
8.2 Actions 90
8.3 Transitions 92
8.4 Stored effective actions (allocations) 94
8.5 Linking GRAFCET variables with the electrical part of FluidSIM 95
8.6 Quick reference for the FluidSIM-relevant GRAFCET concepts 98

8.6.1 Initialization 98
8.6.2 Sequence rules 99
8.6.3 Sequence selection 99
8.6.4 Synchronization 99
8.6.5 Transient sequence / unstable step / virtual triggering 100
8.6.6 Determining the values of GRAFCET variables 100
8.6.7 Checking the entries 100
8.6.8 Admissible characters for steps and variables 101
8.6.9 Variable names 101
8.6.10 Access to labels of fluidic and electrical components 102
8.6.11 Functions and formula entry 103
8.6.12 Delays / time limits 104
8.6.13 Boolean value of an assertion 104
8.6.14 Target information 104
8.6.15 Partial GRAFCETs 105
8.6.16 Macro-steps 105
8.6.17 Compulsory commands 105
8.6.18 Enclosing step 106
9. Dimension
   9.1 Draw dimension
   9.2 Settings for the dimension

10. Equipment identifications and designation conventions
    10.1 Renumber Designations

11. Component attributes
    11.1 Component attributes in the Properties dialog window
    11.2 Identification
    11.3 Catalog Properties
    11.4 User Defined Properties
    11.5 Drawing Properties
    11.6 Main and secondary components
    11.7 Linking main and secondary components
    11.8 Link solenoid valves and solenoid coils
    11.9 Attributes of the text components
    11.10 Link text components with attributes
    11.11 Text components with specified links
    11.12 Change the properties of multiple objects simultaneously
        11.12.1 Drawing Properties
        11.12.2 Main Component

12. Parts list management and analyses
    12.1 Display parts list
    12.2 Find components from the parts on the circuit diagram
    12.3 Set parts list properties
    12.4 Export parts list

13. Manage projects
    13.1 Create new project
    13.2 Project nodes
13.2.1 Project archiving 150
13.3 Circuit and parts list nodes 151
13.4 Unplaced objects 152

14. **Circuit and project properties** 155
14.1 Attributes 156
14.1.1 Predefined placeholders 158
14.2 Page Dividers 159
14.3 Basic Unit Length 159
14.4 Language 160
14.5 Encryption 161
14.6 Designation Conventions 163
14.7 Cross Reference Representation 164

15. **Special functions for electric circuits** 165
15.1 Potentials and conduction lines 165
15.2 Cables and wiring 167
15.2.1 Manage cables 173
15.2.2 Insert cable map 174
15.2.3 Insert cable list 176
15.3 Terminals and terminal strips 179
15.3.1 Set terminals 179
15.3.2 Set multiple terminals 181
15.3.3 Create terminal strips 183
15.3.4 Manage terminal strips 184
15.4 Terminal diagram 186
15.4.1 Set links 188
15.5 Contact images 192

16. **Circuit input and output** 195
16.1 Print circuit diagram and parts list 195
16.2 Import DXF file 197
16.3 Export circuit 197
17. Options 209
   17.1 General 209
   17.2 Save 210
   17.3 Folder Locations 211
   17.4 Language 212
   17.5 Dimension 213
   17.6 Designation Conventions 214
   17.7 Cross Reference Representation 215
   17.8 Connector Links 216
   17.9 Warnings 217
   17.10 Automatic Updates 218
   17.11 Text Sizes 219

18. Menu overview 220
   18.1 File 220
   18.2 Edit 223
   18.3 Insert 224
   18.4 Draw 225
   18.5 Page 226
   18.6 Project 227
   18.7 View 228
   18.8 Library 229
   18.9 Tools 230
   18.10 Window 231
   18.11 Help 232

19. Functional diagram 238
   19.1 Edit Mode 239
   19.1.1 Set diagram properties 239
   19.1.2 Table textboxes 240
   19.1.3 Adjust the presentation of the diagrams 243
   19.2 Draw diagram curve 244
   19.3 Insert signal elements 245
   19.4 Insert text boxes 246
<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>19.5</td>
<td>Draw signal lines and insert signal connections</td>
<td>238</td>
</tr>
<tr>
<td>19.5.1</td>
<td>Free-draw signal lines</td>
<td>238</td>
</tr>
<tr>
<td>19.5.2</td>
<td>Drawing signal lines from signals</td>
<td>240</td>
</tr>
<tr>
<td>19.5.3</td>
<td>Draw signal lines from diagram support points</td>
<td>240</td>
</tr>
<tr>
<td>19.6</td>
<td>Insert additional signal lines</td>
<td>241</td>
</tr>
<tr>
<td>19.7</td>
<td>Insert row</td>
<td>241</td>
</tr>
<tr>
<td>19.8</td>
<td>Delete row</td>
<td>241</td>
</tr>
<tr>
<td>19.9</td>
<td>Additional editing functions</td>
<td>242</td>
</tr>
<tr>
<td>19.9.1</td>
<td>Zoom</td>
<td>242</td>
</tr>
<tr>
<td>19.9.2</td>
<td>Undo editing steps</td>
<td>242</td>
</tr>
</tbody>
</table>

**20. The Component Library**

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>20.1</td>
<td>Hydraulic Components</td>
<td>243</td>
</tr>
<tr>
<td>20.1.1</td>
<td>Service Components</td>
<td>243</td>
</tr>
<tr>
<td>20.1.2</td>
<td>Configurable Way Valves</td>
<td>250</td>
</tr>
<tr>
<td>20.1.3</td>
<td>Mechanically Actuated Directional Valves</td>
<td>255</td>
</tr>
<tr>
<td>20.1.4</td>
<td>Solenoid-actuated Directional Valves</td>
<td>262</td>
</tr>
<tr>
<td>20.1.5</td>
<td>Shutoff Valves</td>
<td>268</td>
</tr>
<tr>
<td>20.1.6</td>
<td>Pressure Control Valves</td>
<td>272</td>
</tr>
<tr>
<td>20.1.7</td>
<td>Pressure Switches</td>
<td>283</td>
</tr>
<tr>
<td>20.1.8</td>
<td>Flow Control Valves</td>
<td>284</td>
</tr>
<tr>
<td>20.1.9</td>
<td>Continuous valves</td>
<td>288</td>
</tr>
<tr>
<td>20.1.10</td>
<td>Actuators</td>
<td>293</td>
</tr>
<tr>
<td>20.1.11</td>
<td>Measuring Devices</td>
<td>298</td>
</tr>
<tr>
<td>20.2</td>
<td>Pneumatic Components</td>
<td>301</td>
</tr>
<tr>
<td>20.2.1</td>
<td>Supply Elements</td>
<td>301</td>
</tr>
<tr>
<td>20.2.2</td>
<td>Configurable Way Valves</td>
<td>307</td>
</tr>
<tr>
<td>20.2.3</td>
<td>Mechanically Operated Directional Valves</td>
<td>312</td>
</tr>
<tr>
<td>20.2.4</td>
<td>Solenoid Operated Directional Valves</td>
<td>319</td>
</tr>
<tr>
<td>20.2.5</td>
<td>Pneumatically Operated Directional Valves</td>
<td>323</td>
</tr>
<tr>
<td>20.2.6</td>
<td>Shutoff Valves and Flow Control Valves</td>
<td>328</td>
</tr>
<tr>
<td>20.2.7</td>
<td>Pressure Operated Switches</td>
<td>334</td>
</tr>
<tr>
<td>20.2.8</td>
<td>Pressure Operated Switches</td>
<td>337</td>
</tr>
<tr>
<td>20.2.9</td>
<td>Vacuum Technique</td>
<td>338</td>
</tr>
<tr>
<td>20.2.10</td>
<td>Valve Groups</td>
<td>341</td>
</tr>
<tr>
<td>20.2.11</td>
<td>Continuous valves</td>
<td>343</td>
</tr>
</tbody>
</table>
21. Learning, Teaching, and Visualizing Technologies 413

21.1 Information about Single Components 413
21.1.1 Component Descriptions 413
21.1.2 Component Illustrations 416
21.2 Selecting Didactics Material from a List 422
21.2.1 Tutorial 422
21.2.2 Component Library 424
21.2.3 Didactics Material 427
21.3 Presentations: Combining Instructional Material 429
21.4 Extended Presentations in the Microsoft PowerPoint Format 435

22. Didactics Material Survey (Pneumatics) 438

22.1 Basics 438
22.2 Supply elements 440
22.3 Actuators 445
22.4 Directional control valves 450
22.5 Shutoff valves 461
22.6 Flow control valves 468
22.7 Pressure control valves 470
22.8 Time delay valve 472
22.9 Sequential circuit and signal overlap circuit 475
22.10 Educational Films 477
22.10.1 Educational Films 477
22.11 Standard Presentations 478
22.11.1 Presentations 478

23. Didactics Material Survey (Hydraulics) 480

23.1 Applications 480
23.2 Components of a Hydraulic Plant 481
23.3 Symbols 483
23.4 Some Physical Fundamentals 487
23.5 Components of a Power Unit 490
23.6 Fundamentals of Valves 494
23.7 Pressure Valves 496

© Festo Didactic GmbH & Co. KG • Art Systems GmbH • FluidSIM
23.8 Way Valves 503
23.9 Shutoff Valves 512
23.10 Flow Valves 516
23.11 Hydraulic Cylinders and Motors 519
23.12 Gauges 522
23.13 Exercises 523
23.14 Educational Films 533
23.14.1 Educational Films 533
23.15 Standard Presentations 533
23.15.1 Presentations 534

Index 535
Welcome!

Chapter 1

Welcome to FluidSIM! Thank you for purchasing the FluidSIM training software. This handbook functions both as an introduction to FluidSIM and as a reference manual outlining the possibilities, concepts, and operation of the software package. This handbook, however, is not intended to help in defining special aspects of hydraulics or pneumatics. Concerns of this nature can be found in the Festo Didactic GmbH & Co. KG textbook series.

A major feature of FluidSIM is its close connection with CAD functionality and simulation. FluidSIM allows DIN-compliant drawing of electro-fluidic circuit diagrams and can perform realistic simulations of the drawing based on physical models of the components. Simply stated, this eliminates the gap between the drawing of a circuit diagram and the simulation of the related technical system. The CAD functionality of FluidSIM has been specially tailored for fluidics. For example, while drawing, the program will check whether or not certain connections between components are permissible. Another feature of FluidSIM results from its well thought-out didactic concept: FluidSIM supports learning, educating, and visualizing hydraulic, pneumatic and electronic knowledge. All components are explained with textual descriptions, figures, and animations that illustrate underlying working principles; exercises and educational films mediate knowledge about both important circuits and the usage of components. The development of FluidSIM included special emphasis on both an intuitive and easy-to-learn user interface. The user will quickly learn to draw and simulate electro-hydraulic and electro-pneumatic circuit diagrams.

Users of this software are encouraged to contribute tips, criticism, and suggestions for improvement of the program via email at

info@fluidsim.com

did@de.festo.com

Moreover, the newest updates can be found at our Internet site at

www.fluidsim.com

www.festo-didactic.com
Chapter 2

2.1 Technical Requirements

You need a computer with that runs using Windows XP (SP3), Windows Vista, Windows 7 or Windows 8.

If you intend to simulate complex circuit diagrams, a dual-core CPU is recommended.

Having purchased the full version of FluidSIM, you received two DVD-ROMs and possibly a license connector. The installation procedure is described in the following sections. The full version of FluidSIM is available in two versions: A version that supports the automatic online activation and the license connector version.

2.2 Installation and Online Activation

For the online activation you will need a computer with internet access. During the installation you will be prompted to activate FluidSIM. There are three ways of doing so:

— Automatic Online Activation This variant requires Internet access from the computer where FluidSIM is to be activated and realizes a completely automated procedure.

— Indirect Activation In this variant an activation dialog box is opened that shows an Internet address (url) and your individual license ID. With this information you can generate your individual activation key at an arbitrary computer with Internet access. Then, the activation key has to be entered in the activation dialog box of the installation PC.

— Call Festo to receive your individual activation key If you don’t have Internet access or if the Internet activation fails, you can
call a service employee at weekday office hours who will provide you with your activation code. Please note: The displayed phone number in Germany is available at European office times only. Depending on the geographical position of your site, you will find different telephone numbers for the software activation on the shipping box.

2.2.1 Import Online Activation Notes

During the activation of FluidSIM several features of your PC and the product ID are used to generate an individual activation key. This string is valid for your PC only. I.e., if your PC is substantially modified or if you want to use another PC, your FluidSIM license has to be transferred to the new hardware. Such a transfer requires the deactivation of the license of the original PC, which is accomplished by uninstalling FluidSIM. The respective uninstallation program can be found in the menu Start under “Deinstallation” or in the control panel under “Software”. If a deactivation of FluidSIM is not possible because of technical problems, as an exception your license can be transferred without deactivation.

! Note that a license transfer without a preceding deactivation is possible only a few times. Also note that if your license has been transferred to another PC, it cannot be re-activated for the initial PC without deactivating it before.

2.3 Installation with license connector

Depending on the license model (single-position systems or network), the license connector is needed only during the Installation of FluidSIM or must be attached to the so-called license server. The network license connector defines how many instances of FluidSIM can be running at the same time in the network. If you attempt to start more instances than the allowed number, an error message is displayed. If the license server is down or if the license connector has been removed from the system, all circuits that are
already open and modified can be saved before FluidSIM terminates. If the license server is up again FluidSIM starts as usual.

Details for a network installation of FluidSIM is given in an addendum of the FluidSIM package and can also be found as pdf-file “net_inst.pdf” in the “Doc”-Folder of the installation DVD.

2.4 FluidSIM Full Version: Installation from DVD

If your software needs a license connector, connect the key not until you are requested by the installation program.

→ Switch on your PC and login with administrator permissions.

→ Insert the DVD.

Usually the installation program starts automatically. Please run it manually if it doesn't.

After a few seconds the startup screen of the installation program appears. Here you can choose whether to install the student version or the full version of FluidSIM. When installing the full version, please select the appropriate license connector (single-position systems or network). If you got a FluidSIM version for online activation no license connector is necessary but only your individual product ID is required, which is printed on the back of the DVD cover. Note that the student version does neither require a license connector nor a product ID.

→ Follow the directions as they appear on the screen. If you are unsure how to answer or are unsure of a question, simply click “Next »”.
Chapter 3

3.1 Create a new circuit diagram

→ Select the New / File... menu item from the File menu.

An empty circuit diagram window opens in which you can insert symbols and connect them with lines. You should set the diagram size in advance.

→ Select the Paper Size... menu item from the Page menu.
If you use a drawing frame then FluidSIM can automatically adjust the paper size. If you wish to manually define the drawing size then deactivate the “Adopt from drawing frame” option and select the drawing’s desired dimensions and orientation. If the drawing’s dimensions are larger than your printer’s printing area then you can distribute your drawing across several pages (tiles).

To retain a better overview you can create attributes for every circuit drawing.
Click the “Attributes” tab.

Figure 3/2: dialog window, Attributes tab: creating attributes

The attribute table allows you to save any desired data in the form of attribute value pairs. The associated placeholders (attributes with the same name) in the drawing frame are replaced by the values entered.
You can also access this dialog window directly by using the Page menu and the Properties... menu item.

3.2 Organize symbols, libraries and circuit diagrams

In order to support the organization of the different document types in FluidSIM all of the circuit files are assigned to one of three groups.

Symbols
Symbols are formal, abstract models providing a graphical representation of the function of a component or component group. This can consist of simple circuit symbols or entire circuits. Symbols can be inserted into their own circuits and linked between the connecting points. The insert can be performed either via the Insert menu or via drag and drop from a library window. Symbols can be compiled into library files with the .lib file suffix.

Libraries
Libraries are hierarchically organized collections of symbols. In addition to the standard library, which users cannot modify, users can compile any desired number of their own libraries. You can find functions for organizing the libraries on the Library menu as well as on the context menu of the currently active library. To switch libraries use the tab in the upper margin of the library window. Library files have the .lib file suffix.

Circuits
The default location for circuits is in the FluidDraw folder contained in the My Documents folder defined by the operating system. These have the .circ file suffix.

Note: It is worthwhile to create a new sub-folder in the FluidDraw directory for every customer or every project.
3.3 Insert symbol from menu

To find a specific symbol you can either enter characteristic key words in the Find Symbol dialog windows or navigate through the hierarchical structure.

→ Where necessary open a new window and select the Find Symbol Description... entry on the Insert menu.

The Find Symbol dialog window then opens. You can enter your search terms in the “Search” input line. Separate the individual search terms using commas or spaces. Neither the order of the search terms nor upper or lower case letters have any influence on the search results.
Figure 3/3: *Find Symbol* dialog window

You can see the symbols found in the two results lists. The library hierarchy is displayed on the left-hand side although only those branches appear which contain matching symbols. An alphabetical list of the search hits is displayed on the right-hand side. The symbol of the highlighted entry is shown in the preview. Once you have found the symbol that you were looking for, you can select it using the **OK** button or by double-clicking on the appropriate row in the results list. The symbol then “hangs” on the mouse pointer and is placed by left-clicking on the drawing area.
With the *Fuzzy Search* option you can activate a tolerance in order to achieve results despite minor typing errors or spelling variants.

In addition to the option of inserting a specific symbol using the *Find Symbol* dialog window you can also insert a real component along with its part number and technical details from the Festo product catalogue. You can find details of how to use the Festo product catalogue with FluidSIM under Using the Festo product catalogue with FluidSIM.

### 3.4 Symbol libraries

FluidSIM is capable of managing multiple libraries, each of which is displayed in a tab in the library window. Libraries which cannot be modified in FluidSIM are labeled with a lock symbol in the tab. This applies to standard library as well as to symbol folders which FluidSIM does not manage itself or for which the registered user does not possess write authorization.

Every library is displayed hierarchically. Every hierarchy level can be shown or hidden by clicking on the group name. Right-clicking in a library opens a context menu offering the following menu items for editing the library:

- **View**
  - Defines the size of the symbols displayed. Small, Normal and Large are available.

- **Expand All**
  - Opens all of the hierarchy levels.

- **Collapse All**
  - Closes all of the hierarchy levels.

There are three types of library:

- **The standard library**
  - This library is delivered with FluidSIM and cannot be modified.

- **Symbol folders**
  - Circuit and symbol files saved on the disk can be used as libraries in FluidSIM. The files from the selected folder are added as a library via the Library menu and the Add Existing Symbol Folder...
menu item. The library hierarchy corresponds exactly to the folder hierarchy. These libraries cannot be modified in FluidSIM. The files must be modified directly.

User libraries

You can create and subsequently edit new libraries via the \textbf{Library} menu and the \textbf{Add New Library...} menu item (see section Create user library). Using drag and drop you can move the symbols and groups within the library as desired.

3.4.1 Create user library

In order to be able to access frequently used symbols (or circuits) more quickly multiple symbols can be compiled into libraries. Libraries are saved as files with the \texttt{lib} file suffix. You can create new libraries using the \textbf{Library} and the \textbf{Add New Library...} menu item. Right-clicking in the new library opens a context menu with which you can modify the library.

The following options are available:

- \textbf{Copy} \hspace{1cm} Copies the selected symbols to the clipboard
- \textbf{Paste} \hspace{1cm} Inserts the symbols into the library from the clipboard. These symbols can also be partial circuits.
- \textbf{Delete} \hspace{1cm} Removes the selected symbols from the library.
- \textbf{Rename...} \hspace{1cm} Edits the text which libraries display below the symbol.
- \textbf{Add Existing Symbols...} \hspace{1cm} Opens a dialog window for selecting symbol files to be copied into the library as new symbols.
- \textbf{Copy to Other Library} \hspace{1cm} Copies the selected symbols into another library. The available libraries are listed in a submenu. Only the currently open libraries are displayed here (appearing as tabs in the library window) which are not write-protects (recognizable as no lock symbol \textbullet{} is displayed).
New Sub-Folder... Creates a new hierarchy level below the active group. The active group is the one belonging to the area below the mouse point and can be recognized by the dark blue coloring.

Remove Sub-Folder Removes the hierarchy level which the mouse pointer is located in.

Rename Sub-Folder... Enables you to rename the hierarchy level which the mouse pointer is located in.

### 3.5 Circuit files

FluidSIM circuit files have the `.circ` file suffix and are saved as compressed XML files. An option in the `Save` tab under the `Options...` menu item from the `Tools` menu allows you to deactivate this compression so that the circuit files can be viewed as plain text. This can be useful for version management software, for example.

However, please note that editing a `.circ` file outside FluidSIM can cause the file to become unreadable or corrupted upon re-import.
Library and project window

Chapter 4

4.1 Change window position

The library window is anchored on the left-hand side by default and the project window (when a project is open) is on the right-hand side.

To separate the window from the anchor move the mouse pointer to the upper margin. Click and hold the left mouse button. Move the window a small distance towards the center of the screen. Now release the left mouse button. Now you need to move the library window to the lower right and the project window to the lower left. Once a window has been separated from the anchor it can be moved freely.

To re-anchor the window move the mouse pointer to the upper margin. Click and hold the left mouse button. Move the window as far as possible to the right or the left. Now release the left mouse button. This window snaps into place. This enables you to anchor the library window to the right and the project window to the left, for example. You can also anchor both windows on the same side. In this case you can move the desired window into the foreground by clicking the associated tab.

4.2 Automatic show and hide

The tabs offer an additional, practical function: Automatically showing and hiding the library or project window. Click the associated vertical tab “Library” or “Project” at the edge of the window. This causes the window to be hidden providing a larger area for the drawing. In order to make the window visible again move the mouse pointer over the tab; the window opens once again. As soon as you have performed your operations in this window and move the mouse pointer to a circuit window the library window and / or
the project window are automatically hidden. To deactivate the function click the associated tab again (this then appears de-pressed).
Chapter 5

5.1 Insert and arrange symbols

You can insert symbols into the symbol window being edited using the dialog window *Find Symbol* and by means of the libraries. You can also transfer objects from every other window by selecting them and dragging them to the desired window. Alternatively you can also utilize the clipboard by selecting the items, choosing the *Copy* menu item on the *Edit* menu, bringing the target window into the foreground and selecting the *Paste* menu item on the *Edit* menu. Using the mouse pointer to drag objects from one window to another copies them. Dragging the objects from one position to another within a window moves them. In order to copy within a window you need to hold down the *Shift* key while moving the mouse pointer. You can recognize operation by the shape of the mouse pointer. During a move-operation a cross with arrows appears, when copying a plus symbol also appears in the lower right-hand corner of the cross.

5.2 Using the Festo product catalogue with FluidSIM

The standard FluidSIM installation already contains all of the products from Festo. That is why an extract from the Festo product catalogue is installed in multiple languages.

Note: In order to remain up to date, we recommend always installing the latest product catalogue. FluidSIM recognizes more current versions of the catalogue and uses these for the product search.

There are two basic options for inserting symbols with part numbers and technical details in the circuit.
If you wish to insert a symbol from the FluidSIM symbol library, simply select a graphical image which represents the function of a component or component group. For the majority of the symbols there is a large number of different products with different part numbers and technical details (attributes and parameters). To select a product open the Properties dialog window by right-clicking the symbol and click the Find... button.

The product catalogue represents a complete database of the available Festo products. If you wish to insert the associated symbols with part numbers and technical details for certain products then select the From Festo Catalog... menu item from the Insert menu. The Insert from catalog dialog window appears. Enter your key words in the “Search” input line. The upper table contains the search result. Highlighting a row there displays the associated symbol in the preview. Select a product by double-clicking a table row or using the Add to Selection button. Selected products are collected in the lower table. When leaving the dialog window the symbols of the selected products are inserted into the circuit window. The symbols contain the part numbers and technical details of the previously selected products in the form of attribute value pairs.

If you use a custom product database you can select it in the Product Database list box. You can use the selected database in the same way as the Festo product catalogue.
Figure 5/1: *Insert from catalog* dialog window

If you wish to insert one or more symbols from an existing shopping cart select the **From Festo Shopping Basket...** menu item from the **Insert** menu.
If you have selected a product which does not possess a graphical illustration then a text appears in the circuit diagram which takes on the component attributes instead of the symbol. Both this text and the identifiers for the symbols appear in the parts list.

You can make the settings that influence the generation of the symbol designations and accessories using the General tab under the Options... menu item from the Tools menu. If desired FluidSIM can automatically generate text elements acquired from the type attribute of the associated symbol.
5.3 Connect connectors / ports

In order to connect two component connectors with a line move the mouse pointer to the component connector. You can recognize a connector by the small circle at the end of a symbol's connection line. As soon as you have touched the line the mouse pointer transforms into a crosshair.

![Figure 5/3: Mouse pointer as a crosshair over a component connector.](image)

Now press the left mouse button and move the mouse pointer to the connector which you wish to connect with the first.

You can recognize when you are over the connector by the shape of the mouse pointer. If the mouse pointer is over a connector...
which is already connected to a line then the prohibited sign \(\bigcirc\) appears and no line can be connected.

→ Release the mouse button once you have touched the second connector.

FluidSIM automatically lays a line between the two connectors.

![Figure 5/4: Line between two connectors](image)

Support points can be set when dragging lines. To do so simply release the mouse button while dragging the line and click the desired points. The line is completed as soon as you click a second connector or the same point twice. You can cancel the action by pressing the `Esc` key or the right mouse button.
5.4 Automatically connect connectors

FluidSIM supports two methods of automatically connecting connectors. The first is to drop a symbol on an existing line. To be able to use this method, the symbol must have at least two connectors that precisely fit onto one or more existing lines and the lines that will be produced must not cross the symbol. The following two illustrations show this function.

Figure 5/5: Circuit before the connectors are automatically connected

Figure 5/6: Circuit after the connectors are automatically connected

Another method of automatically connecting connectors is to position symbols so that their connectors can be horizontally or vertically connected with free connectors from other symbols. After
the symbol has been dropped the corresponding lines are automatically drawn if they do not cross any symbols. The free connectors can also be T distributors.

You can define how different objects' connectors are automatically connected in the Connector Links tab under the Options... menu item from the Tools menu. The following two illustrations show this function.

**Figure 5/7**: Circuit before the connectors are automatically connected

**Figure 5/8**: Circuit after the connectors are automatically connected

### 5.5 Insert T distributor

You do not need to utilize a special symbol in order to insert a T distributor. FluidSIM automatically inserts a T distributor when you lay a component connection on a line or lay a line segment to a connection. If you wish to connect two lines then you can also draw
one line segment to another; FluidSIM then inserts two T distributors and connects these with a new line.

→ Move the mouse points to a connector and press the left mouse button.

As soon as you touch the line the mouse pointer transforms into a crosshair.

→ Release the mouse button once you have touched the desired point on the line.

FluidSIM inserts a T distributor and automatically lays a line.

Figure 5/9: Line connection with inserted T distributor

Every T distributor can connect up to 4 lines with each other.
The default representation for the T distributor can be selected via the corresponding drop-down list on the toolbar.

You can customize the representation of the T distributor by double-clicking the T distributor or highlighting the T distributor and selecting the Properties... menu item from the Edit menu. The “Properties” dialog window opens. Select the “Representation” tab.

Figure 5/10: T distributor dialog window. Tab: Representation
Defines the representation of the basic T distributor. Here you can select whether the distributor should be represented as a filled circle or a simple intersection.

**Cross-Link**

Defines that the T distributor should be represented as an electric link. This representation has a knock-on effect on the connected lines, which are automatically marked as links.

**Junction**

Defines that the T distributor should be represented as an electric junction. This representation has a knock-on effect on the terminals' target search. With a junction, the target in the direction of a straight line or right angle is found first and then the target via an angled branch.

### 5.6 Move lines

Once you have joined two connectors you can then adjust the length of the lines. You can move the line segments in parallel by moving the respective line segment. You can see when you have touched the line on the basis of the line-selection shape of the mouse pointer.

→ Press the left mouse button and move the line segment orthogonally to the desired position.
Figure 5/11: Moving a line segment

→ Release the left mouse button; FluidSIM adjusts the adjoining line segments in such a way that they remain connected.

If you move a line segment with is directly connected to a component connector then FluidSIM may insert additional line segments in order to prevent gaps.

If you move a line segment that is horizontally or vertically connected with other line segments via T distributors then these line segments are moved together with the T distributors.
Figure 5/12: Moving multiple line segments

If you only want to move the individual line segment in the case described above then release the mouse button after you highlight the line segment. Click the segment again and move it while keeping the mouse button pressed.
5.7 Define the characteristics of lines

Lines, like other symbols, can be assigned an identification, catalogue properties and user-defined properties. You can find further information on this under Component attributes in the Properties dialog window.

You can also define the style, color and drawing layer of the lines by double-clicking a line segment or highlighting the line segment and selecting the Properties... menu item from the Edit menu. The Line Properties dialog window opens. Select the Drawing Properties tab in this window. The settings are applied to the entire line section as far as the next connector or T distributor.
Figure 5/15: *Line Properties* dialog window: defining the properties of a pneumatic or electric line

<table>
<thead>
<tr>
<th>Layer</th>
<th>Sets the drawing layer of the line.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Color</td>
<td>Sets the color of the line.</td>
</tr>
<tr>
<td>Line Style</td>
<td>Sets the line style of the line.</td>
</tr>
<tr>
<td>Line Width</td>
<td>Sets the line thickness of the line.</td>
</tr>
</tbody>
</table>

Note: Working lines are typically displayed as solid lines, pilot lines as dashed lines.
5.8 Delete line

To delete a line you can either highlight an associated line segment and press the Del key or select the Delete menu item from the Edit menu or highlight a component connector and press the Del key. In these cases it is the line rather than the connector itself that is deleted.

If you delete a T distributor which three or four lines are attached to then all of the lines are deleted. If, on the other hand, only two lines are connected then only the T distributor is deleted and the two lines combined into one.

5.9 Set the properties of the connectors

You can assign a component connector an identification and a blanking plug or silencer by double-clicking on the connector or by selecting the connector and choosing the Properties... menu item on the Edit menu. The Connector dialog window then opens.
Figure 5/16: Connector dialog window: Set the properties of a connector

Identification
You can enter a text identifying this connector into the input line. If the Display option is activated then the identification is displayed in the circuit diagram.

Whether or not the identification is actually displayed depends on the option selected under Show Connector Descriptions.

Terminator
Open the symbol list containing connector terminators by clicking the button using the arrow. Select a suitable silencer or a blanking plug.

Note: Please note that this symbol list is only available if a line is not connected to the connector in question. If you wish to connect a line to a sealed connector you first have to remove the blanking plug or silencer. To do this select the empty field in the symbol list with the connector terminators. The alignment of the connector terminator can be set via the radio buttons.
5.10 Define component connector / set T distributor

You can set T distributors on existing lines or define a new component connector by selecting the Define Connector... menu item from the Insert menu. FluidSIM then switches to a special mode in which the next mouse click sets a T distributor or defines the new connector. You can cancel the action by pressing the Esc key or the right mouse button.

Connectors in symbols can be set at any desired position.

Note: To set the connector precisely at the desired position we recommend zooming the display window in closely to the relevant symbol. As soon as the mouse pointer is over a symbol the mouse pointer converts into a cross-hair. Left-clicking sets the new connector.

![Define Connector dialog window](image)

Figure 5/17: Define Connector... dialog window

**Type of connector**
Selects the connector type. The following are available: “Pneumatic”, “Electric” and “Electric (Label)”.

**Define multiple connectors**
Multiple connectors can be set one after the other if this option is active. You can cancel the action by pressing the Esc key.
5.11 Delete component connector

To delete a component connector select this and choose the [Delete Connector] menu entry on the [Edit] menu.

Note: Please note that the [Delete] menu entry or the [Del] do not delete the connector but rather only one possibly connected line.

5.12 Configure a way valve

If you require a certain valve which you cannot find in the standard FluidSIM library you can create your own valve symbol with the help of the valve editor.

→ Insert a 5/n-way valve into a circuit window from the “Standard Symbols / Pneumatic Symbols / Valves / Configurable Way Valves” library.

To set the valve body and the actuation types of the way valves double-click the valve. The dialog window Properties then opens. Click the “Configure Valve” tab to access the valve editor.
Figure 5/18: Properties dialog window: Configure Valve tab

Left Actuation – Right Actuation

You can select the actuation types of the valve from the “Manually”, “Mechanically” and “Pneumatically/Electrically” categories for both sides of the valve. Click the button with the mouse pointer and select a symbol element. A valve can have multiple actuation types at the same time. If you do not want an actuation type from a category then select the empty field in the list. You can also define whether each side should have a spring return, pilot control, pneumatic spring or external supply.

Valve Body

A configurable valve can possess a maximum of four switching positions. One valve body can be selected for each switching position. Click the associate button with the mouse points to open the
symbol elements list. Select a symbol element for each switching position. If you want to use less than four switching positions then select the empty field on the list for the positions not required.

**Initial Position**
Here you set which switching position the valve should use in the normal position. Note: When determining this setting ensure that it does not conflict with a possible spring return.

**Dominant Signal**
This provides a graphical identification of whether the right or left signal should dominate in the event of equally strong signals.

**External Supply**
This creates an additional connector for connecting the external supply for the controller.

### 5.13 Configure cylinder

If you require a certain cylinder which you cannot find in the standard FluidSIM library you can create your own cylinder symbol with the help of the cylinder editor.

→ Insert a double-acting cylinder into a circuit window from the “Standard Symbols / Pneumatic Symbols / Pneumatic Drives / Configurable Cylinders” library.

To configure the cylinder double-clock on the cylinder. The dialog window *Properties* then opens. Click the “Configure Cylinder” tab. This brings you to the cylinder editor.
Figure 5/19: Properties dialog window: Configure Cylinder tab

Cylinder Type
Click the button with the mouse pointer to open the symbol elements list. Select a cylinder type. Set whether the cylinder should be single-acting or double-acting.

Return Spring
 Specifies whether a spring for the return should be inserted into the right or left cylinder chamber.

Piston
Click the button with the mouse pointer and select a symbol element for the piston. Set whether the cylinder should possess end position cushioning and whether this should be adjustable.
Click the button with the mouse pointer and select a symbol element for the piston rod.

Using the slider you can specify the relative piston position in 25 % steps. 0 % stands for the completely retracted and 100 % extended piston.

5.14 Group symbols

If you wish to combine multiple symbols into a group select these and choose the Group menu item on the Edit menu. Groups can also be nested, i.e. already grouped objects can be grouped again.

A group primarily serves as a drawing aid and does not represent any new components. Every element in a group is included in a parts list in exactly the same way as without being grouped. Double-clicking on a group element opens the dialog window Properties of group element clicked.

If you wish to combine multiple symbols into a new component with its own attributes create a macro object.

5.15 Create macro objects

If you wish to combine multiple symbols into a new component with its own attributes then highlight these and select the Create Macro Object menu item from the Edit menu. This creates a new macro object. Macro objects are included in the parts lists as independent components. The original symbols are removed from the parts lists. It is no longer possible to edit their component attributes.
5.16 Delete symbol groups and macro objects

To delete a group or a macro object select the group or the macro object and select the [Ungroup/Break Off] menu item from the [Edit] menu. This always deletes the outermost group. In order to delete nested groups you must repeat the operation.

5.17 Align symbols

To align objects with each other, select these and choose the desired orientation from the [Align] menu item on the [Edit] menu or click the appropriate button on the toolbar.

5.18 Mirror symbols

The symbols can be both horizontally and vertically mirrored. Select the desired mirror axis from the [Mirror] menu item on the [Edit] menu or click the appropriate button on the toolbar. If you select multiple objects at the same time then every object will be mirrored separately. If you wish the operation to use a common mirror axis then group the objects before the operation.

The geometrical properties can be entered directly via the “Drawing Properties” tab. Enter a minus sign in front of the corresponding scaling factor in order to mirror the symbol.
5.19 Rotate symbols

The symbols can be rotated in 90 degree steps or with the help of the mouse pointer. To rotate objects in 90 degree steps, select the desired angle from the [Rotate] menu item on the [Edit] menu or click the appropriate button on the toolbar. If you select multiple objects at the same time then every object will be rotated separately. If you wish the operation to use a common axis of rotation then group the objects before the operation.

You can also rotate symbols with the help of the mouse pointer by clicking and dragging the edge of the symbol. In order to do this FluidSIM must be in [Enable Rotate] mode. This mode can be activated or deactivated using the [Enable Rotate] menu item from the [Edit] menu or by clicking the corresponding button on the toolbar.

Note: Activating the [Enable Scale] mode deactivates the [Enable Rotate] mode and vice versa.

→ In [Enable Rotate] mode click the edge of the symbol and hold down the mouse button.

![Figure 5/20: Rotate symbol](image)

The current angle of rotation and guides are displayed.

→ Hold down the mouse button and move the mouse pointer until the desired angle of rotation is achieved. The angle changes in 15 degree steps.

Note: If you also press the [Shift] key then you can rotate the symbol steplessly.
The angle of rotation can also be entered directly in the properties dialog window in the Drawing Properties tab.

5.20 Scale symbols

The component symbols can be scaled with the help of the mouse pointer. In order to do this FluidSIM must be in Enable Scale mode. This mode can be activated or deactivated using the Enable Scale menu item from the Edit menu or by clicking the corresponding button on the toolbar.

Note: Activating the Enable Scale mode deactivates the Enable Rotate mode and vice versa.

→ In Enable Scale mode click the edge or corner of the symbol and hold down the mouse button.

The current scaling relationship to the current original size is displayed.

→ Hold down the mouse button and move the mouse pointer until the desired size is reached. The scaling relationship is changed.
in 0.25 steps. Note: If you also press the \texttt{Shift} key then you can scale the symbol steplessly.

Figure 5/23: Scale symbol

You can simultaneously mirror the symbol by moving the mouse pointer over the middle of the symbol to the opposite side.

Figure 5/24: Mirror symbol

The scaling factor can also be entered directly in the \textit{Properties} dialog window in the \textit{Drawing Properties} tab.
Chapter 6

In FluidSIM drawing frames are “circuit diagrams” which consists of a title block and the frame with the field divisions. They can also be displayed in other circuit diagrams. Existing CAD drawing frames can be imported using the DXF import menu item on the File menu. No order to make a drawing frame usable in different projects and circuit diagrams a number of texts in the title block must be editable. These texts are Author, Creation date, Project name, Page name and Page number, for example. In FluidSIM these are text components with Attribute Link.

6.1 Editable labels

Texts in the title block of a drawing frame are text components. You can use the imported texts or insert new text components at the desired positions. Editable texts are text components with Attribute Link. These texts are replaced by the corresponding attribute values of the project and the circuit.

→ Double-click a text component to open the Properties dialog window.

→ Enter the name of the attribute to be linked, e.g. “creator”, in the text field and activate the “Attribute Link” option.

Note: You can also use an imported text as an attribute name.

The attribute name is utilized as a placeholder. These attributes are displayed in angle brackets in the “circuit diagram” with the drawing frame. These attributes are replaced by the corresponding attribute values when using the drawing frame in a project or circuit diagrams. Edit the attribute values in the Properties dialog window of the project or the circuit diagram. Clicking on a text component of the drawing frame opens the Properties dialog window of the project or the circuit which contains the attribute which the text component refers to.
6.2  Use a drawing frame

Drawing frames can be copied into a project and/or a circuit diagram. Insert the drawing frame via the Properties dialog window of a project or a circuit.

All of the objects belonging to a drawing frame are inserted into the circuit diagram as a copy. Changing the file with the drawing frame at a later date does not have any effect on the circuit diagram which the drawing frame was inserted into.

When copying the objects belonging to the drawing frame all of the attributes are generated with the drawing frame’s text components refer to and which do not exist in the project or circuit.
Figure 6/1: **Page** dialog window: inserting a drawing frame

**Inherit From Project**

If this option is activated then the drawing frame specified in the project is copied into the circuit. The path and the file used are displayed in the "Frame File" line.

**Pick...**

This button opens a dialog window in which an included frame can be selected. These frame files are located in the *frm* directory and are compiled in the project file *frames.prj*.
Opens the frame file for editing.

Removes the drawing frame from the circuit. The drawing frame's attributes remain attributes of the project or circuit.

When inserting a drawing frame the attributes of the text components of the drawing frame are listed. These attributes are saved with the project or the circuit drawing and can be edited and deleted. The Reload Frame Attributes button reloads all of the attributes from the drawing frame, thus updating the attribute list of the project or the circuit drawing.
All of the available frame files are displayed as a tree on the right-hand side. The desired drawing frame can be selected in this tree. The drawing frame is then displayed in the preview. In addition the “Attributes” list displays all of the attributes of the texts from the drawing frame which were defined as links.

Figure 6/2: Select Drawing Frame dialog window
Opens a dialog window to select a circuit file to be used as a frame.

6.3 Page dividers

A circuit diagram or page can be logically divided into rows and columns, which can be labeled with numbers or letters. These page dividers are usually shown in the drawing frame and serve as a means of orientation within the page. Above all they allow the current paths (columns) of contacts to be specified in the contact images.

The graphical representation of the page dividers matches the logical page dividers in the drawing frames provided. The logical page dividers can be shown and hidden via the Show Page Dividers menu item from the View menu or via the button. They are displayed at the left-hand as well as the upper edge of the circuit window.

If the page dividers are visible you can customise them using the mouse so that they match the graphical representation of the drawing frame, for example. This customization can be done in different ways:

→ Click and hold the mouse buttons in a column or row to move the entire column or row.

Figure 6/3:

→ Click and hold the mouse buttons at the outer margin of a column or row to move the margin of the column or row.
Figure 6/4:

The opposite margin is not moved and the columns or rows are resized proportionally.

→ Click and hold the mouse buttons at the margin of an inner division in a column or row to move the margin of the column or row.

Figure 6/5:

In this case only the adjacent columns or rows are resized.

Columns and rows can be inserted and removed using the + and - buttons.

The label type and the number of rows and columns can be defined using the button. The settings are saved as page properties. The following dialog window is opened:
Page Dividers

Figure 6/6: Page dialog window, Page Dividers tab

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adopt from drawing frame</td>
<td>Selecting this option only makes sense for pages that do not represent drawing frames. This option must be deactivated if the current page represents a drawing frame that is to be inserted into other pages later. If this option is activated then all settings that have been defined in the drawing frame will be adopted.</td>
</tr>
<tr>
<td>Rows</td>
<td>Defines the settings for the horizontal rows.</td>
</tr>
<tr>
<td>Columns</td>
<td>Defines the settings for the vertical columns.</td>
</tr>
<tr>
<td>Number</td>
<td>Defines the number of page dividers.</td>
</tr>
<tr>
<td>Numbering</td>
<td>Numbers, lowercase letters or uppercase letters can be used for numbering.</td>
</tr>
<tr>
<td>First Item</td>
<td>Defines the first numbering item. The numbering will be continued on analogously from this item.</td>
</tr>
<tr>
<td>Descending Order</td>
<td>Changes the numbering order.</td>
</tr>
<tr>
<td>Reset</td>
<td>Resets the page dividers to default values.</td>
</tr>
</tbody>
</table>
Chapter 7

7.1 Drawing tools

7.1.1 Grid

For arranging the symbols and laying the lines it is often practical to show a point or line grid. You can activate or deactivate the display of the grid using the Show Grid menu item from the View menu. You can also define further grid settings in the General tab under the Options... menu item from the Tools menu.

In order to simplify handling the connectors snap into place when they are close to a grid line. This makes it easier to find the precise position when moving the connectors.

Note: The grid snap function may not be desired as it prevents free positioning. In this case you can hold down the Ctrl key during the moving operation; this temporarily deactivates the grid snap function.

7.1.2 Alignment lines

Connectors between symbols should be exactly horizontal or vertical wherever possible. Then they can be connected with a straight line.

FluidSIM supports the exact positions firstly via the grid snap and secondly via automatically displaying red alignment lines while moving the selected objects.
Open a circuit file which contains multiple objects. Select one of these and slowly move it back and forth above and next to other objects.

Observe the dashed red lines which appear when two or more connectors lie above each other.

Figure 7/1: Automatically display the alignment lines

In order to simplify handling the connectors snap into place when they are close to an alignment line. This makes it easier to find the precise position when moving the connectors.

Note: The grid snap function may not be desired as it prevents free positioning. In this case you can hold down the Ctrl key during the moving operation; this temporarily deactivates the alignment lines and the grid snap function.

### 7.1.3 Object snap

Various snap points can be activated for precise drawing. During a drawing operation the mouse pointer snaps into place as soon as it is close to a snap point. The following snap functions are available:

- **Snap to Grid**
- **Snap to Connector**
7.1.4 Rulers

The rulers can be shown and hidden via View Show Rulers. They are displayed at the left-hand as well as the upper edge of the circuit window.

7.2 Drawing levels

FluidSIM supports 256 drawing levels which can be shown / hidden and locked / unlocked individually. In addition you can also define the color and line thickness for every drawing level. Using the Drawing Layers... menu item on the View menu you can set the properties of the individual layers and also insert a description.

Note: The drawing frame is located on layer “0” by default.
The drawing layer settings can be copied over as default settings from the current circuit using the *Inherit From Page* button.

You can select the drawing layer where newly inserted objects should be placed under “Default Layer”. If you do not want the symbol layer to be changed when objects are inserted then select the “Preserve Object Layer” option.

Objects located on a drawing layer for which the “Edit” option is deactivated are visible but cannot be highlighted and therefore neither moved nor deleted. This enables you to lock a drawing frame, for example, if it was inserted manually and not via the *Properties* dialog window for the circuit or project. In order to still be able to edit objects on layers of this type you must activate the “Edit” option for the corresponding layer.

Figure 7/2: *Drawing Layers* dialog window
Drawing layers for which the “Display” option is deactivated are neither visible nor can they be edited.

7.3 Cross-references

Cross-references serve to link connected parts of a circuit drawing when the entire drawing is spread across multiple pages. This allows lines to be interrupted, for example, and continued on another page.

FluidSIM offers two types of cross-references. Paired cross-references consist of two cross-reference symbols that reference each other. The two cross-reference symbols are linked via a unique label that is entered for both symbols.

The option also exists to reference any object within a project from a cross-reference symbol. The cross-reference is uni-directional in this case: from the cross-reference to the target object. This allows several cross-references to reference the same object.

Both types enable you to jump directly from a cross-reference to the associated target. With the paired cross-reference the target is the corresponding cross-reference, otherwise an object.

You jump to the corresponding target either using the [Jump to Target] button in the properties dialog window for the cross-reference symbol or by highlighting the cross-reference and selecting the [Jump to Target] menu item from the context menu.

The circuit drawings involved must belong to the same project.

Open the Cross-reference dialog window from the [Edit] menu and the [Properties...] menu item. Alternatively you can open this dialog window by double-clicking the cross-reference symbol or using the [Properties...] context menu.
Cross-reference dialog window

- **Text**: This text is displayed in the cross-reference.
- **Label**: Defines the labels via which the linked cross-references are identified.
- **Link**: If this option is activated then the label entered constitutes a link to a target object. The cross-reference only works in the direction of the target object in this case. This option can be combined with the *Show Location* option to show the location of the target object.
- **Target Text**: If the *Show Location* option is activated then the location of the target object will be displayed here. The representation of the location is defined in the *Cross Reference Representation* tab in the properties dialog window for the page or project.
If Show Description is activated then the text of the corresponding cross-reference is displayed for paired cross-references, otherwise the description of the target object is displayed.

**Display Target Text**
If this option is activated then the above-mentioned text from the Target Text field is displayed below the text for this cross-reference.

**Jump to Target**
Activating this button opens the circuit window containing the corresponding cross-reference. The associated symbol is indicated by an animation.

The font type, text color and alignment of the texts to be displayed can also be customized.

### 7.3.1 Create cross-references from symbols

You can generate a cross-reference from one or more symbols. To do so highlight the corresponding symbols and select the Create Cross-reference menu item or the Create Cross-reference menu item from the context menu. The highlighted symbols are combined into a group that constitutes a cross-reference with two additional texts. One of these texts shows the label used and the other the target text for the cross-reference.

### 7.3.2 Cross-reference representation

The location of the target object can be shown in cross-references. How it is represented can be specified in the Cross Reference Representation tab in the properties dialog window for the circuit or project. The location can be composed from the “Page number”, “Page”, “Page Column”, “Page Row” and “Object Identification” components. These reference the target object. Separators can be placed before and after each component. The default representation is:
The description for the page and the page number are specified in the Properties dialog window for the circuit.

The page number is a predefined placeholder that can be used in text components and drawing frames among other things.

Figure 7/4: Cross Reference Representation tab

<table>
<thead>
<tr>
<th>Inherit From Parent Node</th>
<th>Defines whether the representation rules for the parent node should be applied.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example</td>
<td>A sample location that conforms to the specified rules is displayed here.</td>
</tr>
<tr>
<td>Reset</td>
<td>Resets the cross-reference representation to the default setting.</td>
</tr>
</tbody>
</table>

7.3.3 Manage cross-references

All paired cross-references in a project are listed in a dialog window that is opened using the [Project] [Manage Cross References...] menu item. Using this dialog you can jump to all paired cross-references in the project.
Figure 7/5: **Manage Cross References...** tab

<table>
<thead>
<tr>
<th>Label</th>
<th>Contains the label for the corresponding cross-reference.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Containing Page</td>
<td>A page containing the cross-reference in question can be selected in the drop-down list.</td>
</tr>
<tr>
<td>Jump to Target</td>
<td>Using this button you can jump to the corresponding cross-reference.</td>
</tr>
</tbody>
</table>

### 7.4 Drawing functions and graphical elements

Graphical elements can be inserted into a circuit using the **Draw** menu or by activating the drawing function on the toolbar. In order to prevent you from unintentionally moving other symbols when drawing you enter a special mode for the drawing function in which you can only perform the selected drawing functions. After every drawing operation FluidSIM returns to the normal editing mode. To insert another drawing element you must select the associated
menu item or the corresponding drawing function on the toolbar again.

Note: If you wish to draw several elements in a row without leaving the special drawing mode then you can select the menu item or the corresponding drawing function on the toolbar while holding down the Shift key. The drawing mode then remains active until the menu item or the drawing function is deactivated by selecting it again or another drawing function is selected without the Shift key being pressed.

The drawing functions toolbar contains the following buttons:

- Switches to the normal editing mode.
- Switches to the mode for drawing a line.
- Switches to the mode for drawing a polyline.
- Switches to the mode for drawing a rectangle.
- Switches to the mode for drawing a circle.
- Switches to the mode for drawing a ellipse.
- Switches to the mode for drawing a text.
- Switches to the mode for drawing an image.
- Switches to the mode for drawing a conduction line. You can start by choosing whether you would like to draw a pneumatic or electric conduction line.

The graphical elements are drawn in the color shown.

The graphical elements are drawn in the line style shown.

The graphical elements are drawn in the line thickness shown.

The line beginnings are drawn with the symbol shown.

The line ends are drawn with the symbol shown.
7.4.1 Interruption/Potential

If conduction lines extend over several pages then the line ends can be assigned interruptions. Interruptions can be used to define that a conduction line is only interrupted in the drawing and is continued somewhere else. An interruption can be assigned an identification and linked with another interruption. The location of the linked interruption can be displayed at the source interruption.

If an electric interruption is used with an electric line then this interruption is a potential. The use of electric potentials is described under Potentials and conduction lines.

You can insert an interruption into an existing line or position it freely in a circuit.

Select the **Interruption/Potential...** menu item from the **Insert** menu.

A dialog window opens where you can make various settings for the interruption to be inserted.

![Interruption/Potential dialog window](image)

**Figure 7/6: Interruption/Potential... dialog window**

**Type of connector** Defines whether a pneumatic or electric interruption (potential) is to be inserted.
Define multiple connectors: Multiple interruptions can be set one after the other if this option is active. You can cancel the action by pressing the Esc key.

You can edit the properties for an interruption by double-clicking it. The following dialog window opens.

**Figure 7/7: Interruption/Potential dialog window**

- **Layer**: Defines the drawing layer for the interruption.
- **Identification**: Defines the identification for the interruption. The identification will be displayed in the circuit if the Display option is active.
- **Target**: Interruptions can reference each other in pairs. The counterpart interruption can be selected from a list or entered directly in the list box. The Browse... button opens a dialog window where all interruptions are displayed in a tree and can be selected. Only interruptions that are not linked will be shown in the list if the Only Free Interruptions/Potentials option is active.
- **Jump to Target**: If the interruption is linked with another interruption then this button can be used to jump to the counterpart interruption.
7.4.2 Conduction line

A conduction line is drawn by defining two end points. A pneumatic or electric line of this type consists of two connectors with a line between them. Both connectors can be used as the starting point for further connections. The conduction lines can only be drawn horizontally or vertically.

You open a dialog window where you can make various settings for the line to be dragged using the [Insert Conduction Line...] menu item or the button on the toolbar.
Figure 7/8: Conduction Line... dialog window

Type of connection line

Selects the conduction line type. The following are available: “Pneumatic” and “Electric”.

Define multiple lines

Multiple conduction lines can be set one after the other if this option is active. You can cancel the action by pressing the Esc key.

If multiple conduction lines with the same distance between them are to be drawn horizontally or vertically then change the number in the “Number of lines” field. You specify the distance to be maintained between the lines using “Distance”.

Under “Start Point Appearance” and “End Point Appearance” you can define the representation of the respective end point. If the “Display Identification” option is selected then the identification for the start point is displayed. In order to guarantee that the same identification is displayed for the start point and the end point, a text reference for the start point is displayed for the end point.
instead of its identification. **Interruptions** are used as end points for conduction lines.

After confirming the dialog window you switch to a special mode where you define the end points of the line with two consecutive mouse clicks. Alternatively you can also draw a line by clicking and dragging.

An electric conduction line can constitute a potential line. This is described under **Potentials and conduction lines**.

### 7.4.3 Line

A line is drawn by defining two points. In contrast to a conduction line this line is purely a drawing element. As such it can be drawn with any desired angle but does not allow connections with pneumatic or electric connectors.

The line-specific properties can be defined in the **Drawing Properties** tab of the **Properties** dialog window for the line:
Figure 7/9: Properties dialog window for a line: Drawing Properties tab

- **Start Point**: Defines the x/y coordinate of the start point.
- **End Point**: Defines the x/y coordinate of the end point.
- **Scale**: Defines the scaling in the x or y direction.
- **Rotation**: Defines the angle of rotation in degrees.
- **Override Color**: Defines the color of the drawing element.
- **Line Style**: Defines the line style.
- **Line Width**: Defines the line thickness.
- **Start Cap**: Defines how the beginning of the line is displayed.
- **End Cap**: Defines how the end of the line is displayed.
- **Background**: Sets the location of the drawing element to the background. This means that all of the circuit symbols are on top of this. For example symbols are not covered by filled drawing elements.
Sets the location of the drawing element to the foreground. This means that all of the circuit symbols are underneath this. For example symbols are covered by filled drawing elements.

Reset

Reset the settings to the default values.

7.4.4 Polyline (set of connected lines)

A polyline (also called a set of connected lines or polygonal chain) is drawn by defining two or more points. Each mouse click sets a further vertex. The polyline is ended by clicking the same point twice.

The properties of the polyline can be defined in the Drawing Properties tab in the Properties dialog window:

Figure 7/10: Properties dialog window for a polyline: Drawing Properties tab

Scale

Defines the scaling in x or y direction.
### 7.4.5 Rectangle

A rectangle is drawn by defining two diagonally opposite corner points.

The rectangle-specific properties can be defined in the *Drawing Properties* tab of the *Properties* dialog window for the rectangle:

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rotation</td>
<td>Defines the angle of rotation in degrees.</td>
</tr>
<tr>
<td>Override Color</td>
<td>Defines the color of the drawing element.</td>
</tr>
<tr>
<td>Line Style</td>
<td>Defines the line style.</td>
</tr>
<tr>
<td>Line Width</td>
<td>Defines the line width.</td>
</tr>
<tr>
<td>Start Cap</td>
<td>Defines how the beginning of the line is displayed.</td>
</tr>
<tr>
<td>End Cap</td>
<td>Defines how the end of the line is displayed.</td>
</tr>
<tr>
<td>Background</td>
<td>Sets the location of the drawing element to the background. This means that all of the circuit symbols are on top of this. In particular it means that symbols are not covered by filled drawing elements, for example.</td>
</tr>
<tr>
<td>Foreground</td>
<td>Sets the location of the drawing element to the foreground. This means that all of the circuit symbols are underneath this. In particular it means that symbols are covered by filled drawing elements, for example.</td>
</tr>
</tbody>
</table>

To change the vertices of a polyline or to set new vertices switch to the “polyline editing mode” by selecting the *Edit Poly Line* menu item or activating the button on the toolbar.

You can move the existing vertices by clicking and dragging. The mouse pointer changes to when you mouse over an existing vertex. If the mouse pointer is over a line without a vertex is displayed and a new vertex is inserted as soon as you click.
Figure 7/11: Properties dialog window for a rectangle: Drawing Properties tab

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scale</td>
<td>Defines the scaling in the x or y direction.</td>
</tr>
<tr>
<td>Rotation</td>
<td>Defines the angle of rotation in degrees.</td>
</tr>
<tr>
<td>Override Color</td>
<td>Defines the color of the drawing element.</td>
</tr>
<tr>
<td>Fill Area</td>
<td>Fills the rectangle with the color listed.</td>
</tr>
<tr>
<td>Line Style</td>
<td>Defines the line style.</td>
</tr>
<tr>
<td>Line Width</td>
<td>Defines the line thickness.</td>
</tr>
<tr>
<td>Background</td>
<td>Sets the location of the drawing element to the background. This means that all of the circuit symbols are on top of this. For example symbols are not covered by filled drawing elements.</td>
</tr>
<tr>
<td>Foreground</td>
<td>Sets the location of the drawing element to the foreground. This means that all of the circuit symbols are underneath this. For example symbols are covered by filled drawing elements.</td>
</tr>
</tbody>
</table>
7.4.6 Circle

A circle is drawn by defining a middle point and a radius. You can draw a circular arc by subsequently entering the beginning and final angles into the *Drawing Properties* tab in the *Properties* dialog window of the circle.

The circle-specific properties can be defined in the *Drawing Properties* tab of the *Properties* dialog window for the circle:

![Figure 7/12: Properties dialog window for a circle: Drawing Properties tab](image)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scale</td>
<td>Defines the scaling in the x or y direction.</td>
</tr>
<tr>
<td>Arc</td>
<td>Defines the starting and final angles of a circular arc.</td>
</tr>
<tr>
<td>Rotation</td>
<td>Defines the angle of rotation in degrees.</td>
</tr>
<tr>
<td>Override Color</td>
<td>Defines the color of the drawing element.</td>
</tr>
<tr>
<td>Fill Area</td>
<td>Fills the circle with the color listed.</td>
</tr>
</tbody>
</table>
Line Style  
Defines the line style.

Line Width  
Defines the line thickness.

Start Cap  
Defines how the beginning of the line is displayed.

End Cap  
Defines how the end of the line is displayed.

Background  
Sets the location of the drawing element to the background. This means that all of the circuit symbols are on top of this. For example symbols are not covered by filled drawing elements.

Foreground  
Sets the location of the drawing element to the foreground. This means that all of the circuit symbols are underneath this. For example symbols are covered by filled drawing elements.

7.4.7 Ellipse

An ellipse is drawn by defining a middle point and two radii with parallel axes. You can draw an ellipse by subsequently entering the beginning and final angles into the Drawing Properties tab in the Properties dialog window of the ellipse.

The ellipse-specific properties can be defined in the Drawing Properties tab of the Properties dialog window for the ellipse:
### Properties dialog window for an ellipse

#### Drawing Properties tab

<table>
<thead>
<tr>
<th>Tab</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scale</td>
<td>Defines the scaling in the x or y direction.</td>
</tr>
<tr>
<td>Arc</td>
<td>Defines the starting and final angles of an ellipse.</td>
</tr>
<tr>
<td>Rotation</td>
<td>Defines the angle of rotation in degrees.</td>
</tr>
<tr>
<td>Override Color</td>
<td>Defines the color of the drawing element.</td>
</tr>
<tr>
<td>Fill Area</td>
<td>Fills the circle with the color listed.</td>
</tr>
<tr>
<td>Line Style</td>
<td>Defines the line style.</td>
</tr>
<tr>
<td>Line Width</td>
<td>Defines the line thickness.</td>
</tr>
<tr>
<td>Start Cap</td>
<td>Defines how the beginning of the line is displayed.</td>
</tr>
<tr>
<td>End Cap</td>
<td>Defines how the end of the line is displayed.</td>
</tr>
<tr>
<td>Background</td>
<td>Sets the location of the drawing element to the background. This means that all of the circuit symbols are on top of this. For example symbols are not covered by filled drawing elements.</td>
</tr>
</tbody>
</table>

Figure 7/13: *Properties* dialog window for an ellipse: *Drawing Properties* tab
### Foreground

Sets the location of the drawing element to the foreground. This means that all of the circuit symbols are underneath this. For example symbols are covered by filled drawing elements.

### 7.4.8 Text

A text is inserted at the position of the mouse pointer by clicking. The *dialog window Properties* for entering the text and setting the attributes then opens.

### 7.4.9 Image

An image is inserted at the position of the mouse pointer by clicking. The dialog window for selecting an existing image file then opens.

Large background images can massively decrease the processing speed as the screen has to be re-drawn whenever symbols are moved or edited.

The image-specific properties can be defined in the *Drawing Properties* and *Picture* tabs of the *Properties* dialog window for the image:
Figure 7/14: Properties dialog window for an image: Drawing Properties tab

**Scale**
Defines the scaling in the x or y direction.

**Rotation**
Defines the angle of rotation in degrees.

**Override Color**
Defines the color of the drawing element.

**Background**
Sets the location of the drawing element to the background. This means that all of the circuit symbols are on top of this. For example symbols are not covered by filled drawing elements.

**Foreground**
Sets the location of the drawing element to the foreground. This means that all of the circuit symbols are underneath this. For example symbols are covered by filled drawing elements.

**File**
Defines the image file for the image.

**External Link**
When this option is active FluidSIM only saves a link to the image file. However if this option is deactivated then the image is embedded in the circuit diagram. This is the preferable variant if you wish to pass on or archive the circuit diagram.
7.5 Check drawing

Using the [Check Drawing] menu item from the [Page] menu you can have FluidSIM check your drawing for possible drawing errors. FluidSIM displays the following messages where necessary:

- *Duplicated identification labels*
- *Unresolved link targets*
- *Superimposed objects*
- *Lines through connectors*
- *Open connectors*

If messages are displayed then the corresponding objects are selected after confirmation in the dialog window.
Chapter 8

This chapter provides an introduction to creating and simulating GRAFCET plans with FluidSIM. See norm DIN EN 60848 for the complete specification of the GRAFCET description language. Festo Didactic provides a range of training documentation for more detailed introductions to GRAFCET. Unlike an SPS programming language, such as Sequential Function Chart (SFC), GRAFCET is a graphic description language that describes the logical behaviour and operation of a control system or a process - regardless of the technical software and hardware implementation. FluidSIM can be used to both create and simulate GRAFCET plans. The term GRAFCET is also used as a synonym for a GRAFCET plan. It should be obvious from the context whether the word GRAFCET refers to the plan or the language. A GRAFCET essentially describes two aspects of a control system, according to specified rules: the actions (commands) to be carried out and the sequence of execution. The elementary components of a GRAFCET are steps, actions and transitions and can be used in the same way as pneumatic or electrical components. To achieve a uniform operating concept, the GRAFCET elements feature connections that can be used to link them to each other (as with all other FluidSIM components).

8.1 Steps

Steps are either active or inactive and can be linked by actions. The actions of active steps are executed. The sequence of a GRAFCET is described by the transitions from a previous to a subsequent step. Steps and transitions have to alternate in the plan. The creation and simulation of GRAFCETs in FluidSIM is illustrated in the following using simple examples.

→ Drag a step into a newly created circuit diagram.
Each step has to be assigned a name. If a step is to be active at the start of the sequence control, it is marked as the initial step.

→ Open the step’s dialogue box by double-clicking on it or via the menu (Edit Properties...), enter “1” as the name and select the type “initial step”.

Active steps are marked with a point. Additionally, active steps are framed in green.

8.2 Actions

To execute commands, you can link any number of actions to a step. Actions do not have to be directly linked to a step; you can also link them to each other. To make it easier to create the drawing, it is enough to place actions next to each other, without having to draw connecting lines. If the connections for the elements overlap each other, they are automatically connected.
Actions can be defined by a textual description or by setting (or changing) variable values. If you want to simulate a GRAFCET with FluidSIM, the variable values are taken into account in the simulation. When displaying a GRAFCET graphically, you can decide whether the variable name or the descriptive text is shown in an action. If you want to display the description, you can set the checkmark next to “Display description instead of formula” in the action’s properties dialogue (see example: Grafcet/Grafcet18.ct). At View GRAFCET..., you can specify whether the descriptions are displayed instead of the formulae for all GRAFCET components. There are two types of action: continuously effective and stored effective actions. For a continuously effective action, its associated variable is set to the Boolean value (logical value) “TRUE” (1), provided that the step connected to the action is active. If the step is inactive, the value is set to “FALSE” (0). This way of setting a variable is referred to as “assignment” in the GRAFCET specifications. For a stored effective action, the set value of the variable remains unchanged until it is changed by another action. This way of setting a variable is referred to as “allocation” in the GRAFCET specifications. At the start of a sequence, all the variable values are initialised with “0”.

Create the following GRAFCET. Select the action “Simple action” in the properties dialogue and enter “A” under “Variable/output”. Then start the simulation.

Figure 8/4: Actions

Figure 8/5: Executed action

Step “1” is active and the action connected to the step is executed. Variable “A” is set to “1”. The value of an action variable is shown during simulation in brackets after the variable’s name.
8.3 Transitions

Transitions are used to describe the sequence of a control system. To do this, add the following information to GRAFCET:

![Diagram](image)

Figure 8/6: GRAFCET

→ Select “2” as the name of the second (simple) step. The transition conditions that specify when the system moves from one step to the next are still missing. A transition is considered released once all the immediately preceding steps are active. A transition is triggered once it has been released and its condition has the value “1”. A transition with the value “1” is displayed in green in FluidSIM. You can show a descriptive text instead of the formula, as with the actions.

A Boolean value is automatically generated for each step. The name begins with an “X”, followed by the name of the step. In the example here, the variables “X1” and “X2” are generated. The value of a step variable is “1” if the step is active; otherwise it is “0”. Transition conditions can be time-dependent. These have the following form: \( t_1 \text{ s } / \text{“term” } / t_2 \text{ s} \) Where \( t_1 \) and \( t_2 \) have to be replaced by numbers and “term” by a Boolean term. The transition condition becomes true (“1”) \( t_1 \) seconds after “term” has changed its value from “0” to “1”. This is called a “rising edge”. The transition condition becomes false again (“0”) \( t_2 \) seconds after “term” has changed its value from “1” to “0”. This is called a “falling edge”. The short form \( t_1 \text{ s } / \text{“term”} \) is also allowed. The system then assumes that \( t_2 \) is 0 seconds.
→ Enter the transition conditions into the transitions' properties dialogue as shown and then start the simulation.

Figure 8/7: GRAFCET

The following cycle runs through:
8.4 Stored effective actions (allocations)

In the next example, a counter is to be implemented. This works using a stored effective action (allocation) and an action on an event. To do this, add the following information to GRAFCET:

→ Select “Action on activation” for the action of the second step, “C” as the variable and “C + 1” as the allocation. “C” will work as a counter. For the second action of the first step, select “Action on event”, “B” as the variable with the allocation. “1” and “[ C>2]” as the condition/event. Then start the simulation.
8.5 Linking GRAFCET variables with the electrical part of FluidSIM

The GRAFCET I/O component is used to link the GRAFCET variables with the electrical part of FluidSIM.

The access to labels associated with FluidSIM components is explained in section Access to labels of fluidic and electrical components.
In the GRAFCET I/O component, you can specify GRAFCET variables to be used as inputs or outputs. The actions' variables serve as outputs. The inputs can be the conditions of actions and transitions. If a potential is created as the input of the GRAFCET I/O component, the corresponding variable is set to “1”. If an output variable has a value other than “0”, an electric potential (24V) is present at the corresponding output of the GRAFCET I/O component. The following simple example illustrates the use of the GRAFCET I/O component.

In the GRAFCET I/O component's properties dialogue, “E1” is specified as the input and “A1” as the output. As soon as the electrical switch is closed, there is a potential at the input of “E1”; this potential causes the GRAFCET variable “E1” to change its value from “0” to “1”. As a consequence of this, the condition in the action becomes true (“1”) and the value of variable “A1” is set to “1”. This in turn leads to a potential being created at the output of “A1” and the indicator light lights up.
As soon as the switch is opened again, the following situation arises:
8.6 Quick reference for the FluidSIM-relevant GRAFCET concepts

The next sections introduce all GRAFCET concepts that are related to FluidSIM.

8.6.1 Initialization

All the variables in a GRAFCET are preset with the value “0” at the start of the simulation.
8.6.2 Sequence rules

- A transition is considered released once all the immediately preceding steps are active. A transition is triggered once it has been released and its condition has the value “1”. A transition with the value “1” is shown in green in FluidSIM, regardless of whether the step linked to it is active or inactive.

- The relevant transition is triggered at the same time and does not take any time.

- Since triggering a transition does not take any time, a step can be activated and deactivated at the same time (even across various intermediate steps). An active step remains active in this situation. A loop of steps is only run through once at one point in time (see example: Graf cet/Graf cet06.ct).

8.6.3 Sequence selection

A step can branch off into various partial sequences. In the GRAFCET specifications, these partial sequences have to be exclusive. Since this can generally only be checked during the sequence, this exclusivity is not required in FluidSIM (see example: Graf cet/Graf cet07.ct).

8.6.4 Synchronization

The GRAFCET synchronization component can be used to implement synchronizations (see example: Graf cet/Graf cet08.ct).
8.6.5 Transient sequence / unstable step / virtual triggering

As described in Sequence rules, triggering a transition does not take any time. As a consequence of this, multiple consecutive steps can be activated at the same point in time one after the other. This sequence is called transient (continuous). The intermediate steps in the sequence chain are referred to as unstable. The continuously effective actions connected to them are not displayed in the simulation. The allocations in the stored effective actions are carried out. Triggering the intermediate steps and their associated transitions is called virtual triggering (see example: Grafcet/Grafcet06.ct).

8.6.6 Determining the values of GRAFCET variables

Variables of continuously effective actions (allocations) receive the value “1” if the corresponding action is linked to an active step and any action condition present has the value “1”. Variables of stored effective actions (assignation) are changed if the corresponding action is linked to an active step and the relevant action event occurs (e.g., action on event or on activation). FluidSIM does not check whether the two types of variable identification contradict each other for a variable. If this case occurs, the variable value is determined by an internal calculation, which the user cannot predict (see example: Grafcet/Grafcet09.ct).

8.6.7 Checking the entries

FluidSIM checks the validity of entries for conditions and assignations. If this kind of term does not match the specifications, the term in question is displayed in red. The simulation is only released once all the terms are valid.
8.6.8 Admissible characters for steps and variables

Only the following characters may be used for steps and variables:

— Numbers from “0” to “9”
— Lower-case letters from “a” to “z”
— Upper-case letters from “A” to “Z”
— The underscore “_”

There are no limitations for the descriptions that can be shown for conditions and actions, because these are only displayed and are not used for simulation.

Labels of fluidic or electrical components that are intended to be used from GRAFCETs (see Access to labels of fluidic and electrical components) are allowed to contain only the characters mentioned above.

8.6.9 Variable names

There are four different types of variables. All variables can be used in conditions and assignments.

Action Variables

Action variables are available throughout GRAFCET and can be set in actions (see example: Graf/Date/GrafetGrafet10.ct).

Step Variables

Step variables are inserted automatically for each step and have the value “1” when and only when the corresponding step is active. Step variables have the form X + “step name”. If, for example, the step name is “12”, then the associated variable is “X12”. Step names are only ever valid within a partial GRAFCET or within the global GRAFCET. This means that the same step name can be used in different partial GRAFCETs. In order to be able to address step variables across partial GRAFCETs in FluidSIM, the step variable has to be preceded by the partial GRAFCET name. Example: Partial
GRAFCET “1” contains step “2” and is meant to be addressed in the global GRAFCET. Within the global GRAFCET, the step variable name “G1.X2” has to be used. Within partial GRAFCET “1”, “X2” is enough (see example: Grafcet/Grafcet11.ct). Variables of macro-steps have the form XM + “step name”, macro inputs have XE + “step name” and macro outputs have XS + “step name” (see example: Grafcet/Grafcet15.ct).

Partial GRAFCET variables are automatically inserted for each partial GRAFCET and have the value “1” when and only when at least one step in the corresponding partial GRAFCET is active. Partial GRAFCET variables have the form XG + “partial GRAFCET name”. If, for example, the partial GRAFCET name is “1”, the associated variable is “XG1” (see example: Grafcet/Grafcet12.ct).

These labels can be used as GRAFCET input variables (see Access to labels of fluidic and electrical components).

8.6.10 Access to labels of fluidic and electrical components

GRAFCET-I/O components are the standard means to access electrical components in FluidSIM. In addition, certain labels of a circuit can be used as Boolean input variables in GRAFCET directly, without using a GRAFCET-I/O component (see example Grafcet/TP201_09gc2.ct). Such a direct access pertains to labels of the following components:

- Distance rule
- Semi-rotary actuator
- Pressure switch
- Manually actuated switch
- Relay
- Valve solenoid
8.6.11 Functions and formula entry

A range of functions can be used in conditions and assignations. These functions are displayed according to the GRAFCET specifications (e.g. upwards arrow for rising edge). Entering GRAFCET-specific functions is supported by the buttons in the dialogues with the relevant labels:

- “+” (logical OR)
- “*” (logical AND)
- “NOT” (logical NOT)
- “RE” (rising edge)
- “FE” (falling edge)
- “s / / s” (delay)
- “s /” (delay, short form)
- “NOT(s /)” (time limit)

If the functions “NOT”, “RE” or “FE” refer to a term, the term has to be placed in brackets. Examples: NOT a NOT (a + b) RE X1 RE (X1 * X2) The following additional mathematical functions are available:

- abs (absolute amount)
- sign (algebraic sign: +1, 0, -2)
- max (maximum of two numbers)
- min (minimum of two numbers)
- ^ (to the power of, e.g. a^3)
- sqrt (square root)
- exp (to the power of constant “e”)
- log (natural logarithm)
— sin (sine)
— cos (cosine)

8.6.12 Delays / time limits

Delays have the following form (see example: Grafcet/Grafcet03.ct): “Time in seconds” s / “Boolean term” / “time in seconds” or “Time in seconds” s / “Boolean term”
Examples: 1 s / X1 / 2s 3s/X3 Time limits have the following form:
NOT (“time in seconds” s / “Boolean term”) Example: NOT(6s/X28)

8.6.13 Boolean value of an assertion

In GRAFCET, you can use Boolean values to calculate an assertion, for example: a counter “C” should be larger than 6 and step “X1” should be activated. “C” is larger than “6” can be calculated as with a variable. To do this, the assertion has to be set in square brackets. So in this example: \[ C > 6 \] * X1 If a Boolean assertion is positioned on its own in a condition, then you can omit the square brackets in FluidSIM, for example C > 6 instead of \[ C > 6 \]. (See example: Grafcet/Grafcet13.ct)

8.6.14 Target information

If you want to interrupt an operative connection from a transition to a step, you can enter the name of the target step in the transition’s properties dialogue (see example: Grafcet/Grafcet14.ct).
8.6.15 Partial GRAFCETs

Partial GRAFCETs can be used to separate a GRAFCET into different hierarchy levels. This function is most often used for enclosing steps and compulsory commands. The name of a partial GRAFCET is always preceded by a “G”. In order to determine partial GRAFCETs in FluidSIM, the partial GRAFCET frame has to be placed over the relevant GRAFCET part and you have to assign a name in the properties dialogue. The preceding “G” is not part of the name that you have to enter; it is added automatically by FluidSIM and shown at the bottom left of the partial GRAFCET frame. You can alter the size of the partial GRAFCET frame by dragging its edges with the mouse (see example: Grafcet/Grafcet11.ct). It is important that all the elements of the partial GRAFCET are located entirely within the relevant frame and that there are no “foreign” elements overlapping the frame.

8.6.16 Macro-steps

Macro-steps can be specified using a step’s properties dialogue. The preceding “M” is not a part of the name that you have to enter; it is added automatically by FluidSIM. You can specify macro inputs and macro outputs in the same way. The preceding “E” and “S” in these cases are not part of the name either and are automatically added by FluidSIM (see example: Grafcet/Grafcet15.ct).

8.6.17 Compulsory commands

Compulsory commands can be used to control partial GRAFCETs regardless of their normal sequence. There is an entry mask to help you enter these commands in FluidSIM. There are four types of compulsory command. They are shown here using four examples (see example: Grafcet/Grafcet16.ct).
<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>G12 {8, 9, 11}</td>
<td>Setting a specific situation. This example activates steps 8, 9 and 11 of partial GRAFCET 12.</td>
</tr>
<tr>
<td>G12 {*}</td>
<td>Freezing a partial GRAFCET. In this example, the current situation for partial GRAFCET 12 is maintained as it is. No further transitions are triggered.</td>
</tr>
<tr>
<td>G12</td>
<td>Setting a blank situation. All steps in partial GRAFCET 12 are deactivated in this example.</td>
</tr>
<tr>
<td>G12 {INIT}</td>
<td>Setting the initial situation. In this example, the steps in partial GRAFCET 12 that are marked as initial steps are activated.</td>
</tr>
</tbody>
</table>

### 8.6.18 Enclosing step

Enclosing steps can be specified using a step’s properties dialogue. You can either enter the enclosed partial GRAFCETs directly or select them from a list. You have to separate individual partial GRAFCETs with a comma or a blank space. During simulation, the name of the enclosing step is shown at the top left of the partial GRAFCET frame, as soon as the step is activated (see example: Grafct/Grafct17.ct). You have to set the “Activation link” field in the properties dialogue for steps within the enclosed partial GRAFCET that you wish to activate when the enclosing step is activated.
Dimension

Chapter 9

FluidSIM allows both automatic and manual dimensioning.

9.1 Draw dimension

The buttons

- Horizontal
- Vertical
- Align
- Angular
- Flag

activate the corresponding mode for drawing the dimension arrows. Alternatively you can also access the dimensioning functions in the Draw menu under Dimension.

Horizontal, vertical and diagonal dimensioning is done by defining two points for the distance as well as then clicking to position the dimension text. Angular dimensioning requires the center point to be defined as well as two points for the angle. The fourth click in turn defines the position of the dimension text. The Flag dimension function can also be used for general labeling of important points in the circuit. Two points for a line with any pitch and a final click for the text are needed for this.
9.2 Settings for the dimension

![Dimension dialog window]

Figure 9/1: *Dimension* dialog window

- **Layer**: Defines the drawing layer for the dimension.
- **Automatic Dimensioning**: Activates or deactivates automatic adaptation of the dimension when the dimension length is changed.
- **Length**: If the *Automatic Dimensioning* option is deactivated you can enter any number that will be displayed as the length dimension. A unit can also be selected. *Show Unit* defines whether the unit should be displayed.
- **Decimals**: Defines the number of decimal places.
- **Factor**: Determines the factor by which the real length is multiplied for the displayed value. This is necessary if you are creating a drawing with a scale other than 1:1.
- **Color**: Defines the color for the dimension.
Defines the line style for the dimension.

Line Width

Defines the line width for the dimension.

Dimensions, like all other objects in FluidSIM, can be moved, rotated, mirrored and scaled. The display value of the dimension is automatically adapted during scaling if the *Automatic Dimensioning* option is activated.
Chapter 10

FluidSIM supports the structured and hierarchical assignment of equipment identifications, i.e. a complete equipment identification can be made up of several component identifications.

The following attributes can be used for structuring and are put together according to predefined conventions to form a complete equipment identification:

- Installation
- Location
- Circuit
- Component
- Connector

The attributes Installation, Location and Circuit can be specified for a symbol, circuit and project. You can specify whether the attributes should be copied over from a parent element (node). For example, you can copy over the installation information from the circuit diagram so that it does not have to be individually entered for each symbol.

Designation conventions describe how the individual attributes Installation, Location, Circuit, Component and Connector are put together to form a full identification. They specify the order in which the individual attributes are put together to form a full identification and the separators (prefix or postfix) used between them.

The following example is intended to serve as an explanation. The list below constitutes a set of designation conventions. Each attribute can have a preceding (prefix) or succeeding (postfix) separator. The separators to be used are placed in inverted commas. The specified set of designation conventions corresponds to the default setting in FluidSIM for electrical engineering.

- “=” Installation
- “+” Location
- “-” Component
The value of the *Component* attribute is “B1” and is stored in the symbol to be identified. *Installation* gets the value “G1” and *Location* the value “X1”, both of which are stored in the circuit. A note is included with the symbol that these attributes should be copied over from the circuit. The full equipment identification is then as follows:

— $=G1+X1-B1$

If it is clear from the context that *Installation* and *Location* are stored in the circuit then this information can be hidden when displaying the equipment identification in the circuit to make things clearer. The *Suppress Inherited Parts* option must be selected in the associated symbol for this. The identification that is displayed is then:

— -$B1$

FluidSIM also supports the hierarchical structuring of identifications. Using a hierarchy makes sense if a symbol is a subobject of another object, for example the plug in a plug strip or the solenoid coil in a solenoid valve. The full identification is put together according to the defined designation conventions. The *Component* attribute is also added in accordance with the defined object hierarchy. You start at the top hierarchy level when designating an object.

The hierarchy is defined by establishing a reference between a symbol (object) and the parent object. To illustrate this we will expand upon the example described above. The symbol with the *Component* attribute with the value “B1” was not previously hierarchically structured. This is changed by assigning an “A1” for a parent symbol to the symbol. The full identification for “B1” is then as follows:

— $=G1+X1-A1-B1$

The identification that is displayed remains unchanged.

FluidSIM supports different sets of designation conventions. For each symbol you can select which set of conventions should be used for its identification. The set of conventions to be used for the supplied symbols is preset. The preset sets of conventions can be customized in the *Designation Conventions* tab under **Tools**-.
These sets of conventions are copied when a project or circuit diagram is created from new. Copying the sets of conventions into the circuit diagram or project guarantees that the designation conventions are not dependent on the FluidSIM presets if the circuit diagram or project is passed on to someone else. Changes to the conventions must be made in the circuit diagram or project.

The identification type *Free Input* can be chosen if no designation conventions are to be used. In this case the identification is an unstructured character string that is not made up of the attributes described above.

The sets of conventions preset in FluidSIM are as follows:

**Fluidics**
Fluid engineering symbols are designated in accordance with ISO 1219-2. The identification is put together as follows: *Installation - Circuit Component: Connector* This set of conventions can be customized if necessary.

**Electrics**
Electrical engineering symbols are designated in accordance with EN 81346-1 (successor to EN 61346-1). The identification is put together as follows:

\[ \text{Installation + Location - Component: Connector} \]

This set of conventions can be customized if necessary.

**User Defined**
This set of conventions allows you to freely define the identification. The attributes *Installation, Location, Circuit, Component* and *Connector* can be selected in any order for this. You can also specify separators that are to be inserted before (prefix) and after (postfix) the individual attributes.

### 10.1 Renumber Designations

Designations (identifications) are automatically assigned when symbols are created. FluidSIM supports the reassignment of identifications within a circuit diagram. You can define which symbols are
to get new identifications and the order in which they are to be renumbered.

Renumbering is started via the **Page > Renumber Designations...** menu. The following dialog window opens.

![Renumber Designations dialog window](image)

**Figure 10/1: Renumber Designations dialog window**

### Component Types

For each symbol you can specify the designation convention to be used. You can specify the designation conventions to be taken into consideration during renumbering under **Component Types**. Only those symbols with the appropriate convention will be given a new identification.

### Renumber Unenumerated Only (e.g. ?V1)

Only symbols that have not yet been given an identification will be taken into consideration.
If the *Enumerate Automatically* option is selected in the *Designation Conventions* tab in the program options then FluidSIM will automatically assign identifications for newly created symbols. If this option is not active identifications beginning with a question mark will be assigned. As per the convention, FluidSIM will not regard these symbols as having an identification.

If this option is activated the renumbering will be done in two passes. The main components are renumbered in the first pass and the secondary components in the second pass. An example of a main component is the coil of a relay, while its contacts are secondary components.

The labeling order can be defined using the various buttons.

The renumbering is started after you click the **Next** button.
## Renumber Designations dialog window

<table>
<thead>
<tr>
<th><strong>Current Identification</strong></th>
<th>Shows the current full identification.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>New Identification</strong></td>
<td>Contains the suggested new identification for the component. You can change this suggestion. The new full identification is displayed in the <em>Full Identification</em> field.</td>
</tr>
<tr>
<td><strong>Full Identification</strong></td>
<td>Shows the new full identification.</td>
</tr>
<tr>
<td><strong>Displayed Identification</strong></td>
<td>Shows the new identification as it is displayed in the circuit. If the <em>Suppress Inherited Parts</em> option is selected then parts of the identification such as “Installation”, “Circuit” or “Location” will be hidden if they have been stored in the circuit diagram or project.</td>
</tr>
<tr>
<td><strong>Designation Conventions</strong></td>
<td>The designation conventions for the component to be identified can be selected here.</td>
</tr>
</tbody>
</table>
If this option is not active the following identification components can be defined for the symbol: “Installation”, “Location” and “Circuit”. Only components that are used in the set designation convention are available.

The **Next** button copies over the new identification and the **Skip** button leaves the old identification unchanged. FluidSIM then continues with the next symbol.
Chapter 11

The FluidSIM circuit symbols largely correspond to the components in the Festo product catalogue. Even if you have not installed the product catalogue FluidSIM can read most of the component attributes from the database supplied with the program. If you have installed a newer version of the product catalogue then FluidSIM automatically accesses the current data. Open the Properties dialog window for the component by double-clicking a symbol or using the Edit menu and the Properties... menu item.
11.1 Component attributes in the *Properties* dialog window

![Properties dialog window for a component](image)

Figure 11/1: *Properties* dialog window for a component:

The properties of a component are saved in attribute value pairs. The attributes are divided into different groups. The first group contains the general properties:
Figure 11/2: Detail from the Properties dialog window for a component: General properties

Symbol Name
Displays the name of the circuit symbol. The symbol name is mapped to appropriate products in the Festo product catalogue. Users cannot edit the symbol name.

Description
Contains a more detailed description or the complete name of the circuit symbol where applicable. Users can edit this. The identification is shown as text in the circuit drawing if the “Display” option is selected.

Part number
The part number uniquely identifies a product. You can enter the part number manually or search via the Find... button in the product catalogue. The component attributes saved in the catalogue are only automatically taken over if the selection is made via the product catalogue. You can find these attributes in the Catalog Properties tab of the Properties dialog window for the component.

Layer
In this selection list you define the drawing layer for the symbol. Depending on the setting for the drawing layer it may not be possible to display or edit the symbol. In order to make the symbol visible or change the settings you have to temporarily activate the drawing layer on the Drawing Layers... menu item from the View menu.

Identification
Here you can assign an identification that uniquely identifies the component in the circuit diagram. The identification is shown as text in the circuit drawing if the “Display” option is selected.

Note: FluidSIM automatically assigns a unique identification when inserting or copying circuit symbols. An automatically assigned identification text begins with a question mark and can be edited by the user (FluidSIM shows a warning if you are assigning an identifi-
cation that already exists). You can make more detailed settings for the equipment identification in the Identification tab.

Display in Parts Lists
Deactivate this option if you do not want the symbol to appear in the parts list.

11.2 Identification

In the “Identification” tab you can enter properties that influence how the identification for the symbol is displayed in the circuit diagram. You can find further information under Equipment identifications and designation conventions.
Treat as Contact Actuator

If this option is activated then contacts can be linked with this symbol and the symbol is assigned a contact image. This allows the number of symbols that can actuate contacts to be extended as a user-defined setting. For example it allows custom relay magnets to be defined.

Parent Object

If this option is activated then a parent object can be specified whose identification is used to make up the full identification. Parent objects can be selected via the list box or their full identifica-
tion entered directly. The “Browse...” button opens a dialog window that shows all objects in the project as a tree.

Full Identification
This field shows the full equipment identification.

Inherit prefix/postfix
If this option is deactivated then the separators that are placed before (prefix) or after (postfix) the identification can be specified. The separators specified in the designation conventions are ignored in this case. In combination with parent objects this enables aspect changes as described in EN 81346-1.

Displayed Identification
This field shows the equipment identification displayed in the circuit diagram. If the Suppress Inherited Parts option is selected then parts of the identification such as “Installation”, “Location” or “Circuit” will be hidden if they have been stored in the circuit diagram or project. The parts of the parent object’s identification will also be hidden if a parent object was specified.

Designation Conventions
Here you define the designation convention to be used for the identification. The following are available: Fluidics, Electrics, User Defined and Free Input. The properties dialog window for the circuit where the designation conventions can be displayed and customized is opened using the Designation Conventions... button.

Installation
The Installation property that can be used as part of the identification is defined in this field. If the Inherit From Parent Object option is selected then the property will be copied over from the circuit, project or specified parent object. This field will only be visible if Installation is used in the set designation convention.

Location
The Location property that can be used as part of the identification is defined in this field. If the Inherit From Parent Object option is selected then the property will be copied over from the circuit, project or specified parent object. This field will only be visible if Location is used in the set designation convention.

Circuit
The Circuit property that can be used as part of the identification is defined in this field. If the Inherit From Parent Object option is selected then the property will be copied over from the circuit, project or specified parent object. This field will only be visible if Circuit is used in the set designation convention.
11.3 Catalog Properties

Component attributes from the product catalogue as well as attributes specified by the user are displayed in tabular form in different tabs. The table entries from the catalogue cannot be edited. The value of an attribute is listed in the “Value” column. This value can be displayed as text in the circuit diagram next to the symbol if the “Display” option is activated.

The component attributes copied over from the product catalogue are displayed in the “Catalog Properties” tab.

![Catalog Properties](image)

Figure 11/4: Detail from the Properties dialog window for a component: Catalog Properties tab

11.4 User Defined Properties

You can enter your own component attributes in the “User Defined Properties” tab.
Figure 11/5: Detail from the Properties dialog window for a component: User Defined Properties tab

**Translation Table...**

If you are editing a text field you can use this button to open a search dialog via which you can find the text ID for a language text from the translation table.

In order to edit an entry the corresponding row must be selected by clicking on it. Clicking on the table cell to be modified again then enables you to edit the entry in the cell.

A row can be deleted by first clicking the row to highlight it. The highlighted row can then be deleted using the Del key.

You can add any desired attributes by filling out the empty cells on the last row.
11.5 Drawing Properties

You can enter a number of drawing properties that influence how the symbols are displayed in the circuit diagram in the “Drawing Properties” tab.

Scale
Defines the scaling in the x or y direction. The scaling factor can also be defined with the help of the mouse pointer. This is described in the “Scale symbols” section.

Rotation
Defines the angle of rotation in degrees. The angle of rotation can also be defined with the help of the mouse pointer. This is described in the “Rotate symbols” section.

Override Color
If this option is activated then another color can be selected for the symbol.

Reset
Resets the geometrical settings to the default values: Scaling to 1, rotation to 0 and “Override Color” deactivated.
11.6 Main and secondary components

As described under Component attributes in the Properties dialog window, the FluidSIM circuit symbols largely correspond to the components in the Festo product catalogue. These symbols are called main components. However there are also secondary components, which do not correspond to components in the Festo product catalogue. These secondary components are usually symbolic representations of a partial aspect of an associated main component.

All product properties are stored in the main component. The secondary components only have a description and a reference to the associated main component. In electrical engineering in particular, components such as relays are divided into main and secondary components where the coil is the main component and the contacts are the secondary components.

11.7 Linking main and secondary components

Main and secondary components are linked using the symbol for the secondary component. The circuit diagram detail shows a relay comprising a coil as the main component and two contacts as the secondary components. The contacts are to be linked with the coil. This information is evaluated when displaying the contact image.

![Relay symbol](image)

Figure 11/7: Relay comprising coil with two contacts

The symbol identifications are the defaults used in FluidDraw. The symbols are not linked together yet.
Open the corresponding properties dialog window by double-clicking a contact.

![Properties dialog window for a contact](image)

**Figure 11/8: Properties dialog window for a contact**

<table>
<thead>
<tr>
<th>Description</th>
<th>Defines a description for the secondary component. In the case of a contact, this is shown in the <a href="#">terminal diagram</a>.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Main Component</td>
<td>A compatible main component can be selected from a list. The main component identification can also be entered directly as text.</td>
</tr>
<tr>
<td>Browse...</td>
<td>Opens a dialog that shows all compatible main components as a tree in accordance with the object hierarchy.</td>
</tr>
<tr>
<td>Link</td>
<td>If this box is checked then the secondary component is logically linked with the main component. If the main component is then renamed, the link is retained and the identification of the linked secondary component is adapted as appropriate to the main component identification.</td>
</tr>
<tr>
<td>Find Target...</td>
<td>If the secondary component is logically linked with a main component, a search can be performed for the associated main component using this button.</td>
</tr>
<tr>
<td>Display</td>
<td>If this box is checked then the main component's identification is shown as the identification for the secondary component.</td>
</tr>
</tbody>
</table>
If there are designation conventions assigned for the main component, parent parts of the identification that are defined in the circuit diagram or project will be hidden.

→ Select “Q1” from the list of compatible main components. Proceed in the same way for the second contact.

Selecting from the list of compatible main components automatically establishes the logical links between the contacts and the coil. The circuit diagram should now look as follows:

```
-Q1
-o
```

![Figure 11/9: Relay comprising coil with two contacts](image)

If you now change the coil identification to “Q2”, the logical links mean that the identifications at the contacts will also be automatically changed to “Q2”.

Examples of this are relays with the coil as the main component and the contacts as secondary components as well as electromagnetic directional control valves with the pneumatic symbol as the main component and the valve solenoids as secondary components in the electrical part of the circuit diagram.

### 11.8 Link solenoid valves and solenoid coils

The coils belonging to solenoid valves are usually displayed separately in the electrical part of a circuit diagram. The link between a solenoid valve and the associated coils is defined at the solenoid valve symbol.
The following circuit diagram shows a solenoid valve and the symbols for two separate solenoid coils. No link has been established yet between the solenoid valve and the coils.

There are two ways of establishing a link between a solenoid valve and a coil. The first is using the properties dialog window for the solenoid valve.

→ Open the appropriate properties dialog window by double-clicking the solenoid valve and select the Connector Labels tab.
Figure 11/11: *Properties* dialog window, *Connector Labels* tab

This tab shows all of the solenoid valve’s connectors. Connectors refer, among other things, to the logical connection options for the solenoid coils. The input fields of the left-hand electric connector are described below. The descriptions apply analogously to the right-hand connector and other types of logical connectors.

**Electric Connector (Left)**

The identification for the left-hand solenoid coil can be entered in this list box or selected from a list. When you click in this field the corresponding connector is highlighted in the preview. This helps to locate the connector, particularly when dealing with turned or mirrored symbols.
Opens a dialog that shows all compatible solenoid coils as a tree in accordance with the object hierarchy.

If this box is checked then the solenoid coil is logically linked with the connector at the solenoid valve. If the solenoid coil is renamed the link is retained and the identifications of the coils at the solenoid valve are changed to match the coil identifications.

If the connector at the solenoid valve is logically linked with a coil a search can be performed for the associated coil using this button.

If this box is checked the coil’s identification is shown as the identification for the solenoid valve connector.

→ Select “-K1” from the list of compatible solenoid coils.

![Diagram](image)

Figure 11/12: Left connector linked with coil “-K1”

The second way of linking a solenoid valve with a coil is to double-click the solenoid valve’s connector directly. The coil connectors are represented like pneumatic connectors within the solenoid valve by means of small circles.

→ Double-click the right connector of the solenoid valve.

A dialog window whose fields correspond to the entries for a connector in the Connector Labels tab of the Properties dialog window.
Select “-K2” from the list of compatible solenoid coils.

The (electric) connectors of the solenoid valve are now linked with the solenoid coils.

The above-mentioned ways of linking a solenoid valve and coils should only be used if each symbol has been individually inserted into the circuit diagram. For projects, FluidSIM manages the associated coil symbols for each solenoid valve internally. When a solenoid valve is inserted into a circuit diagram, the associated solenoid coils are simultaneously placed in a special library. This concept is described under Unplaced objects.

11.9 Attributes of the text components

In FluidSIM text components serve, firstly, to insert comments and labels and, secondly, can be defined by the labels and accessories...
without displaying a symbol. Open the dialog window Properties of the text component by double-clicking on a text or via the Properties... menu item on the Edit menu.

Figure 11/15: Properties dialog window for a text component:

A text component possess all of the attributes of a standard component. The text properties are located on the “Edit Text” tab.
Figure 11/16: Detail from the \textit{Properties} dialog window for a text component: \textit{Edit Text} tab

\textbf{Edit Text} Enter your text into the input field on the left-hand side. You can also enter text with multiple lines. Press the \textbf{Enter} key to create a line break.

\textbf{Alignment} Defines the horizontal or the vertical alignment of the text within the text field.

\textbf{Font…} Defines the text font.

\textbf{Color…} Defines the text color.

\textbf{Frame Text} Draws a frame around the text field.

\textbf{Attribute Link} If this option is activated a text that identifies a link to an attribute is displayed instead of the text entered. The value of the selected attribute is displayed in the circuit diagram. You can find a detailed description of this function under \textit{Link text components with attributes}. A predefined placeholder such as the page number can also be selected using the \textbf{Predefined variable…} button.
If you are editing a text field you can use this button to open a search dialog via which you can find the text ID for a language text from the translation table.

11.10 Link text components with attributes

Text components can also display attributes of other components, values of predefined placeholders, attributes of a circuit or the project. The text component must be linked to the corresponding attribute for this. The linked attribute is defined in the input field of the “Edit Text” tab in the Properties dialog window for the text component. The activated Attribute Link option defines that the text in the text field should not be displayed but rather interpreted as a link.

Example:

Assuming that your project is called “Project1” and possesses the “Supplier” attribute with the value “Festo”. You project contains the “Circuit1” circuit and you would like to display the value of the “Supplier” attribute, in this example namely the value “Festo”, in this circuit diagram.

→ Insert a text component into the circuit drawing by selecting the text element on the drawing elements toolbar and then left-clicking the circuit drawing. The Properties dialog window for the text component then opens.

Note: You can open the dialog window of an existing text component by double-clicking it or using the Edit menu and the Properties... menu item.

→ Activate the Attribute Link option and then click the Browse... button.

A window opens displaying the hierarchy of all of the available attributes. Please note that only those objects are listed that have an identification assigned by the user. Identifications beginning
with a question mark “?” are not listed. These are identifications that have been automatically assigned by FluidSIM. The desired attribute is located under “Attribute Tree” - “Project1” - “Supplier”.

![Browse Attributes dialog window](image)

**Figure 11/17: Browse Attributes dialog window**

箭头 > Select “Supplier” and then click the [Select] button.

The “Project1.Supplier” value is displayed in the input field and “Festo” in the preview. The complete and unique name of the attribute contains all of the hierarchy levels beginning at the project. The individual layers in the name are separated by a full stop. It is also possible to enter only the attribute name into the input field. In this example: “Supplier”. The hierarchy is then searched from the bottom up for the attribute, beginning with the text components. If the attribute searched for is not found in that component then the circuit and then the project are searched for the attribute.

If the attribute is not found then the attribute name is displayed in the circuit diagram in angle brackets. The missing attribute can be created at a later point in time. The link is then created automatically.
The concept of linking text components with attributes is also utilized for labeling drawing frames.

### 11.11 Text components with specified links

Text components are automatically generated for displayable component attributes and connector labels which are linked to the corresponding attributes. Open the *Display Attribute* dialog window with which you can adjust how the text is displayed by double-clicking on the text component or via the *Properties...* menu item on the *Edit* menu.

![Display Attribute dialog window](image)

**Figure 11/18: Display Attribute dialog window**

**Alignment**  
Defines the horizontal or the vertical alignment of the text within the text field.

**Scale**  
Defines the scaling factor of the text in the x or y direction.

Note: You can also change the text size by selecting another font size in the font type dialog window. You open this dialog window using the *Font...* button under *Text Attributes.*
Rotation
Defines text's angle of rotation in degrees.

Font...
Defines the text font.

Color...
Defines the text color.

Frame Text
Draws a frame around the text field.

Find Target...
The target of a linked text is the attribute which the text refers to. This button opens the Properties dialog window of the object which contains this attribute.

11.12 Change the properties of multiple objects simultaneously

If multiple objects are selected, choosing the Properties... menu item on the Edit menu opens a dialog window with a limited selection of properties. It only contains those properties which meaningfully relate to all of the selected objects. This enables you to change the font for multiple texts in a single operation, for example. The more different object types (symbols, connectors, drawing elements, texts, etc.) that are selected, the less common properties are available.

The following tabs are available for the common properties depending on the objects highlighted.

11.12.1 Drawing Properties

The dialog elements available within a tab depend on the objects highlighted.
Figure 11/19: Properties dialog window, Drawing Properties tab: several highlighted objects

Font... Defines the font type of the text.
Frame Text Draws a frame around the text field.
Scale Defines the scaling factor of the text in the x or y direction.
Rotation Defines the angle of rotation of the text field in degrees.
Override Color Defines the color of the drawing element.
Line Style Defines the line style.
Line Width Defines the line width.
Start Cap Defines how the beginning of the line is displayed.
End Cap Defines how the end of the line is displayed.
Background Sets the location of the drawing element to the background. This means that all of the circuit symbols are on top of this. In particular, this means that symbols are not covered by filled drawing elements, for example.
Foreground

Sets the location of the drawing element to the foreground. This means that all of the circuit symbols are underneath this. In particular it means that symbols are covered by filled drawing elements, for example.

Reset

Reset the settings to the default values.

11.12.2 Main Component

| Main Component | A compatible main component can be selected from a list. The main component identification can also be entered directly as text. |
| Browse...      | Opens a dialog that shows all compatible main components as a tree in accordance with the object hierarchy. |
| Link           | If this box is checked then the secondary component is logically linked with the main component. If the main component is then renamed, the link is retained and the identification of the linked secondary component is adapted as appropriate to the main component identification. |
If the secondary component is logically linked with a main component, a search can be performed for the associated main component using this button.
Chapter 12

Various analyses can be inserted into a circuit diagram using the **Insert** menu item. Alternatively you can also use the **[ ]** button on the toolbar. The following dialog window opens.

![List/Table dialog window](image)

**Figure 12/1: List/Table... dialog window**

The following analyses can be inserted into the circuit diagram using this dialog: **Parts List**, **Terminal diagram**, **Cable Map** and **Cable List**.

The use of parts lists is described below. The use and function of the other analyses are described in the corresponding chapters.

FluidSIM creates parts lists that are automatically updated in the background while the circuits are being edited.

If a parts list has been added to a circuit diagram as described above it can be used like a symbol. The use of parts lists as a special page type is described under **Display parts list**.

You can customise the appearance of the parts list under “**Properties...**” in the “**Appearance**” tab. You can see the effects of the settings straight away in the preview on the right-hand side.

If the “**Lines per Page**” option is selected you can specify the number of lines to be displayed per page. The relevant pages will also be output when the circuit diagram is **printed**. Buttons for navigation are displayed underneath the page if the list is split across multiple pages.
12.1 Display parts list

We recommend setting up one file specifically for the parts list in a project. If you wish to create a circuit drawing without creating a project you can switch the view for this circuit to the parts list view. Selecting the [Parts List] menu item from the [View] menu enables you to switch from the circuit view to the parts list view. Conversely, selecting the [Circuit Diagram] menu item from the [View] menu enables you to switch from the parts list view to the circuit view.

A parts list is displayed as a table in the window. You can edit the following options for editing the table:

— Attributes which the user can edit can be entered directly into the corresponding table field.

— Clicking on the column header sorts the rows on the basis of the column clicked. Clicking on the head of the same column again reverses the sorting order.

— You can adjust the column width by dragging the edges of a column header.

— You can change the order of the columns by dragging and dropping a column header in another position.

12.2 Find components from the parts on the circuit diagram

FluidSIM enables you to easily find components on the parts list in the circuit diagram and vice versa.
You have the following options:

— Clicking on the **Find...** button on the “Find Target” parts list column switches to the circuit diagram display and an animation identifies the corresponding components. If the same circuit diagram is already open in another window than the parts list view remains in the active window. The already opened window containing the circuit diagram is moved into the foreground and an animation identifies the corresponding circuit diagram symbol.

— When you click a cell in the parts list table an animation identifies the corresponding component in all of the opened windows displaying the circuit diagram.

— If you click a column header in the parts list table then both the entire column of the parts list as well as the corresponding components in the associated circuit diagram windows are selected.
If you click a component in a circuit diagram then both this component and the corresponding row in the open parts lists are selected.

12.3 Set parts list properties

In the parts list view clicking on the Properties... button opens the Parts List Properties dialog window.

![Parts List Properties dialog window](image)

Figure 12/4: Parts List Properties dialog window: Included Pages tab

Accumulated Parts List Compiles the components with the same attributes.
Lists all of the components individually

Interprets the column contents as numbers, so that “10” appears after “2”, for example.

Only lists the components of the corresponding circuit diagram.

Lists all of the components of the active project.

Lists all of the components of the selected circuit diagrams belonging to the active project.

Figure 12/5: Parts List Properties dialog window: Listed Attributes tab

Lists all of the component attributes within a parts list row.
List Selected Attributes: Only lists selected component attributes within a parts list row.

Figure 12/6: Parts List Properties dialog window: Print Options tab

In this tab you can adjust the appearance of the parts list printout. In the preview on the right-hand side you can immediately see the effects of the adjustments. You can find information regarding printing a parts list in the “Print circuit diagram and parts list” section.

12.4 Export parts list

You can export the parts list as a text file.
Click the **Export...** button in the parts list view.

A dialog window for selecting a file or entering a new file name appears. After you have entered a file and left the dialog field you can define the following format settings for the export in the *Parts List Export* dialog window:

![Parts List Export dialog window](image)

**Figure 12/7: Parts List Export dialog window**

- **Column Header**: If this option is selected then the names of the attributes appear in the first row of the text file.

- **Quotation Marks**: Select this option to set the field elements in quotation marks.

- **Delimiter**: The selected separator is used to separate the columns.
Chapter 13

FluidSIM supports the management of projects by compiling different files under one name in a single project file. This has the following benefits: When opening a project all of the associated data is loaded. It is possible to rapidly access files belonging to a project via the project window. Parts lists whose elements are located in different circuit diagram files can be maintained in one project.

13.1 Create new project

→ Select the New.../Project... menu item from the Project menu and enter a file name for the new project.

Project files possess the prj file suffix. By default they only contain links to files contained in the project. If you wish to pass on a project then you must either pass on all of the associated files along with the project file or activate the “Save Projects as Single File” option.

When creating a new project, a project folder is automatically created to store the project file and all other files belonging to the project. This automatically created project folder has the same name as the project file. If you create the project file in an empty folder this will be used for the project (i.e. another new folder will not be created underneath it). The automatic creation of project directories can be activated and deactivated in the options under Save.

In the project window a project is represented hierarchically as a list. The top element is the project node. Below this are the associated circuit nodes and parts list nodes which can be differentiated from each other via the symbol in front of the name.
13.2 Project nodes

Every project possesses one project node as the uppermost element. All of the project-specific properties are saved with the project node. Right-clicking on a project node opens a context menu. You can also find the menu items on the Project menu. Here you can find the functions for adding and removing files, among other things.

Under the Properties... menu item from the Project menu you can define properties for the project. Properties that can be specified for both projects and circuits are described under Circuit and project properties.

13.2.1 Project archiving

Project files generally consist of links to the files contained therein. However, where desired FluidSIM can also save the project along with all of the associated files in one single file. Among other things, this makes it easier to pass on the project. Activate the Save Projects as Single File option in the Archiving tab.
Save Projects as Single File

If this option is activated all of the files belonging to the project are saved in a single file.

Please note the advice displayed under this option.

13.3 Circuit and parts list nodes

A circuit node is created beneath the project node for every circuit file that belongs to the project. This also applies to parts lists since they are saved as circuits. These are just displayed differently in the window. All of the circuit-specific or parts list-specific properties are saved with the circuit node.

Right-clicking a circuit node opens a context menu containing the following menu items:

Open...

Opens the selected circuit or the selected parts list in a window. Double-clicking on the node in the project tree also opens the window.

Close Windows

Closes the window of the selected circuit or the selected parts list.
Remove From List

Removes the selected circuit or the selected parts list from the project.

Rename...

Changes the description of the selected circuit or the selected parts list.

Properties...

In this dialog window you can enter data for the circuit or parts list.

Note: Please note that the additional parts list-specific properties can be set using the window view of the parts list.

![Drawing Size dialog window](image)

**Figure 13/2:** [Page] dialog window: *Drawing Size* tab

Here you can define the circuit dimensions and orientation, both of which are relevant for printing.

### 13.4 Unplaced objects

Various symbols consist of a main component and several secondary components. For solenoid valves in particular FluidSIM manages the associated solenoid coils automatically. The linking of solenoid valves with their solenoid coils is described in detail under *Link solenoid valves and solenoid coils.*
If a main component is inserted into a circuit diagram, the associated coils are automatically entered in the *Unplaced Objects* symbol library.

![Circuit diagram with solenoid valve and associated solenoid coils](image)

Figure 13/3: Circuit diagram with solenoid valve and associated solenoid coils in the *Unplaced Objects* symbol library

The associated coils are already internally linked with the solenoid valve in the circuit diagram. Clicking one of the “electric connectors” in the solenoid valve automatically highlights the corresponding coil in the *Unplaced Objects* library.

![Highlighting of the connector link with associated solenoid coil](image)

Figure 13/4: Highlighting of the connector link with associated solenoid coil

As soon as you drag a coil from the library into a circuit diagram it is “used up” and removed from the library. The valve is entered as the parent object for the coil.
Assigning a new identification to the coil has a direct knock-on effect on the valve since the coil and valve are linked. The identification is displayed at the valve.

If you delete the solenoid coil in the circuit diagram it is automatically added to the Unplaced Objects symbol library again. This symbol library is completely self-managing.
Chapter 14

Circuit and project properties

Circuits and projects have a host of common properties. The properties set in the project can be used by circuits in the project. All of the properties that can be specified for both circuits and projects are listed below. The screenshots shown are dialog windows for the circuits.

Figure 14/1: Properties dialog window

Properties

The file name field displays the file name of the circuit or project along with the complete path. The file name is carried over to the input field for the “Description” and can be edited there. This entry is displayed in the upper margin of the window as well as beside the circuit or project node.

Page number

Here you can specify a page number. The page number can be made up of any character string. The page number can be defined using the “%PageNumber” predefined placeholder. This placeholder can be used in text components and drawing frames among others.

Drawing Frame

Here you can make settings for the drawing frame. This function is described in the section Drawing frame.
14.1 Attributes

Any number of attributes can be created for every circuit or node in a project. The attributes are listed in a table in the “Attributes” tab. New attributes can be entered in the empty cells at the end of the table. The use of attributes is described in the section Attributes of the nodes in a project.

The attributes of a project node are automatically copied to all circuit and parts list nodes (inherited) and are thus available in all of the circuit drawings. This concept is particularly useful for the drawing frames if project attributes are to be displayed in the circuit diagram, for example. You can find further information in the section Link text components with attributes.

Circuit attributes copied from a project cannot be edited initially. The corresponding row in the Attributes tab of the [Page] dialog window is grayed out and the “Inherit From Project” option in the column is activated.

However it is possible to overwrite a copied attribute in a circuit. The option in the “Inherit From Project” column must be deactivated for this. The value of the attribute can then be edited. This function can be used to assign individual page numbers in the drawing frame, for example. If the “Inherit From Project” option is reactivated then the attribute value is copied from the project again.
<table>
<thead>
<tr>
<th>Attribute</th>
<th>Value</th>
<th>Action</th>
<th>Inherit From Project</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project</td>
<td></td>
<td>Delete</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Additional text 2</td>
<td></td>
<td>Delete</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Revision 1, Text</td>
<td></td>
<td>Delete</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Company, Line 1</td>
<td></td>
<td>Delete</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Revision 1, Date</td>
<td></td>
<td>Delete</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Revision 1, Name</td>
<td></td>
<td>Delete</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Number of pages</td>
<td></td>
<td>Delete</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Company, Line 2</td>
<td></td>
<td>Delete</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Company, Line 3</td>
<td></td>
<td>Delete</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Figure 14/2: Attributes tab

Attribute
This column contains the name of the attribute.

Value
This column contains the value of the attribute.

Action
The buttons in this column allow the following actions: if the attribute was created in the parent project node then the “Find Target...” action is available. Clicking this opens the Project or Circuit dialog window for the project node as the target that contains the corresponding attribute. If the attribute was created in the same node then the “Delete” action that allows you to delete the attribute is available.

Inherit From Project
If the attribute was created in the same node then this option is deactivated and grayed out. This applies to all of the attributes of the project node since it does not have a parent node. For child nodes the value of the attribute from the project node is copied when this option is activated. After deactivating this option it is possible to locally overwrite the attribute value.

Comment
Here you can enter a comment about the attribute.

Translation Table...
If you are editing a text field you can use this button to open a search dialog via which you can find the text ID for a language text from the translation table.
14.1.1 Predefined placeholders

FluidSIM provides a host of predefined placeholders. These placeholders can be used in text components and drawing frames among others.

The placeholders begin with a percentage sign. The following predefined placeholders are some of those available:

- **%PageNumber**  
The page number is specified in the properties dialog window for the circuit diagram.

- **%PageDescription**  
The description for the page is specified in the properties dialog window for the circuit diagram.

- **%PageFileName**  
Stands for the file name of the page without the file path.

- **%PageFullFilePath**  
Stands for the file name of the page with the full file path.

- **%PageFileDateTime**  
Stands for the date and time of the most recent change to the circuit diagram.

- **%PageFileDate**  
Stands for the date of the most recent change to the circuit diagram.

- **%PageFileTime**  
Stands for the time of the most recent change to the circuit diagram.
14.2 Page Dividers

Page dividers can only be defined for pages. Editing of page dividers is described under Page dividers.

14.3 Basic Unit Length

The symbols in the FluidSIM symbol libraries are created according to various DIN ISO standards. Instead of specifying absolute units of length, the standards simply use a relative basic unit of length “M”. All of the symbols have been created with reference to this basic unit of length “M”. The actual size of the symbol is not defined until the symbol is inserted into a circuit.

Information on how to convert the basic unit of length “M” is stored with the circuit diagram. You can change the set values for a circuit diagram by calling up the properties dialog window for the circuit diagram using the Page Properties... menu. You will find the relevant settings in the Basic Unit Length tab.
As soon as the value of “M” is changed, the sizes of the existing symbols are recalculated with respect to the specified basic unit of length. The specification has no effect on elements in the drawing frame.

The Basic Unit Length tab is also in the project settings. The settings made in this tab are used as a template for circuit diagrams created from new in the project tree.

14.4 Language

The language settings are found in the Language tab. The settings made in this tab affect language-dependent text, etc. in parts lists. The language used for program elements such as buttons is defined via the program options, see Language.
Inherit From Parent Node | Copies the language settings from the parent project node.

Product Catalog | Defines the language used for the Festo product catalogue. All of the product attributes are displayed in the relevant language. The predefined attributes are also displayed in this language.

Translation Table | Defines the translation table to be used.

Translation Language | Defines the language from the selected translation table to be used. The user-defined attributes are displayed in the selected language.

### 14.5 Encryption

Projects and circuit diagrams can be encrypted. The encryption method used is AES-128.
This option activates and deactivates encryption. When encryption is activated the password to be used can be entered in the *Password* input field.

Figure 14/5: *Encryption* tab
14.6 Designation Conventions

![Designation Conventions Tab](image)

Figure 14/6: Designation Conventions tab

This tab is used to define the settings for the designation conventions. Further information can be found under Equipment identifications and designation conventions.

Settings can be made for the following sets of conventions: Fluidics, Electrics and User Defined. If the Inherit From Parent Node option is active then the sets of conventions will be copied from the parent project node.

Frame Identification

Defines that the identifications produced by the selected set of conventions will be framed.

Specifications can be made for Installation, Location and Circuit that will be evaluated for displaying the symbol identifications. If the Inherit From Parent Node option is active then the specification will be copied from the parent project node.

Example

The example shown illustrates the effects of the selected designation conventions.
Automatically frame identification for free input

If “free input” is chosen for a symbol identification then this option determines whether these identifications should be framed.

14.7 Cross Reference Representation

This tab is used to define the settings for the cross-reference representation. You can find further information under Cross-reference representation. If the Inherit From Parent Node option is active then the settings will be copied from the parent project node.

Example

Illustrates the effects of the settings using an example.

Reset

Resets the settings to the settings defined in FluidSIM.
15.1 Potentials and conduction lines

The creation of horizontal and vertical potential lines is supported by drawing conduction lines. The end points of the conduction line consist of potentials that also serve as interruptions. In the dialog window for drawing conduction lines you can specify whether the potentials should have an identification.

In this example we want to draw three horizontal potential lines where each line comes from a preceding sheet “1” and is continued on a sheet “3”.

You open a dialog window where you can make the settings shown using the Insert Conduction Line... menu item or the button on the toolbar.
Figure 15/1: Settings for the potential lines to be created

You can then define the end points of the line with two consecutive mouse clicks.

![Diagram of two potential lines with identifiers L1, L2, L3, and L4, L5, L6.]

Figure 15/2: Three horizontal potential lines

The identifications of the potentials can be changed. In this example we want to rename the potential from L4 to L6.

→ Double-click the left-hand potential L1. Then enter L4 for the identification in the dialog window.

Then following prompt then opens.
FluidSIM supports the automatic renaming of the potentials linked with the source potential. If you answer “Yes”, the potential L1 on the right-hand side will also be renamed L4.

→ Rename the potentials L2 and L3 to L5 and L6 in the same way.

→ Then enter the corresponding markers for the predecessors or successors in the properties dialog windows for the potentials. If the corresponding cross-references have the same markers in the respective predecessor and successor pages, the potential lines might look as follows.

Figure 15/4: Three horizontal potential lines with cross-references

15.2 Cables and wiring

Cables and wiring are represented in the circuit diagram by a special cable symbol. All of the lines defined by the cable symbol are assigned to a cable or to wiring. You can define for the symbol whether it is a cable or wiring.

Wiring only summarizes the defined lines (wires) graphically in the circuit diagram and is assigned the identification “W” by default. Wiring is not listed in analyses such as cable maps and cable lists. Unlike a cable, wiring cannot be assigned to a product. With wiring, product information can only be saved in the lines.
If the cable symbol represents a cable then a cable object must be assigned to the symbol. Product properties can be saved in the cable object and are analyzed in cable maps and cable lists, etc. Several cable symbols can reference the same cable object. This is the case if, for example, a cable has to be spread over several pages.

Figure 15/5: Cable symbol

→ Select the **Cable** menu item from the **Insert** menu or click the **button to define a cable or wiring.

This activates a mode that allows you to insert a cable symbol by making two consecutive clicks. All of the lines that are defined by the cable symbol are initially assigned to wiring.

If you want to use a cable instead of wiring you can assign a cable object to the symbol using the properties dialog window for the cable symbol.
Figure 15/6: *Cable Symbol* dialog window, *Wires* tab

**Layer**
Defines the drawing layer for the cable symbol.

**Cable – Wiring**
Defines whether the cable symbol represents a cable or wiring comprising single wires. Wiring is not listed in cable maps, etc. If *Wiring* is selected then an identification can be specified that can be displayed with *Display Identification*.

If *Cable* is selected then an existing cable object can be assigned to the cable symbol using a drop-down list. A new cable object can be created using the [Create New...] button. Clicking [Properties...] opens the properties dialog window for the selected cable object.

**Wires**
In order to analyze cable maps the component connections that join a wire must be determined. The connectors are automatically entered in the list box if they can be uniquely assigned. If a unique assignment is not possible, the relevant connector must be selected manually via the list box. The identification for the individual
wires can also be entered. These are saved in the individual lines (wires). The wire identifications are displayed at the cable symbol using the Display button.

**Reverse Direction**

The entries in the From and To column are automatically defined as the direction of the wires when creating the cable symbol. Clicking the Reverse Direction button reverses the directions of all of the wires.

**Renumber From:**

Clicking this button renumbers all of the wires defined by the cable symbol, starting with the number entered in the list box.

---

**Figure 15/7: Cable Symbol dialog window, Display Attributes tab**

In the “Display Attributes” tab you can select the attributes of the associated cable object that are to be displayed at the cable symbol.

→ Click the Create New... button to create a new cable symbol.

The following dialog window opens.
Figure 15/8: *New Cable* dialog window

- **Containing Page**: Indicates the page where the cable object will be saved. This is important if various cable symbols on different pages reference the same cable object. The cable object is only saved with one page.

- **Identification**: Enter the identification for the cable here.

- **Number of Wires**: Enter the number of lines (wires) in the cable here. The number can be higher than the underlying lines if, for example, a concrete cable has unconnected wires. If the associated cable symbols overscore more lines than are defined in the cable object, a warning is output when the page is checked and the corresponding entries are highlighted in color in the cable lists.

After you specify the identification for the cable and confirm the dialog, the cable object is generated and the cable symbol is assigned to it.

→ Click the “Properties...” button to edit the properties of the cable object.
Number of Wires

Defines the number of lines (wires) in the cable. The number can be higher than the lines overscored by the associated cable symbols if, for example, a concrete cable has unconnected wires. If the associated cable symbols overscore more lines than are defined in the cable object, a warning is output when the page is checked and the corresponding entries are highlighted in color in the cable lists.

The associated cable symbols are listed in rows in the table. You can jump to the associated cable symbol using the “Find...” button.

The *User Defined Properties* tab in the properties dialog window for the cable symbol lists the cable-specific product properties such as *Cable Type* and *Length*. These properties and the entries in the *Cable* tab are analyzed in the cable map, etc.
15.2.1 Manage cables

All cables within a circuit can be listed and renamed using the Manage Cables... menu item from the Page menu. You open the properties dialog window for the relevant cable object using the Properties... button.

You can also call up the cables of all circuits belonging to the project using the Manage Cables... menu item from the Project menu.

Figure 15/10: Manage Cables... dialog window

<table>
<thead>
<tr>
<th>Containing Page</th>
<th>Shows which circuit the cable is assigned to. You can edit this assignment within a project.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>You can add a new cable object to the project using the Create New... button. Each cable object must be assigned to a page.</td>
</tr>
</tbody>
</table>
Clicking the **Create New...** button first opens the following dialog window where you can define the assignment.

![Browse Pages dialog window](image)

**Figure 15/11: Browse Pages dialog window**

After you click the **Select** button a dialog window opens where you can define the name and number of wires for the new cable object. The dialog window is described under **Cables and wiring**.

### 15.2.2 Insert cable map

You can insert an associated cable map for a cable into the circuit diagram. You do this by inserting a cable map into a circuit diagram and then assigning a cable to this map.

→ To insert a cable map into the circuit diagram select the **Cable Map** menu item from the **Insert** menu. Alternatively you can
click the button. Select **Cable Map** in the selection dialog window that opens.

The mouse pointer changes to a crosshair. Click the position in the circuit diagram where you want to insert the cable map. A dialog window then opens where you can assign the relevant cable and customise the appearance.

![Cable Map dialog window](image)

**Figure 15/12:** **Cable Map** dialog window

<table>
<thead>
<tr>
<th>Cable</th>
<th>Defines the relevant cable.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Properties...</td>
<td>Opens the <strong>properties dialog window</strong> for the associated cable symbol.</td>
</tr>
</tbody>
</table>
You can customise the appearance of the cable map in the “Appearance” tab. You can see the effects of the settings straight away in the preview on the right-hand side.

If the “Lines per Page” option is selected you can specify the number of lines to be displayed per page. The relevant pages will also be output when the circuit diagram is printed. Buttons for navigation are displayed underneath the page if the list is split across multiple pages.

Figure 15/13: Buttons for navigating through lists

15.2.3 Insert cable list

You can insert a cable list into a cable map.

To insert a cable list into the circuit diagram select the [Cable List] menu item from the [Insert] menu. Alternatively you can click the button. Select [Cable List] in the selection dialog window that opens.

The mouse pointer changes to a crosshair. Click the position in the circuit diagram where you want to insert the cable list. A dialog window then opens where you can select the associated cable and customise the appearance.
Figure 15/14: **Cable List** dialog window, *Included Pages* tab

- **Include This Page’s Components Only**: Lists only the cables in the associated circuit.
- **Include All Project Files**: Lists all cables in the active project.
- **Include Selected Files**: Lists all cables in the selected circuit in the active project.
You can customise the appearance of the cable map in the “Appearance” tab. You can see the effects of the settings straight away in the preview on the right-hand side.

If the cable symbols of a cable object overscore more lines than are defined in the cable object, a warning is output when the page is checked and the corresponding entries are highlighted in color in the cable list.

If the “Lines per Page” option is selected you can specify the number of lines to be displayed per page. The relevant pages will also be output when the circuit diagram is printed. Buttons for navigation are displayed underneath the page if the list is split across multiple pages.
15.3 Terminals and terminal strips

15.3.1 Set terminals

You can set individual terminals or multiple terminals in one step.

→ Select the [Terminal] menu item from the [Insert] menu or click the [button to define an individual electric terminal.

This activates a mode that allows you to insert a terminal by clicking a free point on the electric line.

As soon as you have set a new terminal in this way the dialog window containing the settings for this terminal appears. You can use this dialog window to assign the terminal to a terminal strip. This assignment can also be made or changed later.
Description: Contains the description of the terminal or the terminal designation.

Display: If this box is checked then the description entered will be displayed beside the terminal.

Layer: Defines the drawing layer for the line.

Pos: Defines the position of the terminal within the associated terminal strip. An entry is only possible once the terminal has been assigned to a terminal strip.

Internal # External: Changes the direction of the terminal. The direction is indicated in the circuit by an arrow that shows which connector is inside the control cabinet and which is outside. The tip of the arrow points into the control cabinet.

Show Direction: If this box is checked then the direction arrow is displayed at the terminal.

Terminal Strip: Defines the terminal strip containing the terminal in question. The list contains the terminal strips already created. You call up the properties dialog window for the selected terminal strip using...
Properties... You can also create a new terminal strip using Create New...

Display Identification If this box is checked then the identification for the associated terminal strip is displayed beside the terminal.

15.3.2 Set multiple terminals

As well as the option of setting individual terminals, FluidSIM also offers a mode that allows you to set multiple terminals one after the other. You can keep inserting terminals by simply clicking on the electric lines until you leave the mode again.

→ To insert multiple terminals select the Multiple Terminals... menu item from the Insert menu or click the button.

Figure 15/19:

The operation begins with a dialog window where you can make some settings for the new terminals. Above all you need to first select an existing terminal strip or create a new one. If a suitable
If the terminal strip does not already exist then a prompt to create a new one will automatically appear.

![Define Multiple Terminals dialog window](image)

Figure 15/20: *Define Multiple Terminals* dialog window

**Description**

Defines how the new terminals are to be numbered. The *Enumerate Manually* option allows you to specify a start number from which the numbering continues. Otherwise a free terminal from the selected terminal strip is automatically used. The start number “2” was specified in the example shown.

**Display**

If this box is checked then the description entered will be displayed beside the terminal.

**Direction**

Defines the direction of the new terminals. The direction is indicated in the circuit by an arrow that shows which connector is inside the control cabinet and which is outside. The tip of the arrow points into the control cabinet. The direction can also be changed later using the properties dialog window for the individual terminals.

**Layer**

Defines the drawing layer for the line.

**Terminal Strip**

Defines the terminal strip containing the terminals in question. The list contains the terminal strips already created. You call up the properties dialog window for the selected terminal strip using
15.3.3 Create terminal strips

FluidSIM does not treat terminal strips as visible objects within the circuit pages which explains why they cannot be interactively selected using the mouse in order to highlight them, delete them or change their properties. Terminal strips can either be managed via the associated terminals or using the [Manage Terminal Strips...] menu item under [Page] or [Project].

A terminal strip is always part of a specific circuit. To define a new terminal strip you must therefore define a circuit file in addition to the description and number of terminals.

![New Terminal Strip dialog window](image)

Figure 15/21: *New Terminal Strip* dialog window

All properties can also be changed later at any time. You open the properties dialog window for a terminal strip via any terminal in that terminal strip using the [Properties...] button.
If the target of a terminal \textit{inside} the control cabinet is unique due to the wiring, FluidSIM automatically enters the identification for the connected component. Otherwise the list contains the identifications of all objects that can be reached from the terminal. The target search can be controlled by selecting a \textit{junction symbol as a T distributor}.

The targets of the terminals \textit{outside} the control cabinet are listed here. As with the internal targets, unique links are automatically entered.

Jumps to the associated terminal in the circuit diagram.

15.3.4 Manage terminal strips

All terminal strips within a circuit can be listed and renamed using the \textit{Manage Terminal Strips...} menu item from the \textit{Page} menu. You open the properties dialog window for the relevant terminal strip using the \textit{Properties...} button.
You can also call up the cables of all terminal strips belonging to the project using the [Manage Terminal Strips...] menu item from the [Project] menu.

Figure 15/23: [Manage Terminal Strips...] dialog window

**Containing Page**

Shows which circuit the terminal strip is assigned to. You can edit this assignment within a project.

You can add a new terminal strip to the project using the [Create New...] button. Each terminal strip must be assigned to a page. Clicking the [Create New...] button first opens the following dialog window where you can define the assignment.
After you click the **Select** button a dialog window opens where you can define the properties of the new terminal strip. The dialog window is described under *Create terminal strips*.

### 15.4 Terminal diagram

You can insert an associated terminal diagram for a terminal strip into the circuit diagram. You do this by inserting a terminal diagram into a circuit diagram and then assigning a terminal strip to this diagram.

→  Select the **Terminal diagram** menu item from the **Insert** menu or click the button to insert a terminal diagram into the circuit diagram. Alternatively you can click the button. Select **Terminal diagram** in the selection dialog window that opens.
The mouse pointer changes to a crosshair. Click the position in the circuit diagram where you want to insert the terminal diagram. A dialog window then opens where you can assign the relevant terminal strip and customise the appearance.

![Terminal diagram - Properties dialog window](image)

**Figure 15/25: Terminal diagram - Properties dialog window**

<table>
<thead>
<tr>
<th>Terminal Strip</th>
<th>Defines the associated terminal strip.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Properties...</td>
<td>Opens the properties dialog window for the associated terminal strip.</td>
</tr>
</tbody>
</table>

You can customise the appearance of the terminal diagram in the “Print Options” tab. You can see the effects of the settings straight away in the preview on the right-hand side.

If the “Lines per Page” option is selected you can specify the number of lines to be displayed per page. The relevant pages will also
be output when the circuit diagram is printed. Buttons for navigation are displayed underneath the page if the list is split across multiple pages.

The entries in the “Description”, “Identification” and “Connector” columns are taken from the object properties of the associated targets.

15.4.1 Set links

You can set so-called links in a terminal strip. These links are drawn in the circuit diagram as regular electric lines and marked as links. The representation of the T distributors can be customized using their properties dialog window.

The following example shows a circuit diagram with a terminal strip X1 with 10 terminals and the associated terminal diagram. A link plug is to be placed at level “1” between terminals “7” and “8” and at level “2” between terminals “8” and “9”, and a wire link is to be placed between terminals “9” and “10”.

Double-click the electric line between terminals “7” and “8”.

**Figure 15/26:**

<table>
<thead>
<tr>
<th>Terminal</th>
<th>Links</th>
<th>Identification</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>S1</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Q1</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>K1</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>K1</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>K2</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Q1</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>K1</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>K2</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Y1</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Y2</td>
<td></td>
</tr>
</tbody>
</table>
The properties dialog window for the electric line opens. The options for setting the links are in the top right:

- **Link**
  - Defines that this line is to be treated as a link.

- **Link Plug**
  - Defines that the link is a link plug.

- **Level**
  - Specifies the level if a link plug was selected.

- **Wire Link**
  - Defines that the link is a wire link.

→ Set "Link", "Link Plug" and "Level 3".

FluidSIM tracks the line across one distributor point at most. This means that the specified link will find the contacts “7” and “8”. This link will be represented in the terminal diagram as follows.
### Terminal Strip - X1

<table>
<thead>
<tr>
<th>Terminal</th>
<th>Links</th>
<th>Identification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Terminal</td>
<td>Link Plug</td>
<td>Wire Link</td>
</tr>
<tr>
<td>1</td>
<td></td>
<td>S1</td>
</tr>
<tr>
<td>2</td>
<td></td>
<td>Q1</td>
</tr>
<tr>
<td>3</td>
<td></td>
<td>K1</td>
</tr>
<tr>
<td>4</td>
<td></td>
<td>K1</td>
</tr>
<tr>
<td>5</td>
<td></td>
<td>K2</td>
</tr>
<tr>
<td>6</td>
<td></td>
<td>Q1</td>
</tr>
<tr>
<td>7</td>
<td>∙</td>
<td>K1</td>
</tr>
<tr>
<td>8</td>
<td>∙</td>
<td>K2</td>
</tr>
<tr>
<td>9</td>
<td></td>
<td>Y1</td>
</tr>
<tr>
<td>10</td>
<td></td>
<td>-Y2</td>
</tr>
</tbody>
</table>

Figure 15/29:

→ Proceed in the same way to set a link plug between “8” and “9” at level “2” and a wire link between “9” and “10”.

The terminal diagram then has the following appearance.
The contact images can be displayed within a circuit diagram beneath relay coils and similar symbols. The contact images list all the contacts of the associated relay coil and show which current paths these contacts are in. The division of the page or circuit diagram can be defined using the page dividers.

To do this select the Display Contact Images menu item from the View menu.

The contact images of the current circuit diagram are shown or hidden.

Contact images can be highlighted, moved and aligned like other symbols.
You can have all of the contacts in a contact image displayed in a list and customise the appearance by double-clicking the contact image or highlighting the contact image and selecting the **Properties** menu item from the **Edit** menu.

---

**Figure 15/31:**

You can have all of the contacts in a contact image displayed in a list and customise the appearance by double-clicking the contact image or highlighting the contact image and selecting the **Properties** menu item from the **Edit** menu.
You can customise the representation of the contact image in the “Print Options” tab.

The “Contacts” tab lists all of the associated contacts. You can jump to the corresponding contact in the circuit diagram using the [Jump to Target] button.
Chapter 16

16.1 Print circuit diagram and parts list

FluidSIM circuits and parts lists can be printed by opening the Print dialog window via the Print... menu item on the File menu.

In FluidSIM a parts list is the representation of a circuit as a table. If you wish to print an individual parts list then the corresponding circuit must be shown in the parts list display.
Figure 16/1: Print dialog window:

**Printer**
Select the desired output device from the list of the available printers.

**Properties...**
This button enables you to open the dialog window for setting the printer options.

**Print to File**
Activate this option if you wish to write the print data to a file.

**Print Project Files**
When you work in a project you can select which circuits and parts lists are to be printed.

**Copies**
Select the number of copies. If the printout consists of multiple pages you can cause FluidSIM to print a correspondingly sorted sequence.

Scale
You can increase or decrease the output size by entering a scaling factor. If the dimensions of the area to be printed are larger than the printable area on the paper then the printout is spread across multiple pages (tiled). You can see the page divisions in the print preview.

Note: Please note that it may not always be possible to precisely comply with the page margins. Therefore you should plan a certain amount of leeway for the page margin.

Page
Here you can specify additional margins in order to manually customise the print area.

Margins
You can select which page the print preview displays.

### 16.2 Import DXF file

Files saved in the DXF format can be imported and retain most of their element attributes. If several special points were taken into account when creating the drawing using a CAD program then FluidSIM can easily expand the symbol library.

### 16.3 Export circuit

The FluidSIM circuits can be saved as a file with a variety of different formats. The BMP, JPG, GIF, WMF, PNG, DXF, TIF and PDF formats are available. Once you have selected the [Export...] menu item from the [File] menu a dialog window opens where you can define the different settings for the export. The settings depend on the format selected.
You are then prompted to select a file name or enter a new one.

Select a suitable resolution for the image file.

Please note that a high resolution generates extremely large files which mean the export may take longer. However you can cancel the image export at any time.
Chapter 17

You can access the various program settings in the *Options* dialog window via the **Options...** menu item on the **Tools** menu.

17.1 General

![Options dialog window: General tab](image)

**Figure 17/1:** *Options* dialog window: **General** tab

**View**

In order to simplify connection of connectors FluidSIM draws a small circle around the connectors on the circuit symbols. Deactivate the **Display Snap Radius** option in order to disable the display of the snap-in circles.

**Product Catalog**

Activating the “**Insert Symbols With Type Attribute**” option causes a text field to be added with the circuit symbol which contains a link to the attribute with the type designation of the product when components are inserted from the Festo product catalogue.

**Text fields for accessories**

When inserting accessories without symbols texts with the type designation of the products are displayed. Here you can limit the number of text fields inserted.
Products

Specifies which products from the Festo product catalogue are to be used, for example *Europe* or *Festo worldwide*.

Grid

Here you can set the grid width and the style. To display the grid select the **Show Grid** menu item on the **View** menu.

As well as absolute values such as “mm” you can also specify the relative **basic unit of length** “M”.

17.2 Save

![Figure 17/2: Options dialog window: Save tab](image)

**Compress Files**

FluidSIM normally compresses the saved files in order to save space on the disk. If you deactivate the option the files are saved as XML files without compression. You can find further information in the **Circuit files** section.

**Create Backup Files**

The “**Create Backup Files**” option causes the previous versions of saved files are created with the **bak** file suffix. This enables you to restore previous versions.
Project files generally consist of links to the files contained therein. However, where desired FluidSIM can also save the project along with all of the associated circuit files in one single file. This serves to simplify passing on or archiving the project, among other things. You can set whether a project saves links or all of the associated files using the Project dialog window – Properties of the project. This option defines the default setting for new projects.

A folder with the project name where all project files are stored is automatically generated when a new project is created if this option is active.

### 17.3 Folder Locations

**Folder Locations**

- **Page Files**: This is the default path for opening and saving circuits.
- **Project Files**: This is the default path for opening and saving projects.
- **Library Files**: This is the default path for opening and saving libraries.

![Folder Locations](image)
This is the default path for opening and saving **drawing frames**.

This is the default path for opening and saving **database files**.

### 17.4 Language

![Language Tab](image)

**Program**
Defines the languages for the program interface including dialog windows and messages.

**Product Catalog**
Defines the language used for the [Festo product catalogue](#).

**Translation Table**
Defines the **translation table** to be used.

**Translation Language**
Defines the language from the selected **translation table** to be used.

**Figure 17/4: Options dialog window: Language tab**

---

© Festo Didactic GmbH & Co. KG • Art Systems GmbH • FluidSIM
17.5 Dimension

This tab is used to define the default settings for the dimensions. You can find further information under Dimension.

Layer

Defines the drawing layer where the newly generated dimensions are placed.

Automatic Dimensioning

Activates and deactivates automatic dimensioning. If this option is activated then the displayed dimension value is automatically adapted if the dimension is scaled.

Unit

Defines the unit to be used for the dimension.

Show Unit

Defines whether the unit should be displayed.

Decimals

Defines the number of decimal places.

Figure 17/5: Options dialog window: Dimension tab

All of the settings are only applied to newly generated dimensions. They have no effect on existing dimensions in the circuit.
Determines the factor by which the real length is multiplied for the displayed value. This is necessary if you are creating a drawing with a scale other than 1:1.

### 17.6 Designation Conventions

![Designation Conventions tab](image)

**Figure 17/6: Options dialog window: Designation Conventions tab**

This tab is used to define the default settings for the designation conventions. You can find further information under Equipment identifications and designation conventions.

The settings are only applied to newly generated projects or circuits. They have no effect on existing objects.

Settings can be made for the following sets of conventions: Fluidics, Electrics and User Defined.

**Frame Identification**

Defines that the identifications produced by the selected set of conventions will be framed.
Enumerate Automatically Defines that the identifications of newly inserted symbols will be automatically numbered. All of the project files and not just the current circuit will be taken into consideration for the numbering if Consider All Project Files is active.

17.7 Cross Reference Representation

Figure 17/7: Options dialog window: Cross Reference Representation tab

This tab is used to define the default settings for the cross-reference representation. You can find further information under Cross-reference representation.

The settings are only applied to newly generated projects or circuits. They have no effect on existing objects.

Example Illustrates the effects of the settings using an example.

Reset Resets the settings to the settings defined in FluidSIM.
17.8 Connector Links

![Connector Links tab](image)

**Figure 17/8: Options dialog window: Connector Links tab**

- **Allow connections between same connector types only**
  
  Only connectors of the same type can be connected if this option is active. For example a line from an electric connector to a pneumatic connector cannot be created in this case.

- **FluidSIM supports the automatic connection of connectors.** The following settings define which connections should be automatically created.

- **Pneumatic – Horizontal**
  
  Pneumatic connectors that are on one horizontal line will be automatically connected when a symbol is inserted or moved.

- **Pneumatic – Vertical**
  
  Pneumatic connectors that are on one vertical line will be automatically connected when a symbol is inserted or moved.

- **Electric – Horizontal**
  
  Electric connectors that are on one horizontal line will be automatically connected when a symbol is inserted or moved.

- **Electric – Vertical**
  
  Electric connectors that are on one vertical line will be automatically connected when a symbol is inserted or moved.
17.9 Warnings

![Warnings dialog window](image)

**Figure 17/9: Options dialog window: Warnings tab**

**Show Warnings**
Different types of warnings that FluidSIM should or should not deliver can be activated and deactivated here. These warnings include “Duplicated identification labels” and “Superimposed objects”.

**Enable Background Check**
All of the circuits will be checked during editing if this option is active. Only the criteria that would lead to the warnings specified under “Show Warnings” are checked. Objects that caused an error are highlighted in red in the circuit. If this option is not active then the check must be initiated manually using the **Page – Check Drawing** menu.
17.10 Automatic Updates

Check for updates at startup  FluidSIM can search on the Internet for a new version when the program starts. You can activate or deactivate the automatic search here.

Check for updates now...  As soon as there is an Internet connection you can use this button to initiate the search for a new FluidSIM version.

Figure 17/10: Options dialog window: Automatic Updates tab
17.11 Text Sizes

Figure 17/11: Options dialog window: Text Sizes tab

This tab defines the font sizes to be used for objects newly inserted into the circuit diagram.

Label/Attribute

This group lists the font sizes used for identifications and cross-references, etc.

List/Table

This group lists the font sizes used for analyses and tables.
Menu overview

Chapter 18

18.1 File

New

New / File...
Opens a new window for creating a new circuit drawing.

New / Project...
Opens the dialog window for creating a new project.

Open

Open / File...
Opens a new window for selecting an existing circuit drawing.

Open / Project...
Opens the dialog window for selecting an existing project.

Add
Adds files, etc. to the active project.
Add / New Page...
Creates a new circuit file and adds it to the active project.

Add / New Parts List...
Creates a new parts list and adds it to the active project.

Add / Existing Files...
Opens the dialog window for selecting existing files to be added to the active project.

Close
Closes the active window or project, etc.

Close / File...
Closes the active window.

Close / Project...
Closes the active project.

Save File
Saves the circuit diagram in the active window to disk.

Save File As...
Saves the circuit diagram in the active window to disk under a new name.

Save Project
Saves the active project.
Save Project As...

Saves the active project under a new name on the data storage medium. Files that are within the project folder are duplicated while references to external files are left. With external file references you must therefore consider that changes to these files affect all projects containing them.

Save as Component Library...

Saves the active project as a library. As a result a new library symbol is generated for every circuit. The new library bears the name of the project with the `lib` file suffix.

DXF Import...

Opens the dialog window for selecting a saved DXF file. The selected file is subsequently converted into a FluidSIM circuit diagram. The original file remains unchanged.

Export...

Exports the circuit diagram in the active window to the data storage medium as a BMP, JPG, GIF, WMF, PNG, DXF or TIF file.

Page Setup...

Sets up the printer properties for a page to be printed.

Print Preview

Opens a print preview as a page view.

Print...

Opens the FluidSIM Print dialog window to set the print options for the active circuit.
Recent Files
A file can be selected for opening from a list of the recently opened files.

Recent Projects
The most recently opened projects can be selected for opening from a list.

Exit
Ends FluidSIM.

18.2 Edit

Undo
Undoes the last editing action for the active circuit.

Redo
Takes back the last undo-action for the active circuit.

Cut
Deletes the selected objects and adds them to the clipboard.

Copy
Copies the selected objects to the clipboard

Paste
Pastes the objects from the clipboard into the active circuit.
Delete
Deletes the selected objects from the active circuit.

Select All
Selects all of the objects from the active circuit.

Group
Groups the selected objects.

Create Macro Object
Creates a macro object out of the selected objects.

Create Cross-reference
Creates a cross-reference.

Ungroup/Break Off
Ungroups the selected groups or macro objects.

Enable Scale
Activates or deactivates the “enable scaling” mode which enables the scaling of symbols with the help of the mouse pointer.

Enable Rotate
Activates or deactivates the “enable rotate” mode which enables the rotation of symbols with the help of the mouse pointer.

Edit Poly Line
Activates or deactivates the “Edit Polyline” mode that allows you to edit a polyline.
Aligns the selected objects with each other.

**Rotate**

Rotates the selected objects by 90, 180 or 270 degrees anti-clockwise. **Grouped objects** are rotated around the center point of the group rectangle.

**Mirror**

Mirrors the selected objects horizontally or vertically. **Grouped objects** are mirrored along the axis of the group rectangle.

**Delete Connector**

Deletes the selected component connector.

**Properties...**

Opens the *Properties* dialog window for the selected circuit symbols in order to enter the **component properties**. This also enables you to carry over attributes from the Festo product catalogue.

The *Connector* dialog window is opened for the selected component connector enabling you to enter the **connector properties**.

When a line segment is highlighted a dialog window opens enabling you to enter the **line properties**.

If multiple objects are selected then a **dialog window with a limited selection of properties** appears. It only contains those properties which affect all of the selected objects.
18.3 Insert

**Find Symbol Description...**
Opens the search dialog for selecting a symbol via its appearance or its description.

**From Festo Catalog...**
Opens the Festo product catalogue to select a component via the product features.

**From Festo Shopping Basket...**
Opens the Festo product catalogue to transfer components from an existing shopping cars.

**From File...**
Opens the dialog window for selecting an existing text file in CSV format which was created by an export from the Festo product catalogue.

**From Custom Database**
Opens a dialog window similar to the Festo product catalogue for selecting a component via the product properties. It is not the database of the Festo product catalogue that is used, however, but the selected user database.

**Conduction Line...**
Opens a dialog window that defines the settings for one or more conduction lines that are to be inserted in the circuit diagram after the dialog window is confirmed.
Define Connector...
Creates a new component connector the next time the left mouse button is clicked in a circuit symbol.

Interruption/Potential...
Adds an interruption or an electric potential to the circuit diagram.

Parts List
Inserts a parts list into the circuit diagram.

Terminal
Inserts a terminal into the circuit diagram.

Multiple Terminals...
Inserts multiple terminals into the circuit diagram.

Terminal diagram
Inserts a terminal diagram into the circuit diagram.

Cable
Inserts a cable into the circuit diagram.

Cable Map
Inserts a cable map into the circuit diagram.

Cable List
Inserts a cable list into the circuit diagram.
18.4 Draw

This menu contains functions for freely drawing graphical elements such as lines, rectangles, circles, etc as well as for inserting texts and images.

**Line**

Draws a line by defining two defined end points.

**Poly Line**

Draws a polyline by defining the vertices with successive mouse clicks. The drawing operation can be cancelled by pressing the Esc key or clicking the right mouse button. The last vertex must be set with a double-click.

**Rectangle**

Draws a rectangle by defining two diagonally opposite corner points.

**Circle**

Draws a circle by defining a middle point and a radius.

**Ellipse**

Draws an ellipse by defining a middle point and a radii on parallel axes.

**Text**

Inserts a text at the mouse position.
<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Picture</strong></td>
<td>Inserts an image at the mouse position.</td>
</tr>
<tr>
<td><strong>Dimension</strong></td>
<td>Inserts a dimension symbol.</td>
</tr>
</tbody>
</table>

### 18.5 Page

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Check Drawing</strong></td>
<td>Checks the active circuit drawing for drawing errors.</td>
</tr>
<tr>
<td><strong>Paper Size...</strong></td>
<td>Opens a dialog window enabling you to set the paper size.</td>
</tr>
<tr>
<td><strong>Language...</strong></td>
<td>Opens a dialog window enabling you to set the circuit language.</td>
</tr>
<tr>
<td><strong>Renumber Designations...</strong></td>
<td>Opens a dialog window enabling you to interactively renumber the symbol identifications.</td>
</tr>
<tr>
<td><strong>Manage Terminal Strips...</strong></td>
<td>Opens a dialog window enabling you to manage the terminal strips in the circuit.</td>
</tr>
<tr>
<td><strong>Manage Cables...</strong></td>
<td>Opens a dialog window enabling you to manage the cable objects in the circuit.</td>
</tr>
</tbody>
</table>
18.6 Project

**Properties...**
Opens an dialog window enabling you to set the circuit properties.

**Add Current Window**
Adds the active window to the file list of the open project.

**Remove Current Window**
Removes the active window from the file list of the open project.

**Manage Terminal Strips...**
Opens a dialog window enabling you to manage the terminal strips in the project.

**Manage Cables...**
Opens a dialog window enabling you to manage the cable objects in the project.

**Manage Cross References...**
Opens a dialog window enabling you to manage the cross-references in the project.

**Properties...**
Opens the dialog window for entering the project properties.
18.7 View

**Circuit Diagram**
Switches from the parts list view to the circuit diagram view.

**Parts List**
Switches to the parts list view.

**Library**
Shows or hides the libraries window.

**Project**
Shows or hides the window for managing the project files.

**Standard Size**
Displays the circuit diagram in its original size.

**Previous View**
Displays the previous view of the circuit diagram. Repeatedly activating this function switches back and forth between the views previously used.

**Fit to Window**
Set the zoom level to fit the entire circuit diagram into the window.

**View Detail**
Defines the new view by drawing a rectangle while holding down the left mouse button.
**Zoom In**
Zooms the view of the circuit diagram in by one step. Three steps correspond approximately to doubling the zoom factor.

**Zoom Out**
Zooms the view of the circuit diagram out by one step. Three steps correspond approximately to halving the zoom factor.

**Show Page Borders**
Shows or hides the page borders in the form of a red rectangle. This rectangle displays the borders of the paper format defined on the **Paper Size** menu. Using the **print preview** you can decide whether and how the drawing is distributed among multiple sheets when printing.

**Show Grid**
Shows a **background grid** in the active circuit window. The grid settings can be made in the **General** tab under the **Options** menu item from the **Tools** menu.

**Show Rulers**
Shows or hides the rulers in the active circuit window.

**Show Page Dividers**
Shows or hides the **page dividers** in columns and rows. Cross-references can refer to the column and row containing a symbol. The position and number of the columns and rows can be interactively defined via the page dividers shown.
### Show Connector Descriptions
Shows or hides the connector descriptions. The *Display* option can be selected in the properties dialog window for the connectors. This option is only evaluated if “*Individual*” was selected.

<table>
<thead>
<tr>
<th>Show Connector Descriptions / All</th>
<th>Shows all connector descriptions regardless of the settings at the connectors.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Connector Descriptions / Individual</td>
<td>Shows only the connector descriptions for those connectors with the <em>Display</em> option activated.</td>
</tr>
<tr>
<td>Show Connector Descriptions / None</td>
<td>Hides all connector descriptions regardless of the settings at the connectors.</td>
</tr>
</tbody>
</table>

### Show Terminal Directions
Shows or hides the direction arrows at the terminals. The tip of the arrow points into the control cabinet here.

<table>
<thead>
<tr>
<th>Show Terminal Directions / All</th>
<th>Shows all arrows regardless of the settings at the terminals.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Terminal Directions / Individual</td>
<td>Shows only the arrows for those terminals with the <em>Show Direction</em> option activated.</td>
</tr>
<tr>
<td>Show Terminal Directions / None</td>
<td>Hides all arrows regardless of the settings at the terminals.</td>
</tr>
</tbody>
</table>
Display Contact Images
Shows or hides the contact images.

Drawing Layers...
Opens a Drawing Layers dialog window enabling you to set the properties of the drawing layers.

18.8 Library

Add New Library...
Creates a new library.

Add Existing Library...
Opens the dialog window enabling you to select a saved library file with the .lib file suffix. The library saved in the file is added to the library window.

Add Existing Symbol Folder...
Opens the dialog window for selecting an existing folder. The entire contents of the selected folder, including all of the circuit symbols and sub-folders contained therein are displayed as a library.

Close Current Library
Removes the active library from the list in the library window. The library file is not deleted by this action and can be opened again using the Library menu and the Add Existing Library... menu item.
Rename Active Library...
Opens a dialog window for entering the name of the library. This function is only available to libraries which the user has created. For write-protected libraries the folder name is shown in the tab.

Sort Current Library Alphabetically
Sorts the contents of the active library alphabetically. This function is only available to libraries which the user has created. Write-protected libraries are automatically sorted and cannot be resorted by the user.

18.9 Tools

Options...
Opens the dialog window with program settings, file paths and language options.

Custom Product Databases...
Opens a dialog window for managing custom product databases.

Translation Tables...
Opens a dialog window for managing translation tables.

Restore Defaults...
Resets the program settings to the default values. This enables you to undo unintentional settings made.

Note: Use this function if you feel that FluidSIM is behaving unexpectedly or files and windows have suddenly disappeared.
18.10 Window

**New Window**
Opens a window with an additional view of the active window.

**Navigation Pane**
Opens an overview window with a scaled-down view of the entire circuit diagram. The currently visible area of the active window appears as a white area. The non-visible area of the drawing is shaded grey. By drawing a rectangle in the overview window with the mouse pointer you can define the section of the circuit diagram displayed in the active window. Simply left-clicking on the overview window moves the visible area while retaining the zoom level.

**Cascade**
Arranges the windows so that they overlap.

**Tile Horizontally**
Arranges the windows into horizontal tiles.

**Tile Vertically**
Arranges the windows next to each other.

**Close All**
Closes all open windows.
18.11 Help

Contents
Displays the contents of the FluidSIM help pages.

Index
Displays the index of the FluidSIM help pages.

Search
Displays the search dialog for the FluidSIM help pages.

Check for updates...
As soon as there is an Internet connection you can use this menu item to initiate the search for a new FluidSIM version.

About...
Displays the FluidSIM program information.
Chapter 19

You can find the function diagram in the standard FluidSIM library. You can apply the functions from the Edit menu to the function diagram. Double-click the function diagram or open the Functional diagram using the Properties... menu item on the Edit menu.

The buttons in the upper toolbar of the editor are for editing a function diagram. The following six buttons determine the editing mode:

- **Edit Mode**
- **Draw diagram curves**
- **Insert signal elements**
- **Insert text boxes**
- **Draw signal lines and insert signal connections**
- **Insert additional signal lines**

The selected mode is highlighted in white or displayed as a pressed button. **** shows that signal lines can be drawn in the diagram area by clicking, for example.

If you hover the mouse pointer over a button for a short period of time then a short description is displayed.
19.1 Edit Mode

This mode serves to adjust the objects in the function diagram. Elements in the diagram can be moved. Changing the size of text boxes is only possible in this mode.

Movement and dragging operations can be cancelled using the Esc key.

If the mouse pointer is moved outside the window area while the left mouse button is held down the view automatically scrolls.

Double-clicking on a diagram element (diagram row, text box, signaling element, etc.) opens a dialog window in which you can make the desired adjustments.

19.1.1 Set diagram properties

Clicking on the Eigenschaften button opens a dialog window in which you can set the diagram properties.
Figure 19/2:

Text columns – Number

If the number of text columns is changed than all of the table text boxes are distributed horizontally and evenly.

Text columns – Width

If the width of the text columns is changed than all of the table text boxes are distributed horizontally and evenly.

Diagram columns – Number

The diagram columns are located on the right-hand side of the function diagram. The diagram curves can be drawn in this area. The number of diagram columns can also be changed by dragging the mouse pointer to the right-hand edge of the diagram.

Diagram columns – Width

Color

The color which the grid lines are drawn in the diagram area.

Row height

Defines the row height of all of the rows.

19.1.2 Table textboxes

The table textboxes are located on the left-hand side of the function diagram.
Double-clicking on a table textbox opens the corresponding dialog window.

Figure 19/3:

Font size
Color
Width
Height
Horizontal adjustment
Vertical adjustment

The font size of the text to be shown.
A selection from sixteen standard colors for the text to be displayed.
The width of the selected table column can be changed by dragging the mouse pointer.
The height of the selected table column can be changed by dragging the mouse pointer.
The following alignment options are available: “Left”, “Center” and “Right”.
The following alignment options are available: “Top”, “Center” and “Bottom”
Alignment within a table cell

If a text within a textbox should resemble a table then set a tab stop between the text parts. The text is displayed in the textbox in accordance with the number of tab stops and the specified horizontal and vertical alignment. To enter tab stops hold down the \texttt{Ctrl} key.

Examples:

1. Insert text boxes

2. Insert text boxes
19.1.3 Adjust the presentation of the diagrams

The area in which curves can be drawn is located on the right-hand side of a diagram row.

Figure 19/5:

Double-clocking on this area opens a corresponding window in which you can define the appearance of the drawing area. Please ensure that no diagram element, such as a signaling element, for example, is underneath the mouse pointer.

Figure 19/6:

States – Number

The entry defines the number of states and thus the number of horizontal lines in the diagram row.
States – Base state  
Horizontal lines are drawn through the base state with a thin pencil.

Numbering – Start column  
The start column defines which column the numbering should begin with.

Numbering – Start number  
The start number defines which number the numbering should begin with.

Numbering – Number  
The number specified who many steps need to be numbered.

Numbering – Step width  
Defines the step width between two numbers.

Numbering – Loop  
If this field is selected then an equals sign and the start number are always displayed after the last number.

Representation – Display arrows  
If this field is selected then two arrows are displayed.

Representation – Display grid  
If this field is selected then the background grid is displayed.

Representation – Display text 1  
If this field is selected then a textbox is shown which can serve as a label. This textbox belongs to the selected row and cannot be moved to another row.

Representation – Display text 2  
If this field is selected then an additional textbox is shown which can serve as a label. This textbox belongs to the selected row and cannot be moved to another row.

Representation – Line color  
Sets the color of the diagram lines.

19.2 Draw diagram curve

In this mode diagram curves can be drawn. Supporting points can only be inserted on the grid. A supporting point is drawn at every left-click.
If you hold down the left mouse button then supporting points can be moved as in the selection mode.

Selected supporting points are shown in grey. Use the Del key to delete a selected symbol.

### 19.3 Insert signal elements

In this mode signaling elements can be inserted by left-clicking.

1.  

2.  

If you hold down the left mouse button then signaling elements can be moved as in the selection mode.

Selected signaling elements are shown in grey. Use the Del key to delete a selected signaling element.

Double-clicking on a signaling element in the selection mode opens a dialog window in which you can modify how the signaling element is shown.
If this field is selected then a text is shown which can serve as a label for the signaling element. The signaling element is displayed in this color.

### 19.4 Insert text boxes

In this mode textboxes can be inserted by left-clicking. Selected textboxes are shown in grey. Use the `Del` key to delete a selected textbox.
In “Edit Mode” the size and position of a textbox can be changed using the mouse pointer.

Adjust size:

1. 
2. 
3. 

Move textbox:

1. 
2. 
3. 

Double-clicking on a textbox in the selection mode opens a dialog window in which you can modify how the textbox is shown.

Figure 19/8:

Font size
The font size of the text to be shown.
19.5 Draw signal lines and insert signal connections

In this mode signal lines can be drawn freely or automatically laid from signaling elements.

19.5.1 Free-draw signal lines

An additional supporting point is set with every left-click. The process ends when you click the current line while holding down the Ctrl key, press the Esc key or switch the editing mode. Use the Del key to delete a selected signal line. If only a supporting point is selected then only this is removed from the line.

In “Edit Mode” the supporting points belonging to the signal lines can be moved. If the Shift is held down while setting or moving
supporting points then the supporting point is vertically or horizontally aligned.

In the selection mode double-clicking can change the way the line is displayed.

![Signal line dialog box](image)

Figure 19/9:

**Display description**
A framed label on the line and a label next to the framed label is shown. The framed label can be moved freely along the line. The additional label can be moved freely.

**Start with arrow**
An arrow is displayed at the beginning of the line. The arrow can be moved freely along the line.

**End with arrow**
An arrow is displayed at the end of the line. The arrow can be moved freely along the line.

**Color**
Line color

If you click a finished signal line to activate the “Freely move signal lines” mode, then a signal logic is inserted. This logic point (snap point) can then be freely moved along the line 1.

![Signal lines](image)

In the selection mode you can change how the signal logic is displayed by double-clicking on it.
19.5.2 Drawing signal lines from signals

In the “Freely draw signal lines” mode signal lines can be drawn from signals. Left-click a signal and hold down the mouse button. Drag the mouse pointer to a position which you have selected as the end point of a signal line. The signal line will be drawn once you release the mouse button.

1. 2. 3.

19.5.3 Draw signal lines from diagram support points

In the “Freely draw signal lines” mode signal lines can be drawn from curve support points. Left-click a supporting point and hold down the mouse button. Drag the mouse pointer to a second supporting point. The signal line will be drawn once you have the
mouse pointer over the second supporting point and release the mouse button.

19.6 Insert additional signal lines

In the "Insert additional signal lines" mode additional supporting points can be inserted into existing signal lines.

19.7 Insert row

Clicking on the "Insert row" button inserts a new diagram row above the current selection. If no cell is marked then a new row is attached to the end of the diagram.

19.8 Delete row

Clicking on the "Delete row" button deletes a selected diagram row. If nothing is selected then the function is not available.
19.9 Additional editing functions

19.9.1 Zoom

Using the button the view is reset to the standard zoom level.

Using the button increases the zoom level.

Using the button decreases the zoom level.

19.9.2 Undo editing steps

Using the button you can undo the last 50 editing steps.

Using the button you can redo the previously undone editing steps.
Chapter 20

In FluidSIM each component in the component library is assigned a physical model. Using these models, FluidSIM first creates a global behavior model of the circuit which is then processed during simulation.

This chapter provides for a short description of the components in FluidSIM 's component library. If the component has adjustable parameters, their value ranges are given. A number in brackets after the value range indicates the default setting for the parameter.

20.1 Hydraulic Components

20.1.1 Service Components

Pump unit

The pump unit supplies a constant volumetric flow. The operating pressure is limited by the internal pressure relief valve. The pump unit has two tank connections.

Adjustable parameters
- Opening pressure: 0 ... 40 MPa (6)
- Revolution: 0 ... 5000 l/min (1450)
- Displacement: 0.1 ... 5000 cm³ (1.6)
- Internal leakage: 0 ... 10 l/(min.bar) (0.002)
Pump unit (simplified)

Simplified representation of the detailed pump unit. The component does not have tank connections in the circuit diagram.

*Adjustable parameters*
- **Delivery rate:** 0 ... 500 l/min (2)
- **Maximum pressure:** 0 ... 40 MPa (6)
- **Internal leakage:** 0 ... 10 l/(min.bar) (0)

Fixed displacement pump

The fixed displacement pump delivers a constant volumetric flow rate dependent upon the revolutions and the displacement volume.

*Adjustable parameters*
- **Revolution:** 0 ... 5000 1/min (1320)
- **Displacement:** 0.1 ... 10000 cm³ (1.6)
- **Maximum pressure:** 0.1 ... 40 MPa (6)
- **Internal leakage:** 0 ... 10 l/(min.bar) (0)

Variable displacement pump

The revolutions of the variable displacement pump can be changed under operating conditions. The pump delivers a variable volumetric flow rate dependent upon the variable revolutions and the displacement volume.

*Adjustable parameters*
- **Revolution:** 0 ... 5000 1/min (1320)
- **Displacement:** 0.1 ... 10000 cm³ (1.6)
- **Flow rate ratio:** 0 ... 100 % (100)
- **Maximum pressure:** 0.01 ... 40 MPa (6)
- **Internal leakage:** 0 ... 10 l/(min.bar) (0)
Proportional pump

The revolutions of the variable displacement pump can be changed proportionally from zero to maximum through a voltage signal between 0 V and 10 V and the assistance of a proportional-amplifier. The pump delivers a variable volumetric flow rate dependent upon the variable revolutions and the displacement volume.

Adjustable parameters
Mode of control: Displacement control, Speed control (Displacement control)
Displacement: 0.1 ... 5000 cm³ (1.6)
Revolution (min): 0 ... 5000 1/min (0)
Revolution (max): 0 ... 5000 1/min (1320)
Flow rate ratio (min): 0 ... 1 (0)
Flow rate ratio (max): 0 ... 1 (1)
Maximum pressure: 0.01 ... 40 MPa (6)
Internal leakage: 0 ... 10 l/(min.bar) (0)

Hydraulic power pack with LS variable and constant displacement pump combination

Vane pump with hydraulic load-sensing controller

Adjustable parameters
Revolution: 0 ... 5000 1/min (910)
Displacement (Variable displacement pump): 0 ... 10000 cm³ (5.6044)
Opening pressure (Variable displacement pump): 0 ... 40 MPa (5)
Spring preload: 0.1 ... 10 MPa (1.17)
Displacement (Fixed displacement pump): 0 ... 10000 cm³ (4.5055)
Opening pressure (Fixed displacement pump): 0 ... 40 MPa (5)
Steering unit (Orbitrol)

The steering unit is used to steer vehicles that are equipped with hydrostatic steering.

The steering unit consists of a proportional rotary valve, a pump control valve and a dosing pump. The rotary valve is opened proportionally to torque (steering force) and direction of rotation. The control edges of the proportional valve are arranged radially at several levels on the rotary piston and the inside of the rotary valve housing. A spring package assures a spring centred, closed mid-position.

*Adjustable parameters*

*External torque:* -10 ... 10 N.m (0)
*Displacement:* 0 ... 10000 cm³ (32)
*Hydraulic resistance:* 1e-6 ... 1000 bar.min²/l² (0.1)
Tank

The tank is integrated into the pump unit and has a pressure of 0 MPa. It can be inserted into the circuit diagram as an independent component.

Hose with quick-action coupling

The hose is available in 3 lengths: 600 mm, 1500 mm, and 3000 mm. The pressure loss in a hose is taken into account by specifying a hydraulic resistance. In FluidSIM no pressure loss is simulated with simple connections between two components.

Adjustable parameters

**Hydraulic resistance:** 1e-6 ... 1000 bar.min²/l² (0.1)

Hydraulic reservoir

The reservoir enables the performance of a hydraulic system to be optimized. For example, it can be utilized as an energy reservoir and for the absorbance of pressure surges or flow fluctuations. Reservoirs are capable of absorbing a defined volume of fluid under pressure and releasing it again with minimal losses. The construction consists essentially of a pressure resistant container, generally a gas charge of nitrogen and a separator e.g. a piston, a membrane or a bubble elastomer. Hydraulic fluid only starts to flow into the reservoir when the fluid pressure is greater than the gas-preload pressure.

Adjustable parameters

**Volume:** 0.01 ... 100 l (0.32)
**Pre-load pressure:** 0 ... 40 MPa (1)
**Polytropic exponent:** 0.5 ... 3 (1.4)
Hydraulic reservoir

The reservoir enables the performance of a hydraulic system to be optimized. For example, it can be utilized as an energy reservoir and for the absorbance of pressure surges or flow fluctuations. Reservoirs are capable of absorbing a defined volume of fluid under pressure and releasing it again with minimal losses. The construction consists essentially of a pressure resistant container, generally a gas charge of nitrogen and a separator e.g. a piston, a membrane or a bubble elastomer. Hydraulic fluid only starts to flow into the reservoir when the fluid pressure is greater than the gas-preload pressure.

Adjustable parameters

Volume: 0.01 ... 100 l (0.32)
Pre-load pressure: 0 ... 40 MPa (1)
Polytropic exponent: 0.5 ... 3 (1.4)

Diaphragm accumulator with shutoff block

Stores the pressure and is equipped with a pressure relief valve to prevent overpressure.

Adjustable parameters

Pre-load pressure: 0 ... 40 MPa (1)
Volume: 0.01 ... 100 l (0.32)
Opening pressure: 0 ... 35 MPa (8)

Filter

The filter limits the contamination of the fluid respecting a certain tolerance value in order to reduce the risk of damage at the components.

Adjustable parameters
Hydraulic resistance: 1e-6 ... 1000 bar.min²/l² (0.001)

Cooler

An unacceptable fall in the hydraulic fluid’s viscosity can be avoided through the use of a cooler.

Adjustable parameters

Hydraulic resistance: 1e-6 ... 1000 bar.min²/l² (0.001)

Heater

The hydraulic fluid’s optimal viscosity can be reached quickly through the use of a heater.

Adjustable parameters

Hydraulic resistance: 1e-6 ... 1000 bar.min²/l² (0.001)

Connection (hydraulic)

A hydraulic connection is a place where a hydraulic line can be attached to. To simplify the line drawing process, a connection appears as a small circle in Edit Mode. Hydraulic connections can be shut by means of a blind plug. An open hydraulic connection may result in leaking oil; FluidSIM-H thus pops up a warning message, if some hydraulic connection was left open. Note that at each hydraulic connection values for the flow and pressure can be displayed.
Line (hydraulic)

A hydraulic line links two hydraulic connections. Note that a hydraulic connection may be a simple hydraulic connection or a T-junction. A hydraulic line causes no pressure drop, i.e., it has no fluidic resistance. From a drawing point of view, FluidSIM distinguishes between control lines and main lines. The former is represented by a dashed line, the latter is represented by a solid line and establishes the default case.

T-junction (hydraulic)

A T-junction joins up to four hydraulic lines, thus having a single pressure potential. Note that T-junctions are introduced automatically by FluidSIM when dropping the line drawing cursor onto another line in Edit Mode.

20.1.2 Configurable Way Valves

Configurable 2/n way valve

The configurable 2/n way valve is a way valve with two connections, where both its body elements and its operation modes are user-definable.

Additionally, the hydraulic connections can be closed with blind plug.

Adjustable parameters

Desired position: 0 ... 4 (0)
Hydraulic resistance: 1e-6 ... 1000 bar.min²/l² (0.164)
Positioning time: 1e-4 ... 10 s (0.02)
Reset time: 1e-4 ... 10 s (0.03)
Configurable 3/n way valve

The configurable 3/n way valve is a way valve with three connections, where both its body elements and its operation modes are user-definable.

Additionally, the hydraulic connections can be closed with blind plugs.

Adjustable parameters

Desired position: 0 ... 4 (0)
Hydraulic resistance: 1e-6 ... 1000 bar.min2/l2 (0.164)
Positioning time: 1e-4 ... 10 s (0.02)
Reset time: 1e-4 ... 10 s (0.03)
Minimum voltage: 0.1 ... 300 V (20)
Electrically left at U_min: 0.01 ... 100 N (70)
Electrically right at U_min: 0.01 ... 100 N (70)
Mechanically left: 0.01 ... 100 N (100)
Mechanically right: 0.01 ... 100 N (100)
Physical spring force: 0.01 ... 100 N (30)
Minimum force: 0.01 ... 100 N (20)
Min. pilot control force: 0.01 ... 100 N (15)
Left: 0.01 ... 100 cm2 (1)
Right: 0.01 ... 100 cm2 (1)
Pilot control left: 0.01 ... 100 cm2 (1)
Pilot control right: 0.01 ... 100 cm2 (1)
Configurable 4/n way valve

The configurable 4/n way valve is a way valve with three connections, where both its body elements and its operation modes are user-definable.

Additionally, the hydraulic connections can be closed with blind plugs.

Adjustable parameters

Desired position: 0 ... 4  (0)
Hydraulic resistance: 1e-6 ... 1000 bar.min2/l2  (0.164)
Positioning time: 1e-4 ... 10 s  (0.02)
Reset time: 1e-4 ... 10 s  (0.03)
Minimum voltage: 0.1 ... 300 V  (20)
Electrically left at U_min: 0.01 ... 100 N  (70)
Electrically right at U_min: 0.01 ... 100 N  (70)
Mechanically left: 0.01 ... 100 N  (100)
Mechanically right: 0.01 ... 100 N  (100)
Physical spring force: 0.01 ... 100 N  (30)
Minimum force: 0.01 ... 100 N  (20)
Min. pilot control force: 0.01 ... 100 N  (15)
Left: 0.01 ... 100 cm2  (1)
Right: 0.01 ... 100 cm2  (1)
Pilot control left: 0.01 ... 100 cm2  (1)
Pilot control right: 0.01 ... 100 cm2  (1)

Configurable 5/n way valve

The configurable 5/n way valve is a way valve with three connections, where both its body elements and its operation modes are user-definable.

Additionally, the hydraulic connections can be closed with blind plugs.

Adjustable parameters
**Desired position:** 0 ... 4 (0)
**Hydraulic resistance:** 1e-6 ... 1000 bar.min²/l² (0.164)
**Positioning time:** 1e-4 ... 10 s (0.02)
**Reset time:** 1e-4 ... 10 s (0.03)
**Minimum voltage:** 0.1 ... 300 V (20)
**Electrically left at U_min:** 0.01 ... 100 N (70)
**Electrically right at U_min:** 0.01 ... 100 N (70)
**Mechanically left:** 0.01 ... 100 N (100)
**Mechanically right:** 0.01 ... 100 N (100)
**Physical spring force:** 0.01 ... 100 N (30)
**Minimum force:** 0.01 ... 100 N (20)
**Min. pilot control force:** 0.01 ... 100 N (15)
**Left:** 0.01 ... 100 cm² (1)
**Right:** 0.01 ... 100 cm² (1)

**Adjustable parameters**

**Desired position:** 0 ... 4 (0)
**Hydraulic resistance:** 1e-6 ... 1000 bar.min²/l² (0.164)
**Positioning time:** 1e-4 ... 10 s (0.02)
**Reset time:** 1e-4 ... 10 s (0.03)
**Minimum voltage:** 0.1 ... 300 V (20)
**Electrically left at U_min:** 0.01 ... 100 N (70)
**Electrically right at U_min:** 0.01 ... 100 N (70)
**Mechanically left:** 0.01 ... 100 N (100)
**Mechanically right:** 0.01 ... 100 N (100)
**Physical spring force:** 0.01 ... 100 N (30)
**Minimum force:** 0.01 ... 100 N (20)
**Min. pilot control force:** 0.01 ... 100 N (15)
**Left:** 0.01 ... 100 cm² (1)

**Configurable 6/n way valve**

The configurable 6/n way valve is a way valve with three connections, where both its body elements and its operation modes are user-definable.

Additionally, the hydraulic connections can be closed with blind plugs.
Configurable 8/n way valve

The configurable 8/n way valve is a way valve with three connections, where both its body elements and its operation modes are user-definable.

Additionally, the hydraulic connections can be closed with blind plugs.

Adjustable parameters
Desired position: 0 ... 4 (0)
Hydraulic resistance: 1e-6 ... 1000 bar.min²/l² (0.164)
Positioning time: 1e-4 ... 10 s (0.02)
Reset time: 1e-4 ... 10 s (0.03)
Minimum voltage: 0.1 ... 300 V (20)
Electrically left at U_min: 0.01 ... 100 N (70)
Electrically right at U_min: 0.01 ... 100 N (70)
Mechanically left: 0.01 ... 100 N (100)
Mechanically right: 0.01 ... 100 N (100)
Physical spring force: 0.01 ... 100 N (30)
Minimum force: 0.01 ... 100 N (20)
Min. pilot control force: 0.01 ... 100 N (15)
Left: 0.01 ... 100 cm² (1)
Right: 0.01 ... 100 cm² (1)
Pilot control left: 0.01 ... 100 cm² (1)
Pilot control right: 0.01 ... 100 cm² (1)
20.1.3 Mechanically Actuated Directional Valves

2/2-way stem-Actuated valve (i)

If the cylinder piston actuates the stem, flow is enabled from P to A.

This valve is derived from a configurable 2/n way valve. You find this valve in the component library “Frequently used Way Valves”, under the [Library] menu.

Adjustable parameters
- Desired position: 0 ... 4 (0)
- Hydraulic resistance: 1e-6 ... 1000 bar.min2/l2 (0.164)
- Positioning time: 1e-4 ... 10 s (0.02)
- Reset time: 1e-4 ... 10 s (0.03)
- Minimum voltage: 0.1 ... 300 V (20)
- Electrically left at U_min: 0.01 ... 100 N (70)
- Electrically right at U_min: 0.01 ... 100 N (70)
- Mechanically left: 0.01 ... 100 N (100)
- Mechanically right: 0.01 ... 100 N (100)
- Physical spring force: 0.01 ... 100 N (30)
- Minimum force: 0.01 ... 100 N (20)
- Min. pilot control force: 0.01 ... 100 N (15)
- Left: 0.01 ... 100 cm2 (1)
- Right: 0.01 ... 100 cm2 (1)
- Pilot control left: 0.01 ... 100 cm2 (1)
- Pilot control right: 0.01 ... 100 cm2 (1)

2/2-way stem-Actuated valve (ii)

If the cylinder piston actuates the stem, the flow from P to A is shut off. This valve is derived from a configurable 2/n way valve. You find this valve in the component library “Frequently used Way Valves”, under the [Library] menu.
Adjustable parameters

Desired position: 0 ... 4 (0)
Hydraulic resistance: 1e-6 ... 1000 bar.min²/l² (0.164)
Positioning time: 1e-4 ... 10 s (0.02)
Reset time: 1e-4 ... 10 s (0.03)
Minimum voltage: 0.1 ... 300 V (20)
Electrically left at U_min: 0.01 ... 100 N (70)
Electrically right at U_min: 0.01 ... 100 N (70)
Mechanically left: 0.01 ... 100 N (100)
Mechanically right: 0.01 ... 100 N (100)
Physical spring force: 0.01 ... 100 N (30)
Minimum force: 0.01 ... 100 N (20)
Min. pilot control force: 0.01 ... 100 N (15)
Left: 0.01 ... 100 cm² (1)
Right: 0.01 ... 100 cm² (1)
Pilot control left: 0.01 ... 100 cm² (1)
Pilot control right: 0.01 ... 100 cm² (1)

3/2-way hand-lever valve

In normal position the connection P is closed and A to T opened. When manually actuated T is shut off and P to A opened. This valve is derived from a configurable 3/n way valve. You find this valve in the component library “Frequently used Way Valves”, under the Library menu.

Adjustable parameters

Desired position: 0 ... 4 (0)
Hydraulic resistance: 1e-6 ... 1000 bar.min²/l² (0.164)
Positioning time: 1e-4 ... 10 s (0.02)
Reset time: 1e-4 ... 10 s (0.03)
Minimum voltage: 0.1 ... 300 V (20)
Electrically left at U_min: 0.01 ... 100 N (70)
Electrically right at U_min: 0.01 ... 100 N (70)
Mechanically left: 0.01 ... 100 N (100)
Mechanically right: 0.01 ... 100 N (100)
Physical spring force: 0.01 ... 100 N (30)
Minimum force: 0.01 ... 100 N (20)
Min. pilot control force: 0.01 ... 100 N (15)
Left: 0.01 ... 100 cm² (1)
Right: 0.01 ... 100 cm² (1)
Pilot control left: 0.01 ... 100 cm² (1)
Pilot control right: 0.01 ... 100 cm² (1)

4/2-way hand-lever valve (i)

In normal position the connection P is open to B and A to T. When manually actuated the valve is set to parallel position. This valve is derived from a configurable 4/2 way valve. You find this valve in the component library "Frequently used Way Valves", under the Library menu.

Adjustable parameters
Desired position: 0 ... 4 (0)
Hydraulic resistance: 1e-6 ... 1000 bar.min²/l² (0.164)
Positioning time: 1e-4 ... 10 s (0.02)
Reset time: 1e-4 ... 10 s (0.03)
Minimum voltage: 0.1 ... 300 V (20)
Electrically left at U_min: 0.01 ... 100 N (70)
Electrically right at U_min: 0.01 ... 100 N (70)
Mechanically left: 0.01 ... 100 N (100)
Mechanically right: 0.01 ... 100 N (100)
Physical spring force: 0.01 ... 100 N (30)
Minimum force: 0.01 ... 100 N (20)
Min. pilot control force: 0.01 ... 100 N (15)
Left: 0.01 ... 100 cm² (1)
Right: 0.01 ... 100 cm² (1)
Pilot control left: 0.01 ... 100 cm² (1)
Pilot control right: 0.01 ... 100 cm² (1)

4/2-way hand-lever valve (ii)

In normal position the connection P is open to A and B to T. When manually actuated the valve is set to crossover position. This valve is derived from a configurable 4/2 way valve. You find this valve in the component library "Frequently used Way Valves", under the Library menu.
Adjustable parameters

Desired position: 0 ... 4 (0)
Hydraulic resistance: 1e-6 ... 1000 bar.min²/l² (0.164)
Positioning time: 1e-4 ... 10 s (0.02)
Reset time: 1e-4 ... 10 s (0.03)
Minimum voltage: 0.1 ... 300 V (20)
Electrically left at U_min: 0.01 ... 100 N (70)
Electrically right at U_min: 0.01 ... 100 N (70)
Mechanically left: 0.01 ... 100 N (100)
Mechanically right: 0.01 ... 100 N (100)
Physical spring force: 0.01 ... 100 N (30)
Minimum force: 0.01 ... 100 N (20)
Min. pilot control force: 0.01 ... 100 N (15)
Left: 0.01 ... 100 cm² (1)
Right: 0.01 ... 100 cm² (1)
Pilot control left: 0.01 ... 100 cm² (1)
Pilot control right: 0.01 ... 100 cm² (1)

4/3-way hand-lever valve with shutoff position (i)

In normal position all connections are closed. When manually actuated the valve is set to parallel or crossover position. This valve is derived from a configurable 4/n way valve. You find this valve in the component library “Frequently used Way Valves”, under the Library menu.

Adjustable parameters

Desired position: 0 ... 4 (0)
Hydraulic resistance: 1e-6 ... 1000 bar.min²/l² (0.164)
Positioning time: 1e-4 ... 10 s (0.02)
Reset time: 1e-4 ... 10 s (0.03)
Minimum voltage: 0.1 ... 300 V (20)
Electrically left at U_min: 0.01 ... 100 N (70)
Electrically right at U_min: 0.01 ... 100 N (70)
Mechanically left: 0.01 ... 100 N (100)
Mechanically right: 0.01 ... 100 N (100)
Physical spring force: 0.01 ... 100 N (30)
Minimum force: 0.01 ... 100 N (20)
Min. pilot control force: 0.01 ... 100 N (15)
Left: 0.01 ... 100 cm² (1)
**4/3-way hand-lever valve with shutoff position (ii)**

In normal position all connections are closed. When manually actuated the valve is set to crossover or parallel position. This valve is derived from a configurable 4/n way valve. You find this valve in the component library “Frequently used Way Valves”, under the [Library](#) menu.

**Adjustable parameters**

- **Desired position:** 0 ... 4 (0)
- **Hydraulic resistance:** 1e-6 ... 1000 bar.min2/l2 (0.164)
- **Positioning time:** 1e-4 ... 10 s (0.02)
- **Reset time:** 1e-4 ... 10 s (0.03)
- **Minimum voltage:** 0.1 ... 300 V (20)
- **Electrically left at U_min:** 0.01 ... 100 N (70)
- **Electrically right at U_min:** 0.01 ... 100 N (70)
- **Mechanically left:** 0.01 ... 100 N (100)
- **Mechanically right:** 0.01 ... 100 N (100)
- **Physical spring force:** 0.01 ... 100 N (30)
- **Minimum force:** 0.01 ... 100 N (20)
- **Min. pilot control force:** 0.01 ... 100 N (15)
- **Left:** 0.01 ... 100 cm2 (1)
- **Right:** 0.01 ... 100 cm2 (1)
- **Pilot control left:** 0.01 ... 100 cm2 (1)
- **Pilot control right:** 0.01 ... 100 cm2 (1)

**4/3-way hand-lever valve with floating position (i)**

In normal position the connections A and B are open to T. When manually actuated the valve is set to parallel or crossover position. This valve is derived from a configurable 4/n way valve. You find this valve in the component library “Frequently used Way Valves”, under the [Library](#) menu.
**Adjustable parameters**

Desired position: 0 ... 4  (0)
Hydraulic resistance: 1e-6 ... 1000 bar.min²/l² (0.164)
Positioning time: 1e-4 ... 10 s (0.02)
Reset time: 1e-4 ... 10 s (0.03)
Minimum voltage: 0.1 ... 300 V (20)
Electrically left at U_min: 0.01 ... 100 N (70)
Electrically right at U_min: 0.01 ... 100 N (70)
Mechanically left: 0.01 ... 100 N (100)
Mechanically right: 0.01 ... 100 N (100)
Physical spring force: 0.01 ... 100 N (30)
Minimum force: 0.01 ... 100 N (20)
Min. pilot control force: 0.01 ... 100 N (15)
Left: 0.01 ... 100 cm² (1)
Right: 0.01 ... 100 cm² (1)
Pilot control left: 0.01 ... 100 cm² (1)
Pilot control right: 0.01 ... 100 cm² (1)

---

**4/3-way hand-lever valve with floating position (ii)**

In normal position the connections A and B are open to T. When manually actuated the valve is set to crossover or parallel position. This valve is derived from a configurable 4/n way valve. You find this valve in the component library “Frequently used Way Valves”, under the Library menu.

**Adjustable parameters**

Desired position: 0 ... 4  (0)
Hydraulic resistance: 1e-6 ... 1000 bar.min²/l² (0.164)
Positioning time: 1e-4 ... 10 s (0.02)
Reset time: 1e-4 ... 10 s (0.03)
Minimum voltage: 0.1 ... 300 V (20)
Electrically left at U_min: 0.01 ... 100 N (70)
Electrically right at U_min: 0.01 ... 100 N (70)
Mechanically left: 0.01 ... 100 N (100)
Mechanically right: 0.01 ... 100 N (100)
Physical spring force: 0.01 ... 100 N (30)
Minimum force: 0.01 ... 100 N (20)
Min. pilot control force: 0.01 ... 100 N (15)
Left: 0.01 ... 100 cm² (1)
4/3-way hand-lever valve with bypass position (i)

In normal position the connections A and B are closed and P to T opened. When manually actuated the valve is set to parallel or crossover position. This valve is derived from a configurable 4/n way valve. You find this valve in the component library “Frequently used Way Valves”, under the [Library] menu.

Adjustable parameters
Desired position: 0 ... 4 (0)
Hydraulic resistance: 1e-6 ... 1000 bar.min²/l² (0.164)
Positioning time: 1e-4 ... 10 s (0.02)
Reset time: 1e-4 ... 10 s (0.03)
Minimum voltage: 0.1 ... 300 V (20)
Electrically left at U_min: 0.01 ... 100 N (70)
Electrically right at U_min: 0.01 ... 100 N (70)
Mechanically left: 0.01 ... 100 N (100)
Mechanically right: 0.01 ... 100 N (100)
Physical spring force: 0.01 ... 100 N (30)
Minimum force: 0.01 ... 100 N (20)
Min. pilot control force: 0.01 ... 100 N (15)
Left: 0.01 ... 100 cm² (1)
Right: 0.01 ... 100 cm² (1)
Pilot control left: 0.01 ... 100 cm² (1)
Pilot control right: 0.01 ... 100 cm² (1)

4/3-way hand-lever valve with bypass position (ii)

In normal position the connections A and B are closed and P to T opened. When manually actuated the valve is set to crossover or parallel position. This valve is derived from a configurable 4/n way valve. You find this valve in the component library “Frequently used Way Valves”, under the [Library] menu.
20.1.4 Solenoid-actuated Directional Valves

4/2-way solenoid valve (i)

In normal position the connection P is open to B and A to T. When actuated by the control solenoid, the valve is set to parallel position. If no current is flowing through the control solenoid, the valve can be manually actuated. This valve is derived from a configurable 4/n way valve. You find this valve in the component library “Frequently used Way Valves”, under the Library menu.

Adjustable parameters

Desired position: 0 ... 4   (0)
Hydraulic resistance: 1e-6 ... 1000 bar.min2/l2  (0.164)
Positioning time: 1e-4 ... 10 s  (0.02)
Reset time: 1e-4 ... 10 s  (0.03)
Minimum voltage: 0.1 ... 300 V (20)
Electrically left at U_min: 0.01 ... 100 N (70)
Electrically right at U_min: 0.01 ... 100 N (70)
Mechanically left: 0.01 ... 100 N (100)
Mechanically right: 0.01 ... 100 N (100)
Physical spring force: 0.01 ... 100 N (30)
Minimum force: 0.01 ... 100 N (20)
Min. pilot control force: 0.01 ... 100 N (15)
Left: 0.01 ... 100 cm² (1)
Right: 0.01 ... 100 cm² (1)
Pilot control left: 0.01 ... 100 cm² (1)
Pilot control right: 0.01 ... 100 cm² (1)

4/2-way solenoid valve (ii)

In normal position the connection P is open to A and B to T. When actuated by the control solenoid, the valve is set to crossover position. If no current is flowing through the control solenoid, the valve can be manually actuated. This valve is derived from a configurable 4/n way valve. You find this valve in the component library “Frequently used Way Valves”, under the Library menu.

Adjustable parameters
Desired position: 0 ... 4 (0)
Hydraulic resistance: 1e-6 ... 1000 bar.min²/l² (0.164)
Positioning time: 1e-4 ... 10 s (0.02)
Reset time: 1e-4 ... 10 s (0.03)
Minimum voltage: 0.1 ... 300 V (20)
Electrically left at U_min: 0.01 ... 100 N (70)
Electrically right at U_min: 0.01 ... 100 N (70)
Mechanically left: 0.01 ... 100 N (100)
Mechanically right: 0.01 ... 100 N (100)
Physical spring force: 0.01 ... 100 N (30)
Minimum force: 0.01 ... 100 N (20)
Min. pilot control force: 0.01 ... 100 N (15)
Left: 0.01 ... 100 cm² (1)
Right: 0.01 ... 100 cm² (1)
Pilot control left: 0.01 ... 100 cm² (1)
Pilot control right: 0.01 ... 100 cm² (1)
4/3-way solenoid valve with shutoff position (i)

In normal position all connections are closed. When actuated by the control solenoids, the valve is set to parallel or crossover position. If no current is flowing through the control solenoids, the valve can be manually actuated. This valve is derived from a configurable 4/n way valve. You find this valve in the component library “Frequently used Way Valves”, under the Library menu.

Adjustable parameters

Desired position: 0 ... 4 (0)
Hydraulic resistance: 1e-6 ... 1000 bar.min2/l2 (0.164)
Positioning time: 1e-4 ... 10 s (0.02)
Reset time: 1e-4 ... 10 s (0.03)
Minimum voltage: 0.1 ... 300 V (20)
Electrically left at U_min: 0.01 ... 100 N (70)
Electrically right at U_min: 0.01 ... 100 N (70)
Mechanically left: 0.01 ... 100 N (100)
Mechanically right: 0.01 ... 100 N (100)
Physical spring force: 0.01 ... 100 N (30)
Minimum force: 0.01 ... 100 N (20)
Min. pilot control force: 0.01 ... 100 N (15)
Left: 0.01 ... 100 cm2 (1)
Right: 0.01 ... 100 cm2 (1)
Pilot control left: 0.01 ... 100 cm2 (1)
Pilot control right: 0.01 ... 100 cm2 (1)

4/3-way solenoid valve with shutoff position (ii)

In normal position all connections are closed. When actuated by the control solenoids, the valve is set to crossover or parallel position. If no current is flowing through the control solenoids, the valve can be manually actuated. This valve is derived from a configurable 4/n way valve. You find this valve in the component library “Frequently used Way Valves”, under the Library menu.

Adjustable parameters
Desired position: 0 ... 4 (0)
Hydraulic resistance: 1e-6 ... 1000 bar.min²/l² (0.164)
Positioning time: 1e-4 ... 10 s (0.02)
Reset time: 1e-4 ... 10 s (0.03)
Minimum voltage: 0.1 ... 300 V (20)
Electrically left at U_min: 0.01 ... 100 N (70)
Electrically right at U_min: 0.01 ... 100 N (70)
Mechanically left: 0.01 ... 100 N (100)
Mechanically right: 0.01 ... 100 N (100)
Physical spring force: 0.01 ... 100 N (30)
Minimum force: 0.01 ... 100 N (20)
Min. pilot control force: 0.01 ... 100 N (15)
Left: 0.01 ... 100 cm² (1)
Right: 0.01 ... 100 cm² (1)
Pilot control left: 0.01 ... 100 cm² (1)
Pilot control right: 0.01 ... 100 cm² (1)

4/3-way solenoid valve with floating position (i)

In normal position the connections A and B are open to T. When actuated by the control solenoids, the valve is set to parallel or crossover position. If no current is flowing through the control solenoids, the valve can be manually actuated. This valve is derived from a configurable 4/n way valve. You find this valve in the component library “Frequently used Way Valves”, under the Library menu.

Adjustable parameters
Desired position: 0 ... 4 (0)
Hydraulic resistance: 1e-6 ... 1000 bar.min²/l² (0.164)
Positioning time: 1e-4 ... 10 s (0.02)
Reset time: 1e-4 ... 10 s (0.03)
Minimum voltage: 0.1 ... 300 V (20)
Electrically left at U_min: 0.01 ... 100 N (70)
Electrically right at U_min: 0.01 ... 100 N (70)
Mechanically left: 0.01 ... 100 N (100)
Mechanically right: 0.01 ... 100 N (100)
Physical spring force: 0.01 ... 100 N (30)
Minimum force: 0.01 ... 100 N (20)
Min. pilot control force: 0.01 ... 100 N (15)
4/3-way solenoid valve with floating position (ii)

In normal position the connections A and B are open to T. When actuated by the control solenoids, the valve is set to crossover or parallel position. If no current is flowing through the control solenoids, the valve can be manually actuated. This valve is derived from a configurable 4/n way valve. You find this valve in the component library “Frequently used Way Valves”, under the Library menu.

Adjustable parameters

- Desired position: 0 ... 4  (0)
- Hydraulic resistance: 1e-6 ... 1000 bar.min²/l²  (0.164)
- Positioning time: 1e-4 ... 10 s  (0.02)
- Reset time: 1e-4 ... 10 s  (0.03)
- Minimum voltage: 0.1 ... 300 V  (20)
- Electrically left at U_min: 0.01 ... 100 N  (70)
- Electrically right at U_min: 0.01 ... 100 N  (70)
- Mechanically left: 0.01 ... 100 N  (100)
- Mechanically right: 0.01 ... 100 N  (100)
- Physical spring force: 0.01 ... 100 N  (30)
- Minimum force: 0.01 ... 100 N  (20)
- Min. pilot control force: 0.01 ... 100 N  (15)
- Left: 0.01 ... 100 cm²  (1)
- Right: 0.01 ... 100 cm²  (1)
- Pilot control left: 0.01 ... 100 cm²  (1)
- Pilot control right: 0.01 ... 100 cm²  (1)

4/3-way solenoid valve with bypass position (i)

In normal position the connections A and B are closed and P to T opened. When actuated by the control solenoids, the valve is set to
parallel or crossover position. If no current is flowing through the control solenoids, the valve can be manually actuated. This valve is derived from a configurable 4/n way valve. You find this valve in the component library “Frequently used Way Valves”, under the Library menu.

**Adjustable parameters**

- **Desired position:** 0 ... 4 (0)
- **Hydraulic resistance:** 1e-6 ... 1000 bar.min2/l2 (0.164)
- **Positioning time:** 1e-4 ... 10 s (0.02)
- **Reset time:** 1e-4 ... 10 s (0.03)
- **Minimum voltage:** 0.1 ... 300 V (20)
- **Electrically left at U_min:** 0.01 ... 100 N (70)
- **Electrically right at U_min:** 0.01 ... 100 N (70)
- **Mechanically left:** 0.01 ... 100 N (100)
- **Mechanically right:** 0.01 ... 100 N (100)
- **Physical spring force:** 0.01 ... 100 N (30)
- **Minimum force:** 0.01 ... 100 N (20)
- **Min. pilot control force:** 0.01 ... 100 N (15)
- **Left:** 0.01 ... 100 cm2 (1)
- **Right:** 0.01 ... 100 cm2 (1)
- **Pilot control left:** 0.01 ... 100 cm2 (1)
- **Pilot control right:** 0.01 ... 100 cm2 (1)

**4/3-way solenoid valve with bypass position (ii)**

In normal position the connections A and B are closed and P to T opened. When actuated by the control solenoids, the valve is set to crossover or parallel position. If no current is flowing through the control solenoids, the valve can be manually actuated. This valve is derived from a configurable 4/n way valve. You find this valve in the component library “Frequently used Way Valves”, under the Library menu.

**Adjustable parameters**

- **Desired position:** 0 ... 4 (0)
- **Hydraulic resistance:** 1e-6 ... 1000 bar.min2/l2 (0.164)
- **Positioning time:** 1e-4 ... 10 s (0.02)
- **Reset time:** 1e-4 ... 10 s (0.03)
- **Minimum voltage:** 0.1 ... 300 V (20)
20.1.5 Shutoff Valves

Shutoff valve

The shutoff valve can be manually opened or closed. The hydraulic resistance relates to the completely opened valve.

Adjustable parameters
Opening level: 0 ... 100 % (100)
Hydraulic resistance: 1e-6 ... 1000 bar.min2/l2 (0.1)

Check valve

If the inlet pressure at A is higher than the outlet pressure at B, then the check valve allows the flow to pass, otherwise it blocks the flow.

Adjustable parameters
Hydraulic resistance: $1 \times 10^{-6} \ldots 1000 \text{ bar.min}^2/\text{l}^2$ (0.09)

Check valve, spring loaded

If the inlet pressure at A is higher than the outlet pressure at B and the nominal pressure, then the check valve allows the flow to pass, otherwise it blocks the flow.

*Adjustable parameters*

Opening pressure: 0 ... 40 MPa (0.6)
Pressure regulation range: 0.01 ... 10 MPa (0.864)
Hydraulic resistance: $1 \times 10^{-6} \ldots 1000 \text{ bar.min}^2/\text{l}^2$ (0.09)

Check valve with pilot control

If the input pressure is higher than the output pressure, the check valve opens. Otherwise it is shut. In addition, the check valve can be opened via a control line, allowing flow in both directions.

*Adjustable parameters*

Area ratio: 0.1 ... 10 (3.3)
Hydraulic resistance: $1 \times 10^{-6} \ldots 1000 \text{ bar.min}^2/\text{l}^2$ (0.093)

Check valve with pilot control, spring loaded

If the input pressure is higher than the output and nominal pressure, the check valve opens. Otherwise it is shut. In addition, the check valve can be opened via a control line, allowing flow in both directions.

*Adjustable parameters*

Opening pressure: 0 ... 40 MPa (0.2)
Pressure regulation range: 0.01 ... 10 MPa (0.864)
**Double non-return valve, delockable**

The valve is made up of two delockable non-return valves.

*Adjustable parameters*

**Hydraulic resistance:** $10^{-6}$ ... $10^{3}$ bar.min$^2$/l$^2$ (0.093)

**Area ratio:** 0.1 ... 10 (3.3)

---

**Pilot to close check valve**

If the inlet pressure at A is higher than the outlet pressure at B, then the check valve allows the flow to pass, otherwise it blocks the flow. Additionally, the check valve can be closed using the pilot line X.

*Adjustable parameters*

**Area ratio:** 0.1 ... 10 (3.3)

**Hydraulic resistance:** $10^{-6}$ ... $10^{3}$ bar.min$^2$/l$^2$ (0.093)
Pilot to close check valve, spring loaded

If the inlet pressure at A is higher than the outlet pressure at B and the nominal pressure, then the check valve allows the flow to pass, otherwise it blocks the flow. Additionally, the check valve can be closed using the pilot line X.

*Adjustable parameters*
- **Opening pressure:** 0 ... 40 MPa  (0.2)
- **Pressure regulation range:** 0.01 ... 10 MPa  (0.864)
- **Area ratio:** 0.1 ... 10   (3.3)
- **Hydraulic resistance:** 1e-6 ... 1000 bar.min²/l²  (0.093)

Shuttle valve

If one of the two input pressures is larger than zero, the shuttle valve opens (OR function) and the higher input pressure becomes the output pressure.

*Adjustable parameters*
- **Hydraulic resistance:** 1e-6 ... 1000 bar.min²/l²  (0.09)

Two-pressure valve

If both input pressures are larger than zero, the two-pressure valve opens (AND function) and the higher input pressure becomes the output pressure.

*Adjustable parameters*
- **Hydraulic resistance:** 1e-6 ... 1000 bar.min²/l²  (0.09)
20.1.6 Pressure Control Valves

**Pressure relief valve**

In normal position the valve is closed. If the opening pressure is reached at P, T opens. When the pressure drops below the preset level, the valve closes again. The flow direction is indicated by the arrow. The hydraulic resistance relates to the completely opened valve.

*Adjustable parameters*

**Opening pressure:** 0 ... 40 MPa (3)

**Pressure regulation range:** 0.01 ... 10 MPa (3.8)

**Hydraulic resistance:** $10^{-6}$ ... 1000 bar.min$^2$/l$^2$ (0.17)

---

**Pressure relief valve**

The valve restricts the pressure at port P to the set value compared with the pressure at T.

If the differential pressure ($dp=p_P-p_T$) times the cross-sectional area of the sealing cone exceeds the spring force, the sealing cone lifts out of the seat and allows oil through to port T. The valve closes again once the pressure in port P drops again. The cushioning piston acts like a shock absorber to increase stability during the control response. The spring pretension can be adjusted at the handwheel. Oil flows through the non-return valve if the pressure at port T is greater than at P.

*Adjustable parameters*

**Opening pressure:** 0 ... 40 MPa (3)

**Pressure regulation range:** 0.01 ... 10 MPa (3.5)

**Hydraulic resistance (Pressure relief valve):** $10^{-6}$ ... 1000 bar.min$^2$/l$^2$ (0.08)

**Hydraulic resistance (Non-return valve):** $10^{-6}$ ... 1000 bar.min$^2$/l$^2$
Pressure regulator, balanced

The valve restricts the pressure at port P to the set value compared with the pressure at T.

If the hydraulic force at the sealing cone exceeds the spring force, the sealing cone lifts out of the seat and allows oil to flow to port T. The valve closes again once the pressure in port P drops again. The cushioning piston acts like a shock absorber to increase stability. The spring pretension can be adjusted at the hand wheel. Oil flows through the non-return valve when the pressure at port T is greater than at P. Since the spring chamber is separated from the oil by the stem, the pressure in T has no effect on the limiting pressure.

Adjustable parameters
Nominal pressure: 0 ... 40 MPa (3)
Pressure regulation range: 0.01 ... 10 MPa (3.5)
Hydraulic resistance (Pressure relief valve): 1e-6 ... 1000 bar.min²/l² (0.09)
Hydraulic resistance (Non-return valve): 1e-6 ... 1000 bar.min²/l² (0.7)

Counterbalance valve

The valve limits pressure at port P vis-à-vis pressure applied to T to the selected value.

Adjustable parameters
Opening pressure: 0 ... 40 MPa (3.0)
Pressure regulation range: 0.01 ... 10 MPa (1)
Hydraulic resistance (Pressure control valve): 1e-6 ... 1000 bar.min²/l² (0.1)
Area ratio: 0.1 ... 10 (3)
Hydraulic resistance (Non-return valve): 1e-6 ... 1000 bar.min²/l²
Pressure sequence valve

The valve connects port P and port T if the pressure at port X is greater than the total of the spring force and pressure in port T.

Adjustable parameters

- **Opening pressure**: 0 ... 40 MPa (3)
- **Pressure regulation range**: 0.01 ... 10 MPa (0.7)
- **Hydraulic resistance**: $1 \times 10^{-6} ... 1000$ bar.min$^2$/l$^2$ (0.1)

Shutoff/counteracting valve

If the opening pressure is reached at the control line connection, the valve opens from P to T. The hydraulic resistance relates to the completely opened valve.

Adjustable parameters

- **Opening pressure**: 0 ... 40 MPa (3)
- **Pressure regulation range**: 0.01 ... 10 MPa (0.7)
- **Hydraulic resistance**: $1 \times 10^{-6} ... 1000$ bar.min$^2$/l$^2$ (0.1)

Priority valve Load Sensing, dynamic

The priority valve assures that priority is given to outlet CF as opposed to outlet EF.

Adjustable parameters

- **Spring preload**: 0 ... 40 MPa (0.8)
- **Pressure regulation range**: 0.01 ... 10 MPa (0.24)
- **Hydraulic resistance (P-CF)**: $1 \times 10^{-6} ... 1000$ bar.min$^2$/l$^2$ (0.9)
- **Hydraulic resistance (P-EF)**: $1 \times 10^{-6} ... 1000$ bar.min$^2$/l$^2$ (0.9)
Hydraulic resistance (CF): $1 \times 10^{-6} \ldots 1000 \text{ bar.min}^2/\text{l}^2$ (10)

Hydraulic resistance (LS-EF): $1 \times 10^{-6} \ldots 1000 \text{ bar.min}^2/\text{l}^2$ (1450)

Pressure relief valve with pilot control

In normal position the valve is closed. If the opening pressure is reached at P, T opens. When the pressure drops below the preset level, the valve closes again. In simple terms, the pilot pressure is generated by the input pressure. The flow direction is indicated by the arrow. The pilot operated pressure relief valve consists of a pilot stage and a main stage. When open, there is less volumetric flow at the pilot stage that leads internally to connection T. The hydraulic resistance relates to the completely opened valve.

Adjustable parameters
- Opening pressure: $0 \ldots 40 \text{ MPa}$ (3.5)
- Pressure regulation range: $0.01 \ldots 10 \text{ MPa}$ (3.5)
- Hydraulic resistance: $1 \times 10^{-6} \ldots 1000 \text{ bar.min}^2/\text{l}^2$ (0.08)

Pressure relief valve with pilot control

The valve is closed in the idle position. The hydraulic fluid drains off at T, when the pressure difference at the connections P and T exceeds the nominal pressure. If the pressure falls below the preset value, the valve closes again. The flow direction is marked with an arrow. The pilot operated pressure relief valve consists of a pilot stage and a main stage. When open, there is less volumetric flow at the pilot stage that leads to connection Y. The hydraulic resistance relates to the completely opened valve.

Adjustable parameters
- Opening pressure: $0 \ldots 40 \text{ MPa}$ (3.5)
- Pressure regulation range: $0.01 \ldots 10 \text{ MPa}$ (3.5)
- Hydraulic resistance: $1 \times 10^{-6} \ldots 1000 \text{ bar.min}^2/\text{l}^2$ (0.08)
Shut-off-/counterbalancing valve

The valve connects port P with port T if the pressure set at control port X is exceeded.

The hydraulic resistance relates to the completely opened valve.

Adjustable parameters
Open pressure: 0 ... 40 MPa (3)
Pressure regulation range: 0.01 ... 10 MPa (0.7)
Hydraulic resistance: 1e-6 ... 1000 bar.min²/l² (0.1)

2-way pressure reducing valve

The pressure regulator valve regulates the pressure at connection A to the preset operating pressure and equalizes the pressure fluctuations. The valve closes when the pressure at connection A exceeds the operating pressure. The setting of the real components is component dependent and cannot be changed. The hydraulic resistance relates to the completely opened valve.

Adjustable parameters
Nominal pressure: 0 ... 40 MPa (1)
Pressure regulation range: 0.01 ... 10 MPa (0.2)
Hydraulic resistance: 1e-6 ... 1000 bar.min²/l² (0.1)

2-way pressure reducing valve, adjustable

The pressure regulator valve regulates the pressure at connection A to the preset operating pressure and equalizes the pressure fluctuations. The valve closes when the pressure at connection A exceeds the operating pressure.

Adjustable parameters
**Nominal pressure:** 0 ... 40 MPa (1)  
**Pressure regulation range:** 0.01 ... 10 MPa (0.2)  
**Hydraulic resistance:** 1e-6 ... 1000 bar.min²/l² (0.1)

### 3-way pressure reducing valve

The pressure reducing valve maintains a constant output pressure despite fluctuating input pressure. The hydraulic fluid is drained off at T when the pressure at connection A exceeds the operating pressure. The hydraulic resistance relates to the completely opened valve.

**Adjustable parameters**  
**Nominal pressure:** 0 ... 40 MPa (3)  
**Pressure regulation range:** 0.01 ... 10 MPa (1.9)  
**Hydraulic resistance:** 1e-6 ... 1000 bar.min²/l² (0.1)

### Pressure compensator, upstream

The pressure compensator maintains the differential pressure between port A und port X.

If, for example, a throttle point is located between A and X, pressure is held constant over the throttle point. This corresponds to the function of a 2-way flow control valve.

**Adjustable parameters**  
**Opening pressure:** 0 ... 40 MPa (0.4)  
**Pressure regulation range:** 0.01 ... 10 MPa (0.15)  
**Hydraulic resistance:** 1e-6 ... 1000 bar.min²/l² (0.06)
Pressure compensator, upstream

The pressure compensator maintains the differential pressure between port A and port X.

If, for example, a throttle point is located between A and X, pressure is held constant over the throttle point. This corresponds to the function of a 2-way flow control valve.

Adjustable parameters

Opening pressure: 0 ... 40 MPa (0.4)
Pressure regulation range: 0.01 ... 10 MPa (0.15)
Hydraulic resistance: 1e-6 ... 1000 bar.min²/l² (0.06)

Pressure compensator, downstream

The valve is used as a downstream pressure compensator for flow control in combination with a pump controlled by means of load sensing (variable volume LS pump).

Adjustable parameters

Opening pressure: 0 ... 40 MPa (0.02)
Pressure regulation range: 0.01 ... 10 MPa (0.018)
Hydraulic resistance: 1e-6 ... 1000 bar.min²/l² (0.058)
Hydraulic resistance: $1e^{-6} \ldots 1000 \text{ bar.min}^2/\text{l}$ (0.058)

Pressure compensator for open centre load sensing

P $\rightarrow$ T, $p_X = 0 \text{ MPa}$: Pressure at P pushes the piston against the spring. As of adjusted pressure, the valve opens: P $\rightarrow$ T, P $\rightarrow$ T, $p_X > 0 \text{ MPa}$: Pressure at X is added to spring force. The valve opens as soon as opening pressure plus spring pressure is greater than $p_X$.

Adjustable parameters
Opening pressure: 0 ... 40 MPa (0.4)
Pressure regulation range: 0.01 ... 10 MPa (0.15)
Hydraulic resistance: $1e^{-6} \ldots 1000 \text{ bar.min}^2/\text{l}$ (0.058)

Pressure compensator for open centre load sensing

P $\rightarrow$ T, $p_X = 0 \text{ MPa}$: Pressure at P pushes the piston against the spring. As of adjusted pressure, the valve opens: P $\rightarrow$ T, P $\rightarrow$ T, $p_X > 0 \text{ MPa}$: Pressure at X is added to spring force. The valve opens as soon as opening pressure is greater than $p_X$.

Adjustable parameters
Opening pressure: 0 ... 40 MPa (0.4)
Pressure regulation range: 0.01 ... 10 MPa (0.15)
Hydraulic resistance: $1e^{-6} \ldots 1000 \text{ bar.min}^2/\text{l}$ (0.058)

Pilot valves, 2x2-channel

2-channel hydraulic pilot control is used. Each channel consists of two pressure regulators. Depending on direction, the hand lever actuates one of the two pressure regulators via a rocker. Pressure is then regulated at the respective pilot port proportional to deflection.
Adjustable parameters

**Maximum pressure:** 0 ... 40 MPa (1.5)
**Displacement (Left group):** -100 ... 100 % (0)
**Displacement (Right group):** -100 ... 100 % (0)

Shock and anti-cavitation valve

The valve limits pressure from port A or B vis-à-vis pressure applied to T to the selected value.

Adjustable parameters

**Opening pressure (Left group):** 0 ... 40 MPa (3)
**Pressure regulation range (Left group):** 0.01 ... 10 MPa (3.8)
**Hydraulic resistance (Left group):** 1e-6 ... 1000 bar.min²/l² (0.08)

**Opening pressure (Right group):** 0 ... 40 MPa (3)
**Pressure regulation range (Right group):** 0.01 ... 10 MPa (3.8)
**Hydraulic resistance (Right group):** 1e-6 ... 1000 bar.min²/l² (0.08)

Closing pressure compensator

The pressure compensator represents a pressure dependent hydraulic resistance. The pressure compensator closes when the pressure difference X-Y exceeds the nominal pressure. A pressure regulating valve is implemented by the combination of connections A and X. The pressure balance is also a component of 2-way flow control valves. The nominal pressure setting of the real components is component dependent and cannot be changed. The hydraulic resistance relates to the completely opened valve.

Adjustable parameters

**Nominal pressure:** 0 ... 40 MPa (1)
**Pressure regulation range:** 0.01 ... 10 MPa (0.2)
**Hydraulic resistance:** 1e-6 ... 1000 bar.min²/l² (0.1)
Closing pressure compensator, adjustable

The pressure compensator represents a pressure dependent hydraulic resistance. The pressure compensator closes when the pressure difference X-Y exceeds the nominal pressure. A pressure regulating valve is implemented by the combination of the connections A and X. The hydraulic resistance relates to the completely opened valve.

Adjustable parameters
Nominal pressure: 0 ... 40 MPa (1)
Pressure regulation range: 0.01 ... 10 MPa (0.2)
Hydraulic resistance: 1e-6 ... 1000 bar.min^2/l^2 (0.1)

Opening pressure compensator

The pressure compensator represents a pressure dependent hydraulic resistance. The pressure compensator opens when the pressure difference X-Y exceeds the nominal pressure. A pressure relief valve is implemented by the combination of connections P and X. The pressure balance is also a component of 3-way flow control valves. The nominal pressure setting of the real components is component dependent and cannot be changed. The hydraulic resistance relates to the completely opened valve.

Adjustable parameters
Nominal pressure: 0 ... 40 MPa (1)
Pressure regulation range: 0.01 ... 10 MPa (0.2)
Hydraulic resistance: 1e-6 ... 1000 bar.min^2/l^2 (0.1)
relief valve is implemented by the combination of connections P and X. The hydraulic resistance relates to the completely opened valve.

Adjustable parameters
Nominal pressure: 0 ... 40 MPa (1)
Pressure regulation range: 0.01 ... 10 MPa (0.2)
Hydraulic resistance: 1e-6 ... 1000 bar.min²/l² (0.1)

Opening cartridge valve

The 2/2-way cartridge valve is a 2/2-way valve. It is fitted with two working ports and the two switch positions “closed” and “open”. Whether or not the cartridge valve is open or closed depends on the effective areas A, B and X, the adjacent pressures pA, pB and pX, as well as the spring force. A+B=X is valid. If pA*A + pB*B > pX*X + F, then the valve opens, otherwise it is closed. The valve therefore operates purely pressure dependent and can, with the appropriate control, assume directional-, flow- and pressure functions. The spring force is specified by means of the nominal pressure. This is the minimum pressure, with pressureless connections at B and X, necessary at connection A to open the valve. Whether the valve has one (A=B) or two (A ⊕ B) effective areas can be specified in the properties window. The relevant symbol is automatically depicted. The hydraulic resistance relates to the completely opened valve.

Adjustable parameters
Opening pressure: 0 ... 40 MPa (0.5)
Area A: 0.1 ... 100 cm² (6)
Area B: 0.1 ... 100 cm² (3)
Pressure regulation range: 0.01 ... 10 MPa (0.05)
Hydraulic resistance: 1e-6 ... 1000 bar.min²/l² (0.01)
Closing cartridge valve

The 2/2-way cartridge valve is a 2/2-way valve. It is fitted with two working ports and the two switch positions “closed” and “open”. Whether or not the cartridge valve is open or closed depends on the effective areas A and X, the adjacent pressures pA, and pX, as well as the spring force. A=X is valid. If pA*A > pX*X + F, then the valve closes, otherwise it is open. The valve therefore operates purely pressure dependent and can, with the appropriate control, assume directional-, flow- and pressure functions. The spring force is specified by means of the nominal pressure. This is the minimum pressure, with pressureless connections at B and X, necessary at connection A to open the valve. The hydraulic resistance relates to the completely opened valve.

Adjustable parameters
Opening pressure: 0 ... 40 MPa (0.5)
Area: 0.1 ... 100 cm² (6)
Pressure regulation range: 0.01 ... 10 MPa (0.05)
Hydraulic resistance: 1e-6 ... 1000 bar.min²/l² (0.01)

20.1.7 Pressure Switches

Analog pressure sensor

The pressure switch takes the pressure and actuates the associated electrical pressure switch if the preset switching pressure is exceeded.

Adjustable parameters
20.1.8 Flow Control Valves

**Nozzle**

The nozzle represents a hydraulic resistance.

*Adjustable parameters*

**Hydraulic resistance:** 1e-6 ... 1000 bar.min²/l²  (0.19)

**Throttle valve**

The setting of the throttle valve is set by means of a rotary knob. Please note that by the rotary knob no *absolute* resistance value can be set. This means that, in reality, different throttle valves can generate different resistance values despite identical settings.

*Adjustable parameters*

**Opening level:** 0 ... 100 %  (100)

**Hydraulic resistance:** 1e-6 ... 1000 bar.min²/l²  (0.19)

**Orifice**

The orifice represents a hydraulic resistance.
**Adjustable parameters**

*Hydraulic resistance:* \(10^{-6} \ldots 1000 \text{ bar.min}^2/\text{l}^2\) (0.19)

---

**Orifice, adjustable**

The orifice represents a variable hydraulic resistance.

**Adjustable parameters**

*Opening level:* 0 ... 100 % (100)
*Hydraulic resistance:* \(10^{-6} \ldots 1000 \text{ bar.min}^2/\text{l}^2\) (0.19)

---

**One-way flow control valve**

The setting of the One-way flow control valve is set by means of a rotary knob. A check valve (see check valve) is located parallel to the throttle valve. Please note that by the rotary knob no *absolute* resistance value can be set. This means that, in reality, different throttle valves can generate different resistance values despite identical settings.

**Adjustable parameters**

*Opening level:* 0 ... 100 % (100)
*Hydraulic resistance (Flow control valve):* \(10^{-6} \ldots 1000 \text{ bar.min}^2/\text{l}^2\) (0.07)
*Hydraulic resistance (Non-return valve):* \(10^{-6} \ldots 1000 \text{ bar.min}^2/\text{l}^2\) (0.05)

---

**2-way flow control valve**

If the pressure is sufficient, the preset flow is maintained to a constant level in the direction of the arrow. The hydraulic resistance relates to the completely opened valve.
Adjustable parameters

Nominal flow: 0 ... 500 l/min (1)
Spring preload: 0 ... 10 MPa (0.6)
Pressure regulation range: 0.01 ... 10 MPa (0.05)
Hydraulic resistance: 1e-6 ... 1000 bar.min^2/l^2 (0.3)

2-way flow control valve

If the pressure is sufficient, the preset flow is maintained to a constant level in the direction of the arrow. The hydraulic resistance relates to the completely opened valve.

Adjustable parameters

Nominal flow: 0 ... 500 l/min (1)
Spring preload: 0 ... 10 MPa (0.45)
Pressure regulation range: 0.01 ... 10 MPa (0.05)
Hydraulic resistance (Flow control valve): 1e-6 ... 1000 bar.min^2/l^2 (0.4)
Hydraulic resistance (Non-return valve): 1e-6 ... 1000 bar.min^2/l^2 (0.08)

3-way flow control valve

With sufficient pressure, the preset flow rate is kept constant in the direction of the arrow. The surplus hydraulic fluid is drained at connection T using a pressure compensator. The inlet pressure pA is load dependent, i.e. it changes with the outlet pressure pB. Therefore a parallel circuit of several 3-way flow control valves is not possible. In this case, the inlet pressures would be defined by the valve with the lowest inlet pressure. Compared to the 2-way flow control valve, the 3-way flow control valve is admittedly more efficient in its energy consumption. The hydraulic resistance relates to the completely closed pressure compensator.

Adjustable parameters

Nominal flow: 0 ... 500 l/min (1)
Spring preload: 0 ... 10 MPa (0.5)
Pressure regulation range: 0.01 ... 10 MPa (0.05)
Hydraulic resistance: 1e-6 ... 1000 bar.min²/l² (0.4)

Flow divider valve

The flow divider valve divides the flow from P into two equal flows at A and B. This is achieved using two measuring orifices and two variable control resistors. The control resistors are unified in a pressure compensator. The hydraulic resistance relates to the resistance of the individual measuring orifices and control resistors.

Adjustable parameters

Hydraulic resistance (Pressure compensator): 1e-6 ... 1000 bar.min²/l² (0.375)
Hydraulic resistance (Metering orifice): 1e-6 ... 1000 bar.min²/l² (0.537)

Flush valve with pressure relief valve

If differential pressure exceeds the required force for the spring, the valve opens from B to the pressure-relief valve.

The pressure-relief valve assures that pressure on the suction side does not drop to below the required minimum pressure for the pump.

Adjustable parameters

Spring preload: 0 ... 40 MPa (0.25)
Hydraulic resistance (Directional valve): 1e-6 ... 1000 bar.min²/l² (0.08)
Opening pressure: 0 ... 40 MPa (0.5)
Hydraulic resistance (Pressure control valve): 1e-6 ... 1000 bar.min²/l² (0.08)
20.1.9 Continuous valves

4/3-way regulating valve

The regulating valve transforms an analog electrical input signal into corresponding opening cross-sections at the outputs. The setpoint signal must be within the range -10 V to +10 V. At 0 V the hydraulic mid-position is adopted and the valve stops the flow (in relation to the null overlap). The cross section area of the flow opening widens with increasing slide distance. How far the area, and with it the flow at the valve, changes depends on the shape and form of the control notches. A triangular shaped notch results in a progressive flow behavior, a rectangular shaped notch in a linear flow behavior. The hydraulic resistance relates to a completely opened leading edge and the internal leakage relates to one leading edge as appropriate. The overlap of the leading edges can be specified relative to the maximal slide distance. By the use of an integrated electronic position controller for the slide distance, beneficial static and dynamic characteristics are achieved that are manifested in a minimal hysteresis (less than 0.2 %) and a response time of less than 12 ms at a signal change of 0 - 100

Adjustable parameters

Control notch shape: Rectangular, Triangular  (Rectangular)
Relative spool overlap:  -50 ... 50 %  (0)
Hydraulic resistance:  1e-6 ... 1000 bar.min2/l2  (1.4)
Leakage:  0 ... 10 l/(min.bar)  (0.00026)

4/3-way proportional valve

By use of a twin-channel proportional amplifier, the proportional valve transforms an analog electrical input signal into corresponding opening cross-sections at the outputs. The setpoint signal must be within the range -10 V to +10 V. At 0 V the hydraulic mid-position is adopted and the valve stops the flow (in relation to the null overlap). The cross section area of the flow opening widens by
increasing slide distance. How far the area, and with it the flow at the valve, changes depends on the shape and form of the control notches. A triangular shaped notch results in a progressive flow behavior, a rectangular shaped notch in a linear flow behavior. The hydraulic resistance relates to a completely opened leading edge and the internal leakage relates to one leading edge as appropriate. The overlap of the leading edges can be specified relative to the maximal slide distance.

Adjustable parameters
Control notch shape: Rectangular, Triangular (Triangular)
Relative spool overlap: -50 ... 50 % (25)
Hydraulic resistance: 1e-6 ... 1000 bar.min2/l2 (3.2)
Leakage: 0 ... 10 l/(min.bar) (0.001)

Proportional throttle valve

In order to alter the flow rate through the valve, the cross section of the throttle valve is electrically manipulated with the assistance of a proportional amplifier. The control voltage must be between 0 V and 10 V. The deflection of the slide is proportional to the applied voltage. At 0 V the valve is completely closed (in relation to the null overlap). The hydraulic resistance relates to the completely opened valve. The overlap of the leading edges can be specified relative to the maximal slide distance.

Adjustable parameters
Control notch shape: Rectangular, Triangular (Triangular)
Relative spool overlap: -50 ... 50 % (0)
Hydraulic resistance: 1e-6 ... 1000 bar.min2/l2 (0.1)
Leakage: 0 ... 10 l/(min.bar) (0)

Proportional pressure relief valve

The proportional pressure relief valve, with the assistance of a proportional amplifier, is a continuous, electrically adjustable pressure relief valve. The control piston has two adjacent areas
exposed to pressure. The first area is exposed to the pressure at connection P, the other to connection T. If the magnet is not supplied with electricity, then the piston is fully retracted and the complete passage from connection P to connection T is free. The proportional magnet creates a force proportional to its magnetic current, which moves the control piston according to the balance of the adjacent forces (magnetic force, spring force and pressures). The control voltage must be in the range 0 V to 10 V. The minimum nominal pressure defines the opening pressure through the spring force at 0 V. The maximum nominal pressure defines the opening pressure at 10 V. The hydraulic resistance relates to the completely opened main stage leading edge.

Adjustable parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Min. Opening pressure</td>
<td>0 ... 40 MPa</td>
</tr>
<tr>
<td>Max. Opening pressure</td>
<td>0 ... 40 MPa</td>
</tr>
<tr>
<td>Pressure regulation range</td>
<td>0.01 ... 10 MPa</td>
</tr>
<tr>
<td>Hydraulic resistance</td>
<td>1e-6 ... 1000 bar.min²/l²</td>
</tr>
</tbody>
</table>

Proportional pressure relief valve, piloted

The pilot operated pressure relief valve consists of a pilot stage with poppet valve and a main stage with control slide valve. The pressure at connection P acts upon the pilot poppet via a drilling in the control slide valve. If the force of the proportional magnet is greater than the pressure exercised at connection P, then the pilot stage remains closed. A spring keeps the main stage poppet valve closed and the flow rate is null. If the force, that the pressure exercises, exceeds the closing force of the pilot poppet, then this opens. A lower flow rate develops from connection P to connection Y. The flow of fluid causes a pressure loss at the throttle valve inside the control slide valve. Thus the pressure at the spring side is lower than the pressure at connection P. Due to the pressure difference, the control slide valve opens so far until the spring force re-establishes an equilibrium of forces and the valve is perfused from P to T. The control voltage must be between 0 V and 10 V. The minimum nominal pressure defines the opening pressure at the pilot stage via the spring force at 0 V. The maximum nominal pressure defines the opening pressure at 10 V. The hydraulic resistance relates to the completely opened main stage leading edge.
**Adjustable parameters**

**Min. Opening pressure:** 0 ... 40 MPa (0)

**Max. Opening pressure:** 0 ... 40 MPa (10)

**Pressure regulation range:** 0.01 ... 10 MPa (2)

**Hydraulic resistance:** $1e^{-6} ... 1000 \text{ bar.min}^2/l^2$ (0.05)

---

**Proportional pressure reducing valve, piloted**

The pilot operated proportional pressure regulator valve consists of a pilot stage with poppet valve and a main stage with control slide valve. The pressure at connection A acts upon the pilot poppet via a drilling in the control slide valve. The proportional magnet exercises the electrically adjustable counter force with the assistance of a proportional amplifier. If the pressure at connection A is below the preset value, then the pilot control remains closed. The pressure on both sides of the control slide valve is equal. A spring holds the main stage control slide valve open and the hydraulic fluid flow freely from connection P to connection A. If the pressure at connection A exceeds the preset value, then the pilot stage opens causing less volumetric flow to flow to connection A. The pressure falls at the throttle valve inside the control slide valve. Thus the pressure at the spring side is lower than the pressure at connection A. Due to the pressure difference, the control slide valve closes so far until the spring force re-establishes an equilibrium of forces. As a result, the flow resistance at the control edge between connections P and A increases and the pressure at connection A sinks. The control voltage must be between 0 V and 10 V. The minimum nominal pressure defines the opening pressure at the pre stage via the spring force at 0 V. The maximum nominal pressure defines the opening pressure at 10 V. The hydraulic resistance relates to the completely opened main stage leading edge.

**Adjustable parameters**

**Min. Nominal pressure:** 0 ... 40 MPa (0)

**Max. Nominal pressure:** 0 ... 40 MPa (3)

**Pressure regulation range:** 0.01 ... 10 MPa (0.1)

**Hydraulic resistance:** $1e^{-6} ... 1000 \text{ bar.min}^2/l^2$ (0.05)
**6/3-way proportional hand lever valve**

The valve is used to control volumetric flow. Flow rate and direction of flow are controlled. The mid-position is spring centred. The piston is pushed out of its mid-position and against the spring with the hand lever.

*Adjustable parameters*
- **Displacement:** -100 ... 100 % (0)
- **Hydraulic resistance (P1→T1):** 1e-6 ... 1000 bar.min²/l² (0.045)
- **Hydraulic resistance (P2→A,B):** 1e-6 ... 1000 bar.min²/l² (0.051)
- **Hydraulic resistance (T2→A,B):** 1e-6 ... 1000 bar.min²/l² (0.0362)
- **Leakage:** 0 ... 10 l/(min.bar) (5E-06)

**Mobile valve block, Load sensing**

The valve block has two slices, each with a proportional directional control valve for controlling speed and direction. The directional control valve in each slice has an upstream pressure compensator. As a result, the slice functions like a proportional current regulator.

*Adjustable parameters*
- **Displacement (Left group):** -100 ... 100 % (0)
- **Displacement (Right group):** -100 ... 100 % (0)
20.1.10 Actuators

Configurable cylinder

The configurable cylinder can be customized via its properties dialog. Almost any combination of piston type (single-acting, double-acting), the specification of the piston rods (double ended, with magnetic coupling or slide) and the number (none, one, two) is possible. An end position cushioning (without, with, adjustable) can also be defined. FluidSIM automatically adjusts the symbol according to the preset configuration. In addition, a load to be moved (including possible static and sliding friction) and a variable force profile can be defined in the properties dialog. In the component library from FluidSIM there are several pre-configured cylinders that can be inserted in your circuit and directly used. Should no suitable symbol be available, then simply choose the component with the most similarity to the required component, open the properties dialog and adjust the configuration accordingly.

Adjustable parameters
Piston diameter: 1 ... 1000 mm (16)
Piston rod diameter: 0 ... 1000 mm (10)
Piston Position: 0 ... 5000 mm (0)
Maximum stroke: 1 ... 5000 mm (200)
Mounting angle: 0 ... 360 deg (0)
Parameter input: Calculate automatically, Enter manually (Calculate automatically)
Break-away force: 0 ... 10000 N (65)
Coulomb friction force: 0 ... 10000 N (55)
Viscous friction: 0.1 ... 10000 N.s/m (215)
Parameter input: Calculate automatically, Enter manually (Calculate automatically)
Moving mass: 0.01 ... 1000 kg (0.3)
Leakage: 0 ... 10 l/(min.bar) (0)
Spring pressure at x=0: 0 ... 40 MPa (0.4)
Spring pressure at x=x_max: 0 ... 40 MPa (1)
Damping length: 0 ... 100 mm (10)
Double acting cylinder

Double acting cylinder with piston rod on one side. The piston of the cylinder contains a permanent solenoid which can be used to operate a proximity switch.

Adjustable parameters
Piston diameter: 1 ... 1000 mm (16)
Piston rod diameter: 0 ... 1000 mm (10)
Piston Position: 0 ... 5000 mm (0)
Maximum stroke: 1 ... 5000 mm (200)
Mounting angle: 0 ... 360 deg (0)
Parameter input: Calculate automatically, Enter manually (Calculate automatically)
Break-away force: 0 ... 10000 N (65)
Coulomb friction force: 0 ... 10000 N (55)
Viscous friction: 0.1 ... 10000 N.s/m (215)
Parameter input: Calculate automatically, Enter manually (Calculate automatically)
Moving mass: 0.01 ... 1000 kg (0.3)
Leakage: 0 ... 10 l/(min.bar) (0)
Spring pressure at x=0: 0 ... 40 MPa (0.4)
Spring pressure at x=x_max: 0 ... 40 MPa (1)
Damping length: 0 ... 100 mm (10)

Double acting cylinder with shock adsorber at stroke end

The piston of the cylinder is controlled by the connected pressure loads. The shock adsorber can be adjusted by means of two adjustment screws. The piston contains a permanent solenoid which can be used to operate a proximity switch.

Adjustable parameters
Piston diameter: 1 ... 1000 mm (16)
Piston rod diameter: 0 ... 1000 mm (10)
Piston Position: 0 ... 5000 mm (0)
Maximum stroke: 1 ... 5000 mm (200)
Mounting angle: 0 ... 360 deg (0)
Double acting cylinder with in and out piston rod and shock absorber at stroke end

The piston of the cylinder is controlled by the connected pressure loads. The shock absorber can be adjusted by means of two adjustment screws. The piston of the cylinder contains a permanent solenoid which can be used to operate a proximity switch.

Adjustable parameters
Piston diameter: 1 ... 1000 mm (16)
Piston rod diameter: 0 ... 1000 mm (10)
Piston Position: 0 ... 5000 mm (0)
Maximum stroke: 1 ... 5000 mm (200)
Mounting angle: 0 ... 360 deg (0)
Parameter input: Calculate automatically, Enter manually (Calculate automatically)
Break-away force: 0 ... 10000 N (65)
Coulomb friction force: 0 ... 10000 N (55)
Viscous friction: 0.1 ... 10000 N.s/m (215)
Parameter input: Calculate automatically, Enter manually (Calculate automatically)
Moving mass: 0.01 ... 1000 kg (0.3)
Leakage: 0 ... 10 l/(min.bar) (0)
Spring pressure at x=0: 0 ... 40 MPa (0.4)
Spring pressure at x=x_max: 0 ... 40 MPa (1)
Damping length: 0 ... 100 mm (10)
Single acting cylinder

By connecting a sufficiently high pressure load, the piston of the cylinder is extended to its stop. To move the piston back, an external force must be applied.

*Adjustable parameters*

**Piston diameter:** 1 ... 1000 mm (16)
**Piston rod diameter:** 0 ... 1000 mm (10)
**Piston Position:** 0 ... 5000 mm (0)
**Maximum stroke:** 1 ... 5000 mm (200)
**Mounting angle:** 0 ... 360 deg (0)
**Parameter input:** Calculate automatically, Enter manually (Calculate automatically)
**Break-away force:** 0 ... 10000 N (65)
**Coulomb friction force:** 0 ... 10000 N (55)
**Viscous friction:** 0.1 ... 10000 N.s/m (215)
**Parameter input:** Calculate automatically, Enter manually (Calculate automatically)
**Moving mass:** 0.01 ... 1000 kg (0.3)
**Leakage:** 0 ... 10 l/(min.bar) (0)
**Spring pressure at x=0:** 0 ... 40 MPa (0.4)
**Spring pressure at x=x_max:** 0 ... 40 MPa (1)
**Damping length:** 0 ... 100 mm (10)

Loading unit/cylinder load simulator

Two cylinders are positioned opposite each other. Various cylinder types and loads can be combined using the four piston surfaces.

*Adjustable parameters*

**Piston diameter:** 1 ... 1000 mm (16)
**Piston rod diameter:** 1 ... 1000 mm (10)
**Piston Position:** 0 ... 5000 mm (0)
**Maximum stroke:** 1 ... 10000 mm (200)
**Mounting angle:** 0 ... 360 deg (0)
**Moving mass:** 0.01 ... 1000 kg (0.6)
**Opening pressure:** 0 ... 40 MPa (12)
Break-away force: 0 ... 10000 N (65)
Coulomb friction force: 0 ... 10000 N (55)
Viscous friction: 0.1 ... 10000 N.s/m (215)

Loading unit/cylinder load simulator

Two cylinders are positioned opposite each other. Various cylinder types and loads can be combined using the four piston surfaces.

Adjustable parameters
Piston diameter: 1 ... 1000 mm (16)
Piston rod diameter: 1 ... 1000 mm (10)
Piston Position: 0 ... 5000 mm (0)
Maximum stroke: 1 ... 10000 mm (200)
Mounting angle: 0 ... 360 deg (0)
Moving mass: 0.01 ... 1000 kg (0.6)
Break-away force: 0 ... 10000 N (65)
Coulomb friction force: 0 ... 10000 N (55)
Viscous friction: 0.1 ... 10000 N.s/m (215)

Hydraulic motor

The hydraulic motor transforms hydraulic energy into mechanical energy.

Adjustable parameters
External torque: -1000 ... 1000 N.m (0)
Displacement: 0.001 ... 5 l (0.008)
Friction: 0.001 ... 100 N.m.s/rad (0.0108)
Moment of inertia: 0.0001 ... 10 kg.m² (0.0001)
Leakage: 0 ... 10 l/(min.bar) (0.0126)
Semi-rotary actuator

The semi-rotary actuator is controlled by alternately switching the pressure. In the end positions the swivel cylinder can activate switches or valves via labels.

Adjustable parameters
Initial Position: 0 ... 360 deg (0)
Rotation angle (max): 1 ... 360 deg (180)
Displacement: 0.01 ... 1000 l (0.1)
Friction: 0.01 ... 100 N.m.s/rad (0.1)
Moment of inertia: 1e-005 ... 1 kg.m² (0.0001)
External torque: -1000 ... 1000 N.m (0)

20.1.11 Measuring Devices

Manometer

The manometer measures the pressure at its connection.

Differential pressure gauge

The differential pressure gauge displays the pressure difference between the adjacent pressures at the left and the right connection.
Pressure indicator

An optical signal is activated when the pressure at the connection to the pressure display exceeds the preset switching pressure.

*Adjustable parameters*

**Switching pressure:** 0.1 ... 40 MPa (3)

Pressure sensor, analog

This symbol represents the hydraulic part of the analog pressure sensor. The analog pressure sensor measures the adjacent pressure and transforms it into a proportional electrical voltage signal. In the process, only pressures in the specified pressure ranges are considered. Within this range, the pressure in the voltage range from 0 V to 10 V is represented, i.e. the minimum pressure delivers 0 V and the maximum pressure 10 V.

*Adjustable parameters*

**Minimum pressure:** -40 ... 40 MPa (0)
**Maximum pressure:** -40 ... 40 MPa (10)
**Voltage at p1:** -100 ... 100 V (0)
**Voltage at p2:** -100 ... 100 V (10)

Flow meter

The flow meter measures the flow rate. Either the current flow or the total quantity flowed can be displayed. The component image is automatically adjusted accordingly.

*Adjustable parameters*

**Hydraulic resistance:** 1e-6 ... 1000 bar.min2/l2 (0.001)
Flow meter

The flow meter consists of a hydraulic motor connected to an RPM gauge.

*Adjustable parameters*

- **Displacement**: 0.1 ... 5000 cm³ (8.2)
- **Friction**: 0.001 ... 100 N·m·s/rad (0.0108)
- **Moment of inertia**: 0.0001 ... 10 kg·m² (0.0001)
- **Leakage**: 0 ... 10 l/(min·bar) (0.0126)
- **Flow Direction**: Ignore, Consider (Ignore)
- **Flow rate (min)**: -500 ... 500 l/min (0)
- **Flow rate (max)**: -500 ... 500 l/min (10)
- **Voltage (q1)**: -100 ... 100 V (0)
- **Voltage (q2)**: -100 ... 100 V (10)

Flow meter, analog

This symbol represents the hydraulic part of the analog flow meter. The analog flow meter measures the volumetric flow and transforms it into a proportional electrical voltage signal. In the process, only flow rates in the specified pressure ranges are considered. Within this range, the flow rate in the voltage range from 0 V to 10 V is represented, i.e. the minimum volumetric flow delivers 0 V and the maximum volumetric flow 10 V.

*Adjustable parameters*

- **Flow Direction**: Ignore, Consider (Ignore)
- **Flow rate (min)**: -500 ... 500 l/min (0)
- **Flow rate (max)**: -500 ... 500 l/min (10)
- **Voltage (q1)**: -100 ... 100 V (0)
- **Voltage (q2)**: -100 ... 100 V (10)
- **Hydraulic resistance**: 1e-6 ... 1000 bar·min²/l² (0.001)
20.2 Pneumatic Components

20.2.1 Supply Elements

Compressed air supply

The compressed air supply provides the needed compressed air. It contains a pressure control valve that can be adjusted to output the desired operating pressure.

*Adjustable parameters*

- **Operating pressure**: 0 ... 2 MPa (0.6)
- **Max. flow rate**: 0 ... 5000 l/min (1000)
- **Volume**: 0.001 ... 1000 l (0.1)

Compressor

The compressor provides the necessary compressed air. The pressure is restricted to the preset operating pressure.

*Adjustable parameters*

- **Operating pressure**: 0 ... 2 MPa (0.6)
- **Max. flow rate**: 0 ... 5000 l/min (1000)
- **Volume**: 0.001 ... 1000 l (0.1)

Compressor, adjustable

The adjustable compressor provides the necessary compressed air, whereby the maximum flow rate can be adjusted under actual
operating conditions and in the simulation. The pressure is restricted to the preset operating pressure.

*Adjustable parameters*

**Operating pressure:** 0 ... 2 MPa (0.6)  
**Max. flow rate:** 0 ... 5000 l/min (1000)  
**Volume:** 0.001 ... 1000 l (0.1)

---

Air service unit, simplified representation

The service unit is made up of a compressed air filter with water separator and a pressure control valve.

*Adjustable parameters*

**Nominal pressure:** 0 ... 2 MPa (0.4)  
**Standard nominal flow rate (Pressure regulator):** 0.1 ... 5000 l/min (300)  
**Standard nominal flow rate (Filter):** 0.1 ... 5000 l/min (1000)

---

Air service unit

The service unit is made up of a compressed air filter with water separator and a pressure control valve.

*Adjustable parameters*

**Nominal pressure:** 0 ... 2 MPa (0.4)  
**Standard nominal flow rate (Pressure regulator):** 0.1 ... 5000 l/min (300)  
**Standard nominal flow rate (Filter):** 0.1 ... 5000 l/min (1000)
Start-up valve with filter control valve

The filter with water separator cleans the compressed air of dirt, pipe scale, rust and condensate. The pressure regulator adjusts the compressed air supplied to the set operating pressure and compensates for pressure fluctuations. The pressure gauge shows the preset pressure. The on/off valve exhausts the entire control.

Manifold

The manifold enables a control system to be supplied with compressed air eight individual connections.

Air pressure reservoir

The air pressure reservoir serves as compensation for pressure fluctuations and is utilized (as a reservoir) for abruptly occurring air consumption. Large time delays can be attained when used in conjunction with time delay- and throttle valves.

Adjustable parameters
Volume: 0.001 ... 1000 l (1)

Air pressure reservoir (2 Connections)

The air pressure reservoir serves as compensation for pressure fluctuations and is utilized (as a reservoir) for abruptly occurring air consumption. Large time delays can be attained when used in conjunction with time delay- und throttle valves.

Adjustable parameters
Volume: 0.001 ... 1000 l (1)
Filter

The compressed air filter removes contamination from the compressed air. The size of the filterable particles is dependent upon the filter class.

Adjustable parameters

Standard nominal flow rate: 0.1 ... 5000 l/min (1000)

Filter, manual condensate drain

The compressed air filter removes contamination from the compressed air. The size of the filterable particles is dependent upon the filter class. Condensation, which can occur through sinking temperatures or the expansion of the compressed air, can be manually drained off.

Adjustable parameters

Standard nominal flow rate: 0.1 ... 5000 l/min (1000)

Filter, automatic condensate drain

The compressed air filter removes contamination from the compressed air. The size of the filterable particles is dependent upon the filter class. Condensation, which can occur through sinking temperatures or the expansion of the compressed air, is automatically drained off.

Adjustable parameters

Standard nominal flow rate: 0.1 ... 5000 l/min (1000)
Water separator

The water separator drains off accrued water.

Adjustable parameters
Standard nominal flow rate: 0.1 ... 5000 l/min (1000)

Water separator, automatic condensate drain

The water separator drains off accrued water and is automatically emptied.

Adjustable parameters
Standard nominal flow rate: 0.1 ... 5000 l/min (1000)

Lubricator

The lubricator enriches the compressed air with oil.

Adjustable parameters
Standard nominal flow rate: 0.1 ... 5000 l/min (1000)

Cooler

The cooler cools the compressed air.

Adjustable parameters
Standard nominal flow rate: 0.1 ... 5000 l/min (1000)
Adsorption dryer

The adsorption dryer reduces the humidity in the compressed air.

Adjustable parameters

Standard nominal flow rate: 0.1 ... 5000 l/min (1000)

Connection (pneumatic)

A pneumatic connection is a place where a pneumatic line can be attached to. To simplify the line drawing process, a connection appears as a small circle in Edit Mode. Pneumatic connections can be shut by means of a blind plug. An open pneumatic connection may result in leaking air; FluidSIM-P thus pops up a warning message, if some pneumatic connection was left open. Note that at each pneumatic connection values for the flow and pressure can be displayed.

Line (pneumatic)

A pneumatic line links two pneumatic connections. Note that a pneumatic connection may be a simple pneumatic connection or a T-junction. A pneumatic line causes no pressure drop, i.e., it has no fluidic resistance. From a drawing point of view, FluidSIM distinguishes between control lines and main lines. The former is represented by a dashed line, the latter is represented by a solid line and establishes the default case.

T-junction (pneumatic)

A T-junction joins up to four pneumatic lines, thus having a single pressure potential. Note that T-junctions are introduced automati-
20.2.2 Configurable Way Valves

Configurable 2/n way valve

The configurable 2/n way valve is a way valve with two connections, where both its body elements operation modes are user-definable.

Additionally, the pneumatic connections can be closed with either blind plugs or exhausts.

Adjustable parameters
Desired position: 0 ... 4 (0)
Standard nominal flow rate: 0.1 ... 5000 l/min (60)
Positioning time: 1e-4 ... 10 s (0.02)
Reset time: 1e-4 ... 10 s (0.03)
Minimum voltage: 0.1 ... 300 V (20)
Electrically left at U_min: 0.01 ... 100 N (70)
Electrically right at U_min: 0.01 ... 100 N (70)
Mechanically left: 0.01 ... 100 N (100)
Mechanically right: 0.01 ... 100 N (100)
Physical spring force: 0.01 ... 100 N (30)
Minimum force: 0.01 ... 100 N (20)
Min. pilot control force: 0.01 ... 100 N (15)
Left: 0.01 ... 100 cm2 (1)
Right: 0.01 ... 100 cm2 (1)
Pilot control left: 0.01 ... 100 cm2 (1)
Pilot control right: 0.01 ... 100 cm2 (1)
air spring left: 0.01 ... 100 cm2 (0.5)
air spring right: 0.01 ... 100 cm2 (0.5)
Configurable 3/n way valve

The configurable 3/n way valve is a way valve with two connections, where both its body elements operation modes are user-definable.

Additionally, the pneumatic connections can be closed with either blind plugs or exhausts.

Adjustable parameters

- Desired position: 0 ... 4 (0)
- Standard nominal flow rate: 0.1 ... 5000 l/min (60)
- Positioning time: 1e-4 ... 10 s (0.02)
- Reset time: 1e-4 ... 10 s (0.03)
- Minimum voltage: 0.1 ... 300 V (20)
- Electrically left at U_min: 0.01 ... 100 N (70)
- Electrically right at U_min: 0.01 ... 100 N (70)
- Mechanically left: 0.01 ... 100 N (100)
- Mechanically right: 0.01 ... 100 N (100)
- Physical spring force: 0.01 ... 100 N (30)
- Minimum force: 0.01 ... 100 N (20)
- Min. pilot control force: 0.01 ... 100 N (15)
- Left: 0.01 ... 100 cm2 (1)
- Right: 0.01 ... 100 cm2 (1)
- Pilot control left: 0.01 ... 100 cm2 (1)
- Pilot control right: 0.01 ... 100 cm2 (1)
- air spring left: 0.01 ... 100 cm2 (0.5)
- air spring right: 0.01 ... 100 cm2 (0.5)

Configurable 4/n way valve

The configurable 4/n way valve is a way valve with two connections, where both its body elements operation modes are user-definable.

Additionally, the pneumatic connections can be closed with either blind plugs or exhausts.
Adjustable parameters

Desired position: 0 ... 4 (0)
Standard nominal flow rate: 0.1 ... 5000 l/min (60)
Positioning time: 1e-4 ... 10 s (0.02)
Reset time: 1e-4 ... 10 s (0.03)
Minimum voltage: 0.1 ... 300 V (20)
Electrically left at U_min: 0.01 ... 100 N (70)
Electrically right at U_min: 0.01 ... 100 N (70)
Mechanically left: 0.01 ... 100 N (100)
Mechanically right: 0.01 ... 100 N (100)
Physical spring force: 0.01 ... 100 N (30)
Minimum force: 0.01 ... 100 N (20)
Min. pilot control force: 0.01 ... 100 N (15)
Left: 0.01 ... 100 cm2 (1)
Right: 0.01 ... 100 cm2 (1)
Pilot control left: 0.01 ... 100 cm2 (1)
Pilot control right: 0.01 ... 100 cm2 (1)
air spring left: 0.01 ... 100 cm2 (0.5)
air spring right: 0.01 ... 100 cm2 (0.5)

Configurable 5/n way valve

The configurable 5/n way valve is a way valve with two connections, where both its body elements operation modes are user-definable.

Additionally, the pneumatic connections can be closed with either blind plugs or exhausts.

Adjustable parameters

Desired position: 0 ... 4 (0)
Standard nominal flow rate: 0.1 ... 5000 l/min (60)
Positioning time: 1e-4 ... 10 s (0.02)
Reset time: 1e-4 ... 10 s (0.03)
Minimum voltage: 0.1 ... 300 V (20)
Electrically left at U_min: 0.01 ... 100 N (70)
Electrically right at U_min: 0.01 ... 100 N (70)
Mechanically left: 0.01 ... 100 N (100)
Mechanically right: 0.01 ... 100 N (100)
Physical spring force: 0.01 ... 100 N (30)
**Configurable 6/n way valve**

The configurable 6/n way valve is a way valve with two connections, where both its body elements operation modes are user-definable.

Additionally, the pneumatic connections can be closed with either blind plugs or exhausts.

**Adjustable parameters**

- **Desired position**: 0 ... 4 (0)
- **Standard nominal flow rate**: 0.1 ... 5000 l/min (60)
- **Positioning time**: 1e-4 ... 10 s (0.02)
- **Reset time**: 1e-4 ... 10 s (0.03)
- **Minimum voltage**: 0.1 ... 300 V (20)
- **Electrically left at U_min**: 0.01 ... 100 N (70)
- **Electrically right at U_min**: 0.01 ... 100 N (70)
- **Mechanically left**: 0.01 ... 100 N (100)
- **Mechanically right**: 0.01 ... 100 N (100)
- **Physical spring force**: 0.01 ... 100 N (30)
- **Minimum force**: 0.01 ... 100 N (20)
- **Min. pilot control force**: 0.01 ... 100 N (15)
- **Left**: 0.01 ... 100 cm^2 (1)
- **Right**: 0.01 ... 100 cm^2 (1)
- **Pilot control left**: 0.01 ... 100 cm^2 (1)
- **Pilot control right**: 0.01 ... 100 cm^2 (1)
- **Air spring left**: 0.01 ... 100 cm^2 (0.5)
- **Air spring right**: 0.01 ... 100 cm^2 (0.5)
Configurable 8/n way valve

The configurable 8/n way valve is a way valve with two connections, where both its body elements operation modes are user-definable.

Additionally, the pneumatic connections can be closed with either blind plugs or exhausts.

Adjustable parameters

Desired position: 0 ... 4 (0)
Standard nominal flow rate: 0.1 ... 5000 l/min (60)
Positioning time: 1e-4 ... 10 s (0.02)
Reset time: 1e-4 ... 10 s (0.03)
Minimum voltage: 0.1 ... 300 V (20)
Electrically left at U_min: 0.01 ... 100 N (70)
Electrically right at U_min: 0.01 ... 100 N (70)
Mechanically left: 0.01 ... 100 N (100)
Mechanically right: 0.01 ... 100 N (100)
Physical spring force: 0.01 ... 100 N (30)
Minimum force: 0.01 ... 100 N (20)
Min. pilot control force: 0.01 ... 100 N (15)
Left: 0.01 ... 100 cm² (1)
Right: 0.01 ... 100 cm² (1)
Pilot control left: 0.01 ... 100 cm² (1)
Pilot control right: 0.01 ... 100 cm² (1)
air spring left: 0.01 ... 100 cm² (0.5)
air spring right: 0.01 ... 100 cm² (0.5)
20.2.3 Mechanically Operated Directional Valves

3/2-way roller lever valve, normally closed

The roller lever valve is operated by pressing on the lever, for example through the use of a switching cam of a cylinder. The flow passes through from 1 to 2. After releasing the lever, the valve returns to its initial position through the use of a return spring. Connection 1 is shut. In the Simulation Mode, the valve can be switched manually by clicking on the component, thus not requiring a cylinder to operate the valve. This valve is derived from a configurable 3/n way valve. You find this valve in the component library “Frequently used Way Valves”, under the Library menu.

Adjustable parameters

Desired position: 0 ... 4 (0)
Standard nominal flow rate: 0.1 ... 5000 l/min (60)
Positioning time: 1e-4 ... 10 s (0.02)
Reset time: 1e-4 ... 10 s (0.03)
Minimum voltage: 0.1 ... 300 V (20)
Electrically left at U_min: 0.01 ... 100 N (70)
Electrically right at U_min: 0.01 ... 100 N (70)
Mechanically left: 0.01 ... 100 N (100)
Mechanically right: 0.01 ... 100 N (100)
Physical spring force: 0.01 ... 100 N (30)
Minimum force: 0.01 ... 100 N (20)
Min. pilot control force: 0.01 ... 100 N (15)
Left: 0.01 ... 100 cm² (1)
Right: 0.01 ... 100 cm² (1)
Pilot control left: 0.01 ... 100 cm² (1)
Pilot control right: 0.01 ... 100 cm² (1)
air spring left: 0.01 ... 100 cm² (0.5)
air spring right: 0.01 ... 100 cm² (0.5)
3/2-way roller lever valve, normally open

The roller lever valve is operated by pressing on the lever, for example through the use of a switching cam of a cylinder. Connection 1 is shut. After releasing the lever, the valve returns to its initial position through the use of a return spring. The flow may pass through freely from 1 to 2. In the Simulation Mode, the valve can be switched manually by clicking on the component, thus not requiring a cylinder to operate the valve. This valve is derived from a configurable 3/n way valve. You find this valve in the component library “Frequently used Way Valves”, under the [Library] menu.

Adjustable parameters
Desired position: 0 ... 4  (0)
Standard nominal flow rate: 0.1 ... 5000 l/min  (60)
Positioning time: 1e-4 ... 10 s  (0.02)
Reset time: 1e-4 ... 10 s  (0.03)
Minimum voltage: 0.1 ... 300 V  (20)
Electrically left at U_min: 0.01 ... 100 N  (70)
Electrically right at U_min: 0.01 ... 100 N  (70)
Mechanically left: 0.01 ... 100 N  (100)
Mechanically right: 0.01 ... 100 N  (100)
Physical spring force: 0.01 ... 100 N  (30)
Minimum force: 0.01 ... 100 N  (20)
Min. pilot control force: 0.01 ... 100 N  (15)
Left: 0.01 ... 100 cm2  (1)
Right: 0.01 ... 100 cm2  (1)
Pilot control left: 0.01 ... 100 cm2  (1)
Pilot control right: 0.01 ... 100 cm2  (1)
air spring left: 0.01 ... 100 cm2  (0.5)
air spring right: 0.01 ... 100 cm2  (0.5)

3/2-way idle return roller valve, normally closed

The idle return roller valve is operated when the roller is driven in a specific direction by the switching cam of a cylinder. After releasing the roller, the valve returns to its initial position through the use of a return spring. Connection 1 is shut. When the roller is driven in
the opposite direction, the valve is not operated. In the Simulation Mode, the valve can be switched manually by clicking on the component, thus not requiring a cylinder to operate the valve. This valve is derived from a configurable 3/n way valve. You find this valve in the component library “Frequently used Way Valves”, under the Library menu.

Adjustable parameters
Desired position: 0 ... 4   (0)
Standard nominal flow rate: 0.1 ... 5000 l/min  (60)
Positioning time: 1e-4 ... 10 s  (0.02)
Reset time: 1e-4 ... 10 s  (0.03)
Minimum voltage: 0.1 ... 300 V  (20)
Electrically left at U_min: 0.01 ... 100 N  (70)
Electrically right at U_min: 0.01 ... 100 N  (70)
Mechanically left: 0.01 ... 100 N  (100)
Mechanically right: 0.01 ... 100 N  (100)
Physical spring force: 0.01 ... 100 N  (30)
Minimum force: 0.01 ... 100 N  (20)
Min. pilot control force: 0.01 ... 100 N  (15)
Left: 0.01 ... 100 cm2  (1)
Right: 0.01 ... 100 cm2  (1)
Pilot control left: 0.01 ... 100 cm2  (1)
Pilot control right: 0.01 ... 100 cm2  (1)
air spring left: 0.01 ... 100 cm2  (0.5)
air spring right: 0.01 ... 100 cm2  (0.5)

Pressurizing valve

The pressurizing valve with plunger control is operated by the surface of the cylinder cam. When the plunger is operated, compressed air flows freely until the nozzle is closed. A signal up to the level of the boost pressure is assembled at exit connection 2. In the Simulation Mode, the valve can be switched manually by clicking on the component, thus not requiring a cylinder to operate the valve.

Adjustable parameters
Desired position: 0 ... 4   (0)
Standard nominal flow rate: 0.1 ... 5000 l/min  (60)
Pneumatic proximity switch, solenoid operated

A permanent solenoid found on the piston of a cylinder drives this 3/2 pneumatic directional valve and triggers the control signal. The flow passes freely from 1 to 2. In the Simulation Mode, the valve can be switched manually by clicking on the component, thus not requiring a cylinder to operate the valve. This valve is derived from a configurable 3/n way valve. You find this valve in the component library “Frequently used Way Valves”, under the Library menu.

Adjustable parameters
Desired position: 0 ... 4 (0)
Standard nominal flow rate: 0.1 ... 5000 l/min (60)
Positioning time: 1e-4 ... 10 s (0.02)
Reset time: 1e-4 ... 10 s (0.03)
Minimum voltage: 0.1 ... 300 V (20)
Electically left at U_min: 0.01 ... 100 N (70)
Electically right at U_min: 0.01 ... 100 N (70)
Mechanically left: 0.01 ... 100 N (100)
Mechanically right: 0.01 ... 100 N (100)
Physical spring force: 0.01 ... 100 N (30)
Minimum force: 0.01 ... 100 N (20)
Min. pilot control force: 0.01 ... 100 N (15)
Left: 0.01 ... 100 cm² (1)
Right: 0.01 ... 100 cm² (1)
Pilot control left: 0.01 ... 100 cm² (1)
Pilot control right: 0.01 ... 100 cm² (1)
air spring left: 0.01 ... 100 cm² (0.5)
air spring right: 0.01 ... 100 cm² (0.5)
3/2-way valve with pushbutton, normally closed

Pressing the pushbutton operates the valve. The flow passes freely from 1 to 2. Releasing the pushbutton allows the valve to return to its starting position through the use of a return spring. Connection 1 is shut. By holding down the Shift key and simultaneously clicking on the component with the mouse cursor, FluidSIM keeps the valve in permanent operating position. Simply clicking on the component cancels the operated state and returns the valve to its starting position. This valve is derived from a configurable 3/n way valve. You find this valve in the component library “Frequently used Way Valves”, under the Library menu.

Adjustable parameters
Desired position: 0 ... 4 (0)
Standard nominal flow rate: 0.1 ... 5000 l/min (60)
Positioning time: 1e-4 ... 10 s (0.02)
Reset time: 1e-4 ... 10 s (0.03)
Minimum voltage: 0.1 ... 300 V (20)
Electrically left at U_min: 0.01 ... 100 N (70)
Electrically right at U_min: 0.01 ... 100 N (70)
Mechanically left: 0.01 ... 100 N (100)
Mechanically right: 0.01 ... 100 N (100)
Physical spring force: 0.01 ... 100 N (30)
Minimum force: 0.01 ... 100 N (20)
Min. pilot control force: 0.01 ... 100 N (15)
Left: 0.01 ... 100 cm² (1)
Right: 0.01 ... 100 cm² (1)
Pilot control left: 0.01 ... 100 cm² (1)
Pilot control right: 0.01 ... 100 cm² (1)
air spring left: 0.01 ... 100 cm² (0.5)
air spring right: 0.01 ... 100 cm² (0.5)
3/2-way valve with pushbutton, normally open

Pressing the pushbutton operates the valve. Connection 1 is shut. Releasing the pushbutton allows the valve to returns to its starting position through the use of a return spring. The passes freely from 1 to 2. By holding down the Shift key and simultaneously clicking on the component with the mouse cursor, FluidSIM keeps the valve in permanent operating position. Simply clicking on the component cancels the operated state and returns the valve to its starting position. This valve is derived from a configurable 3/n way valve. You find this valve in the component library “Frequently used Way Valves”, under the Library menu.

Adjustable parameters
Desired position: 0 ... 4  (0)
Standard nominal flow rate: 0.1 ... 5000 l/min  (60)
Positioning time: 1e-4 ... 10 s  (0.02)
Reset time: 1e-4 ... 10 s  (0.03)
Minimum voltage: 0.1 ... 300 V  (20)
Electrically left at U_min: 0.01 ... 100 N  (70)
Electrically right at U_min: 0.01 ... 100 N  (70)
Mechanically left: 0.01 ... 100 N  (100)
Mechanically right: 0.01 ... 100 N  (100)
Physical spring force: 0.01 ... 100 N  (30)
Minimum force: 0.01 ... 100 N  (20)
Min. pilot control force: 0.01 ... 100 N  (15)
Left: 0.01 ... 100 cm2  (1)
Right: 0.01 ... 100 cm2  (1)
Pilot control left: 0.01 ... 100 cm2  (1)
Pilot control right: 0.01 ... 100 cm2  (1)
air spring left: 0.01 ... 100 cm2  (0.5)
air spring right: 0.01 ... 100 cm2  (0.5)

3/2-way valve with selection switch or striking button

Pressing the red striking button operates the valve. The flow passes freely from 1 to 2. Releasing the button has no effect; the valve remains in its operating position. Turning the button to the right
sets the striking button back to its original position and the valve returns to its starting position through the use of a return spring. Connection 1 is shut. This valve is derived from a configurable 3/n way valve. You find this valve in the component library “Frequently used Way Valves”, under the Library menu.

Adjustable parameters
Desired position: 0 ... 4  (0)
Standard nominal flow rate: 0.1 ... 5000 l/min  (60)
Positioning time: 1e-4 ... 10 s  (0.02)
Reset time: 1e-4 ... 10 s  (0.03)
Minimum voltage: 0.1 ... 300 V  (20)
Electrically left at U_min: 0.01 ... 100 N (70)
Electrically right at U_min: 0.01 ... 100 N (70)
Mechanically left: 0.01 ... 100 N (100)
Mechanically right: 0.01 ... 100 N (100)
Physical spring force: 0.01 ... 100 N (30)
Minimum force: 0.01 ... 100 N (20)
Min. pilot control force: 0.01 ... 100 N (15)
Left: 0.01 ... 100 cm2 (1)
Right: 0.01 ... 100 cm2 (1)
Pilot control left: 0.01 ... 100 cm2 (1)
Pilot control right: 0.01 ... 100 cm2 (1)
air spring left: 0.01 ... 100 cm2 (0.5)
air spring right: 0.01 ... 100 cm2 (0.5)

5/2-way valve, with selection switch

Turning the selection switch operates the valve. The flow passes freely from 1 to 4. Releasing the switch has no effect; the valve remains in its operating position. Turning the switch back to its original position allows the flow to pass freely from 1 to 2. This valve is derived from a configurable 5/n way valve. You find this valve in the component library “Frequently used Way Valves”, under the Library menu.

Adjustable parameters
Desired position: 0 ... 4  (0)
Standard nominal flow rate: 0.1 ... 5000 l/min  (60)
Positioning time: 1e-4 ... 10 s  (0.02)
20.2.4 Solenoid Operated Directional Valves

3/2-way solenoid valve, normally closed

The solenoid valve is controlled by applying a voltage signal at the solenoid coil. The flow passes freely from 1 to 2. By stopping the signal the valve is set back to its starting position through the use of a return spring. Connection 1 is shut. If no signal is applied to the valve, it can be manually operated. This valve is derived from a configurable 3/n way valve. You find this valve in the component library “Frequently used Way Valves”, under the Library menu.

Adjustable parameters
Desired position: 0 ... 4  (0)
Standard nominal flow rate: 0.1 ... 5000 l/min  (60)
Positioning time: 1e-4 ... 10 s  (0.02)
Reset time: 1e-4 ... 10 s  (0.03)
Minimum voltage: 0.1 ... 300 V  (20)
**3/2-way solenoid valve, normally open**

The solenoid valve is controlled by applying a voltage signal at the solenoid coil. Connection 1 is shut. By stopping the signal the valve is set back to its starting position through the use of a return spring. The flow passes freely from 1 to 2. If no signal is applied to the valve, it can be manually operated. This valve is derived from a configurable 3/n way valve. You find this valve in the component library “Frequently used Way Valves”, under the **Library** menu.

**Adjustable parameters**

- **Desired position**: 0 ... 4  (0)
- **Standard nominal flow rate**: 0.1 ... 5000 l/min  (60)
- **Positioning time**: 1e-4 ... 10 s  (0.02)
- **Reset time**: 1e-4 ... 10 s  (0.03)
- **Minimum voltage**: 0.1 ... 300 V  (20)
- **Electrically left at U_min**: 0.01 ... 100 N  (70)
- **Electrically right at U_min**: 0.01 ... 100 N  (70)
- **Mechanically left**: 0.01 ... 100 N  (100)
- **Mechanically right**: 0.01 ... 100 N  (100)
- **Physical spring force**: 0.01 ... 100 N  (30)
- **Minimum force**: 0.01 ... 100 N  (20)
- **Min. pilot control force**: 0.01 ... 100 N  (15)
- **Left**: 0.01 ... 100 cm²  (1)
- **Right**: 0.01 ... 100 cm²  (1)
- **Pilot control left**: 0.01 ... 100 cm²  (1)
- **Pilot control right**: 0.01 ... 100 cm²  (1)
- **air spring left**: 0.01 ... 100 cm²  (0.5)
- **air spring right**: 0.01 ... 100 cm²  (0.5)
5/2-way solenoid valve

The solenoid valve is controlled by applying a voltage signal at the solenoid coil. The flow passes freely from 1 to 4. By stopping the signal the valve is set back to its starting position through the use of a return spring. The flow passes freely from 1 to 2. If no signal is applied to the valve, it can be manually operated. This valve is derived from a configurable 5/n way valve. You find this valve in the component library “Frequently used Way Valves”, under the Library menu.

Adjustable parameters
Desired position: 0 ... 4 (0)
Standard nominal flow rate: 0.1 ... 5000 l/min (60)
Positioning time: 1e-4 ... 10 s (0.02)
Reset time: 1e-4 ... 10 s (0.03)
Minimum voltage: 0.1 ... 300 V (20)
Electrically left at U_min: 0.01 ... 100 N (70)
Electrically right at U_min: 0.01 ... 100 N (70)
Mechanically left: 0.01 ... 100 N (100)
Mechanically right: 0.01 ... 100 N (100)
Physical spring force: 0.01 ... 100 N (30)
Minimum force: 0.01 ... 100 N (20)
Min. pilot control force: 0.01 ... 100 N (15)
Left: 0.01 ... 100 cm² (1)
Right: 0.01 ... 100 cm² (1)
Pilot control left: 0.01 ... 100 cm² (1)
Pilot control right: 0.01 ... 100 cm² (1)
air spring left: 0.01 ... 100 cm² (0.5)
air spring right: 0.01 ... 100 cm² (0.5)
5/2-way solenoid impulse valve

The solenoid valve is controlled by applying a voltage signal at the solenoid coil (flow passes from 1 to 4) and remains in this operating position even when the signal is cut off. Only by applying an opposite signal will the valve return to its starting position (flow passes freely from 1 to 2). If no signal is applied to the valve, it can be manually operated. This valve is derived from a configurable 5/n way valve. You find this valve in the component library “Frequently used Way Valves”, under the Library menu.

Adjustable parameters

- **Desired position:** 0 ... 4 (0)
- **Standard nominal flow rate:** 0.1 ... 5000 l/min (60)
- **Positioning time:** 1e-4 ... 10 s (0.02)
- **Reset time:** 1e-4 ... 10 s (0.03)
- **Minimum voltage:** 0.1 ... 300 V (20)
- **Electrically left at U_min:** 0.01 ... 100 N (70)
- **Electrically right at U_min:** 0.01 ... 100 N (70)
- **Mechanically left:** 0.01 ... 100 N (100)
- **Mechanically right:** 0.01 ... 100 N (100)
- **Physical spring force:** 0.01 ... 100 N (30)
- **Minimum force:** 0.01 ... 100 N (20)
- **Min. pilot control force:** 0.01 ... 100 N (15)
- **Left:** 0.01 ... 100 cm² (1)
- **Right:** 0.01 ... 100 cm² (1)
- **Pilot control left:** 0.01 ... 100 cm² (1)
- **Pilot control right:** 0.01 ... 100 cm² (1)
- **Air spring left:** 0.01 ... 100 cm² (0.5)
- **Air spring right:** 0.01 ... 100 cm² (0.5)

5/3-way solenoid valve, mid-Position closed

The solenoid valve is controlled by applying a voltage signal at the solenoid coil (flow passes from 1 to 4 or from 1 to 2). By stopping the signal the valve is set back to its starting position through the use of a return spring. Connections 1, 2, and 4 are shut. If no signal is applied to the valve, it can be manually operated. This valve is
derived from a configurable 5/n way valve. You find this valve in the component library “Frequently used Way Valves”, under the Library menu.

Adjustable parameters
Desired position: 0 ... 4 (0)
Standard nominal flow rate: 0.1 ... 5000 l/min (60)
Positioning time: 1e-4 ... 10 s (0.02)
Reset time: 1e-4 ... 10 s (0.03)
Minimum voltage: 0.1 ... 300 V (20)
Electrically left at U_min: 0.01 ... 100 N (70)
Electrically right at U_min: 0.01 ... 100 N (70)
Mechanically left: 0.01 ... 100 N (100)
Mechanically right: 0.01 ... 100 N (100)
Physical spring force: 0.01 ... 100 N (30)
Minimum force: 0.01 ... 100 N (20)
Min. pilot control force: 0.01 ... 100 N (15)
Left: 0.01 ... 100 cm2 (1)
Right: 0.01 ... 100 cm2 (1)
Pilot control left: 0.01 ... 100 cm2 (1)
Pilot control right: 0.01 ... 100 cm2 (1)
air spring left: 0.01 ... 100 cm2 (0.5)
air spring right: 0.01 ... 100 cm2 (0.5)

20.2.5 Pneumatically Operated Directional Valves

3/2-way valve, pneumatically operated, normally closed

The pneumatic valve is controlled by applying a pilot pressure at connection 12. The flow passes freely from 1 to 2. By stopping the signal the valve is set back to its starting position through the use of a return spring. Connection 1 is shut. This valve is derived from a configurable 3/n way valve. You find this valve in the component library “Frequently used Way Valves”, under the Library menu.
**Adjustable parameters**

- **Desired position:** 0 ... 4 (0)
- **Standard nominal flow rate:** 0.1 ... 5000 l/min (60)
- **Positioning time:** 1e-4 ... 10 s (0.02)
- **Reset time:** 1e-4 ... 10 s (0.03)
- **Minimum voltage:** 0.1 ... 300 V (20)
- **Electrically left at U_min:** 0.01 ... 100 N (70)
- **Electrically right at U_min:** 0.01 ... 100 N (70)
- **Mechanically left:** 0.01 ... 100 N (100)
- **Mechanically right:** 0.01 ... 100 N (100)
- **Physical spring force:** 0.01 ... 100 N (30)
- **Minimum force:** 0.01 ... 100 N (20)
- **Min. pilot control force:** 0.01 ... 100 N (15)
- **Left:** 0.01 ... 100 cm² (1)
- **Right:** 0.01 ... 100 cm² (1)
- **Pilot control left:** 0.01 ... 100 cm² (1)
- **Pilot control right:** 0.01 ... 100 cm² (1)
- **Air spring left:** 0.01 ... 100 cm² (0.5)
- **Air spring right:** 0.01 ... 100 cm² (0.5)

**3/2-way valve, pneumatically operated, normally open**

The pneumatic valve is controlled by applying a pilot pressure at connection 10. Connection 1 is shut. By stopping the signal the valve is set back to its starting position through the use of a return spring. The flow passes freely from 1 to 2. This valve is derived from a configurable 3/n way valve. You find this valve in the component library “Frequently used Way Valves”, under the [Library] menu.

**Adjustable parameters**

- **Desired position:** 0 ... 4 (0)
- **Standard nominal flow rate:** 0.1 ... 5000 l/min (60)
- **Positioning time:** 1e-4 ... 10 s (0.02)
- **Reset time:** 1e-4 ... 10 s (0.03)
- **Minimum voltage:** 0.1 ... 300 V (20)
- **Electrically left at U_min:** 0.01 ... 100 N (70)
- **Electrically right at U_min:** 0.01 ... 100 N (70)
- **Mechanically left:** 0.01 ... 100 N (100)
- **Mechanically right:** 0.01 ... 100 N (100)
- **Physical spring force:** 0.01 ... 100 N (30)
Minimum force: 0.01 ... 100 N (20)
Min. pilot control force: 0.01 ... 100 N (15)
Left: 0.01 ... 100 cm² (1)
Right: 0.01 ... 100 cm² (1)
Pilot control left: 0.01 ... 100 cm² (1)
Pilot control right: 0.01 ... 100 cm² (1)
air spring left: 0.01 ... 100 cm² (0.5)
air spring right: 0.01 ... 100 cm² (0.5)

5/2-way valve, pneumatically operated

The pneumatic valve is controlled by applying a pilot pressure at connection 14. The flow passes freely from 1 to 4. By stopping the signal the valve is set back to its starting position through the use of a return spring. The flow passes freely from 1 to 2. This valve is derived from a configurable 5/n way valve. You find this valve in the component library “Frequently used Way Valves”, under the Library menu.

Adjustable parameters
Desired position: 0 ... 4 (0)
Standard nominal flow rate: 0.1 ... 5000 l/min (60)
Positioning time: 1e-4 ... 10 s (0.02)
Reset time: 1e-4 ... 10 s (0.03)
Minimum voltage: 0.1 ... 300 V (20)
Electrically left at U_min: 0.01 ... 100 N (70)
Electrically right at U_min: 0.01 ... 100 N (70)
Mechanically left: 0.01 ... 100 N (100)
Mechanically right: 0.01 ... 100 N (100)
Physical spring force: 0.01 ... 100 N (30)
Minimum force: 0.01 ... 100 N (20)
Min. pilot control force: 0.01 ... 100 N (15)
Left: 0.01 ... 100 cm² (1)
Right: 0.01 ... 100 cm² (1)
Pilot control left: 0.01 ... 100 cm² (1)
Pilot control right: 0.01 ... 100 cm² (1)
air spring left: 0.01 ... 100 cm² (0.5)
air spring right: 0.01 ... 100 cm² (0.5)
5/2-way impulse valve, pneumatically operated

The pneumatic valve is controlled by applying reciprocal pilot pressures at connection 14 (flow passes from 1 to 4) and connection 12 (flow passes from 1 to 2). The valve’s operating position remains until an opposite signal is received by the valve. This valve is derived from a configurable 5/n way valve. You find this valve in the component library “Frequently used Way Valves”, under the Library menu.

Adjustable parameters
- Desired position: 0 ... 4 (0)
- Standard nominal flow rate: 0.1 ... 5000 l/min (60)
- Positioning time: 1e-4 ... 10 s (0.02)
- Reset time: 1e-4 ... 10 s (0.03)
- Minimum voltage: 0.1 ... 300 V (20)
- Electrically left at U_min: 0.01 ... 100 N (70)
- Electrically right at U_min: 0.01 ... 100 N (70)
- Mechanically left: 0.01 ... 100 N (100)
- Mechanically right: 0.01 ... 100 N (100)
- Physical spring force: 0.01 ... 100 N (30)
- Minimum force: 0.01 ... 100 N (20)
- Min. pilot control force: 0.01 ... 100 N (15)
- Left: 0.01 ... 100 cm² (1)
- Right: 0.01 ... 100 cm² (1)
- Pilot control left: 0.01 ... 100 cm² (1)
- Pilot control right: 0.01 ... 100 cm² (1)
- air spring left: 0.01 ... 100 cm² (0.5)
- air spring right: 0.01 ... 100 cm² (0.5)

5/3-way pneumatic valve, mid-Position closed

The pneumatic valve is controlled by applying reciprocal pilot pressures at connection 14 (flow passes from 1 to 4) and connection 12 (flow passes from 1 to 2). By stopping the signals the valve is set back to its starting position through the use of a return spring. Connections 1, 2, and 4 are shut. This valve is derived from
a configurable 5/n way valve. You find this valve in the component library “Frequently used Way Valves”, under the Library menu.

Adjustable parameters

Desired position: 0 ... 4 (0)
Standard nominal flow rate: 0.1 ... 5000 l/min (60)
Positioning time: 1e-4 ... 10 s (0.02)
Reset time: 1e-4 ... 10 s (0.03)
Minimum voltage: 0.1 ... 300 V (20)
Electrically left at U_min: 0.01 ... 100 N (70)
Electrically right at U_min: 0.01 ... 100 N (70)
Mechanically left: 0.01 ... 100 N (100)
Mechanically right: 0.01 ... 100 N (100)
Physical spring force: 0.01 ... 100 N (30)
Minimum force: 0.01 ... 100 N (20)
Min. pilot control force: 0.01 ... 100 N (15)
Left: 0.01 ... 100 cm² (1)
Right: 0.01 ... 100 cm² (1)
Pilot control left: 0.01 ... 100 cm² (1)
Pilot control right: 0.01 ... 100 cm² (1)
air spring left: 0.01 ... 100 cm² (0.5)
air spring right: 0.01 ... 100 cm² (0.5)

Low pressure amplifier unit, 2 compartments

Each of the two double-level low pressure amplifier units has the function of a 3/2 directional valve that is normally closed. The signal at connection 12 is raised to a higher boost pressure level through the use of a double-level amplifier and is put out by connection 2.

Adjustable parameters

Standard nominal flow rate: 0.1 ... 5000 l/min (60)
20.2.6 Shutoff Valves and Flow Control Valves

**Shuttle valve**

The shuttle valve is switched based on the compressed air entering into either input connection 1 and leaving via an output connection 2. Should both input connections begin receiving compressed air, the connection with the higher pressure takes precedence and is put out (OR function).

*Adjustable parameters*

**Standard nominal flow rate:** 0.1 ... 5000 l/min (108)

**Quick exhaust valve**

The compressed air passes from connection 1 to connection 2. If the pressure should decrease at connection 1, then the compressed air from connection 2 will escape to the outside via the installed silencer.

*Adjustable parameters*

**Standard nominal flow rate 1...2:** 0.1 ... 5000 l/min (300)

**Standard nominal flow rate 2...3:** 0.1 ... 5000 l/min (550)

**Two pressure valve**

The two pressure valve is switched based on the compressed air entering into both input connections 1 and leaving via an output connection 2. Should both input connections begin receiving compressed air, the connection with the lower pressure takes precedence and is put out (AND function).
Adjustable parameters
Standard nominal flow rate: 0.1 ... 5000 l/min (550)

Check valve

If the inlet pressure at 1 is higher than the outlet pressure at 2, then the check valve allows the flow to pass, otherwise it blocks the flow.

Adjustable parameters
Standard nominal flow rate: 0.1 ... 5000 l/min (108)

Check valve, spring loaded

If the inlet pressure at 1 is higher than the outlet pressure at 2 and the nominal pressure, then the check valve allows the flow to pass, otherwise it blocks the flow.

Adjustable parameters
Opening pressure: 0 ... 2 MPa (0.1)
Pressure regulation range: 0.01 ... 1 MPa (0.05)
Standard nominal flow rate: 0.1 ... 5000 l/min (108)

Check valve with pilot control

If the entering pressure at connection 1 is higher that the outgoing pressure at 2, the check valve allows the flow to pass freely. Otherwise, the valve stops the flow. Additionally, the check valve can be opened via the control line 12. This action allows the flow to pass freely in both directions.

Adjustable parameters
Check valve with pilot control, spring loaded

If the inlet pressure at 1 is higher than the outlet pressure at 2 and the nominal pressure, then the check valve allows the flow to pass, otherwise it blocks the flow. Additionally, the check valve can be released using the pilot line 12, thus enabling the flow in both directions.

Adjustable parameters
- Opening pressure: 0 ... 2 MPa (0.1)
- Pressure regulation range: 0.01 ... 1 MPa (0.05)
- Area ratio: 0.1 ... 10 (3.3)
- Standard nominal flow rate: 0.1 ... 5000 l/min (108)

Pilot to close check valve

If the inlet pressure at 1 is higher than the outlet pressure at 2, then the non-return valve allows the flow to pass, otherwise it blocks the flow. Additionally, the non-return valve can be closed using the pilot line 10.

Adjustable parameters
- Area ratio: 0.1 ... 10 (3.3)
- Standard nominal flow rate: 0.1 ... 5000 l/min (108)

Pilot to close check valve, spring loaded

If the inlet pressure at 1 is higher than the outlet pressure at 2 and the nominal pressure, then the non-return valve allows the flow to pass, otherwise it blocks the flow. Additionally, the non-return valve can be closed using the pilot line 10.
**Adjustable parameters**

**Opening pressure:** 0 ... 2 MPa (0.1)  
**Pressure regulation range:** 0.01 ... 1 MPa (0.05)  
**Area ratio:** 0.1 ... 10 (3.3)  
**Standard nominal flow rate:** 0.1 ... 5000 l/min (108)

---

**Nozzle**

The nozzle represents a pneumatic resistance.

**Adjustable parameters**

**Standard nominal flow rate:** 0.1 ... 5000 l/min (100)

---

**Throttle valve**

The setting of the throttle valve is set by means of a rotary knob. Please note that by the rotary knob no *absolute* resistance value can be set. This means that, in reality, different throttle valves can generate different resistance values despite identical settings.

**Adjustable parameters**

**Opening level:** 0 ... 100 % (100)  
**Standard nominal flow rate:** 0.1 ... 5000 l/min (100)

---

**Orifice**

The orifice represents a pneumatic resistance.

**Adjustable parameters**

**Standard nominal flow rate:** 0.1 ... 5000 l/min (100)
Orifice, adjustable

The orifice represents a variable pneumatic resistance.

*Adjustable parameters*

*Opening level:* 0 ... 100 % (100)
*Standard nominal flow rate:* 0.1 ... 5000 l/min (100)

One-way flow control valve

The one-way flow control valve is made up of a throttle valve and a check valve. The check valve stops the flow from passing in a certain direction. The flow then passes through the throttle valve. The cross-section of the throttle is adjustable via a regular screw. In the opposite direction the flow can pass through the check valve.

*Adjustable parameters*

*Opening level:* 0 ... 100 % (100)
*Standard nominal flow rate (Flow control valve):* 0.1 ... 5000 l/min (45)
*Standard nominal flow rate (Non-return valve):* 0.1 ... 5000 l/min (65)

Pneumatic counter

The counter registers pneumatic signals starting at a predetermined number and counting backwards. If zero is reached, then the counter releases an output signal. This output signal continues until the counter is reset either by hand or from a signal at connection 10.

*Adjustable parameters*

*Counter:* 0 ... 9999 (3)
*Standard nominal flow rate:* 0.1 ... 5000 l/min (60)
Time delay valve, normally closed

The time delay valve is actuated by a pneumatic signal at port 1 after a preset time delay has elapsed. It is returned to the normal position via return spring when the signal is removed. The time delay is infinitely adjustable by means of a regulating screw. The time delay is reset automatically within 200 ms.

Adjustable parameters

Delay time: 0.1 ... 100 s (3)
Standard nominal flow rate: 0.1 ... 5000 l/min (50)

Time delay valve, normally open

After the pilot signal is applied at port 10, a preset time elapses before the pneumatic timer is actuated. It returns to its initial position via a return spring once the signal is removed. The time delay is infinitely adjustable by means of a regulating screw. The time delay is reset automatically within 200 ms.

Adjustable parameters

Delay time: 0.1 ... 100 s (3)
Standard nominal flow rate: 0.1 ... 5000 l/min (50)

Ring sensor

The ring sensor is a non-contact pneumatic signal output module. It is supplied with low pressure at connection 1. If, due to an object, the entering air flow is disturbed, a low pressure signal will be put out by connection 2. To simulate an object in the air flow, as presented above, simply click on the component during FluidSIM Simulation Mode.
20.2.7 Pressure Operated Switches

2-way pressure regulator valve

The pressure regulator valve regulates the compressed air supply to the preset nominal pressure and equalizes pressure fluctuations. The valve closes when the pressure at connection 2 exceeds the nominal pressure. The setting for the real components is component dependent and cannot be changed.

Adjustable parameters

Nominal pressure: 0 ... 2 MPa (0.4)
Pressure regulation range: 0.01 ... 1 MPa (0.05)
Standard nominal flow rate: 0.1 ... 5000 l/min (300)

2-way pressure regulator valve, adjustable

The pressure regulator valve regulates the compressed air supply to the preset nominal pressure and equalizes pressure fluctuations. The valve closes when the pressure at connection 2 exceeds the nominal pressure.

Adjustable parameters

Nominal pressure: 0 ... 2 MPa (0.4)
Pressure regulation range: 0.01 ... 1 MPa (0.05)
Standard nominal flow rate: 0.1 ... 5000 l/min (300)

Pressure regulator valve with manometer

The pressure control valve regulates the supplied pressure based on the adjustable operating pressure and the variations in the pressure. The manometer displays the pressure at connection 2.
Adjustable parameters
Nominal pressure: 0 ... 2 MPa (0.4)
Pressure regulation range: 0.01 ... 1 MPa (0.05)
Standard nominal flow rate: 0.1 ... 5000 l/min (300)

3-way pressure regulator valve
The pressure regulator valve regulates the compressed air supply to the preset nominal pressure and equalizes pressure fluctuations. The compressed air is discharged via connection 3 when the pressure at connection 2 exceeds the nominal pressure. The setting for the real components is component dependent and cannot be changed.

Adjustable parameters
Nominal pressure: 0 ... 2 MPa (0.4)
Pressure regulation range: 0.01 ... 1 MPa (0.05)
Standard nominal flow rate: 0.1 ... 5000 l/min (300)

3-way pressure regulator valve, adjustable
The pressure regulator valve regulates the compressed air supply to the preset nominal pressure and equalizes pressure fluctuations. The compressed air is discharged via connection 3 when the pressure at connection 2 exceeds the nominal pressure.

Adjustable parameters
Nominal pressure: 0 ... 2 MPa (0.4)
Pressure regulation range: 0.01 ... 1 MPa (0.05)
Standard nominal flow rate: 0.1 ... 5000 l/min (300)
Closing pressure compensator

The pressure compensator represents a pressure dependent pneumatic resistance. The pressure compensator closes when the pressure difference $p_3 - p_4$ exceeds the nominal pressure. A pressure regulating valve is implemented by the combination of connections 2 and 3. The nominal pressure setting of the real components is component dependent and cannot be changed.

Adjustable parameters
Nominal pressure: 0 ... 2 MPa (0.4)
Pressure regulation range: 0.01 ... 1 MPa (0.05)
Standard nominal flow rate: 0.1 ... 500 l/min (300)

Closing pressure compensator, adjustable

The pressure compensator represents a pressure dependent pneumatic resistance. The pressure compensator closes when the pressure difference $p_3 - p_4$ exceeds the nominal pressure. A pressure regulating valve is implemented by the combination of connections 2 and 3.

Adjustable parameters
Nominal pressure: 0 ... 2 MPa (0.4)
Pressure regulation range: 0.01 ... 1 MPa (0.05)
Standard nominal flow rate: 0.1 ... 5000 l/min (300)

Opening pressure compensator

The pressure compensator represents a pressure dependent pneumatic resistance. The pressure compensator opens when the pressure difference $p_3 - p_4$ exceeds the nominal pressure. A sequence valve is implemented by the combination of connections 1 and 3. The nominal pressure setting of the real components is component dependent and cannot be changed.
Adjustable parameters

Nominal pressure: 0 ... 2 MPa (0.4)
Pressure regulation range: 0.01 ... 1 MPa (0.05)
Standard nominal flow rate: 0.1 ... 5000 l/min (300)

Opening pressure compensator, adjustable

The pressure compensator represents a pressure dependent pneumatic resistance. The pressure compensator opens when the pressure difference p3-p4 exceeds the nominal pressure. A sequence valve is implemented by the combination of connections 1 and 3.

Adjustable parameters

Nominal pressure: 0 ... 2 MPa (0.4)
Pressure regulation range: 0.01 ... 1 MPa (0.05)
Standard nominal flow rate: 0.1 ... 5000 l/min (300)

20.2.8 Pressure Operated Switches

Analog pressure sensor

The pressure sensor measures the pressure and operates the pressure switch when the adjustable switching pressure has been exceeded.

Adjustable parameters

Switching pressure: -0.1 ... 2 MPa (0.3)
Hysteresis: 0 ... 1 MPa (0)
Vacuum switch

The vacuum switch operates the linked pressure switch, when the pressure falls below the adjustable switching pressure. If the symbol is used as a pressure switch the respective switch is operated when the pressure exceeds the switching pressure.

Adjustable parameters
Switching pressure: -0.1 ... 2 MPa (0.3)
Hysteresis: 0 ... 1 MPa (0)

Differential pressure switch

The differential pressure switch can be employed as a pressure switch (connection P1), a vacuum switch (connection P2) or as a differential pressure switch (P1-P2). The respective pneumatic to electric converter is operated when the difference in pressure between P1-P2 exceeds the adjustable switching pressure.

Adjustable parameters
Switching pressure: -2 ... 2 MPa (0.3)
Hysteresis: 0 ... 1 MPa (0)

20.2.9 Vacuum Technique

Vacuum suction nozzle

The vacuum suction nozzle creates its vacuum based on the ejector principle. In this case, compressed air flows from connection 1 to 3,
creating a vacuum at connection 1v. A sucker can be connected to the vacuum connection 1v. Stopping the input of compressed air at connection 1 stops any suction also.

**Adjustable parameters**
- **Maximum vacuum:** -0.999 ... 0 bar (-0.85)
- **Operating pressure for max. vacuum:** 0.1 ... 20 bar (4.25)
- **Air consumption at 600 kPa:** 1 ... 1000 l/min (11.6)
- **Max. suction rate:** 0.1 ... 1000 l/min (6)

**Vacuum suction nozzle**

The vacuum suction nozzle creates its vacuum based on the ejector principle. In this case, compressed air flows from connection 1 to 3, creating a vacuum at connection 1v. A sucker can be connected to the vacuum connection 1v. Stopping the input of compressed air at connection 1 stops any suction also.

**Adjustable parameters**
- **Maximum vacuum:** -0.999 ... 0 bar (-0.85)
- **Operating pressure for max. vacuum:** 0.1 ... 20 bar (4.25)
- **Air consumption at 600 kPa:** 1 ... 1000 l/min (11.6)
- **Max. suction rate:** 0.1 ... 1000 l/min (6)

**Vacuum generator with ejector pulse**

Vacuum generator with ejector pulse

**Adjustable parameters**
- **Maximum vacuum:** -0.999 ... 0 bar (-0.85)
- **Operating pressure for max. vacuum:** 0.1 ... 20 bar (4.25)
- **Air consumption at 600 kPa:** 1 ... 1000 l/min (11.6)
- **Max. suction rate:** 0.1 ... 1000 l/min (6)
- **Volume:** 0.001 ... 10 l (0.05)
Sucker

The sucker can be used in connection with the vacuum suction nozzle to suck in objects.

In order to put down or to lift the sucker in FluidSIM click on the component in simulation mode.

*Adjustable parameters*
- **Diameter:** 1 ... 1000 mm (20)
- **Load to be lifted:** 0.001 ... 1000 kg (0.1)
- **Safety factor:** 0.1 ... 100 (1)

Suction gripper

Suction gripper with vacuum security valve.

*Adjustable parameters*
- **Min. spring pressure:** 0 ... 1 bar (0.1)
- **Max. Spring pressure:** 0.01 ... 1 bar (0.2)
- **Min. Flow rate at p1-p2 = 50 kPa:** 0.001 ... 1000 l/min (0.5)
- **Max. Flow rate at p1-p2 = 50 kPa:** 0.1 ... 1000 l/min (4)

Adjustable vacuum actuator valve

The vacuum actuator valve is employed through the conversion of a vacuum signal. As soon as the vacuum reaches the adjustable value at connection 1v, the attached valve body is switched.

*Adjustable parameters*
- **Switching pressure:** -0.1 ... 0 MPa (-0.025)
- **Standard nominal flow rate:** 0.1 ... 5000 l/min (100)
20.2.10 Valve Groups

Pressure sequence valve

The sequence valve is operated when the control pressure at connection 12 has been reached. The flow passes freely from 1 to 2. Removing the signal allows the valve to return to its starting position through the use of a return spring. Connection 1 is shut. The pressure of the control signal is infinitely adjustable via a pressure setting screw.

Adjustable parameters
Switching pressure: 0 ... 20 bar (3)
Standard nominal flow rate: 0.1 ... 5000 l/min (100)

Time delay valve, normally closed

The time delay valve is made up of a pneumatically operated 3/2-way valve, a one-way flow control valve, and small air accumulator. When the necessary pressure is reached at the control connection 12 of the unit, the 3/2-way valve switches and the flow passes freely from 1 to 2.

Adjustable parameters
Opening level: 0 ... 100 % (100)
Standard nominal flow rate (Flow control valve): 0.1 ... 5000 l/min (10)
Volume: 0.001 ... 100 l (0.01)
Standard nominal flow rate (Directional valve): 0.1 ... 5000 l/min (50)
Time delay valve, normally open

The time delay valve is made up of a pneumatically operated 3/2-way valve, a one-way flow control valve, and small air accumulator. When the necessary pressure is reached at the control connection 10 of the unit, the 3/2-way valve switches and stops the flow from passing between 1 and 2.

Adjustable parameters
Opening level: 0 ... 100 % (100)
Standard nominal flow rate (Flow control valve): 0.1 ... 5000 l/min (10)
Volume: 0.001 ... 100 l (0.01)
Standard nominal flow rate (Directional valve): 0.1 ... 5000 l/min (50)

Stepper module, type TAA

The stepper module is made up of a memory unit (3/2-way impulse valve), an AND and an OR component, a viewable announcement, and an auxiliary manual operation.

Adjustable parameters
Initial Position: Left, Right (Left)
Desired position: 0 ... 2 (0)
Standard nominal flow rate: 0.1 ... 5000 l/min (60)

Stepper module, type TAB

The stepper module is made up of a memory unit (3/2-way impulse valve), an AND and an OR component, a viewable announcement, and an auxiliary manual operation.

Adjustable parameters
Initial Position: Left, Right (Right)
Desired position: 0 ... 2 (0)
Standard nominal flow rate: 0.1 ... 5000 l/min (60)

Quickstepper

The Quickstepper is a ready to be fitted, mechanical/pneumatic control device with 12 in- and outputs. The outputs are successively synchronized with the input signals.

Two-hand control block ZSB

The two-hand control block ZSB is a pneumatic AND function.

Adjustable parameters
Opening level: 0 ... 100 % (100)
Standard nominal flow rate: 0.1 ... 5000 l/min (100)

20.2.11 Continuous valves

5/3-way proportional valve

The proportional valve transforms an analog electrical input signal into corresponding opening cross-sections at the outputs. At half nominal voltage i.e. 5 V, the pneumatic mid-position is taken. Here all leading edges are closed, so that no air flows through the valve. Beneficial static and dynamic characteristics with minimal hysteresis (less than 0.3 %), short actuating time (typically 5 ms), and a higher upper frequency limit (approx. 100 Hz), are achieved.
through an integrated electronic position control for the slide distance. Thus the valve, as control element and especially in combination with a higher ranked position controller, is suitable for the positioning of a pneumatic cylinder.

*Adjustable parameters*

**Standard nominal flow rate:** 0.1 ... 5000 l/min (773)

---

**20.2.12 Actuators**

**Configurable cylinder**

The configurable cylinder can be customized via its *properties dialog*. Almost any combination of piston type (single-acting, double-acting), the specification of the piston rods (double ended, with magnetic coupling or slide) and the number (none, one, two) is possible. An end position cushioning (without, with, adjustable) can also be defined. FluidSIM automatically adjusts the symbol according to the preset configuration. In addition, a load to be moved (including possible static and sliding friction) and a variable force profile can be defined in the *properties dialog*. In the component library of FluidSIM there are several pre-configured cylinders that can be inserted in your circuit and directly used. Should no suitable symbol be available, then simply choose the component with the most similarity to the required component, open the *properties dialog* and adjust the configuration accordingly.

*Adjustable parameters*

**Piston diameter:** 1 ... 1000 mm (20)
**Piston rod diameter:** 0 ... 1000 mm (8)
**Piston Position:** 0 ... 5000 mm (0)
**Maximum stroke:** 1 ... 5000 mm (200)
**Mounting angle:** 0 ... 360 deg (0)
**Parameter input:** Calculate automatically, Enter manually (Calculate automatically)
Single acting cylinder

The piston rod of a single acting cylinder is operated by the input of compressed air at the front end position. When the compressed air is shut off, the piston returns to its starting position via a return spring. The piston of the cylinder contains a permanent solenoid which can be used to operate a proximity switch.

Adjustable parameters

- **Piston diameter**: 1 ... 1000 mm (20)
- **Piston rod diameter**: 0 ... 1000 mm (8)
- **Piston Position**: 0 ... 5000 mm (0)
- **Maximum stroke**: 1 ... 5000 mm (200)
- **Mounting angle**: 0 ... 360 deg (0)
- **Parameter input**: Calculate automatically, Enter manually (Calculate automatically)
- **Reference pressure**: 0.1 ... 20 bar (6)
- **Reference velocity**: 0.1 ... 2 m/s (1)
- **Friction at dp_ref**: 1 ... 5000 N (120)
- **Break-away force at dp_ref**: 1 ... 5000 N (12)
- **Parameter input**: Calculate automatically, Enter manually (Calculate automatically)
- **Moving mass**: 0.01 ... 1000 kg (0.3)
- **Leakage**: 0 ... 10 l/(min.bar) (0)
- **Spring pressure at x=0**: 0 ... 10 MPa (0.5)
- **Spring pressure at x=x_max**: 0 ... 10 MPa (1)
- **Damping length**: 1 ... 100 mm (10)
Single acting cylinder with return spring

The piston of the single acting cylinder is extended to its back position by the input of compressed air. When the compressed air is switched off, a return spring moves the piston back to its front position.

Adjustable parameters

- **Piston diameter:** 1 ... 1000 mm (20)
- **Piston rod diameter:** 0 ... 1000 mm (8)
- **Piston Position:** 0 ... 5000 mm (0)
- **Maximum stroke:** 1 ... 5000 mm (200)
- **Mounting angle:** 0 ... 360 deg (0)
- **Parameter input:** Calculate automatically, Enter manually (Calculate automatically)
- **Reference pressure:** 0.1 ... 20 bar (6)
- **Reference velocity:** 0.1 ... 2 m/s (1)
- **Friction at dp_ref:** 1 ... 5000 N (120)
- **Break-away force at dp_ref:** 1 ... 5000 N (12)
- **Parameter input:** Calculate automatically, Enter manually (Calculate automatically)
- **Moving mass:** 0.01 ... 1000 kg (0.3)
- **Leakage:** 0 ... 10 l/(min.bar) (0)
- **Spring pressure at x=0:** 0 ... 10 MPa (0.5)
- **Spring pressure at x=x_max:** 0 ... 10 MPa (1)
- **Damping length:** 1 ... 100 mm (10)

Double acting cylinder

The piston rod of a double acting cylinder is operated by the reciprocal input of compressed air at the front and back of the cylinder. The end position damping is adjustable via two regular screws. The piston of the cylinder contains a permanent solenoid which can be used to operate a proximity switch.

Adjustable parameters

- **Piston diameter:** 1 ... 1000 mm (20)
- **Piston rod diameter:** 0 ... 1000 mm (8)
Double acting cylinder with in and out piston rod

The in and out piston rod of the double acting cylinder is controlled by alternating the compressed air input. The cushioning can be adapted with two adjustment screws.

Adjustable parameters

- **Piston diameter**: 1 ... 1000 mm (20)
- **Piston rod diameter**: 0 ... 1000 mm (8)
- **Piston Position**: 0 ... 5000 mm (0)
- **Maximum stroke**: 1 ... 5000 mm (200)
- **Mounting angle**: 0 ... 360 deg (0)
- **Parameter input**: Calculate automatically, Enter manually (Calculate automatically)
- **Reference pressure**: 0.1 ... 20 bar (6)
- **Reference velocity**: 0.1 ... 2 m/s (1)
- **Friction at dp_ref**: 1 ... 5000 N (120)
- **Break-away force at dp_ref**: 1 ... 5000 N (12)
- **Parameter input**: Calculate automatically, Enter manually (Calculate automatically)
- **Moving mass**: 0.01 ... 1000 kg (0.3)
- **Leakage**: 0 ... 10 l/(min.bar) (0)
- **Spring pressure at x=0**: 0 ... 10 MPa (0.5)
- **Spring pressure at x=x_max**: 0 ... 10 MPa (1)
- **Damping length**: 1 ... 100 mm (10)
Damping length: 1 ... 100 mm (10)

Double acting cylinder with two in and out piston rods and single trestle.

This twin cylinder has two in and out piston rods that move in parallel and that are coupled by a trestle. The construction guarantees minimum torsion when positioning and moving tools or assemblies. Moreover, coming along with the same construction height, the double piston rod conveys the double force as compared to standard cylinders.

Adjustable parameters
Piston diameter: 1 ... 1000 mm (20)
Piston rod diameter: 0 ... 1000 mm (8)
Piston Position: 0 ... 5000 mm (0)
Maximum stroke: 1 ... 5000 mm (200)
Mounting angle: 0 ... 360 deg (0)
Parameter input: Calculate automatically, Enter manually (Calculate automatically)
Reference pressure: 0.1 ... 20 bar (6)
Reference velocity: 0.1 ... 2 m/s (1)
Friction at dp_ref: 1 ... 5000 N (120)
Break-away force at dp_ref: 1 ... 5000 N (12)
Parameter input: Calculate automatically, Enter manually (Calculate automatically)
Moving mass: 0.01 ... 1000 kg (0.3)
Leakage: 0 ... 10 l/(min.bar) (0)
Spring pressure at x=0: 0 ... 10 MPa (0.5)
Spring pressure at x=x_max: 0 ... 10 MPa (1)
Damping length: 1 ... 100 mm (10)

Double acting cylinder with two in and out piston rods and double trestle.

This twin cylinder has two in and out piston rods that move in parallel and that are coupled by a double trestle. The construction
guarantees minimum torsion when positioning and moving tools or assemblies. Moreover, coming along with the same construction height, the double piston rod conveys the double force as compared to standard cylinders.

Adjustable parameters
Piston diameter: 1 ... 1000 mm (20)
Piston rod diameter: 0 ... 1000 mm (8)
Piston Position: 0 ... 5000 mm (0)
Maximum stroke: 1 ... 5000 mm (200)
Mounting angle: 0 ... 360 deg (0)
Parameter input: Calculate automatically, Enter manually (Calculate automatically)
Reference pressure: 0.1 ... 20 bar (6)
Reference velocity: 0.1 ... 2 m/s (1)
Friction at dp_ref: 1 ... 5000 N (120)
Break-away force at dp_ref: 1 ... 5000 N (12)
Parameter input: Calculate automatically, Enter manually (Calculate automatically)
Moving mass: 0.01 ... 1000 kg (0.3)
Leakage: 0 ... 10 l/(min.bar) (0)
Spring pressure at x=0: 0 ... 10 MPa (0.5)
Spring pressure at x=x_max: 0 ... 10 MPa (1)
Damping length: 1 ... 100 mm (10)

Multiple position cylinder

By connecting two cylinders of same piston diameter but different maximum stroke three piston stop positions can be realized. From the first stop position the third stop can be reached either directly or via the intermediate stop. Note that the maximum stroke of the second piston must be larger than the preceding one. When moving back, an intermediate stop requires a particular control. The shorter maximum stroke is half of the other maximum stroke.

Adjustable parameters
Piston diameter: 1 ... 1000 mm (20)
Piston rod diameter: 1 ... 1000 mm (8)
Total stroke: 1 ... 2000 mm (200)
Piston Position: 0 ... 2000 mm (0)
Intermediate position: 0 ... 1000 mm (0)
External force: -10000 ... 10000 N (0)

Linear drive with solenoid coupling

The sliding of the piston in the double rod cylinder is controlled by a reciprocal input of compressed air.

Adjustable parameters
Piston diameter: 1 ... 1000 mm (20)
Piston rod diameter: 0 ... 1000 mm (8)
Piston Position: 0 ... 5000 mm (0)
Maximum stroke: 1 ... 5000 mm (200)
Mounting angle: 0 ... 360 deg (0)
Parameter input: Calculate automatically, Enter manually (Calculate automatically)
Reference pressure: 0.1 ... 20 bar (6)
Reference velocity: 0.1 ... 2 m/s (1)
Friction at dp_ref: 1 ... 5000 N (120)
Break-away force at dp_ref: 1 ... 5000 N (12)
Parameter input: Calculate automatically, Enter manually (Calculate automatically)
Moving mass: 0.01 ... 1000 kg (0.3)
Leakage: 0 ... 10 l/(min.bar) (0)
Spring pressure at x=0: 0 ... 10 MPa (0.5)
Spring pressure at x=x_max: 0 ... 10 MPa (1)
Damping length: 1 ... 100 mm (10)

Pneumatic linear drive with shape-fitting adaptor

The sledge of the double acting cylinder without a piston rod is controlled by alternating the compressed air input. This type of linear drive conveys forces by means of a shape-fitting piston-sledge construction. The slitted cylinder prohibits the torsion of the slider.

Adjustable parameters
Piston diameter: 1 ... 1000 mm (20)
Piston rod diameter: 0 ... 1000 mm (8)
Piston Position: 0 ... 5000 mm (0)
Maximum stroke: 1 ... 5000 mm (200)
Mounting angle: 0 ... 360 deg (0)
Parameter input: Calculate automatically, Enter manually (Calculate automatically)
Reference pressure: 0.1 ... 20 bar (6)
Reference velocity: 0.1 ... 2 m/s (1)
Friction at dp_ref: 1 ... 5000 N (120)
Break-away force at dp_ref: 1 ... 5000 N (12)
Parameter input: Calculate automatically, Enter manually (Calculate automatically)
Moving mass: 0.01 ... 1000 kg (0.3)
Leakage: 0 ... 10 l/(min.bar) (0)
Spring pressure at x=0: 0 ... 10 MPa (0.5)
Spring pressure at x=x_max: 0 ... 10 MPa (1)
Damping length: 1 ... 100 mm (10)

Pneumatic linear drive with shape-fitting adaptor

The sledge of the double acting cylinder without a piston rod is controlled by alternating the compressed air input. This type of linear drive conveys forces by means of a shape-fitting piston-sledge construction. The slitted cylinder prohibits the torsion of the slider.

Adjustable parameters
Piston diameter: 1 ... 1000 mm (20)
Piston rod diameter: 0 ... 1000 mm (8)
Piston Position: 0 ... 5000 mm (0)
Maximum stroke: 1 ... 5000 mm (200)
Mounting angle: 0 ... 360 deg (0)
Parameter input: Calculate automatically, Enter manually (Calculate automatically)
Reference pressure: 0.1 ... 20 bar (6)
Reference velocity: 0.1 ... 2 m/s (1)
Friction at dp_ref: 1 ... 5000 N (120)
Break-away force at dp_ref: 1 ... 5000 N (12)
Parameter input: Calculate automatically, Enter manually (Calculate automatically)
Moving mass: 0.01 ... 1000 kg (0.3)
Leakage: 0 ... 10 l/(min.bar) (0)
Spring pressure at x=0: 0 ... 10 MPa (0.5)
Spring pressure at x=x_max: 0 ... 10 MPa (1)
Damping length: 1 ... 100 mm (10)

Air motor
The air motor transforms pneumatic energy into mechanical energy.

Adjustable parameters
External torque: -1000 ... 1000 N.m (0)
Displacement: 0.001 ... 5 l (0.1)
Friction: 0.001 ... 100 N.m.s/rad (3)
Moment of inertia: 0.0001 ... 10 kg.m^2 (0.0001)

Semi-Rotary actuator
The semi-rotary actuator is controlled by a reciprocal input of compressed air. In the end positions the semi-rotary actuator can activate switches or valves via labels.

Adjustable parameters
Initial Position: 0 ... 360 deg (0)
Rotation angle (max): 1 ... 360 deg (180)
Displacement: 0.01 ... 1000 l (0.1)
Friction: 0.01 ... 100 N.m.s/rad (0.1)
Moment of inertia: 1e-005 ... 1 kg.m^2 (0.0001)
External torque: -1000 ... 1000 N.m (0)
20.2.13 Measuring Instruments

**Manometer**

The manometer displays the pressure at its connection.

**Differential pressure gauge**

The differential pressure gauge displays the pressure difference between the adjacent pressures at the left and the right connection.

**Pressure indicator**

An optical signal is activated when the pressure at the connection to the pressure indicator exceeds the preset switching pressure.

*Adjustable parameters*

**Switching pressure:** -0.1 ... 2 MPa (0.3)

**Pressure sensor, analog**

This symbol represents the pneumatic part of the analog pressure sensor. The analog pressure sensor measures the adjacent pressure and transforms it into a proportional electrical voltage signal. In the process, only pressures in the specified pressure ranges are considered. Within this range, the pressure in the voltage range from 0 V to 10 V is represented, i.e. the minimum pressure delivers 0 V and the maximum pressure 10 V.

*Adjustable parameters*
**Analog pressure sensor**

This symbol represents the pneumatic part of the analog pressure sensor.

*Adjustable parameters*

Minimum pressure: -2 ... 2 MPa (0)

Maximum pressure: -2 ... 2 MPa (1)

Voltage at p1: -100 ... 100 V (0)

Voltage at p2: -100 ... 100 V (10)

---

**Flow meter**

The flow meter measures the flow rate. Either the current flow or the total quantity flowed can be displayed. The component image is automatically adjusted accordingly.

*Adjustable parameters*

Standard nominal flow rate: 0.1 ... 5000 l/min (100)
Standard nominal flow rate: 0.1 ... 5000 l/min (100)

Flow meter, analog

This symbol represents the pneumatic part of the analog flow meter. The analog flow meter measures the volumetric flow and transforms it into a proportional electrical voltage signal. In the process, only flow rates in the specified pressure ranges are considered. Within this range, the flow rate in the voltage range from 0 V to 10 V is represented, i.e. the minimum volumetric flow delivers 0 V and the maximum volumetric flow 10 V.

Adjustable parameters
Flow Direction: Ignore, Consider (Ignore)
Flow rate (min): -500 ... 500 l/min (0)
Flow rate (max): -500 ... 500 l/min (1000)
Voltage (q1): -100 ... 100 V (0)
Voltage (q2): -100 ... 100 V (10)
Standard nominal flow rate: 0.1 ... 5000 l/min (2000)

20.3 Electrical Components

20.3.1 Power Supply

Electrical connection 0V

0 V

0V connection of the power supply.

Adjustable parameters
Voltage: 0 ... 400 V (0)

Electrical connection 24V

24 V

24V connection of the power supply.

Adjustable parameters
Voltage: 0 ... 400 V (24)

Function generator

The function generator is a voltage source that can create constant, rectangle, sine and triangle signals. The voltage range is restricted to -10 V to +10 V. The frequency, the amplitude and the Y-offset of the signal can be set within this range. A voltage profile can be additionally specified. Data points can be set interactively with a mouse-click in the relevant graphic field. These can then be combined to a closed polygon. Alternatively, existing data points can be marked and both numeric values for the time and the corresponding voltage can be entered in the input fields. If the option “loop” is selected, then the voltage profile is started again.

Adjustable parameters
Signal type: Rectangle, Sine, Triangle, Constant, Profile (Sine)
Frequency: 0.01 ... 100000 Hz (1)
Amplitude: 0 ... 400 V (5)
y offset: -100 ... 100 V (0)
Min. Voltage: -400 ... 400 V (-30)
Max. Voltage: -400 ... 400 V (30)
Function generator

The function generator is a voltage source that can create constant, rectangle, sine and triangle signals. The voltage range is restricted to -10 V to +10 V. The frequency, the amplitude and the Y-offset of the signal can be set within this range. A voltage profile can be additionally specified. Data points can be set interactively with a mouse-click in the relevant graphic field. These can then be combined to a closed polygon. Alternatively, existing data points can be marked and both numeric values for the time and the corresponding voltage can be entered in the input fields. If the option “loop” is selected, then the voltage profile is started again.

Adjustable parameters

Signal type: Rectangle, Sine, Triangle, Constant, Profile (Sine)
Frequency: 0.01 ... 100000 Hz (1)
Amplitude: 0 ... 400 V (5)
y offset: -100 ... 100 V (0)
Min. Voltage: -400 ... 400 V (-30)
Max. Voltage: -400 ... 400 V (30)

Setpoint value card

Voltage profiles in the range -10 V to +10 V can be created using the setpoint value card. Up to 8 setpoints W1 to W8 can be specified in the voltage range -10 V to +10 V. The setpoint card requires a power supply of 24 V. The increase from the current setpoint to the next setpoint is defined using 4 ramps R1 to R4 with values between 0 s/V and 10 s/V, i.e. a low ramp value signifies a large increase, whereas a high ramp value results in a small increase. The active ramp is defined as follows: R1 by a positive increase of 0 V, R2 by a negative increase up to 0 V, R3 by a negative increase of 0 V and R4 by a positive increase up to 0 V. Three operating modes can be selected: “Wait for switching time”, “Advance setpoints” and “External control”. In operating mode “Wait for switching time” the setpoints are sequentially advanced when the preset change over time has expired. If “Advance setpoints” is selected then, upon attaining the active setpoint, the next setpoint is started.
without delay. In operating mode “External control” the selection of the active setpoint is effected by gating the inputs I1, I2 and I3 with at least 15 V. The corresponding setpoint is selected by means of the specified bit table. During the process, the internal switching time is inactive.

<table>
<thead>
<tr>
<th></th>
<th>I1=0</th>
<th>I2=0</th>
<th>I3=0</th>
</tr>
</thead>
<tbody>
<tr>
<td>W1:</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>W2:</td>
<td>I1=1</td>
<td>I2=0</td>
<td>I3=0</td>
</tr>
<tr>
<td>W3:</td>
<td>I1=0</td>
<td>I2=1</td>
<td>I3=0</td>
</tr>
<tr>
<td>W4:</td>
<td>I1=1</td>
<td>I2=1</td>
<td>I3=0</td>
</tr>
<tr>
<td>W5:</td>
<td>I1=0</td>
<td>I2=0</td>
<td>I3=1</td>
</tr>
<tr>
<td>W6:</td>
<td>I1=1</td>
<td>I2=0</td>
<td>I3=1</td>
</tr>
<tr>
<td>W7:</td>
<td>I1=0</td>
<td>I2=1</td>
<td>I3=1</td>
</tr>
<tr>
<td>W8:</td>
<td>I1=1</td>
<td>I2=1</td>
<td>I3=1</td>
</tr>
</tbody>
</table>

**Connection (electrical)**

An electric connection is a place where an electric line can be attached to. To simplify the line drawing process, a connection appears as a small circle in Edit Mode. Note that at each electric connection values for the voltage and current can be displayed.

**Line (electrical)**

A electrical line links two electrical connections. Note that a electrical connection may be a simple electrical connection or a T-junction. A electrical line causes no voltage drop, i.e., it has no electrical resistance.

**T-junction (electrical)**

A T-junction joins up to four electrical lines, thus having a single voltage potential. Note that T-junctions are introduced automatical-
ly by FluidSIM when dropping the line drawing cursor onto another line in Edit Mode.

20.3.2 Actuators / Signal Devices

**DC motor**

The DC motor transforms electrical energy into mechanical energy. DC motors produce the continual rotation through repeated changes in the direction of current. The characteristics of the 24 V DC motor relate to the motor used by the Festo Didactic conveyor belts.

*Adjustable parameters*

- **External torque:** 0 ... 20 N.m (0)
- **Idle revolution:** 10 ... 20000 1/min (75)

**Solenoid**

The solenoid converts electrical energy into mechanical energy. An iron core is pulled when a current flows through a coil. The iron core is returned to its neutral position by a spring after electrical current to the coil has been switched off. The solenoid can be used as a gate or a stopper.

*Adjustable parameters*

- **Resistance:** 1 ... 10000 Ohm (20)
Indicator light

If current flows, the indicator light is displayed in the user-defined color.

*Adjustable parameters*
- **Resistance:** 0.01 ... 1E4 Ohm (193.5)
- **Minimum voltage:** 0.1 ... 300 V (5)

Buzzer

If current flows, a flashing ring around the buzzer is shown. Moreover, if “Buzzer” is activated in the menu under **Options... Sound**, the buzzer is activated if a sound hardware is installed.

*Adjustable parameters*
- **Resistance:** 0.01 ... 1E4 Ohm (100)
- **Minimum voltage:** 0.1 ... 300 V (5)

20.3.3 Measuring Instruments / Sensors

Voltmeter

With a voltmeter, the voltage between two positions in a circuit can be measured.

*Adjustable parameters*
**Resistance:** \(1 \text{E}^{-3} \ldots 10 \text{MOhm}\) (1)

**Ammeter**

With an ammeter, the amperage (current strength) of the current between two positions in a circuit can be measured.

**Adjustable parameters**

**Resistance:** \(1 \text{E}^{-6} \ldots 1 \text{Ohm}\) (1E-6)

**Displacement encoder**

The displacement encoder is a slide potentiometer with longitudinal contact and no connecting-rods. It delivers a voltage signal that is proportional to the pick up position. The pick up position is determined by the piston stroke. The voltage range, which will depict the minimal and maximal piston position, can be defined within the range -10 V to +10 V by the user. The displacement encoder requires a power supply of at least 13 V.

**Adjustable parameters**

**Voltage (Cylinder retracted):** -10 ... 10 V (0)

**Voltage (Cylinder extracted):** -10 ... 10 V (10)

**Minimum voltage:** 0.1 ... 300 V (13)

**Resistance:** 1 ... 10000 Ohm (100)

**Pressure sensor, analog**

This symbol represents the electrical part of the Analog-pressure sensor.
Pressure sensor, analog

This symbol represents the electrical part of the Analog-pressure sensor.

Flow meter, analog

This symbol represents the electrical part of the Analog-flow meter.

Flow meter, analog

This symbol represents the electrical part of the Analog-flow meter.

20.3.4 General Switches

Break switch

General break switch that is tailored depending on the type of component that actuates it. For example, if the break switch is linked via a label to a switch-off delay relay, the break switch changes to a switch-off delay break switch in the circuit diagram.

Make switch

General make switch that is tailored according to the component that actuates it. For example, if the make switch is linked via a label to a switch-on delayed relay, the make switch changes to a switch-on delayed make switch in the circuit diagram.
Changeover switch

General changeover switch that is tailored according to the component that actuates it. For example, if the changeover switch is linked via a label to a switch-on delayed relay, the changeover switch changes to a changeover switch in the circuit diagram.

20.3.5 Delay Switches

Break switch (switch-on delayed)

Switch with delayed opening after pickup. Switch-on delayed break switches are created by using a general break switch and setting a label.

Make switch (switch-on delayed)

Switch with delayed closing after pickup. Switch-on delayed make switches are created by using a general make switch and setting a label.

Changeover switch (switch-on delayed)

Changeover switch with delayed changeover after pickup. Switch-on delayed changeover switches are created by using a general changeover switch and setting a label.
**Break switch (switch-off delayed)**

Switch with delayed closing after dropout. Switch-off delayed break switches are created by using a **general break switch** and setting a label.

**Make switch (switch-off delayed)**

Switch with delayed opening after dropout. Switch-off delayed make switches are created by using a **general make switch** and setting a label.

**Changeover switch (switch-off delayed)**

Changeover switch with delayed changeover after dropout. Switch-off delayed changeover switches are created by using a **general changeover switch** and setting a label.

### 20.3.6 Limit Switches

**Limit switch (break)**

Switch that is opened by a cam attached to the cylinder rod. The switch closes immediately when the cam has passed the switch. Limit switches are created by using a **general break switch** and setting a label.
1. **Switch with roll (break)**

Switch that is opened by a cam attached to the cylinder rod. The switch closes immediately when the cam has passed the switch. Switches with roll are created by using a *general break switch*, setting a label and selecting the switch type in the component’s properties dialog.

2. **Reed contact (break)**

Switch that is opened by a cam attached to the cylinder rod. The switch closes immediately when the cam has passed the switch. Reed contacts are created by using a *general break switch*, setting a label and selecting the switch type in the component’s properties dialog.

3. **Limit switch (make)**

Switch that is closed by a cam attached to the cylinder rod. The switch opens immediately when the cam has passed the switch. Limit switches are created by using a *general make switch* and setting a label.

4. **Switch with roll (make)**

Switch that is closed by a cam attached to the cylinder rod. The switch opens immediately when the cam has passed the switch. Switches with roll are created by using a *general make switch*, setting a label and selecting the switch type in the component’s properties dialog.
Reed contact (make)

Switch that is closed by a cam attached to the cylinder rod. The switch opens immediately when the cam has passed the switch. Reed contacts are created by using a general make switch, setting a label and selecting the switch type in the component’s properties dialog.

Limit switch (changeover)

Switch that is changed over by a cam attached to the cylinder rod. The switch changes back immediately when the cam has passed the switch. Limit switches are created by using a general changeover switch and setting a label.

Switch with roll (changeover)

Switch that is changed over by a cam attached to the cylinder rod. The switch changes back immediately when the cam has passed the switch. Switches with roll are created by using a general changeover switch, setting a label and selecting the switch type in the component’s properties dialog.

Reed contact (changeover)

Switch that is changed over by a cam attached to the cylinder rod. The switch changes back immediately when the cam has passed the switch. Reed contacts are created by using a general changeover switch, setting a label and selecting the switch type in the component’s properties dialog.
20.3.7 Manually Operated Switches

**Pushbutton (break)**

Switch that opens when actuated and closes immediately when released. In FluidSIM switches can be actuated permanently (locked) when continuing to hold down the mouse button and pushing the `Shift` key. This permanent actuation is released by a simple click on the component.

**Pushbutton (make)**

Switch that closes when actuated and opens immediately when released. In FluidSIM switches can be actuated permanently (locked) when continuing to hold down the mouse button and pushing the `Shift` key. This permanent actuation is released by a simple click on the component.

**Pushbutton (changeover)**

Switch that changes over when actuated and changes back immediately when released. In FluidSIM switches can be actuated permanently (locked) when continuing to hold down the mouse button and pushing the `Shift` key. This permanent actuation is released by a simple click on the component.

**Detent switch (break)**

Switch that opens and locks when actuated.
20.3.8 Pressure Switches

**Detent switch (make)**
Switch that closes and locks when actuated.

**Detent switch (changeover)**
Switch that changes over and locks when actuated.

**Pneumatic to electric converter**
The converter produces an electrical signal, if the preset differential pressure of the differential pressure switch is exceeded.

**Pressure switch (break)**
Switch that opens when the preset switching pressure of the pneumatic or hydraulic pressure switch is exceeded. Pressure switches are created by using a general break switch and setting a label.

**Pressure switch (make)**
The switch closes when the preset switching pressure of the pneumatic or hydraulic pressure switch is exceeded. Pressure switches are created by using a general make switch and setting a label.
Pressure switch (changeover)

The switch changes over when the preset switching pressure of the pneumatic or hydraulic pressure switch is exceeded. Pressure switches are created by using a general changeover switch and setting a label.

Pressure switch

The switch relays an electrical signal when the preset switching pressure at the pneumatic pressure switch is exceeded.

Pressure switch

The switch relays an electrical signal when the preset switching pressure at the hydraulic pressure switch is exceeded.

20.3.9 Proximity Switches

Magnetic proximity switch

Switch that closes when a solenoid is brought near by. In the Simulation Mode the proximity switch can also be actuated by clicking on it.
Inductive proximity switch

Switch that closes when the induced electro-magnetic field is changed. In the Simulation Mode the proximity switch can also be actuated by clicking on it.

Capacitive proximity switch

Switch that closes when its electrostatic field is changed. In the Simulation Mode the proximity switch can also be actuated by clicking on it.

Optical proximity switch

Switch that closes when the light barrier is interrupted. In the Simulation Mode the proximity switch can also be actuated by clicking on it.

20.3.10 Relay

The relay picks up immediately when current is supplied and drops out immediately when current is removed.

Adjustable parameters
Resistance: 1 ... 10000 Ohm (550)
Minimum voltage: 0.1 ... 300 V (20)
Relay with switch-on delay

The relay picks up after a preset time when current is supplied and drops out immediately when current is removed.

*Adjustable parameters*
- **Delay time:** 0 ... 999 s (5)
- **Resistance:** 1 ... 10000 Ohm (550)
- **Minimum voltage:** 0.1 ... 300 V (20)

Relay with switch-off delay

The relay picks up immediately when current is supplied and drops out after a preset time when current is removed.

*Adjustable parameters*
- **Delay time:** 0 ... 999 s (5)
- **Resistance:** 1 ... 10000 Ohm (550)
- **Minimum voltage:** 0.1 ... 300 V (20)

Relay counter

The relay picks up after a predefined number of current pulses has/have been counted between the connections A1 and A2. If a potential is supplied between the connections R1 and R2, the counter is reset to its predefined value. In the Simulation Mode the relay counter can also be reset by clicking on it.

*Adjustable parameters*
- **Counter:** 0 ... 9999 (5)
- **Resistance:** 1 ... 10000 Ohm (550)
- **Minimum voltage:** 0.1 ... 300 V (20)
Starting current limiter

The starting current limiter consists essentially of a relay, whose coil is situated between the connections IN and 0V, and whose switch contact is situated between the connections 24V and OUT. An electronic longitudinal controller restricts, with a switched relay contact, the current flow to the preset value for the specified duration. The starting current limiter is usually deployed in combination with the electric motor.

Adjustable parameters

Duration: 1 ... 10000 ms (0.05)
Current limit: 0.01 ... 100 A (2)

20.3.11 Controller

Comparator

The comparator is a discontinuous (switching) two-step action controller with differential gap (hysteresis). When activated, it delivers a predefined voltage signal. The switch-on value for the activation is defined by nominal value + 1/2 hysteresis and the switch-off value by nominal value - 1/2 hysteresis. The comparator requires a power supply of 24 V.

Adjustable parameters

Set value voltage: -300 ... 300 V (5)
Hysteresis: 0 ... 100 V (0)
Minimum voltage: 0.1 ... 300 V (13)
Resistance: 1 ... 10000 Ohm (100)
PID controller

The PID-Controller is a continuous controller consisting of three control elements: Proportional, Integral and Derivative. The adjustable parameters refer to the PID-Controller in the Technology Package TP111 pneumatic control TP511 hydraulic control from Festo Didactic. The output voltage restriction can be set within the range (i) -10 V to +10 V or (ii) 0 V to +10 V. In the range (i), a manipulated variable offset from -7 V to +7 V can be specified, and in the range (ii) a manipulated variable offset from 1.5 V to 8.5 V can be specified. The PID-controller requires a power supply of 24 V.

Adjustable parameters

Range selection: -10 .. 10 V, 0 .. 10 V (-10 .. 10 V)
Proportional gain: 0 ... 1000 (1)
Integral gain: 0 ... 1000 1/s (0)
Derivation gain: 0 ... 1000 ms (0)
Control quantity offset: -7 ... 7 V (0)

Status controller

The status controller is especially suitable for controlling pneumatic positioning circuits. A pneumatic positioning circuit counts to the controlled systems that can only be unsatisfactorily controlled with a standard controller. Three parameters can be attributed to the present status controller: position, speed and acceleration of the piston. The controller is therefore referred to as a “triple loop” controller. Speed and acceleration are not measured with sensors out of cost reasons. They are calculated by the controller from the differences in position. The adjustable parameters refer to the status controller in the Technology Package TP111 Closed-loop pneumatics TP511 Closed-loop hydraulics from Festo Didactic. The output voltage restriction can be set within the range (i) -10 V to +10 V or (ii) 0 V to +10 V. In the range (i), a manipulated variable offset from -7 V to +7 V can be specified, and in the range (ii) a manipulated variable offset from 1.5 V to 8.5 V can be specified. The status controller requires a power supply of 24 V.
Adjustable parameters

Range selection: -10 .. 10 V, 0 .. 10 V (-10 .. 10 V)
Deviation gain: 0 .. 10 (1)
Velocity damping: 0 .. 100 ms (0)
Acceleration damping: 0 .. 10 ms² (0)
Total gain: 0 .. 1000 (1)
Control quantity offset: -7 .. 7 V (0)

20.3.12 EasyPort/OPC/DDE Components

FluidSIM Output Port

Communication with the EasyPort-Hardware and other applications is implemented with the FluidSIM-Output.

FluidSIM Input Port

Communication with the EasyPort-Hardware and other applications is implemented with the FluidSIM-Input.

FluidSIM Output Port (analog)

Communication with the EasyPort-Hardware and other applications is implemented with the analog FluidSIM-Output.
FluidSIM Input Port (analog)

Communication with the EasyPort-Hardware and other applications is implemented with the analog FluidSIM-Input.

Multi-pin plug distributor

Communication with EasyPort hardware, as well as with other applications, is carried out with the multi-pin plug distributor. The contacts on the right-hand side (1, 3, 5, 7, 9 and 11) represent the digital outputs, and the contacts on the left-hand side (0, 2, 4, 6, 8 and 10) the digital inputs. If the “priority in case of connected hardware” switch is activated, only the input signals from the external sensors are taken into consideration, if an EasyPort has been connected.

Universal-I/O

The universal input/output-unit is connected with the multi-pin plug distributor by a label. The component is an input if the label refers to a input channel of the multi-pin plug distributor. The component is an output if the label refers to an output channel of the multi-pin plug distributor. If used as an input the universal I/O-component is a voltage source. If the correspondent input channel of the multi-pin plug distributor on high level, the universal I/O-Component delivers 24 V, otherwise 0V. If used as an output channel, the universal I/O-component sets the correspondent output channel of the multi-pin plug distributor on high level, if there is a higher voltage than 20 V.
20.4 Electrical Components (American Standard)

20.4.1 Power Supply

Electrical connection 0V (ladder)

0V connection of the power supply.

Adjustable parameters
Voltage: 0 ... 400 V (0)

Electrical connection 24V (ladder)

24V connection of the power supply.

Adjustable parameters
Voltage: 0 ... 400 V (24)

20.4.2 General Switches

Break switch (ladder)

General break switch that is tailored depending on the type of component that actuates it. For example, if the break switch is
linked via a label to a switch-off delay relay, the break switch changes to a switch-off delay break switch in the circuit diagram.

Make switch (ladder)

General make switch that is tailored according to the component that actuates it. For example, if the make switch is linked via a label to a switch-on delayed relay, the make switch changes to a switch-on delayed make switch in the circuit diagram.

20.4.3 Delay Switches

Break switch (switch-on delayed, ladder)

Switch with delayed opening after pickup. Switch-on delayed break switches are created by using a general break switch and setting a label.

Make switch (switch-on delayed, ladder)

Switch with delayed closing after pickup. Switch-on delayed make switches are created by using a general make switch and setting a label.

Break switch (switch-off delayed, ladder)

Switch with delayed closing after dropout. Switch-off delayed break switches are created by using a general break switch and setting a label.
Make switch (switch-off delayed, ladder)

Switch with delayed opening after dropout. Switch-off delayed make switches are created by using a general make switch and setting a label.

20.4.4 Limit Switches

Limit switch (break, ladder)

Switch that is opened by a cam attached to the cylinder rod. The switch closes immediately when the cam has passed the switch. Limit switches are created by using a general break switch and setting a label.

Switch with roll (break, ladder)

Switch that is opened by a cam attached to the cylinder rod. The switch closes immediately when the cam has passed the switch. Limit switches are created by using a general break switch and setting a label.

Reed contact (break, ladder)

Switch that is opened by a cam attached to the cylinder rod. The switch closes immediately when the cam has passed the switch. Limit switches are created by using a general break switch and setting a label.
Limit switch (make, ladder)

Switch that is closed by a cam attached to the cylinder rod. The switch opens immediately when the cam has passed the switch. Limit switches are created by using a general make switch and setting a label.

Switch with roll (make, ladder)

Switch that is closed by a cam attached to the cylinder rod. The switch opens immediately when the cam has passed the switch. Limit switches are created by using a general make switch and setting a label.

Reed contact (make, ladder)

Switch that is closed by a cam attached to the cylinder rod. The switch opens immediately when the cam has passed the switch. Limit switches are created by using a general make switch and setting a label.

20.4.5 Manually Operated Switches

Pushbutton (break, ladder)

Switch that opens when actuated and closes immediately when released. In FluidSIM switches can be actuated permanently (locked) when continuing to hold down the mouse button and pushing the Shift key. This permanent actuation is released by a simple click on the component.
Pushbutton (make, ladder)

Switch that closes when actuated and opens immediately when released. In FluidSIM switches can be actuated permanently (locked) when continuing to hold down the mouse button and pushing the \texttt{Shift} key. This permanent actuation is released by a simple click on the component.

Pushbutton (changeover, ladder)

Switch that changes over when actuated and changes back immediately when released. In FluidSIM switches can be actuated permanently (locked) when continuing to hold down the mouse button and pushing the \texttt{Shift} key. This permanent actuation is released by a simple click on the component.

20.4.6 Pressure Switches

Pressure switch (break, ladder)

Switch that opens when the preset switching pressure of the pneumatic or hydraulic pressure switch is exceeded. Pressure switches are created by using a \texttt{general break switch} and setting a label.

Pressure switch (make, ladder)

The switch closes when the preset switching pressure of the pneumatic or hydraulic pressure switch is exceeded. Pressure switches are created by using a \texttt{general make switch} and setting a label.
20.4.7 Relays

**Relay**

The relay picks up immediately when current is supplied and drops out immediately when current is removed.

*Adjustable parameters*

- **Resistance**: 1 ... 10000 Ohm (550)
- **Minimum voltage**: 0.1 ... 300 V (20)

**Relay with switch-on delay (ladder)**

The relay picks up after a preset time when current is supplied and drops out immediately when current is removed.

*Adjustable parameters*

- **Delay time**: 0 ... 999 s (5)
- **Resistance**: 1 ... 10000 Ohm (550)
- **Minimum voltage**: 0.1 ... 300 V (20)

**Relay with switch-off delay (ladder)**

The relay picks up immediately when current is supplied and drops out after a preset time when current is removed.

*Adjustable parameters*

- **Delay time**: 0 ... 999 s (5)
- **Resistance**: 1 ... 10000 Ohm (550)
- **Minimum voltage**: 0.1 ... 300 V (20)
20.5 Electronic components

20.5.1 Power supply

**Constant voltage source**

A constant voltage source is an ideal voltage source, which can maintain a fixed voltage that does not depend on the output current or load resistance.

*Adjustable parameters*

**Voltage:** 0 ... 400 V (12)

**Potential**

A potential is an ideal voltage source with a reference point of “ground”.

*Adjustable parameters*

**Voltage:** -400 ... 400 V (5)

**Ground**

The ground symbol defines the 0 V reference potential for all signal and operating voltages.
Three-phase alternator

A three-phase alternator supplies a combined set of three sinusoidal alternating electric voltages. The voltages are phase shifted to one another.

There are three inductors inside the alternator, spatially off-set by 120°. The magnetic field of an evenly rotating permanent magnet induces three alternating voltages, phase shifted to one another by 120°.

Adjustable parameters
Frequency: 0.01 ... 1000 Hz (50)
String voltage: 0 ... 400 V (7)

20.5.2 Passive components

Resistor

A resistor represents an ideal ohmic resistor.

Adjustable parameters
Resistance: 1e-6 ... 1E8 Ohm (100)

Resistor, temperature-dependent (NTC)

In a temperature-dependent resistor of type NTC, the resistance value falls as the temperature rises.
Adjustable parameters

Reference Resistance: 1 ... 1E6 Ohm (5208)
Reference temperature: 0 ... 100 °C (23)

Resistor, voltage-dependent (varistor, VDR)

A varistor is a voltage-dependent resistor. Resistance decreases abruptly once a particular voltage threshold is exceeded.

Resistor, light-dependent (LDR)

A light-dependent resistor consists of an amorphous semiconductor film. As the incidence of light is increased, electrical resistance is decreased, due to the internal photoelectric effect.

Adjustable parameters

Light intensity: 0 ... 100 % (50)
Min. Resistance: 1 ... 1E6 Ohm (183)
Max. Resistance: 1 ... 1E6 Ohm (34324)

Potentiometer

A potentiometer is an electrical resistance component with mechanically adjustable (by means of rotation or sliding) resistance values. It provides three connectors and is mainly used as a continuously adjustable voltage divider.

Adjustable parameters

Potentiometer position: 0 ... 100 % (0)
Resistance: 1E-4 ... 100000 kOhm (1)
Capacitor

A capacitor is a passive electrical component which is able to store electric charge (and therefore electric energy.)

The capacitor in its basic configuration consists of two electrically conductive surfaces, the electrodes. The electrodes are separated through an insulating material, the so-called dielectric. The separation of the two electrodes is so narrow, that the electrical forces are able to act through the insulating material.

If a constant voltage is applied to the connectors of an uncharged capacitor, a current flows for a short period of time and one of the electrodes is positively charged, the other one negatively. This electric charge is retained when the capacitor is disconnected from the voltage source. If charge resp. electric flow is extracted from the capacitor, its voltage drops again.

**Adjustable parameters**

**Capacity:** 1E-4 ... 1E7 μF (1)

Capacitor, polarized

A capacitor is a passive electrical component which is able to store electric charge (and therefore electric energy.)

The capacitor in its basic configuration consists of two electrically conductive surfaces, the electrodes. The electrodes are separated through an insulating material, the so-called dielectric. The separation of the two electrodes is so narrow, that the electrical forces are able to act through the insulating material.

If a constant voltage is applied to the connectors of an uncharged capacitor, a current flows for a short period of time and one of the electrodes is positively charged, the other one negatively. This electric charge is retained when the capacitor is disconnected from the voltage source. If charge resp. electric flow is extracted from the capacitor, its voltage drops again.
In contrast to the **non-polarized capacitor**, the polarized capacitor is only suitable for DC and for AC voltage that does not reverse the capacitor's polarity. The advantage of the polarized capacitor is the much higher capacity for the same form factor compared to non-polarized capacitors.

*Adjustable parameters*

**Capacity:** $1 \times 10^{-4} \ldots 1 \times 10^{7}$ µF (1)

---

**Inductor**

An inductor is a passive electrical component which is able to create induction voltage.

An inductor, also called an inductance, in its basic configuration consists of wire coils. The inductor provides two terminals.

If an inductor is connected to a DC voltage, then an exponentially increasing current will flow.

*Adjustable parameters*

**Inductance:** $1 \times 10^{-3} \ldots 1 \times 10^{4}$ mH (100)

---

**Transformer**

The transformer consists of two transformer coils. If an alternating voltage is applied to one transformer coil, an alternating voltage is induced in the second coil. In the no-load case, the value of the new voltage when compared to the originally supplied voltage, follows the ratio of the number of windings of the corresponding coils to each other.

*Adjustable parameters*

**Inductance 1:** $1 \times 10^{-3} \ldots 1 \times 10^{4}$ mH (595)

**Inductance 2:** $1 \times 10^{-3} \ldots 1 \times 10^{4}$ mH (66)

**Coupling coefficient:** $0 \ldots 1$ (1)
20.5.3 Semiconductor

**Diode**

A diode allows an electric current to pass in only one direction, while in the opposite direction it acts as an insulator. Therefore, diodes have a forward direction and a reverse direction.

*Adjustable parameters*
- **Reference voltage**: 0.1 ... 100 V (0.7)
- **Reference current**: 1 ... 1000 mA (12.6)
- **Resistance in series**: 0.001 ... 1000 Ohm (0.0341512)
- **Saturation current**: 1e-15 ... 100 A (7.02767e-9)

**Light-emitting diode, LED (red)**

A light-emitting diode (LED) is a semiconductor component that emits light and has the electrical characteristics of a diode. If an electric current is flowing through the diode in forward direction, it emits light with a wavelength that depends on the semiconductor material and doping.

To make the use of the LED as a simple signal indicator easier, FluidSIM allows setting the color independent of the physical characteristics.

*Adjustable parameters*
- **Reference voltage**: 0.1 ... 100 V (2)
- **Reference current**: 1 ... 1000 mA (25)
- **Resistance in series**: 0.001 ... 1000 Ohm (12.5)
- **Saturation current**: 1e-15 ... 100 A (1e-12)
Light-emitting diode, LED (green)

A light-emitting diode (LED) is a semiconductor component that emits light and has the electrical characteristics of a diode. If an electric current is flowing through the diode in forward direction, it emits light with a wavelength that depends on the semiconductor material and doping.

To make the use of the LED as a simple signal indicator easier, FluidSIM allows setting the color independent of the physical characteristics.

Adjustable parameters
Reference voltage: 0.1 ... 100 V (2.2)
Reference current: 1 ... 1000 mA (30)
Resistance in series: 0.001 ... 1000 Ohm (12.5)
Saturation current: 1e-15 ... 100 A (1e-12)

Light-emitting diode, LED (blue)

A light-emitting diode (LED) is a semiconductor component that emits light and has the electrical characteristics of a diode. If an electric current is flowing through the diode in forward direction, it emits light with a wavelength that depends on the semiconductor material and doping.

To make the use of the LED as a simple signal indicator easier, FluidSIM allows setting the color independent of the physical characteristics.

Adjustable parameters
Reference voltage: 0.1 ... 100 V (4)
Reference current: 1 ... 1000 mA (35)
Resistance in series: 0.001 ... 1000 Ohm (12.5)
Saturation current: 1e-15 ... 100 A (1e-12)
Light-emitting diode, LED (green/red)

A light-emitting diode (LED) is a semiconductor component that emits light and has the electrical characteristics of a diode. If an electric current is flowing through the diode in forward direction, it emits light with a wavelength that depends on the semiconductor material and doping.

In this component, a green and a red LED with opposite polarity are connected in parallel. Depending on the current direction either the green or red LED lights up. Connected to alternating current with a frequency higher than about 30 Hz, the human eye cannot recognize the blinking and it seems as if both LEDs are lit simultaneously.

Adjustable parameters
Reference voltage: 0.1 ... 100 V (2)
Reference current: 1 ... 1000 mA (25)
Resistance in series: 0.001 ... 1000 Ohm (12.5)
Saturation current: 1e-15 ... 100 A (1e-12)

Zener diode

Because of their characteristics, zener diodes are used in numerous circuitries for stabilizing and limiting electrical voltages. In forward direction, they behave like normal diodes. In reverse direction, resistance drops off considerably after the voltage exceeds a certain value, the so-called breakdown voltage. The voltage does not increase by much after that, even if the electric current is increased.

Adjustable parameters
Reference voltage: 0.1 ... 100 V (0.7)
Reference current: 1 ... 10000 mA (9)
Saturation current: 1e-10 ... 100 A (1e-10)
Z-voltage: 0.1 ... 100 V (10)
Current at Z-voltage: 1 ... 10000 mA (15)
NPN transistor

An NPN transistor is a bipolar junction transistor (BJT). It is operated with an electric current and is used for switching and amplifying signals without using mechanically moving parts.

There are two types of BJTs: NPN and PNP. The letters indicate the order and doping type of the layers. Essentially, a BJT constitutes two p-n junctions connected together in series (like that of a p-n diode.) The three terminals are called collector (C), base (B) and emitter (E).

Adjustable parameters
Forward current gain: 0.1 ... 1000 (120)
Reverse current gain: 0.1 ... 1000 (1)
Saturation current: 1e-16 ... 1e-3 A (8.81138e-14)
Forward early voltage: 1 ... 1000 V (64)

PNP transistor

An PNP transistor is a bipolar junction transistor (BJT). It is operated with an electric current and is used for switching and amplifying signals without using mechanically moving parts.

There are two types of BJTs: NPN and PNP. The letters indicate the order and doping type of the layers. Essentially, a BJT constitutes two p-n junctions connected together in series (like that of a p-n diode.) The three terminals are called collector (C), base (B) and emitter (E).

Adjustable parameters
Forward current gain: 0.1 ... 1000 (230)
Reverse current gain: 0.1 ... 1000 (1)
Saturation current: 1e-16 ... 1e-3 A (8.81138e-14)
Forward early voltage: 1 ... 1000 V (64)
**N-channel JFET**

A junction gate field-effect transistor (JFET) controls the electrical current that flows through the channel between the source and drain terminals, by using a junction between the gate connector and the channel.

Depending on doping type, JFETs are classified in two types: n-channel and p-channel JFETs.

*Adjustable parameters*
- **Threshold voltage:** -10 ... 0 V (-3)
- **Transconductance parameter:** \(10^{-6} \ldots 10^{-1} \text{ A/V}^2\) (1.304e-3)
- **Channel-length modulation parameter:** \(10^{-6} \ldots 10^{-1} \text{ 1/V}\) (2.25e-3)

**P-channel JFET**

A junction gate field-effect transistor (JFET) controls the electrical current that flows through the channel between the source and drain terminals, by using a junction between the gate terminal and the channel.

Depending on doping type, JFETs are classified in two types: n-channel and p-channel JFETs.

*Adjustable parameters*
- **Threshold voltage:** 0 ... 10 V (2.5)
- **Transconductance parameter:** \(10^{-6} \ldots 10^{-1} \text{ A/V}^2\) (1.271e-3)
- **Channel-length modulation parameter:** \(10^{-6} \ldots 10^{-1} \text{ 1/V}\) (0.04)

**N-Kanal-MOSFET-Transistor**

A metal-oxide-semiconductor field-effect transistor (MOSFET) is an active component with at least three terminals (electrodes): G
(gate), D (drain) and S (source.) In some designs, an additional B (bulk) terminal is fed to the outside. Usually though, B is connected internally with S.

Like other field-effect transistors, a MOSFET acts as a voltage-controlled resistor, meaning that the voltage between gate and source can be used to change the resistance (and thus the electrical current) between drain and source by several orders of magnitude.

Depending on doping type, MOSFETs are classified in two types: n-channel and p-channel MOSFETs.

**P-channel MOSFET**

A metal-oxide-semiconductor field-effect transistor (MOSFET) is an active component with at least three terminals (electrodes): G (gate), D (drain) and S (source.) In some designs, an additional B (bulk) terminal is fed to the outside. Usually though, B is connected internally with S.

Like other field-effect transistors, a MOSFET acts as a voltage-controlled resistor, meaning that the voltage between gate and source can be used to change the resistance (and thus the electrical current) between drain and source by several orders of magnitude.

Depending on doping type, MOSFETs are classified in two types: n-channel and p-channel MOSFETs.

**Unijunction transistor**

Similar to a normal bipolar transistor, a unijunction transistor (UJT) provides three terminals. Unlike a bipolar transistor however, but similar to a diode, there is only one p-n-junction. In practice, it acts like a controlled diode that, despite the constant polarity of the applied voltage, can be made conductive or non-conductive. Because of the two B terminals, the UJT is also called “double-base diode.”
If a small, positive control voltage against B1 is applied to the emitter, nothing happens at first. If the control voltage is raised further and a certain potential is reached, the UEB1 voltage will collapse abruptly, and at the same time the emitter current will jump to a certain value. In a sense, the UJT “has been fired.” This behavior is very similar to a thyristor. A UJT is cleared when the emitter current falls below a certain threshold.

**Thyristor**

A thyristor is a semiconductor component built from four or more semiconductor films of varying levels of doping. Thyristors are switchable components, meaning they are non-conductive in their initial state and can be switched on through a small gate current. After a thyristor has been switched on, it remains conductive even if there is no gate current. A thyristor can be switched off by falling below a minimum current, the so-called holding current.

**DIAC**

A DIAC (diode for alternating current) is an electronic component with only two terminals. DIACs are also referred to as “symmetrical trigger diodes.” The junction between the terminals only becomes conductive after a breakover voltage has been reached.

The DIAC’s bidirectional layout allows for the switching of alternating voltages. As soon as the voltage on the terminals (A1 and A2) rises above a certain threshold voltage, it will switch through and the p-n junction becomes conductive. Resistance will rise rapidly again after the current that is flowing through the DIAC falls below a certain value (the holding current.) This procedure is referred to as “resetting the DIAC.”

**TRIAC**

In principle, A TRIAC (triode for alternating current) represents an inverse-parallel connection of two thyristors. This allows for switch-
ing of alternating current, while a single thyristor can switch in only one direction and thus acts - in its on-state - like a diode.

A TRIAC has a control terminal G (gate) and two main terminals MT1 and MT2, where MT2 is usually directly connected to the casing. In order to be able to use a single control terminal for both thyristors, TRIACs contain two firing, or helper, thyristor junctions, so that it can be flipped into the low-impedance state by using a positive and negative control pulse.

20.5.4 Measuring instruments / Sensors

Ohmmeter

An ohmmeter is an electrical test instrument which is used to measure the electrical resistance of components.

Adjustable parameters
 Voltage: 0.1 ... 9 V (9)
 Series resistor: 1 ... 1000 kOhm (47)

Oscilloscope

An oscilloscope is an electronic test instrument that allows visual observation of one or more electrical voltages and their change over time on a display device. The oscilloscope displays a history graph, usually as a two-dimensional graph, where the horizontal x-axis represents time and the vertical y-axis the voltages that are to be displayed. The resulting image is called an oscillogram.

Adjustable parameters
 Resistance: 1E-3 ... 10 MOhm (10)
20.6 Digital Components

20.6.1 Constants and Terminals

Digital input

Digital inputs are designated with an “I”. In FluidSIM digital components can be used inside and outside a digital module. If a digital input is used inside a digital module, you can determine the input connector of the digital module in question with which the digital input shall be linked by allocating a number “I1” to “I16”. If there is an analog signal of more than 10V at the chosen input of the digital module, the digital input is set to “Hi”. If a digital input is used outside a digital module, there is an additional analog electrical connection at the digital input. If there is an analog signal of more than 10V at this connection, the digital input is set to “Hi”. As an alternative you can click on the digital input with the left mouse button in order to set it to “Hi”. Another click resets the value to “Lo”.

Digital output

Digital outputs are designated with an “Q”. The output connects a digital signal through from its input to its output. In FluidSIM digital components can be used inside and outside a digital module. If a digital output is used inside a digital module, you can determine the output connector of the digital module in question with which the digital output shall be linked by allocating a number “Q1” to “Q16”. If the status of the digital output is “Hi”, a potential of 24V is set at the corresponding output connector of the digital module. If a digital output is used outside a digital module, there is an
additional analog electrical connection at the digital output. If the status of the digital output is “Hi”, a potential of 24 V is set at this connection.

**Memory bits**

Memory bits are designated with a “M”. Memory bits are virtual outputs, with a value at their output analog to that at their input. When the simulation start is activated, you can define by using the property dialog box if the output Q shall be set to “Lo” or to “Hi”, independent on the input value. After the simulation start the value at the output is set to the value of the input.

*Adjustable parameters*

Initial state = Hi: ... (false)

**Logic level HI**

At the output Q you have the logic level “Hi”.

**Logic level LO**

At the output Q you have the logic level “Lo”.

**Connection (digital)**

An digital connection is a place where a digital line can be attached to. To simplify the line drawing process, a connection appears as a small circle in Edit Mode. Note that at each digital connection its level “Lo” / “Hi” can be displayed.
Line (digital)

A digital line links two digital connections. Note that a digital connection may be a simple digital connection or a T-junction.

T-junction (digital)

A T-junction joins up to four digital lines, thus having a single digital level. Note that T-junctions are introduced automatically by FluidSIM when dropping the line drawing cursor onto another line in Edit Mode.

20.6.2 Basic Functions

AND

The output Q of the AND is only “Hi” when all inputs are “Hi”, that is, if they are closed. If an input pin of this module is not connected, its status is automatically “Hi”.

Edge-triggered AND

The output Q of the edge-triggered AND is only “Hi” when all inputs are “Hi” and if at least one input was “Lo” in the previous cycle. If an input pin of this block is not connected, its status is automatically “Hi”.
NAND (AND not)

The output Q of the NAND is only “Lo”, when all inputs are “Hi”, that is, if they are closed. If an input pin of this block is not connected, its status is automatically “Hi”.

NAND With Edge Evaluation

The output Q of the NAND with edge evaluation is only “Hi”, if at least one input is “Lo” and if all inputs were “Hi” in the previous cycle. If an input pin of this block is not connected, its status is automatically “Hi”.

OR

The output Q of the OR is only “Hi”, if at least one input is “Hi”, that is, if it is closed. If an input pin of this block is not connected, its status is automatically “Lo”.

NOR (OR not)

The output Q of the NOR is only “Hi” when all inputs are “Lo”, that is, if they are switched off. As soon as any input is switched on (status “Hi”), the output of the NOR is set to “Lo”. If an input pin of this block is not connected, its status is automatically “Lo”.

XOR (exclusive OR)

The output Q of the XOR is “Hi”, if the inputs are nonequivalent. If an input pin of this block is not connected, its status is automatically “Lo”.

© Festo Didactic GmbH & Co. KG • Art Systems GmbH • FluidSIM
20.6.3 Special Functions

**Digital module**

The digital module is used for a compact embedding of a digital switching circuit into an electropneumatic or electrohydraulic circuit. The digital module offers 8 (16) electrical inputs and outputs, which transfer their states to its digital switching circuit in the inner part. Therefore, the digital switching circuit does not need much space in the electropneumatic or electrohydraulic circuit for the display of the digital module as a rectangle with a total number of 18 (34) connections. By making a double-click with the left mouse button on the digital module you come to the digital circuit in the inner part of the module. A new window opens. It shows the digital circuit and can be handled in the usual way. The standard configuration in the inner part of a new inserted digital module is a row with 8 (16) inputs and 8 (16) outputs each. They correspond to the inputs and outputs of the module in the electropneumatic or electrohydraulic circuit. In order to be able to test the digital circuit during the setup, it can be simulated separated from the electropneumatic or electrohydraulic circuit. As soon as the processing window of the digital module is closed or the original circuit window is put into the foreground, the previously effected changes in the digital circuit are automatically adopted into the digital module of the electropneumatic or electrohydraulic circuit. Inside the digital module only digital components can be inserted. Furthermore, an encapsulating of additional digital modules inside a module is not possible. However, you can use several digital modules in one electropneumatic or electrohydraulic circuit. Please note that the digital circuit inside a digital module only works correctly if corre-
sponding potentials are set at the electrical power supply units of the module (+24 V) and (0 V).

**On delay**

An output with on delay is not switched on until a specified time has expired. When the status of input Trg changes from “Lo” to “Hi”, the on delay time starts. If the status of input Trg is “Hi” at least for the duration of the configured time, the output Q is set to “Hi” on expiration of this time. The output follows the input with on delay. The time is reset, when the status of the input changes again to “Lo” before the time has expired. The output is reset to “Lo”, when the status at the input is “Lo”.

*Adjustable parameters*

**Delay time:** 0 ... 100 s (3)

**Off delay**

The output is not reset until a configured time has expired. When the input status turns to “Hi”, the output Q is switched instantaneously to “Hi”. If the status at input Trg changes from “Hi” to “Lo”, the off delay starts. After expiration of the configured time, the output is reset to “Lo” (off delay). When the input Trg is switched on and off again, the off delay restarts. The input R (Reset) is used to reset the delay time and the output before the configured time has expired.

*Adjustable parameters*

**Delay time:** 0 ... 100 s (3)
On/Off delay

An output with on/off delay is switched on after a specified time and is reset on expiration of a second specified time. As soon as the status at input Trg changes from “Lo” to “Hi”, the configured on delay time starts. If the status at input Trg remains “Hi” at least for the duration of the configured time, the output Q is set to “Hi” on expiration of the on delay time (the output follows the input on delayed). If the status at input Trg changes again to “Lo”, before the configured on delay time has expired, the time is reset. When the status at input returns to “Lo”, the configured off delay time starts. If the status at the input remains “Lo” at least for the duration of the configured off delay time, the output is set to “Lo” on expiration of that time (the output follows the input off delayed). If the status at the input returns to “Hi” before this time has expired, the time is reset.

Adjustable parameters
On delay time: 0 ... 100 s (3)
Off delay time: 0 ... 100 s (6)

Retentive On delay

A specified time starts after an input pulse. The output is set on expiration of this time. As soon as the status at the input Trg changes from “Lo” to “Hi”, the specified time starts. After expiration on the configured time, the output Q is set to “Hi”. Further switching actions at input Trg have no influence on the running time. The output and the time are only reset to “Lo” when the status at input R is “Hi”.

Adjustable parameters
Delay time: 0 ... 100 s (3)
Latching Relay

Input S sets output Q. Another input R resets the output Q. A latching relay is a simple logic memory. The output value depends on the input states and on the previous output status.

Pulse Relay

A short oneshot at the input is used to set and reset the output. Output Q status is toggled at every “Lo” to “Hi” transition of the status at input Trg, that is, the output is switched on or off. Use input R to reset the pulse relay to initial state, that is, the output is set to “Lo”.

Wiping Relay - Pulse Output

An input signal generates a signal of specified length at the output. The output status is switched to “Hi” after the input Trg is set to “Hi”. The configured time is started at the same time and the output remains set. After expiration of the configured time, the output is reset to the status “Lo” (pulse output). If the input status changes from “Hi” to “Lo” before the specified time has expired, also the output follows immediately with a with a “Hi” to “Lo” transition.

Adjustable parameters
Delay time: 0 ... 100 s (3)

Edgetriggered Wiping Relay

An input signal generates a signal of specified length at the output (retriggering). The output status is switched to “Hi” after the input Trg is set to “Hi”. The configured time is started at the same time. After expiration of the configured time, the output Q status is reset.
to “Lo” (pulse output). If the input status changes again from “Lo” to “Hi” (retriggering), before the specified time has expired, the time is reset and the output remains switched on.

**Adjustable parameters**

**Delay time:** 0 ... 100 s (3)

---

**Timer Switch**

With the timer switch you can create timer switches referring to days, weeks and years. Upon reach of the specified on-transition time, the output Q of the timer switch is set to “Hi” and upon reach of the specified off-transition time to “Lo”. If you have chosen the option “repeat all”, the on and off transition is repeated each time according to the specified repetition time.

**Adjustable parameters**

**On time:** 0 ... 1000 s (10)
**Off time:** 0.1 ... 1000 s (30)
**Repeat every:** 0.1 ... 1000 s (60)

---

**Up/Down Counter**

Depending on the configuration of the input Dir, an internal value is counted up or down through an input pulse. The output is set when the configured count value is reached. With every status change at the input Cnt from “Lo” to “Hi”, the internal counter is increased (Dir = “Lo”) or decreased (Dir = “Hi”) by one unit. If the internal counter is equal or larger compared to the specified value, the output Q is set to “Hi”. You can use the reset input R to reset the internal count value and the output to “Lo”. As long as R=“Hi”, also the output is “Lo” and the pulses at input Cnt are not counted.

**Adjustable parameters**

**Counter:** 0 ... 9999 (5)
### Symmetric Clock Generator

A timing signal with a configurable period is given at the output. Via the duration of the pulses you can determine the length of the on and off times. Via the input En (for Enable) you can switch on the clock generator, that is, the clock generator sets the output to “Hi” for the duration of the pulse, subsequent the output to “Lo” for the duration of the pulse and so on, until the input status is “Lo” again.

*Adjustable parameters*

| Impulse time: | 0.0005 ... 100 s (0.5) |

### Asynchronous Pulse Generator

The pulse profile of the output can be changed via the configurable pulse duration and pulse pause duration. It is possible to invert the output with input INV. The input INV only negates the output, if the block is enabled via EN.

*Adjustable parameters*

| Impulse time: | 0.01 ... 100 s (3) |
| Impulse pause time: | 0.01 ... 100 s (1) |

### Frequency Threshold Trigger

The output is switched on and off depending on two frequencies which can be specified. The threshold trigger measures the signals at input Fre. The pulses are captured across a measuring interval which can be specified. If the frequency measured within the measuring interval higher than the input frequency, the output Q is switched to “Hi”. Q is switched again to “Lo” when the measured frequency has reached the value of the output frequency or if it is lower.

*Adjustable parameters*
On frequency: 0.01 ... 9999 Hz (6)
Off frequency: 0.01 ... 9999 Hz (2)
Time interval: 0.001 ... 100 s (5)

20.7 GRAFCET Elements

20.7.1 GRAFCET

Step

The name of a step may contain the following characters: “0-9”, “a-z”, “A-Z” and the underscore “_”. You can select from the following seven different step types: simple step, initial step, macro-step, macro input, macro output, enclosing step and initial enclosing step. Furthermore, you can give the step an activation link.

Transition

You can give a transition a name, which is shown to the left of the transition in brackets. Entering a transition condition is supported by buttons for special symbols (AND, OR, NOT, falling edge, rising edge, delay). Via Variable... you can select an existing GRAFCET variable from a list. Alternatively to the formula, you can show a descriptive text. To do this, you have to select the option “Display description instead of formula”. In the “Connection ID/target information” field, you can enter a step that links to the transition's output without having to draw a connecting line. You can select an existing step from a list.
Action

There are three types of action: assignations, allocations and compulsory commands. For assignations and allocations, you can enter a variable or an output, whose value is changed by the action. The name of a variable may contain the following characters: “0-9”, “a-z”, “A-Z” and the underscore “_”. For a “conditional action” or an “action on event”, you can enter a condition that has to be fulfilled before the action is executed. Entering a condition is supported by buttons for special symbols (AND, OR, NOT, falling edge, rising edge, delay). Via Variable... you can select an existing GRAFCET variable from a list. Alternatively to the formula, you can show a descriptive text. To do this, you have to select the option “Display description instead of formula”. For an allocation (“action on activation”, “action on deactivation” and “action on event”), you can enter any term whose value is to be allocated to the action variable. Entering a term is supported by buttons for special symbols (AND, OR, NOT, falling edge, rising edge). Via Variable... you can select an existing GRAFCET variable from a list. Alternatively to the formula, you can show a descriptive text. To do this, you have to select the option “Display description instead of formula”. For a “compulsory command”, you can enter the name of the partial GRAFCET directly or select an existing partial GRAFCET from a list. You can also enter the relevant steps directly or select them from a list of existing steps. You have to separate the step names with commas. You can select the special commands “*” and “INIT” using the relevant buttons.

Synchronization

You can connect synchronizations like other FluidSIM components. However, they do not initially have any connections. You always have to draw connecting lines to a synchronization. The corresponding connections are then generated automatically.
Partial GRAFCET

If you want to allocate GRAFCET elements to a specific partial GRAFCET, place the partial GRAFCET frame over the relevant GRAFCET part and give it a name. The preceding “G” is not part of the name that you have to enter; it is added automatically by FluidSIM and shown at the bottom left of the partial GRAFCET frame. You can alter the size of the partial GRAFCET frame by dragging its edges with the mouse. For the partial GRAFCET to function correctly, it is important that all its elements are completely within the frame and that the frame does not overlap with any foreign elements or other frames.

GRAFCET-PLC-Component

The GRAFCET-PLC component is similar to a SPS controller, whose behavior is described by a GRAFCET. For more information, please read the section GRAFCET-PLC-Component.

GRAFCET-PLC-Component

The GRAFCET-PLC component is similar to a SPS controller, whose behavior is described by a GRAFCET. For more information, please read the section GRAFCET-PLC-Component.

GRAFCET-I/O

The GRAFCET I/O component is used to link the GRAFCET variables with the electrical part of a circuit. You can enter eight GRAFCET input variables and eight GRAFCET output variables into the GRAFCET I/O component. The actions' variables serve as outputs. The inputs can be the allocations and conditions of actions and transitions. If a potential is created as the input of the GRAFCET I/O component, the corresponding variable is set to “1”. If an output
variable has a value other than “0”, a potential of 24V is created at the corresponding output of the GRAFCET I/O component.

20.8 Miscellaneous

20.8.1 Miscellaneous

Connection (mechanical)
A mechanical connection constitutes a place holder for the label of a valve solenoid. To simplify clicking, a mechanical connection appears as a small circle in Edit Mode.

Valve solenoid
The valve solenoid switches the valve. By means of a label the valve solenoid can be linked to a valve that is solenoid operated.

Adjustable parameters
Resistance: 1 ... 10000 Ohm (90)
Minimum voltage: 0.1 ... 300 V (20)

Proportional valve solenoid, position controlled
In FluidSIM the proportional valve solenoid is coupled to the respective continuous directional valve with the help of a label. The required slide position is predetermined via a voltage signal. The valve slide distance is position controlled. The control and amplifier component is integrated in the valve.
Adjustable parameters

Current (max): 0.01 ... 10 A (0.1)
Resistance: 1 ... 10000 Ohm (128)
Minimum voltage: 0.1 ... 300 V (20)

Proportional amplifier, 1-channel

The amplifier is used to control proportional valves. For this purpose, nominal values (voltage signals) from 0 V to +10 V are transformed into the necessary magnetic current for the proportional valves. In FluidSIM the amplifier is coupled to the respective valve with the help of a label. The maximum current at the amplifier output is hereby automatically adjusted in relation to the coupled valve. A step current relative to the maximum current can be specified, in order to compensate the positive overlap of proportional valves. The amplifier requires a power supply of 24 V.

Adjustable parameters

Current (max): 0.01 ... 30 A (0.1)
Jump current: 0 ... 25 % (0)
Resistance: 1 ... 10000 Ohm (100)
Minimum voltage: 0.1 ... 300 V (20)

Proportional amplifier, 2-channel

The amplifier is used to control proportional valves with two magnets. For this purpose, nominal values (voltage signals) from -10 V to +10 V are transformed into the necessary magnetic current for the proportional valves. Output A is gated at a nominal value between 0 V and -10 V, output B between 0 V and -10 V. In FluidSIM the amplifier is coupled to the respective valve with the help of two labels. The maximum currents at the amplifier outputs are hereby automatically adjusted in relation to the coupled valves. A step current relative to the maximum current can be specified, in order to compensate the positive overlap of proportional valves. The amplifier requires a power supply of 24 V.
Adjustable parameters
Current (max): 0.01 ... 30 A (0.1)
Jump current: 0 ... 25 % (0)
Resistance: 1 ... 10000 Ohm (100)
Minimum voltage: 0.1 ... 300 V (20)

Valve solenoid (ladder)

The valve solenoid switches the valve. By means of a label the valve solenoid can be linked to a valve that is solenoid operated.

Adjustable parameters
Resistance: 1 ... 10000 Ohm (90)
Minimum voltage: 0.1 ... 300 V (20)

Distance rule

The distance rule is a device for attaching switches at the cylinder. The labels at the distance rule define links to the actual proximity switches or limit switches in the electrical circuit.

Status indicator

In Edit Mode, the status indicator is automatically displayed at those components that are actuated in the circuit's initial position.

Cam switch

In Edit Mode, the cam switch is automatically displayed at those mechanically operated way valves that are actuated in the circuit's initial position.
Text

The concept of text components in FluidSIM gives the user a way in which to describe components in diagrams, assign identification texts, or to provide commentary on the diagram. The text and the appearance of text components can be customized to the user’s liking.

State diagram

The state diagram records the state quantities of important components and depicts them graphically.

Terminal assignment diagram

The terminal assignment diagram list automatically creates terminals in the electrical circuit and displays the allocation in a table.

Functional diagram

With the functional diagram editor, functional diagrams e.g. displacement-step diagrams can be created.

Parts list

The parts list component creates from the components of a circuit diagram a table, which contains for each component its designation and its description.
Rectangles are graphic primitives, which can also be used within circuit diagrams.

**Ellipse**

Ellipses are graphic primitives, which can also be used within circuit diagrams.

**Bitmap**

In FluidSIM images, as with all other components and objects, can be inserted, positioned, moved, rotated and mirrored. In addition, images such as rectangles and ellipses are freely scalable.
Chapter 21

Beside the creation and simulation of electro-fluidic circuit diagrams, FluidSIM also supports teaching basic knowledge. This knowledge is presented in the form of texts, overview pictures, sectional views, exercises, and educational films. Functions that realize the selection of this instruction material are found under the Didactics menu. One group of these functions refers to information about single, selected components. Another group of functions refers to ordered overviews of the didactics material, allowing the selection of an interesting topic. Finally, it is also possible to select and link together arbitrary topics into so-called Presentation.

Appendix Component Library and Didactics Material offer a complete and concise summary of the instructional material in FluidSIM.

The following sections contain a description of the functions found under the Didactics menu.

21.1 Information about Single Components

The first three entries under the Didactics menu refer to selected components and are context sensitive. More precisely:

When a component in the current circuit diagram window is selected, or all selected components are of the same type, the menu entry Component description will be enabled.

21.1.1 Component Descriptions

All components possess a page with a technical description. This page contains the diagram symbol for the component according to
the DIN standard (“Deutsche Industrienorm”), a textual description of the component’s function, the designations of the connections, and a listing of the adjustable parameters along with their value ranges.

You will find a photograph of the real-life part provided for most components. In the case that a component cannot exist singularly in a real system, FluidSIM displays a photo of the assembly group that this component belongs to. Examples for such components include the indicator light, relays, switches, and the electrical power supply. Components, that do not exist in reality, simply have no photo. Examples include the text component and the distance rule.

→ Select the one-way flow control valve and click on the menu item [Component description] under the [Didactics] menu.

The following page opens:
One-way flow control valve

The one-way flow control valve is made up of a throttle valve and a check valve. The check valve stops the flow from passing in a certain direction. The flow then passes through the throttle valve. The cross-section of the throttle is adjustable via a regular screw. In the opposite direction the flow can pass through the check valve.

**Adjustable parameters**

- **Opening level:** 0 ... 100 %
- **Standard nominal flow rate:** 0.1 ... 5000 l/min

**Related Topics**

- [94] One-way flow control valve
- [95] Throttle valve
- Throttle valve
- Piloted operated check valve

Figure 21/1: Technical page of the one-way flow control valve
One-way flow control valve

The setting of the one-way flow control valve is set by means of a rotary knob. A check valve is located parallel to the throttle valve. Please note that by the rotary knob no absolute resistance value can be set. This means that, in reality, different throttle valves can generate different resistance values despite identical settings.

Adjustable parameters

- **Opening level:** 0 ... 100 % (100)
- **Hydraulic resistance:** 1e-7 ... 100 MPa\(\cdot\)min\(\cdot\)m² (0.01)

Figure 21/2: Technical page of the throttle check valve

Under the heading *Related topics*, but also when appropriate in the component description, cross references for related instruction material and components are defined. By clicking on a cross-reference, the related page will automatically be displayed.

21.1.2 Component Illustrations

Component illustrations provide useful information relating a component’s function. This may include a sectional view of the component, but also illustrations of the component’s usage within a circuit diagram. For several components, their sectional view can be animated like a cartoon.
Select an air motor (4/2-way hand-lever valve in case of hydraulic version) and click on Component description under the Didactics menu.

The following dialog box appears:
Figure 21/3: Page component-specific topics

**Component library**

- **Air motor**

  The air motor transforms pneumatic energy into mechanical energy.

<table>
<thead>
<tr>
<th>Adjustable parameters</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Displacement:</td>
<td>0.01 ... 1000 Liter (0.1)</td>
</tr>
<tr>
<td>Friction:</td>
<td>0.01 ... 100 N<em>m</em>s/rad (3)</td>
</tr>
<tr>
<td>Moment of inertia:</td>
<td>0.00001 ... 1 kg*m2 (0.0001)</td>
</tr>
<tr>
<td>External torque:</td>
<td>-1000 ... 1000 Nm (0)</td>
</tr>
</tbody>
</table>

**Related Topic**

[35] Air motor
4/2-way hand-lever valve (i)

In normal position the connection P is open to B and A to T. When manually actuated the valve is set to parallel position.

This valve is derived from a configurable 4-way valve. You find this valve in the component library "Frequently used Way Valves", under the Library menu.

Related Topics
- Configurable 4/2 way valve
- 4/2-way hand-lever valve (i)
- 4/2-way valve, two pistons (i)

Figure 21/4: Dialog box with component-specific topics

Please click the line with the relevant topic [35] Air motor (hydraulics: [104] 4/2-way valve, two pistons (i)).

The following picture appears:
Figure 21/5: Function illustration of a air motor

Devices which transform pneumatic energy into mechanical rotary motion, with the possibility of continuous motion. They are categorized into the groups of piston motors, sliding vane motors, gear motors and turbines.

Discuss applications for the air motor.
The 4/2-way valve has two working ports A and B, a supply port P and a tank port T. The supply port is always connected to one of the working ports, while the second working port is routed to the tank. In the normal position, there is flow from P to B and from A to T.

In contrast to valves with three pistons, 4/2-way valves with two pistons do not require a leakage-off port (see topic 106).

Figure 21/6: Function illustration of a 4/2-way valve

Often it is easier to understand the functional nature of a component, when its behavior is visualized through the use of animation. For this reason, several components possess different sectional views showing the component at different states. These sectional views can be animated in much the same way as a flip book.

Please mark a quick-exhaust valve (hydraulics: 3-way pressure reducing valve) and click the menu option Didactics Component description to open the window with the component description. Now click the link with the function illustration [87] quick exhaust valve (hydraulics: [84] 3-way pressure reducing valve).

This function illustration can be animated.

Click on or Execute Start to start the animation.
An animation can be “frozen” with \( \square \) or by clicking on \( \text{Pause} \) in the \( \text{Execute} \) menu. \( \square \) or \( \text{Execute} \ \text{Stop} \) stops an animation, whereas \( \square \) or \( \text{Execute} \ \text{Reset} \) restarts an animation.

21.2 Selecting Didactics Material from a List

The entries \( \text{Tutorial ‘Simulating with FluidSIM’} \), \( \text{Component Library} \) and \( \text{Didactics Material} \) under the \( \text{Didactics} \) menu present the didactics material of FluidSIM organized in the form of overview pages. From these pages topics can be chosen and viewed independently of the current window and possibly selected components.

21.2.1 Tutorial

Below this menu option you can launch the tutorial “Simulating with FluidSIM”, which contains a variety of interesting experiments and an excursus. By means of these useful examples you will get to know the possibilities of simulating with FluidSIM. Furthermore, for the most important components the mathematic models used in FluidSIM are also described.

\[ \Rightarrow \text{Please click the menu option} \ \text{Didactics} \ \text{Tutorial ‘Simulating with FluidSIM’} \ \text{to open the tutorial.} \]
Introduction

Welcome to the tutorial: “Simulating with FluidSIM—Pneumatic”

The aim of the tutorial is to provide an insight into the simulation of electro-pneumatic systems using the simulation program FluidSIM and practical examples. It is assumed that you are familiar with the basic functions and operation of FluidSIM.
21.2.2 Component Library

Below the menu option Component Library you will find descriptions and photos of all FluidSIM-components.
Click a menu option Didactics Component Library to open the help pages of the component library.
Figure 21/9: Component Library (Pneumatics)
21.2.3 Didactics Material

FluidSIM, alongside the tutorial and the component reference, contains further didactics material particularly useful for group work. Moreover, here you will find educational films, provided you have copied them onto the hard disk during the installation. If you haven't installed the film files, you may choose a chapter via the menu option [Didactics] EducationalFilm... to view the applicable film from the included video-CD.

→ Click the menu option [Didactics] [Didactics Material] to open the overview of the didactics material.
Figure 21/11: Didactics Material (Pneumatics)
21.3 Presentations: Combining Instructional Material

Sometimes you may want to examine a topic from different angles or combine individual topics into a lesson. For this purpose FluidSIM offers the concept entitled Presentation... There are a number of already prepared presentations, which can be found on the FluidSIM installation disks. However, editing presentations or creating new presentations is also possible with FluidSIM. All presentations can be found under Presentation... in the Didactics menu.
→ Click on **Didactics Presentation...**.

The following dialog box appears:
Figure 21/13: Dialog box for selecting and editing presentations (Pneumatics)
Figure 21/14: Dialog box for selecting and editing presentations (Hydraulics)

- **Presentations**
  - This field contains a list of already created presentations.

- **New presentation...**
  - Clicking on “New Presentation...” opens a second dialog box for the creation of a new presentation.

- **Edit presentation...**
  - Clicking on “Edit presentation...” opens a second dialog box to begin editing a presentation.

- **Preview**
  - When the “Preview” setting is activated, the picture that pertains to the selected presentation appears underneath the topics list.

  → Click on “New Presentation” to open the following dialog box.
Figure 21/15: Dialog box for editing presentations (Pneumatics)
Figure 21/16: Dialog box for editing presentations (Hydraulics)

Description

In this text field a short description of the presentation can be entered. This text may consist of up to 128 characters and will appear with the other presentations, the next time the presentation dialog box is opened.

Available topics

This field contains a list of all available topics dealing with “Pneumatics basics”, “Hydraulics basics”, “Working principle”, and “Exercise”. Moreover, there exist two pictures that can be used to announce a refreshment and a lunch break respectively. A double click on a line in the “Available Topics” list inserts this line in the “Selected topics” list above the highlighted bar. In this way a presentation can be created or altered. Moreover, a user can integrate his own circuit diagrams, DXF files, BMP- and WMF-picture files, or even multimedia files such as sounds or video clips. To do so, click on “User file”: A dialog box opens that allows for the selection of the desired data source on the file system.
This field contains a list of topics chosen for the current presentation.

Clicking on “Add” is the same as double clicking a line in the “Available topics” list: The selected line in “Available topics” will be inserted in the “Selected topics” list.

Clicking on “Delete” deletes the selected line of the “Selected topics” list.

When the “Preview” setting is activated, the picture that pertains to the selected topic appears underneath the respective list.

Within both topics lists the highlighted bar can be moved using the arrow keys. Maybe it will be necessary to click and select the list you want to work with. After creating a new presentation and closing the dialog box by clicking on “OK”, FluidSIM asks you to name the presentation file. Presentation files have the extension .shw and are located in the subdirectory shw under the installation directory.

### 21.4 Extended Presentations in the Microsoft PowerPoint Format

The hydraulics version of FluidSIM contains an additional large set of presentations written in the Microsoft PowerPoint Format. To use these presentations, PowerPoint must not be installed on your PC since FluidSIM installs the necessary viewer at its installation time.

→ Click on Extended Presentation... to open the dialog box of a presentation.
Figure 21/17: Selection of an extended presentation

→ Select the item “Actuators” to open the related presentation in full screen mode.

Most of the topics form a picture sequence, which can be viewed in a single-step manner using the left mouse button or the spacebar.

→ Move two single steps forward in the current presentation.
When clicking the right mouse button, a context menu is opened by which, among others, the presentation can be closed or particular pictures picked out. The files of the extended presentations are in the subdirectory `ppx` of the FluidSIM installation. You can add new PowerPoint presentations on your own by copying the related files (format: “ppt” or “pps”) into the `ppx` directory. Like the other didactics material (illustrations of function, component photos, circuit drawings, educational films, etc.), the PowerPoint presentations can be linked and used within presentations (cf. Section Presentations: Combining Instructional Material).
Chapter 22

This chapter provides a comprehensive listing of those parts of the didactics material in FluidSIM that are not covered by chapter The Component Library “The Component Library”. Basically, this material consists of the components' behavior illustrations, the animations, the exercises, and the educational films, which all can be activated under the Didactics menu. The subsequent sections are arranged thematically. The icon indicates that an animation exists for the related topic. The last section gives an overview of the educational films.

22.1 Basics

[1] Pneumatic system structure and signal flow

A pneumatic system can be broken down into a number of levels representing the hardware and signal flow from the energy source to the actuating devices.

→ The topic highlights the relationship between signals, levels and elements in a pneumatic system.

[2] Circuit diagram and pneumatic elements

Circuit diagrams are drawn in such a way that signals, for instance energy or potential values, are oriented downwards. The numbering of the components is derived from their respective function in the diagram.

→ The topic highlights the various levels in a circuit.
[3] Designating the elements, circuit diagram

This topic shows the relationship between levels in a circuit.

[4] Designating the elements, circuit diagram

The figures contrasts the position of a roller lever valve (initial position: actuated by the cylinder) in a circuit diagram and its physical setup in a plant.

[5] Designating the elements, circuit diagram

The figures contrasts the position of a roller lever valve (initial position: not actuated) in a circuit diagram and its physical setup in a plant.

[6] Designating the elements, circuit diagram

All elements should be shown in the circuit diagram in the initial position. If valves have been drawn with an actuated initial position, this fact is indicated for example by an arrow, or for a limit switch, by drawing the cam.

→ Explain the differences between the following terms: initial position and starting position.
22.2 Supply elements

[7] Symbols of energy and supply components, supply and service equipment

The Symbols are from the DIN ISO 1219 “Circuit symbols for fluidic power components and systems”. The symbols for the energy supply system can be represented as individual components or as combined elements.

→ Compare the symbols with the combined symbols (topic 8).

[8] Symbols of energy and supply components, combined symbols

In general where specific technical details are to be given, such as requirements for non-lubricated air or micro-filtering, the complete detailed symbol should be used. If a standard and common air supply is used for all components, the simplified symbols can be used.

→ Compare the symbols with the previous topic.

[9] Air service unit

The filter is normally combined with the pressure regulator and lubricator to form a compressed air service unit. The selection of the correct filter plays an important role in determining the quality and performance of the control system which is to be supplied with compressed air.

→ Refer to topic 10 for construction of the filter.
[10] Compressed air filter

The compressed air passes through a baffle plate in the filter bowl. The air is rotated, and the heavier dust particles and water droplets are spun by centrifugal force against the inner wall of the filter bowl and run down the wall of the housing. The air which has been precleaned then passes through the filter element.

→ The bowl must be emptied daily to prevent overflow.


The lower the dew point the more the water will condense and reduce the amount entrapped in the air. Using refrigeration methods, it is possible to achieve dew points of between 2°(C) and 5°(C).

→ Compare with adsorption and absorption drying.

[12] Air drying, absorption

Absorption drying is a purely chemical process. The moisture in the compressed air forms a compound with the drying agent in the tank. This causes the drying agent to break down; it is then discharged as a fluid at the base of the tank. The drying agent must be replenished at a rate which is dependent on the compressed air temperature, water content and flow rate.

→ Compare with adsorption drying.

The lowest equivalent dew points (down to -90°C) can be achieved by means of adsorption drying. In this process, the compressed air is passed through gel and the water is deposited on the surface, i.e. it is adsorbed.

→ Compare with absorption drying.

[14] Air lubricator

As a rule, the compressed air which is generated should be dry and free of oil. For some components, lubricated air is damaging, for others, it is undesirable, and for power components, it may in certain cases be necessary. Lubrication of the air should therefore be limited to the sections of the plant which require it.

→ Refer to picture of topic 9 for general arrangement.

[15] Air lubricator

Air passing through the lubricator causes a pressure drop between the oil reservoir and the upper part of the lubricator. This pressure difference forces the oil upwards through a tube and it then drips into a nozzle which can be seen through an inspection glass. The oil is atomized and carried along by the air stream.

→ It is necessary to carefully adjust the oil discharge rate.
[16] Pressure regulator with vent hole

The purpose of the regulator is to maintain the operating pressure (secondary pressure) virtually constant regardless of fluctuations in the line pressure (primary pressure). When air consumption increases, the operating pressure drops and the spring opens the valve. If the pressure on the secondary side increases considerably, the center-piece of the diaphragm then opens and the compressed air can flow to atmosphere through the vent holes in the housing.

[17] Delivery

Due to the pressure losses in the system, the compressor should deliver between 650 and 700 kPa (6.5 and 7 bar). The operating components of the system should be regulated to between 500 and 600 kPa (5 and 6 bar) for economic use. The receiver is used to even out fluctuations in pressure due to demand. The drainage points are at the lowest points.

→ The gradient should be away from the compressor.

[18] Piston compressor

The piston compressor is widely used. Multi-stage compressors are required for compressing to high pressure. The drawn in air is compressed by the first piston, cooled and then compressed further by the next stage.
Discuss the advantages and disadvantages of piston compressors.

[19] Axial flow compressor

Flow compressors produce large volumes of air at small increases in stage pressure. The air is accelerated by the blades of the compressor but there is only a small increase in pressure.

→ The kinetic energy is converted to pressure energy.

[20] Distribution

For ease of maintenance, repair or extension of the air network, it is advisable to sub-divide the network into individual sections by means of shut-off valves. Branches with T-pieces and manifolds with plug-in couplings make it possible to supply additional consuming devices as the need arises.

→ To discharge condensate, the pipes should be inclined 1-2% and include water separators at low points.

[21] Absolute pressure and atmospheric pressure

Absolute pressure is calculated from the absolute zero mark. Below atmospheric pressure the pressure is in the vacuum range. The
atmospheric pressure fluctuates but is approximately 100 kPa (1 bar).

→ Gauge pressure is normally that component above atmospheric pressure and is not an absolute value.

22.3 Actuators

[22] Symbols for actuators, linear actuators

The single acting cylinder and the double acting cylinder form the basis for design variations. The use of cushioning to reduce loads on the end caps and mountings during deceleration of the piston is important for long-life and smooth operation.

→ Refer to topics 25 - 30 for construction details.

[23] Symbols for actuators, rotary motion

Rotary actuators are divided into continuous motion and limited angle of rotation. The air motor is normally a high speed device with either fixed or adjustable speed control. Units with limited angle of rotation are fixed or adjustable in angular distance. The rotary actuator may be cushioned depending on the load and speed of operation.

→ Refer to topics 34 and 35 for construction details.

[24] Control of a single acting cylinder

The position rod of a single acting cylinder is to move forward when air is applied. A valve is to create a signal when a push-button is released. The animation shows the operation of the push-button and the extension of the cylinder. Pressure is maintained on the
piston until the push-button is released. The next stage shows retraction of the cylinder and the release of air via the exhaust port of the 3/2-way valve.

→ The topic can be used as an intermediate stage for explanation of the related symbols.

[25] Single acting cylinder

The cylinder requires one pneumatic connection and an exhaust port. The exhaust port must be clear of obstructions to ensure that the piston is not restricted by the air passage. A filter is normally fitted to the exhaust port.

→ Discuss the importance of selecting the size of the cylinder to match the load conditions.

[26] Single acting cylinder

With single acting cylinders, compressed air is applied on only one side of the piston face. The other side is open to atmosphere. The cylinders can perform work in only one direction. The return movement of the piston is effected by a built-in spring or by the application of an external force. The spring force returns the piston to its start position with a reasonably high speed under no load conditions. The stroke is limited by the natural length of the spring. Single acting cylinders are therefore only available in stroke lengths of up to 100 mm.

→ Compare the construction with the double acting type. Discuss the spring size and return speed.

[27] Control of a double acting cylinder

The 4/2-way directional control valve is suitable for the control of a double acting cylinder. Normal practice is to use the 5/2-way valve.
The cylinder motion is controlled by air in both directions of motion. The animation shows the advance and retraction sequences as separate phases. The fully advanced position is related as long as the push-button is actuated.

→ The topic can be used as an intermediate stage for explanation of the related symbols.

[28] Double acting cylinder

Double acting cylinders are used particularly when the piston is required to perform a work function in both directions of motion. The construction is in general similar to the single acting cylinder.

→ Refer to the large number of variants, which result from the different designs, materials, etc.

[29] Double acting cylinder

The first sequence shows the piston rod advancing. The second stage the retraction. The speed of advance and retraction are fairly constant under no load conditions.

→ Point at the positions of cylinder body, piston cover, cylinder cover, piston seal, piston rod, bearing bush, and scraper ring.

[30] Cushioned double acting cylinder

If large masses are moved by a cylinder, cushioning is used in the end positions. Before reaching the end position, a cushioning piston interrupts the direct flow of air to the outside. For the last
part of the stroke the speed is slowed to reduce impact on the cylinder.

→ Discuss the different concept of throttling the exhausting air by means of one-way flow control valve.

[31] Cylinder seals

The various piston seal arrangements are shown. The double-cup seal materials used are, Perbunan for -20°(C) to +80°(C) Viton for -20°(C) to +190°(C) Teflon for -80°(C) to +200°(C).

→ Emphasize correct temperature range selection for reliability.

[32] Mounting arrangements for cylinders

The type of mounting is determined by the manner in which the cylinder is to be fitted to a machine or fixture. The cylinder can be designed with a permanent type of mounting if it does not have to be altered at any time. Alternatively, the cylinder can utilize adjustable types of mounting which can be altered by using suitable accessories on the modular construction principle.

→ Discuss application examples for each type of mounting.
[33] **Tandem double acting cylinder**

This design features the characteristics of two double acting cylinders forming a single unit. This increases the effective piston area of the unit for high force applications. It is suitable for applications where a large force is required but the cylinder diameter is restricted.

→ Compare the double acting cylinder in topic 29.

---

[34] **Semi-rotary actuator**

The rotary actuator is compact with high torque ratings. The force is transmitted to the drive shaft by a rotary vane. The range of angular movement is adjustable with end stops. The angle can be adjusted between $0^\circ$ and $180^\circ$. The adjustable stop system is separate to the rotary vanes. This allows force to be absorbed by the stop blocks. At the end positions, impacts are cushioned by elastic cushioning rings.

→ Discuss the mounting arrangements for the actuator. Discuss applications for the rotary actuator.

---

[35] **Air motor**

Devices which transform pneumatic energy into mechanical rotary motion, with the possibility of continuous motion. They are categorized into the groups of piston motors, sliding vane motors, gear motors and turbines.
Discuss applications for the air motor.

22.4 Directional control valves

[36] Symbols for directional control valves (1)

The directional control valve is represented by the number of ports and the number of switching positions. Additional information is required to fully describe the symbol function, including the methods of actuation and special flow path characteristics.

→ Compare the full range of symbols for directional control valves.

[37] Symbols for directional valves (2)

Each valve position is shown as a separate square. The designation of the ports is important when interpreting the circuit symbols and the valve as fitted to the physical system.

→ Compare the full range of symbols for directional control valves.

[38] Designation of connections

The designations for directional control valves are in accordance with ISO 5599-3, edition 1990. Prior to this a lettering system was utilized.

→ Discuss the examples and emphasize the numbering systems.
The methods of actuation of pneumatic directional control valves is dependent upon the application. The methods of actuation include manual, mechanical, pneumatic, electrical and combined.

Discuss the actuation and return actuation methods.

When applied to a directional control valve, consideration must be given to the method of initial actuation of the valve and also the method of return actuation. They are both shown on the symbol either side of the position boxes. There may also be additional methods such as manual overrides separately indicated.

Discuss the actuation and return actuation methods.

A spring forces a hemisphere against the valve seat preventing the compressed air from flowing from the air connection 1 to the working line 2. Initially port 1 is blocked and the output port 2 is exhausted through the stem of the plunger. Actuation of the valve plunger causes the sealing element to be forced away from the seat. In doing this, the opposing force of the reset spring and that generated from the compressed air must be overcome. The air supply is then open to the output side of the valve and a signal is generated.

Compare the symbol and the valve construction. Compare the construction of the disc seat valve.
[42] 3/2-way valve, ball seat

The ball seat valve is compact with the possibility of fitting various types of actuating heads. The limitation for directly actuated valves is the force required to operate the stem. If the flow rate required is very high, the valve ball will have a large working area. This requires a large operating force. This limits the size of valve for this design.

→ The load on the stem is dependent on the size of valve.

[43] 3/2-way valve, disc seat, normally closed

The valve is constructed on the disc seat principle. The response time is short and a small movement results in a large area being available for air flow. Valves of the single disc seat type are non-overlapping. Using this topic, discuss the term “blocked normal position”. When operated slowly, there is no loss of air. A 3/2-way valve with flow blocked between ports 1 and 2 in the normal condition, is referred to as a normally closed valve. The valves are insensitive to dirt and thus have a long service life. Explain the term “non-overlapping” with this figure and the animation.

→ The animation sequence shows the operation of the 3/2 way valve. The first sequence describes the actuation and the supply of a signal from 1 to 2. The second sequence shows the closing of the disc seat and the release of air from 2 to 3 which exhausts to atmosphere.
[44] 3/2-way valve, disc seat, normally open

A 3/2-way valve with free flow between ports 1 and 2 in the normal condition, is referred to as normally open. Valves can be operated manually, mechanically, electrically or pneumatically. The configuration of the valve head is changed to meet the actuation method. Upon operation of the actuating stem, the disc seat is sealed and air supply port 1 is blocked. The air at port 2 is exhausted to atmosphere via port 3.

→ Note the change of construction compared to the normally closed valve topic 43.

[45] 3/2-way valve, single pilot, normally closed

The pneumatically operated 3/2-way valve is operated by a directly acting signal at port 12. This is referred to as a single pilot valve since there is only one control signal and the valve has a spring return. A signal is applied at port 12 and the valve plunger is moved against the reset spring. The connections 1 and 2 are then interconnected creating a signal 2. The pressure at port 12 must be sufficient to move the disc against the supply pressure.

→ Note the pneumatic symbol shows direct application of the signal at port 12. Compare the construction of the valve to the 3/2-way disc seat valve topic 43.

[46] 3/2-way valve, single pilot
The valve ports are labeled to ensure the correct connections are made. The pilot valve is available in a range of sizes depending upon the flow rate.

→ Note the need to designate and label the ports.

[47] 3/2-way valve, internal pilot, roller operated

This type of valve can be used as either a normally closed valve or as a normally open valve by exchanging connections 1 and 3 and rotating the actuating head 180 degrees. The force required on the roller lever is small due to the pilot operation.

→ Show the requirements to alter the valve configuration.

[48] 3/2-way valve, internal pilot, normally closed

To avoid high actuating force, mechanically controlled directional valves can be equipped with an internal pilot valve to assist opening. A small hole connects the pressure connection 1 and the pilot valve. If the roller is operated, the pilot valve opens. Compressed air flows to the main piston and actuates the main valve disc.

→ The symbol shows the roller operating a pilot signal.

[49] 4/2-way valve, disc seat

The valve is robust. Two stems directly operate the disc seats. The load required to move the stems may be large for high flow rate valves.
→ Compare the construction with the 3/2-way valve.

[50] 4/2-way valve, disc seat

The 4/2-way valve has four ports and two positions. A disc seat 4/2-way valve is similar in characteristic to the combination of two 3/2-way valves, one valve normally closed and the other normally open. The plungers can be operated by an auxiliary mounted device such as a roller lever or push-button. When the two plungers are actuated simultaneously, 1 to 2 and 4 to 3 are closed by the first movement. By pressing the valve plungers further against the discs, opposing the reset spring force, the passages between 1 to 4 and from 2 to 3 are opened.

→ Show the similarities to the 3/2-way valve construction. Discuss the valve overlap.

[51] 4/3-way valve, mid-position closed

The 4/3-way valve has four ports and three positions. An example of the 4/3-way valve is the plate slide valve with hand or foot actuation. By turning two discs, channels are interconnected with one another.

→ Compare the symbol with the valve construction.
5/2-way valve, longitudinal slide valve

The valve can be mounted onto a common sub-base for supply and exhaust air. This compact arrangement also ensures adequate flow is available to the valve.

Discuss the DIN ISO 5599/1 standard for 5 port valves.

5/2-way valve, longitudinal slide valve

The 5/2-way valve has five ports and two positions. The 5/2-way valve is used for the control of cylinders primarily as a final control element. In pneumatic valves, the gap between spool and housing bore should not exceed 0.002–0.004 mm. The valve is shown here with pilot pressure applied at port 12. To avoid damage to seals, the ports can be distributed around the circumference of the housing. The actuation travel is considerably larger than with seat valves. The valve is shown here with pilot pressure at 14.

Discuss the load conditions on the O-rings. Compare the construction with the disc seat valve.

5/2-way valve, suspended disc seat

A method of sealing the 5/2-way valve is to use a suspended disc seat with a relatively small switching movement. The disc seat seal connects the 1 port to either the 2 port or the 4 port. The 5/2-way double air pilot valve has the characteristic of memory control. The last switched position is retained until a new switching position is initiated by a unique pilot signal from the opposite side. There are
two manual override buttons to manually operate valve spool. The animation shows the two switched positions. The air pilot signals are applied from both directions. The manual override operations are also shown. The manual overrides are used to manually actuate the valve or initialize the valve position.

→ Compare the suspended disc seat construction to the longitudinal slide principle topic 53. Explain the working principle of the manual override button and its related diagram symbol.

[55] 5/3-way valve

The 5/3-way valve has five ports and three positions. Signals applied at ports 14 or 12 operate the valve. If the valve is not actuated it is closed in the mid-position. After actuation via a pilot signal at port 14 air flows from 1 to 4. Port 2 exhausts via 3. After actuation via a pilot signal at port 12 air flows from 1 to 2. Port 4 exhausts via port 5.

→ Show the three valve positions.

[56] Memory circuit, 5/2-way bistable valve

The piston rod of a double acting cylinder is to advance when a 3/2-way push-button valve is actuated. The cylinder is to remain extended until a second push-button is actuated. The cylinder is to then return to the initial position. The speed of the cylinder is to be adjustable in both directions.

→ Discuss the memory characteristic of the bistable valve.
[57] **Memory circuit, 5/2-way bistable valve**

Signals initiated by the push-button signaling devices can be of short or pulse duration due to the memory characteristics of the bistable valve. Upon operation of push-button 1S1, a 1-signal is generated at port 14 of the control valve 1V3. The 5/2-way memory valve switches and the cylinder 1A1 advances.

→ The circuit is shown at the first operation of the button.

[58] **Memory circuit, 5/2-way bistable valve**

When the push-button 1S1 is released, the signal at port 14 is exhausted. The valve 1V3 remains in the current position. The last position is retained until a new input signal is given.

→ Compare the sequence of operation.

[59] **Memory circuit, 5/2-way bistable valve**

The valve 1V3 remains in the current position until the push-button 1S2 is operated. The cylinder then retracts. The cylinder remains retracted until a new signal is generated at port 14 by the valve 1S1.

→ Compare the sequence of operation.

[60] **Memory circuit, 5/2-way bistable valve**

The flow control valves throttle the exhausting air in both directions of piston motion. The cylinder remains retracted until a start signal is generated at port 14 by the valve 1S1. The 5/2-way valve remains in the current position with air supplied continuously to the return side of the cylinder.

→ Discuss the situation when both 1S1 and 1S2 are operated together.
[61] Direct control, unactuated

A single acting cylinder of 25 mm diameter is to clamp a component when a push-button is pressed. As long as the push-button is operated, the cylinder is to remain in the clamped position. Since the cylinder is the only working element or actuator in the circuit, it is designated 1A1. The final control element that advances the cylinder is designated 1S1.

→ Discuss the circuit layout standard, numbering and operation. Note the circuit is shown in the initial state.

[62] Indirect control (unactuated)

A large diameter single acting cylinder is to extend upon operation of a push-button valve. The valve is situated at a remote and distant position. The cylinder is to retract once the remote push-button is released. The signal at the pilot port 12 remains as long as the push-button is held down. This is an indirect push-button control of the cylinder. If the push-button is released, the spring return closes the 3/2-way valve and removes the pilot signal at the control valve.

→ Discuss the circuit layout standard, numbering and operation. Note the circuit is shown in the initial state.

[63] Exercise: Direct control of a double acting cylinder – Problem

A double acting cylinder is to advance when a push-button is operated. Upon release of the push-button, the cylinder is to retract. The cylinder is of small bore (25 mm diameter) requiring a small flow rate to operate at the correct speed.

[64] Exercise: Direct control of a double acting cylinder – Solution

The control valve for a double acting cylinder can be selected as a 4/2 way or a 5/2 way valve. In this case, since the cylinder has a
small capacity, the operation can be directly controlled by a push-button control valve with spring return. On operating the push-button, the air passes through the valve from port 1 to the port 4 and advances the piston rod. On release of the push-button, the valve spring returns the control valve to its initial position and the cylinder retracts. Air escapes from the cylinder via the exhaust port. Since the cylinder is the only working element or actuator in the circuit, it is designated 1A1. The final control element that advances the cylinder is designated 1S1.

[65] Exercise: Direct control of a double acting cylinder – Note

→ If the push-button is pressed for a very short period, the cylinder only partially advances and then retracts, since the spring resets the control valve as soon as the push-button is released. In order to achieve full extension in this case, the push-button must be held down until the cylinder moves fully forward.

[66] Exercise: Indirect control of a double acting cylinder – Problem

A double acting cylinder is to advance when a push-button is operated. Upon release of the push-button the cylinder is to retract. The cylinder is 250 mm diameter and consumes a large volume of air. For controlling cylinders at high speed or of large diameter large size control valves should be used. The operating force to actuate the valve may be relatively large and in this case indirect control is preferable.

[67] Exercise: Indirect control of a double acting cylinder – Solution

Operating valve 1S1 supplies a pilot signal to port 14 of control valve 1V1. This generates a 1-signal at the outlet 4 and the cylinder advances. If the push-button is released the return signal is supplied via port 2 of valve 1V1 and the return air is vented via exhaust port 5. If the push-button is released before the cylinder fully ad-
vances, the cylinder immediately returns to the initial position. The control valve requires a sustained signal for it to remain operated.

[68] Exercise: Indirect control of a double acting cylinder – Note

→ The supply line can be short since the control valve can be mounted close to the cylinder. The other advantage is that the signal element (i.e. push-button 3/2 way valve) can be small, as it only provides a signal to operate the control valve and is not required to operate the cylinder directly.

22.5 Shutoff valves

[69] Non-return valves

The non-return or check valve will open due to the supply pressure exceeding the resistance of the spring (if fitted) and the inertia of the valve. The non-return valve is the basis for development of many combined components. The shuttle valve, two pressure valve and quick exhaust valve incorporate features of the non-return valve.

→ Indicate the valves that include the non-return function.

[70] Non return valve

Non return valves can stop the flow completely in one direction. In the opposite direction the flow is free with a minimal pressure drop due to the resistance of the valve. The one-way blocking action can be effected by cones, balls, plates or diaphragms.

→ Discuss the relationship between pressure to open and the spring size.
[71] Two pressure valve

The two pressure valve has two inputs 1 and one output 2. The two pressure valve is used mainly for interlocking controls, safety controls, check functions or logic operations. The application of a signal at a single input produces no pressure at output 2. If pressure is applied at both inputs 1, the signal which is last applied passes to the output 2. The two pressure circuit is equivalent to two input signaling devices in series, i.e. one after the other.

→ Refer to topics 72 - 74 for the circuit example. Discuss the advantages of the shown solution against series connection.

[72] Circuit: Two pressure valve I

The piston rod of a double acting cylinder is to advance when a 3/2-way push-button valve and a roller lever valve are actuated. If either of the actuations is released, then the cylinder is to return to the initial position.

→ Discuss the circuit layout standard, numbering and operation.

[73] Circuit: Two pressure valve II

The inputs of the two pressure valve is connected to the outputs of the two 3/2-way valves. Upon operation of the push-button 1S1, a signal is generated at the left side of input 1 of the two pressure valve. The signal is blocked by the two pressure valve. No output is given at 2.

→ Discuss the logic function “AND”. Refer to the following topic for additional conditions.
[74] Circuit: Two pressure valve III

If the roller lever valve 1S2 is also operated, then the two pressure valve will produce a 1-signal at port 2 which operates the control valve, via pilot port 1V1, against the return spring and the cylinder advances.

→ Compare this topic to topic 73.

[75] Exercise: The logic AND function, the two pressure valve – Problem

A transfer station removes a product from a conveyor belt. If the product is detected as present and if the operator presses the push-button, the pick-up cylinder 1A1 advances. The product is sensed by a 3/2 way roller lever valve. Upon release of the push-button, cylinder 1A1 is to retract to the initial position. The operating condition for the pick-up cylinder to advance is a logic AND function between the product sensor and the operator push-button. Therefore if a two pressure valve is used to combine the signals from the sensor and push-button the logic conditions can be met.

[76] Exercise: The logic AND function, the two pressure valve – Solution

The two pressure valve is connected between the outlet lines of the two 3/2 way valves. Operating the push-button, a 1-signal is generated at left input 1 of the two pressure valve. Once the part is sensed as present, the 3/2 way roller valve generates a second 1-signal, this time at the right input 1 of the two pressure valve. A signal is passed through to port 2. This signal operates the control valve pilot signal 14 against the spring return and the cylinder advances. If either of the two signals created by the 3/2 way valves is set to zero, the two pressure valve will release the 14 signal back through the exhaust port of one of the 3/2 way valves. The return spring in the control valve then switches the control valve to the initial position. The control valve outlet port 2 is active and with
outlet port 4 exhausted to atmosphere the cylinder retracts. The control valve can be a 4/2 or 5/2 way valve and can be sized to suit the flow rate required for the cylinder speed.

[77] Exercise: The logic AND function, the two pressure valve – Note

Discuss also the advantages of the shown solution against series connection.

[78] Shuttle valve

This non-return element has two inputs 1 and one output 2. If compressed air is applied to one input, the valve seat seals off the opposing input and the air flows to the output 2. Note the similarity in construction to the two pressure valve.

→ Compare the two pressure valve construction topic 71.

[79] Circuit: Shuttle valve I

If the condition states that either of two push-buttons are to advance a cylinder, the inexperienced designer may attempt to use a junction for the output signals of 1S1 and 1S2. The circuit is not functional due to the escape of air through the exhaust ports of the valves.

→ Discuss the sequence of circuits for the shuttle valve.

[80] Circuit: Shuttle valve II

If push-button 1S1 is operated, the air escapes to atmosphere through the exhaust port of 1S2. The air takes the easiest path and the pressure will be very low and inadequate to operate the valve 1V1. This is an inadequate solution to the problem. A shuttle valve is required.
→ Compare the topic with the previous one.

[81] Circuit: Shuttle valve III

The piston rod of a double acting cylinder is to advance when either of two 3/2-way push-buttons are actuated. If both push-buttons are then released, the cylinder is to retract. The shuttle valve is incorporated at the junction and the circuit now functions correctly.

→ Note the function of the ball in the shuttle valve acting as a non-return valve.

[82] Circuit: Shuttle valve IV

The shuttle valve is connected to the junction between the two 3/2-way push-button valves. Upon operation of one of the push-buttons, a signal is generated at the X or Y port of the shuttle valve and an output signal is emitted at port 2. The cylinder advances.

→ Compare the topic with the previous one.

[83] Exercise: The logic OR function, the shuttle valve – Problem

A cylinder is used to transfer parts from a magazine. If either a push-button or a foot pedal is operated, then the cylinder is to advance. Once the cylinder has fully advanced, it is to retract to the initial position. A 3/2 way roller lever valve is to be used to detect forward end position of the cylinder.

[84] Exercise: The logic OR function, the shuttle valve – Solution

The shuttle valve is connected to the junction between the two manual 3/2 way valves. Upon operation of one of the manual 3/2 way valves, a 1-signal is generated at either input 1 of the shuttle valve. This signal passes through the shuttle valve and is emitted at port 2. This operates the control valve via pilot port 14, and the cylinder advances. A limit valve 1S2 senses that the cylinder has fully extended. Pilot signal 2 from valve 1S2 actuates the 5/2 way
valve via port 12 and the cylinder retracts. The signal at port 12 is only effective, if the opposing signal at port 14 is released. If both of the signals produced via the push-button valves are set to zero, then the shuttle valve will release the pilot signal 14 back through the exhaust port of one of the 3/2 way valves. In other words, both the push-button and the foot pedal must be inactive for retraction to occur. The control valve can be a 4/2 way or 5/2 way valve and can be sized to suit the flow rate required for the cylinder speed.

[85] Exercise: The logic OR function, the shuttle valve – Note

The necessity of the shuttle valve can be explained with topic 79.

[86] Quick exhaust valve

To reduce resistance to flow, the air is expelled to atmosphere through a large orifice thus increasing cylinder piston speed. The valve is normally silenced so as to reduce exhaust air noise.

[87] Quick exhaust valve

Quick exhaust valves are used to increase the piston speed of cylinders. Lengthy return times can be avoided, particularly with single acting cylinders. To reduce resistance to flow, the air is expelled to atmosphere close to the cylinder and through a large orifice. In the direction 1 to 2 the air is passed freely via the opening of the non-return seal. Port 3 is blocked by the disc. If air is supplied to port 2, the disc seals port 1. Air is expelled to atmosphere through the large orifice 3. Mount the quick exhaust valve directly on the cylinder, or as near as possible.

Refer to topic 88 for the circuit example.
[88] **Circuit: Quick exhaust valve**

A cylinder piston rod is to travel at an increased speed, utilizing the quick exhaust valve. The forward motion of the piston rod is assisted by the release of exhausting air at the quick exhaust valve. The return stroke is unchanged due to the bypass non-return valve.

→ Refer to topic 70 for construction of the valve.

[89] **Exercise: The quick exhaust valve – Problem**

A cylinder advances a forming tool on an edge-folding device. If a sheet is detected as present and if a push-button is pressed, then the cylinder is to advance. For rapid forward travel, the circuit utilizes a quick exhaust valve. The forward movement folds the edge of a flat sheet. If the push-button is released, the double acting cylinder is to return slowly to the initial position.

[90] **Exercise: The quick exhaust valve – Solution**

Initial position: In the initial state, the cylinder assumes the retracted position. If both of the 3/2 way valves are actuated, pressure is present at the output port 2 of the two pressure valve 1V4. This reverses the 5/2 way control valve. The cylinder advances with air being supplied via an unrestricted passage through the one-way flow control valve 1V1. The actuator travels rapidly to its forward end position since the pressure space on the piston rod side is rapidly exhausted through the quick exhaust valve. If both 3/2 way valves remain actuated, the cylinder remains in the forward end position. If the push-button is released, the actuator is no longer pressurized, since the control valve reverses via the return spring. The actuator travels to its initial position under conditions of restricted flow (valve 1V1) and therefore at a reduced speed.
Exercise: The quick exhaust valve – Note

The quick exhaust valve should be fitted as near as possible to the connection of the cylinder to reduce resistance to flow.

22.6 Flow control valves

Flow control valves

Most flow control valves are adjustable. If the non-return valve is fitted, then the element is a one-way flow control valve.

Discuss the flow in both directions in both cases.

One-way flow control valve

The valve is generally mounted as close to the cylinder as possible. The valve is usually provided with a locking nut to allow finite adjustments to be regulated and then set.

One-way flow control valve

One-way flow control valves influence the volumetric flow of the compressed air. One-way flow control valves are normally adjustable and the setting can be locked in position. The influence of speed control is in one direction only. The first sequence of the animation shows the total cross section of the one-way flow control valve. The animation will be shown in detail by zooming into the air passage area.

Refer to topic 96 for the circuit example.
[95] Throttle valve

Throttle valves are normally adjustable and the setting can be locked in position. These valves are used to regulate the speed regulation of actuators and if possible, should be mounted directly on the cylinder.

→ Compare the flow control with throttle valves and one-way flow control valve topic 94.

[96] Supply and exhaust air throttling

Exhaust air throttling should be used with double acting cylinder circuits. For supply air throttling, the flow valves are installed so that the air entering the cylinder is throttled. With exhaust air throttling, the supply air flows freely to the cylinder and the exhaust air is throttled.

→ Discuss the numbering system. Even numbers relate to advancing signals and odd numbers to the retracting signals.
22.7 Pressure control valves

[97] Pressure control valves

The pressure control valves are generally adjustable against a compression spring. The sensing line for regulators is at the valve outlet and for sequence valves the sensing is before the valve, i.e. that pressure which is to be measured.

→ Compare the sensing line positions and flow arrows.

[98] Adjustable pressure sequence valve

The adjusting screw normally incorporates a lock nut to set the desired position. The valve body is fitted to a sub-base which can frame mounted with other compact valves.

→ Some applications for the valve are clamping, pressing, gluing and safety interlocks.

[99] Adjustable pressure sequence valve (unactuated)

Sequence valves are installed in pneumatic controls where a specific pressure is required for a switching operation. The output signal is transmitted only after the required operation pressure has been reached. If the signal pressure at port 12 exceeds that set on the spring, the valve opens. Outlet port 2 is opened only if a preset pressure has built up in pilot line 12. A pilot spool opens the passage between ports 1 to 2.
Discuss the two elements in the control symbol. Discuss the adjustment required to set the desired operation pressure. A pressure gauge is required.

[100] **Circuit: Pressure sequence valve**

A plastic component is embossed using a die powered by a double acting cylinder. The die is to advance and emboss the plastic when a push-button is operated. The return of the die is to be effected when a preset pressure is reached. The pressure is to be adjustable.

Refer to topic 99 for construction of the valve.

[101] **Exercise: Pressure dependent control, embossing of plastic – Problem**

A plastic component is embossed using a die and a double acting cylinder. The die is to advance and emboss the plastic when a push-button is operated. The return of the die is to occur when the cylinder rod has fully advanced to the embossing position and a preset pressure is reached. A roller limit valve is to be used to confirm full extension. The embossing pressure is adjustable and is indicated on a pressure gauge.

[102] **Exercise: Pressure dependent control, embossing of plastic – Solution**

The cylinder advances if valve 1V1 is switched by push-button valve 1S1. The pressure on the advancing side of the cylinder is fed from a junction to the limit valve 1S2 and then in series to the sequence valve. The signal port 12 at the sequence valve acts against the preset compression of the adjustable spring. If the limit valve 1S2 is operated due to full extension of the cylinder and the preset value is reached, then the sequence valve opens from 1 to 2 and
sends a pilot signal to port 12 of the control valve 1V1. The memory valve switches and the cylinder retracts. At the same time the air from port 4 is exhausted and the pilot signal at the sequence valve is relieved through the limit valve.

[103] Exercise: Pressure dependent control, embossing of plastic

→ If the pressure does not reach the preset limit, then the cylinder will remain advanced. If the cylinder is obstructed during extension to the forward position, the cylinder will not retract due to the dependency upon operation of the limit valve 1S2. The power circuit must be initialized by operating the 5/2 way memory valve manually (via the manual overrides) with the air off. The air can then be turned on.

22.8 Time delay valve

[104] Time delay valve, normally closed

The valve has a lock-able adjusting screw for setting time. The valve is sized to meet the flow requirements.

→ Discuss the accuracy of the time delay valve.

[105] Time delay valve, normally closed

The time delay valve is a combinational valve consisting of a 3/2-way valve, throttle relief valve and an air reservoir. The 3/2-way valve can be a valve with normal position open or closed. The delay time is generally 0-30 seconds for both types of valves. By using additional reservoirs, the time can be extended. When the necessary control pressure from 12 has built up in the air reservoir, the
pilot spool of the 3/2-way valve is actuated. An accurate switch-over time is assured if the air is clean and the pressure constant.

→ Discuss the need for clean and stable air for accuracy. Discuss the relationship between time delay and the reservoir size.

[106] Circuit: Time delay valve

A double acting cylinder is to glue components. The push-button operates the clamping cylinder and trips a roller lever valve. The cylinder is to remain fully extended for a time of 6 seconds and then immediately retracts to the initial position. A new start cycle is only possible after the cylinder has fully retracted. The cylinder advance is to be slow and the retraction adjustable but fast.

→ Refer to topic 104 for construction of the valve.

[107] Exercise: The time delay valve – Problem

A double acting cylinder is used to press together glued components. Upon operation of a push-button, the clamping cylinder advances and trips a roller lever valve. Once the forward end position is reached, the cylinder is to remain for 6 seconds and then immediately retract to the initial position. A new start cycle is only possible after the cylinder has fully retracted and after a delay of 5 seconds. The cylinder extension is to be slow and the retraction adjustable, but relatively fast.

[108] Exercise: The time delay valve – Solution

The start conditions are the actuation of roller limit valve 1S3, a delay of 5 seconds after the end of cycle and the operation of 1S1. The two pressure valve 1V4 actuates the 5/2 way memory valve at port 14. The cylinder advances at a preset speed via the flow control valve 1V2. The limit switch 1S3 is deactivated and therefore
even if the start button is still held, the signal at port 14 is exhausted by the removal of the limit switch signal, which resets the timer 1V6 until the cylinder has retracted again. The cylinder reaches the limit valve 1S2 and produces a pilot signal for the time delay valve 1V5. The time delay valve opens port 2 if the preset time is reached. A pilot signal is produced 6 seconds after the limit valve 1S2 is operated. The 5/2 way valve switches to the initial position and the cylinder retracts and with speed controlled by the valve 1V1. The roller limit valve 1S2 is deactivated and the pilot signal to the timer 1V5 is cut-off, removing the signal at port 12 of the 5/2 way valve.

[109] Exercise: The time delay valve – Note

The memory valve must be positioned manually before air is supplied to the circuit to ensure that the cylinder will be retracted initially.

[110] Exercise: Memory circuit and speed control of a cylinder – Problem

A double acting cylinder is to fully advance when a push-button is actuated and to retract after full extensions is reached (confirmed by a roller lever valve). The cylinder is to continue forward even if the push-button is released. Speed of the cylinder is to be adjustable.

[111] Exercise: Memory circuit and speed control of a cylinder – Solution

Operating the push-button 1S1 then advances the cylinder 1A1. Operation of valve 1V3 produces pressure at port 14 which switches the air to port 4. Once the cylinder travels to the limit valve 1S2, a pilot signal is sent to port 12 of the control valve switching the control valve if the push-button valve is released. If the push-button is held operated after the cylinder has fully advanced, it will remain advanced until valve 1S1 is released. The final control element 1V3 is a memory valve and the last position is retained until a unique opposing signal is received. The speed of advance
and retraction is controlled by the throttle valves 1V1 and 1V2 and in both cases the speed control is by exhaust air throttling. If the roller lever valve is fitted at the mid-stroke position of the cylinder, it will advance up to the limit valve and then retract.

[112] Exercise: Memory circuit and speed control of a cylinder – Note

The memory control valve 1V3 when first fitted could be in either of two positions 14 or 12. It is not easy to predict the position of the valve when fitted. If a manual override button is available the valve should be manually set to the 12 position before turning on the air to ensure that the cylinder remains retracted initially.

22.9 Sequential circuit and signal overlap circuit

[113] Sequential circuit, distance-step diagram

Confirmation is required that cylinder 2A1 is retracted before start of the cycle. The sequence is, A+ B+ A- B-. The valves 2S2 and 1S3 are initially operated. There is no signal overlap at the final control elements 1V2 and 2V2.

→ Discuss the relationship between the circuit and the distance-step diagram.

[114] Sequential circuit

A sequential circuit has the following characteristics; when a 3/2-way push-button valve is operated, cylinder 1A1 extends. Confirmation is required at each step of the sequence. The sequence is A+ B+ A- B-.

→ There is no signal overlap with the circuit.
**Signal overlap circuit I**

It is necessary to identify the points in the circuit where signal overlap occurs on the 5/2-way valves 1V2 and 2V2. With this distance step diagram the circuit design using roller valves cannot operate due to signal overlap.

→ Refer to the next topics for the overlap conditions.

**Signal overlap circuit II**

The first overlap condition occurs at the start. The pilot signals at the valve 1V2 from the valves 1S3 and 1S2 are opposed. The bistable valve cannot move due to overlap.

→ Discuss the options for removal of overlap.

**Signal overlap circuit III**

The second overlap condition occurs in the third step. The valve 2V2 has signals generated by 2S1 and 2S2 opposing each other and causing a signal overlap condition.

→ Review the control diagram topic 118.

**Control diagram, signal overlap**

The first control valve 1V2 has an overlap problem in the first step. The first of these signals must be out short and therefore valve 1S2 could be an idle return roller lever valve. The second overlap problem is with valve 2V2 in step 3, when the cylinder 2A1 is fully advanced. Valve 2S1 could be an idle return roller valve only active in step 2 for a short duration.

→ Idle return roller valves are not a recommended solution.
[119] **Idle return roller valve solution**

The idle return roller limit switch can be used to remove the signal overlap points, i.e. replace the roller lever limit switches identified, with an idle return roller lever valve. Valves 1S2 and 2S1 generated the signal overlap and therefore these valves should be idle return roller valves.

→ Idle return roller valves are not a recommended solution.

[120] **Reversing valve solution**

An alternative method of shortening the duration of signals is to remove the air supply to the two signal valves, except at the steps required. Using the reversing valve 1V2, lines S1 and S2 can be activated consecutively and the signals are prevented from overlapping at the memory valves 1V1 and 2V1.

→ Emphasize the increased reliability of the circuit.

### 22.10 Educational Films

#### 22.10.1 Educational Films

<table>
<thead>
<tr>
<th>No.</th>
<th>Title</th>
<th>Length</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Introduction</td>
<td>2:42</td>
</tr>
<tr>
<td>2</td>
<td>Fundamentals: Structure of hybrid systems</td>
<td>4:32</td>
</tr>
<tr>
<td>3</td>
<td>Fundamentals: Fundamentals of electricity</td>
<td>10:26</td>
</tr>
<tr>
<td>4</td>
<td>Sensors and relays – Signals</td>
<td>0:48</td>
</tr>
<tr>
<td>5</td>
<td>Sensors and relays – Sensors</td>
<td>3:24</td>
</tr>
</tbody>
</table>
22.11 Standard Presentations

For several topics useful presentations have been provided within FluidSIM. The following table lists the titles of the predefined presentations.

22.11.1 Presentations

<table>
<thead>
<tr>
<th>Presentation Title</th>
</tr>
</thead>
<tbody>
<tr>
<td>All topics sorted by number</td>
</tr>
<tr>
<td>Basics</td>
</tr>
<tr>
<td>Supply elements</td>
</tr>
<tr>
<td>Actuators</td>
</tr>
<tr>
<td>Directional control valves</td>
</tr>
<tr>
<td>Shutoff valves</td>
</tr>
<tr>
<td>Flow control valves</td>
</tr>
<tr>
<td>Pressure control valves</td>
</tr>
<tr>
<td>Time delay valve</td>
</tr>
<tr>
<td>Sequential circuit and signal overlap circuit</td>
</tr>
<tr>
<td>---------------------------------------------</td>
</tr>
<tr>
<td>Educational films</td>
</tr>
</tbody>
</table>
Chapter 23

This chapter provides a comprehensive listing of those parts of the didactics material in FluidSIM that are not covered by chapter The Component Library “The Component Library”. Basically, this material consists of the components' behavior illustrations, the animations, the exercises, and the educational films, which all can be activated under the Didactics menu. The subsequent sections are arranged thematically. The icon indicates that an animation exists for the related topic. The last section gives an overview of the educational films.

23.1 Applications

[1] Lathe

Machine-tool construction is a typical area of application of hydraulics. With modern CNC machine tools, the tools and workpieces are clamped by hydraulic means. Feed motions and the spindle drive can also be hydraulically powered.

→ This can also serve as an example of hydraulic circuit with two pressure ranges, for example, 3 MPa (30 bar) for machining and 9 MPa (90 bar) for clamping.

[2] Press with elevated reservoir

This is an application in which extremely high forces are required. Due to the suspended cylinder and the tractive load, special measures are required for the activation of the advance stroke. This in turn requires specially-designed press drives.

→ A special feature is the elevated reservoir, which utilizes the static pressure in the pressure medium.
On this hydraulic excavator, not only all working movements (linear drives) but also the propulsion of the vehicle (rotary drive) are hydraulically powered. The primary drive of the excavator is an internal-combustion engine.

→ A model calculation can be used here to demonstrate an advantage of hydraulics - large forces with relatively small components.

23.2 Components of a Hydraulic Plant

This simplified block diagram shows the division of hydraulic systems into a signal control section and a hydraulic power section. This signal control section is used to activate the valves in the power control section.

→ The material depicted in these electronic slides is concerned in the main with the hydraulic power section and the three “levels” of this which are shown.

The diagram of the hydraulic power section is complemented in this case by a circuit diagram to allow correlation of the various function groups; the power supply section contains the hydraulic pump and drive motor and the components for the preparation of the hydraulic fluid. The energy control section consists of the various valves used to provide control and regulate the flow rate, pressure and
direction of the hydraulic fluid. This drive section consists of cylinders or hydraulic motors, depending on the application in question.

[6] Block diagram of a control system

In analyzing and planning an actual control task, it can be helpful to use a differentiated block diagram showing the actual levels to be found on the machine.

→ The light arrows show the signal flow, while the solid dark arrows show the energy flow.

[7] Interaction of components

The animations show the sequences in a basic hydraulic circuit in simplified form - the actuation and spring return of the final control element (4/2-way valve), the advance and return of the drive component (double acting cylinder) and the opening and closing of the pressure relief valve.

→ The representations of the actuator and final control element are based on the relevant circuit symbols. This can be used as a preparation for the introduction of circuit symbols.

[8] Action related numbering

First of all the control chain is numbered sequentially according to the principle. The first actuator is given the supplementary number 0 and the associated final control element the supplementary number 1. The remaining elements get even numbers if they influence the advance stroke and uneven numbers if they influence the return stroke.

→ The numbering should always be entered in the circuit diagram and also on the machine to enable systematic fault-finding.

The DIN ISO Standard 1219-2 defines the code structure of the components as a string consisting of the following four parts: number of the plant, number of the circuit, component designation, and component number. If the entire system consists of a single plant only, the plant number may be dropped.

[10] Numbering in accordance with parts list

Another method used in practice is to number all the components in a hydraulic system consecutively. The numbers then correspond to the numbers in the parts list.

→ This method is used particularly with complex controls systems, for which a control-chain-related numbering system cannot be used due to the overlaps involved.

23.3 Symbols

[11] Circuit symbols for energy transfer (1)

The symbols shown are used in circuit diagrams for energy transfer and hydraulic-fluid preparation.

→ In the interests of clarity, the lines in the circuit diagram should be drawn without cross-overs as far as possible.
[12] **Circuit symbols for energy transfer (2)**

The direction of the arrows in the circuit symbols for the heater and cooler correspond to the direction of heat flow.

---

[13] **Circuit symbols for energy conversion**

Hydraulic pumps are shown by a circle with a part representation of a drive shaft. Triangles in the circles show the direction of flow. The triangles are shown solid, since pressure fluid is used in hydraulics.

→ If the pressure medium is gaseous, as in the case of pneumatics, the triangles are shown in outline.

---

[14] **Circuit symbols for hydraulic motors**

The symbols for hydraulic motors are distinguished from the symbols for hydraulic pumps by the fact that the arrows showing the direction of flow are the other way round.

---

[15] **Circuit symbols for single acting cylinders**

Single acting cylinders have one port, i.e. pressure fluid can be applied only to the piston side. With these cylinders, the return stroke is produced either by external force, shown in the symbol by an opening bearing cap, or by a spring is shown within the symbol in this latter case.

---

[16] **Circuit symbols for double acting cylinders**

Double acting cylinders have two ports to allow pressure fluid to be applied to both cylinder chambers. The symbol for a differential cylinder is distinguished from the symbol for a double acting cylin-
der by the two lines added to the end of the piston rod. The area ratio is generally 2:1. In the case of cylinders with double-ended piston rods, the symbol shows that the piston areas are of equal size (synchronous cylinders).

[17] Circuit symbols for directional control valves (1)

Designations for directional control valves always give firstly the number of ports and then the number of switching positions. Directional control valves always have at least two ports and at least two switching positions. The number of squares shows the number of possible switching positions of a valve. Arrows within the squares show the direction of flow. Lines shown how the ports are interconnected in the various switching positions of the valve. The designations always relate to the normal position of the valve.

[18] Circuit symbols for directional control valves (2)

This illustration shows the circuit symbols for 4/2- and 5/2-way valves.

→ There are two general methods for the designation of ports, using either the letters P, T, R, A, B and L or consecutively using A, B, C, D etc.; the first method is the preferred one in the relevant standard.

[19] Circuit symbols for directional control valves (3)

The illustration shows the circuit symbols for 4/3-way valves with various mid-positions.

[20] Circuit symbols for manual operation

The switching position of a directional control valve can be changed by various actuation methods. The symbol for the valve is accor-
ingly supplemented by a symbol indicating the actuation methods shown, such as pushbuttons and pedals, a spring is always necessary for resetting. Resetting can, however, also be achieved by actuating the valve a second time, for example in the case of valves with hand levers and detents.

The various actuating methods possible are listed in DIN ISO 1219.

[21] Circuit symbols for mechanical actuation

This illustration shows the symbols for stem or push button, spring and roller stem.

[22] Circuit symbol for pressure valves

Pressure valves are represented using squares. The flow direction is indicated by an arrow. The valve ports can be designated as P (supply port) and T (tank return port) or as A and B. The position of the arrow within the square indicates whether the valve is normally open or normally closed. Adjustable pressure valves are indicated by a diagonal arrow through the spring. Pressure valves are divided into pressure relief valves and pressure regulators.

[23] Circuit symbols for flow control valves

A distinction is made in flow control valves between types which are affected by viscosity and those which are unaffected. Flow control valves unaffected by viscosity are termed orifices. A 2-way flow control valve consists of restrictors, one adjustable restrictor which is unaffected by viscosity (orifice) and a regulating restrictor (pressure compensator). These valves are represented by a rectangle containing the symbol for the adjustable restrictor and an arrow to represent the pressure compensator. The diagonal arrow through the rectangle indicates that the valve is adjustable.
[24] Circuit symbols for non-return valves

The symbol for non-return valves is a ball which is pressed against a seat. Delockable non-return valves are shown by a square containing the symbol for a non-return valve. The pilot control for unlocking the non-return valve is indicated by a broken line at the pilot port. The pilot port is designated by the letter X.

[25] Circuit symbols for measuring devices

The illustration shows the symbols for measuring devices used in hydraulics.

23.4 Some Physical Fundamentals

[26] Hydrostatic pressure

Hydrostatic pressure is the pressure created above a certain level within a liquid as a result of the weight of the liquid mass. Hydrostatic pressure is not dependent on the shape of the vessel concerned but only on the height and density of the column of liquid.

→ Hydrostatic pressure can generally be ignored for the purpose of studying hydraulics (exception: see topic 2).

[27] Pressure propagation

If a force F acts on an area A of an enclosed liquid, a pressure p is produced which acts throughout the liquid (Pascal’s Law).
Hydrostatic pressure has been ignored here. The term pressure propagation is also used to mean the pulse velocity in liquids (approx. 1000 m/s).

[28] **Power transmission**

If a force $F_1$ is applied to an area $A_1$ of a liquid, a pressure $p$ results. If, as in this case, the pressure acts on a larger surface $A_2$, then a larger counter-force $F_2$ must be maintained. If $A_2$ is three times as large as $A_1$, then $F_2$ will also be three times as large as $F_1$.

→ Hydraulic power transmission is comparable to the mechanical law of levers.

[29] **Displacement transmission (1)**

If the input piston of the hydraulic press travels a distance $s_1$, a volume of fluid will be displaced. This same volume displaces the output piston by the distance $s_2$. If the area of this piston is larger than that of the input piston, the distance $s_2$ will be shorter than $s_1$.

→ Hydraulic displacement transmission is comparable to the mechanical law of levers.

[30] **Displacement transmission (2)**

See topic 29

[31] **Pressure transfer (1)**

The fluid pressure $p_1$ exerts a force $F_1$ on the surface $A_1$ which is transferred via the piston rod to the small piston. The force $F_1$ thus acts on the surface $A_2$ and produces the fluid pressure $p_2$. Since the piston area $A_2$ is smaller than the piston area $A_1$, the pressure $p_2$ must be larger than the pressure $p_1$. 
The pressure-transfer (pressure-intensification) effect is put to practical use in pneumatic/hydraulic pressure intensifiers and also in purely hydraulic systems when extremely high pressures are required which a pump cannot deliver.

[32] Pressure transfer (2)

A pressure-transfer effect also occurs in conventional double acting cylinders with single piston rod.

This effect also causes problems in hydraulics. If, for example, an exhaust flow control is fitted to a differential cylinder for the advance stroke, a pressure-intensification effect results in the piston-rod chamber.

[33] Types of flow

A distinction is made between laminar flow and turbulent flow. In the case of laminar flow, the hydraulic fluid moves through the pipe in ordered cylindrical layers. If the flow velocity of the hydraulic fluid rises above a critical speed, the fluid particles at the center of the pipe break away to the side, and turbulence results.

Turbulent flow should be avoided in hydraulic circuits by ensuring they are adequate sized.

[34] Diesel effect

A pressure drop to the level of vacuum may occur at points of restriction, causing precipitation of the air dissolved in the oil. When the pressure rises again, oil bursts into the gas bubbles and spontaneous ignition of the oil/air mixture may occur.

[35] Cavitation

Motion energy is required for an increase in the flow velocity of the oil at a restriction. This motion energy is derived from the pressure energy. If the vacuum which results is smaller than -30 kPa (~0.3 bar).
bar), air dissolved in the oil is precipitated out. When the pressure rises again due to a reduction in speed, the oil bursts into the gas bubbles.

→ Cavitation is a significant factor in hydraulic systems as a cause of wear in devices and connections.

[36] Cavitation

Local pressure peaks occur during cavitation. This causes the erosion of small particles from the wall of the pipe immediately after the reduced cross-section, leading to material fatigue and often also to fractures. This effect is accompanied by considerable noise.

[37] Input and output power

Various losses occur at the individual devices within a hydraulic control chain. These consist essentially of mechanical, electrical and volumetric losses.

→ After an installation has been in service for some time, there will be a change in particular in the volumetric efficiency of the pump, as the result, for example, of cavitation (see topic 35).

23.5 Components of a Power Unit

[38] Hydraulic power unit

The hydraulic power unit (power supply unit) provides the energy required for the hydraulic installation. Its most important components are the reservoir (tank), drive (electric motor), hydraulic pump, pressure relief valve (safety valve), filter and cooler. The
Hydraulic power unit may also act as a carrier for other devices (gauges, directional control valves).

[39] Hydraulic power unit: Reservoir

The hydraulic reservoir contains the hydraulic fluid required to operate the installation. Within the reservoir, air, water and solid matter are separated out of the hydraulic fluid.

→ The size of the reservoir will depend on the practical application involved; for stationary systems, the volume of fluid delivered by the pump in 3 to 5 minutes can be taken as a guide. In mobile hydraulic systems, on the other hand, the reservoir contains only the maximum quantity of hydraulic fluid required.

[40] Externally toothed gear pump

The increase in volume which results when a tooth moves out of mesh produces a vacuum in the suction area. The hydraulic fluid is conveyed into the pressure area. The hydraulic fluid is then forced out of the tooth gaps by the meshing of the teeth and displaced into the above supply line.

[41] Internally toothed gear pump

The inner gear is driven by a motor. The teeth of the inner wheel drive the outer gear wheel. The rotary motion creates a vacuum in the gaps between the teeth, causing hydraulic fluid to be sucked in. On the other side, the teeth engage once more and oil is displaced from the tooth chambers.

→ The design can deliver pressures of up to approx. 17.5 MPa (175 bar). Hydraulic motors represent the reverse of the function principle.
An oil filter situated in the return line to the tank has the advantage that the filter is thus easy to maintain. A disadvantage, however, is that contamination is removed from the hydraulic fluid only after it has passed through the hydraulic components.

→ This configuration is often used.

With this configuration, the pump is protected from contamination. The filter is, on the other hand, less easily accessible.

→ If these filters have a too fine mesh, suction problems and cavitation effects may occur. Additional coarse filters upstream of the pump are recommended.

Pressure filters can be installed selectively upstream of valves which are sensitive to contamination; this also enables smaller mesh sizes to be used.

→ A pressure-resistant housing is required, which makes this configuration more expensive.

It is important that the effectiveness of a filter can be checked by a contamination indicator. The contamination of a filter is measured by the pressure drop; as the contamination increases, the pressure upstream of the filter increases. The pressure acts on a spring-loaded piston. As the pressure increases, the piston is pushed against a spring.
There are a number of different display methods. Either the piston movement is directly visible or it is converted into an electrical or visual indication by electrical contacts.

[46] **Water cooler**

With this design of cooler, hydraulic fluid is fed through tubes over which coolant (water) flows. The heat which is discharged can be re-used.

The operating temperature in hydraulic installations should not exceed 50 - 60°C, since this would cause an unacceptable reduction in viscosity, leading to premature aging of the fluid. In comparison with air cooling, operating costs are higher due to the required coolant and the susceptibility to corrosion. Temperature difference of up to approx. 35°C can be handled.

[47] **Air cooler**

Hydraulic fluid from the return line flows through a coiled pipe which is cooled by a fan.

The advantages here are simplicity of installation and low operating costs. The noise of the fan may be a nuisance (see also topic 46).

[48] **Heating element**

Heaters are often required to ensure that the optimum operating temperature is reached quickly. Heating elements or flow preheaters are used for heating and pre-heating hydraulic fluid.

If the viscosity is to high, the resulting increase in friction and cavitation leads to greater wear.

[49] **Circuit diagram: Hydraulic power unit**

The illustration shows the detailed circuit symbol for a hydraulic power unit.
Since this is an combination unit, a dot/dash line is placed around the symbols representing the individual units.

### 23.6 Fundamentals of Valves

#### [50] Actuating force

With some types of poppet valves, the actuating force, which is dependent on pressure and area, may be very high. In order to avoid this, pressure compensation may be provided at the valves.

#### [51] Poppet principle

Valves are based either on the poppet principle or slide principle. In poppet valves, a ball, a cone or a disc is pressed by a spring against the seat of a passage. The high pressure per unit area which is created, means that valves of this kind provide a very efficient seal. The illustration shows a cone used as a sealing element.

#### [52] Slide principle

This illustration shows the principle of a longitudinal slide valve. In order to allow the piston to move, it has a certain clearance and floats in hydraulic fluids. Ring grooves ensure an even film of oil and thus pressure equilibrium. The piston can thus be moved with minimal frictional losses.

→ This type of valve cannot provide a perfect seal, which means that there is always a certain oil leakage.
[53] Poppet valves

In poppet valves, a ball, cone or occasionally a disk is pressed against a seat area to act as a sealing element. Valves of this type provide a very efficient seal.

[54] Piston overlap

The switching characteristics of a valve are governed by, among other things, its piston overlap. A distinction is made between positive, negative and zero overlap. In the case of positive overlap, the port in question is completely covered by the piston, while with negative overlap it is less than completely covered. In the case of zero overlap, the distances between the control edges of the piston and of the port are exactly the same.

→ The individual control edges of the pilot piston can have different overlaps.

[55] Negative switching overlap

In the case of negative overlap, flow from A to T is not quite closed when the inlet P is opened. This means that the pressure at port A rises slowly and the piston starts gently.

→ In manufacturers’ data sheets, overlap positions are shown within dotted lines between the switching positions, or the overlap positions are shown in color or with a patterned background.

[56] Positive switching overlap

In the case of positive overlap, the left-hand piston does not open the passage from P to A until the tank has been completely isolated by the other piston. Pressure is immediately fed to the load device (cylinder or hydraulic motor) with the result that this starts abruptly.
Control edges

The control edges of the pistons are often either sharp, chamfered or notched. The profiling of the control edges means that the throttling action of the flow when switching is gradual rather than abrupt.

→ See also the example in topic 144.

Vertical interconnection system

Vertical interconnection systems (“modular hydraulics”) mean that less space is required and that no piping is needed between the components. The circuit symbols directly marked on the components give greater clarity in the installation.

23.7 Pressure Valves

Pressure relief valve (1)

In this design incorporating a poppet valve, a seal is pressed against the inlet port P by a pressure spring when the valve is in its normal position.

→ In this situation, for example, an unloaded piston rod is executing an advance stroke and the entire pump delivery is flowing to the cylinder.

Pressure relief valve (2)

As soon as the force exerted by the inlet pressure at A exceeds the opposing spring force, the valve begins to open.
In this situation, for example, the piston rod is fully advanced; the entire pump delivery is flowing at the preset system pressure to the tank.

[61] PRV used to limit system pressure

This illustration shows a pressure relief valve within a basic hydraulic circuit (used to control a double acting cylinder).

The resistances at the outlet (tank line, filter) must be added to the force of the spring in the pressure relief valve. See also the animation “Interaction of components” (topic 7).

[62] Circuit diagram: PRV used to limit system pressure

This illustration shows the same circuit as the previous illustration, but with the cut-away view of the PRV replaced by the appropriate circuit symbol.

[63] Circuit without brake valve

One application of pressure relief valves is as brake valves; these prevent pressure peaks which may otherwise occur as the result of mass moments of inertia when a directional control valve is suddenly closed. The animation shows an (incorrect) circuit in schematic form in which the working line on the exhaust side has fractured due to the absence of a brake valve.

The next animation (topic 64) shows the correct circuit.

[64] Circuit diagram: Brake valve

This illustration shows the correct circuit for the problem in topic 63. This circuit incorporates not only a brake valve on the piston-rod side but also a non-return valve on the inlet side via which oil can be taken in from a reservoir during the vacuum phase following the closure of the directional control valve.
The following animation shows the events which occur in the two working lines.

[65] Circuit with brake valve

First the animation shows in schematic form the behavior of the PRV during the braking phase, then it shows the behavior of the non-return valve (NRV) in the supply line.

The necessity of the brake valve can be demonstrated by topic 63.

[66] Circuit diagram: PRV as back-pressure valve

Back-pressure valves counteract mass moments of inertia with tractive loads. The illustration shows a circuit with a back-pressure valve on the piston-rod side. On the return stroke, the PRV is bypassed by an NRV.

The PRV must be pressure-compensated and the tank port must be capable of carrying a pressure load.

[67] PRV, internally controlled, cushioned

Pressure relief valves often incorporate cushioning pistons or flow control valves. The cushioning device shown provides fast opening and slow closing of the valve. This prevents damage caused by pressure shocks (smooth valve operation).

Pressure shock arise, for example, when the pump delivers oil in an almost unpressurized condition and the supply port of the load device is abruptly closed by a directional control valve.

[68] PRV, externally controlled (1)

This pressure relief valve controls the flow in accordance with an external pressure setting. This pressure acts against an adjustable
spring force. The passage from the supply port P to the tank port T remains closed as long as no load acts on the pilot piston.

[69] PRV, externally controlled (2)
Pressure can be fed to the pilot piston via the pilot port X. As soon as the pressure force at the pilot piston exceeds the preset spring force, the pilot piston is displaced, allowing free flow.

[70] Sequence valve
The example shows a circuit with a pressure relief valve used as a pressure sequence valve. The pressure at the pilot piston of the PRV rises via the pressure regulator. The PRV opens and the high-pressure pump delivers directly to the tank. As soon as the 2/2-way valve opens, the pressure drops. The pressure relief valve closes and the high pressure pump is connected to the system.

[71] Circuit diagram: Sequence valve
This illustration shows the same circuit as the previous illustration, but with the cut-away view of the sequence valve replaced by the appropriate circuit symbol.

[72] Pressure relief valve
Actual photograph of a pressure relief valve.

[73] 2-way pressure regulator (1)
This valve is normally open. The outlet pressure (A) acts via a pilot line on the left-hand surface of the pilot piston against an adjustable spring force.

→ Pressure regulators reduce the inlet pressure to an adjustable outlet pressure. It is appropriate to use these in hydraulic installations only if different pressures are required.

[74] **2-way pressure regulator (2)**

When the pressure rises at outlet A, the force at the left-hand surface of the pilot piston becomes greater, the piston is displaced to the right and the throttle gap becomes narrower. This causes a pressure drop.

→ In the case of slide valves, it is also possible to design the control edges in such way that the opening gap increases only slowly. This gives greater control precision.

[75] **2-way pressure regulator (3)**

When the preset maximum pressure is reached, the throttle point closes completely; the pressure set on the pressure relief valve is produced at the inlet P.

[76] **2-way pressure regulator (4)**

In the circuit illustrated, the piston rod of the cylinder is executing an advance stroke. The pressure at the outlet A of the pressure regulator is less than the system pressure at P and constant.

[77] **2-way pressure regulator (5)**

The piston rod of the cylinder is now in its forward end position. The pressure at outlet A thus continues to rise and the throttle point closes completely.
[78] Circuit diagram: 2-way pressure regulator

The illustration shows the same circuit as the previous illustration, but with the 2-way pressure regulator in the form of a circuit symbol.

[79] Circuit diagram: 2-way pressure regulator

It is appropriate to use PRVs only when different pressures are required in an installation. The mod of operation of pressure regulator will thus be explained here by taking an example with two control circuits. The first control circuit acts via a flow control valve on a hydraulic motor which drives a roller. This roller is used to stick together multi-layered printed circuit boards. The second control circuit acts on a hydraulic cylinder which draws the roller towards the boards at an adjustable reduced pressure.

→ This example can be used as a preliminary stage to the introduction of the 3-way PR. If the 2-way PR is closed due to the fact that the preset maximum pressure has been reached, thickening of the material of the workpieces would cause an increase in the pressure on the outlet side of the PR to a higher value than desired. (See also the animation for topic 84.)

[80] 3-way pressure regulator (1)

The 3-way pressure regulator can be regarded as a combination of a 2-way PR and a pressure relief valve (PRV). The PR is in its normal position here; only a low pressure has built up at the outlet A.

[81] 3-way pressure regulator (2)

When the pressure at A rises the result of external conditions, this pressure acts via a pilot line on the left-hand piston surface of the pilot piston against an adjustable spring force. Every pressure
increase causes the throttle gap to become narrower, resulting in a pressure drop.

[82] 3-way pressure regulator (3)

When the maximum preset pressure is reached, the throttle point closes completely. The pressure set on the system-pressure limiter is produced at the inlet P.

[83] 3-way pressure regulator (4)

If the pressure rises above the preset value as the result of an external load at outlet A, the valve opens to allow flow from A to the tank port T (pressure-limiter function).

→ 3-way pressure regulators are available with both positive and negative piston overlap. If a 3-way pressure regulator is created by combining a 2-way pressure regulator and a pressure relief valve, the “overlap” is adjustable.

[84] 3-way pressure regulator

The animation shows both the pressure-regulator and pressure-limiter function of a 3-way pressure regulator through the example of a roller which exerts a constant pressure on moving material of variable thickness.

→ The final control element which is normally interposed has been omitted here in the interests of clarity.

[85] 3-way pressure regulator (5)

A 3-way PR is shown here in a functional representation, incorporated into a model circuit diagram. The piston rod of the cylinder is subject to external force and the pressure regulator provides a pressure-limiter function.
3-way pressure regulator (6)

The illustration shows the same circuit as the previous illustration, but with the functional representation of the 3-way pressure regulator replaced by a “detailed” circuit symbol.

→ 3-way pressure regulators are available with both positive and negative piston overlap. If a 3-way pressure regulator is created by combining a 2-way pressure regulator and a pressure relief valve, the “overlap” is adjustable.

Circuit diagram: 3-way pressure regulator

The illustration shows the same circuit as the previous illustration, but with the standard circuit symbol for a 3-way pressure regulator.

23.8 Way Valves

2/2-way valve (1)

The 2/2-way valve has a working port A, a supply port P and a leakage-oil port L. In the case of the valve shown here, of slide design, flow from P to A is closed in the normal position.

→ A relief line leading to the leakage-oil port is provided to prevent a build-up of pressure in the spring and piston chambers.

2/2-way valve (2)

The 2/2-way valve is actuated and the passage from P to A is open.

→ 2/2-way valves are also available which are normally open from P to A.
[90] 2/2-way valve as by-pass valve

This example shows a 2/2-way valve used as a by-pass valve; when the 2/2-way valve is actuated, the flow control valve OV2 is by-passed, causing the piston rod of the cylinder to advance at maximum speed.

[91] Circuit diagram: 2/2-way valve as by-pass valve

The illustration shows the same circuit as the previous illustration, but with the functional representation of the 2/2-way valve replaced by a circuit symbol.

[92] Circuit diagram: 2/2-way valve as final control element

In its initial position, the cylinder is advanced. If the 2/2-way valve OV1 is actuated, the entire volumetric flow passes to the tank and piston rod of the cylinder is reset by the external load m. If OV1 is not actuated, the system pressure set on the pressure limiter OV2 builds up and the piston rod advances.

→ In the initial position, the pump operates against the preset system pressure, which has an unfavorable effect on the power balance of the circuit shown.

[93] 2/2-way valve as final control element

The animations show the actuation and release of the 2/2-way valve, which causes the piston rod of the cylinder to advance and retract.
[94] **Circuit diagram for pressure-less pump recirculation**

The part circuit diagram shows a 2/2-way valve used as a by-pass valve to achieve pressure-less pump recirculation; if the valve is actuated, the pump no longer needs to operate against the preset system pressure.

→ One application of this circuit is with 4/3-way valves which are closed in their mid-position in cases where, with the installation operational, it is desired to switch to pump recirculation (see also topic 116).

[95] **Circuit diagram: Pressure stage circuit**

The part circuit diagram shows a 2/2-way valve used as a selector switch for one of two preset system pressures ("pressure levels"); if the 2/2-way valve is actuated, flow is enabled to a second system-pressure limiter.

[96] **3/2-way valve (poppet principle) (1)**

The 3/2-way valve has working port A, a supply port P and a tank port T. Volumetric flow can be routed from the supply port to the working port or from the working port to the tank port. The third port in each case is closed. In the normal position shown, P is closed and flow released from A to T.

→ See also topic 101 (slide principle).

[97] **3/2-way valve (poppet principle) (2)**

The 3/2-way valve is actuated; flow is released from P to A, the outlet T is closed.

→ 3/2-way valves which are normally open from P to A and T closed are also available.
[98] 3/2-way valve as final control element

The circuit shows the 3/2-way valve in a functional representation as a final control element of a single acting cylinder.

→ The non-return valve protects the pump in cases where the 3/2-way valve is actuated and the piston rod is subject to an external load.

[99] Circuit diagram: 3/2-way valve as final control element

The illustration shows the same circuit as the previous illustration, but with the circuit symbol for the 3/2-way valve.

[100] 3/2-way valve

The animations show the actuation and release of the manual pushbutton for a 3/2-way valve, which causes the piston rod of the cylinder to advance and retract.

[101] 3/2-way valve (slide principle) (1)

The 3/2-way valve has a working port A, a supply port P and a tank port T. The volumetric flow can be routed from the supply port to the working port, or from the working port to the tank port. The third port in each case is closed. In the normal position shown, P is closed and flow is released from A to T.

→ See also the 3/2-way valve designed on the poppet principle (Topic 96).
[102] 3/2-way valve (slide principle) (2)

The 3/2-way valve is actuated; flow is released from P to A, and the outlet T is closed.

→ 3/2-way valves which are normally closed from P to A and T are also available.

[103] 3/2-way valves as diverter

In addition to their application as final control elements, 3/2-way valves can also be used as diverters. In this case, port T is connected to a further device, to which a switch-over can then be made.

The part circuit diagrams show the facility to switch between the flow control valves with different settings and between heating and cooling.

→ The circuit symbol is drawn reversed to simplify the representation of the circuit diagram.

[104] 4/2-way valve, two pistons (1)

The 4/2-way valve has two working ports A and B, a supply port P and a tank port T. The supply port is always connected to one of the working ports, while the second working port is routed to the tank. In the normal position, there is flow from P to B and from A to T.

→ In contrast to valves with three pistons, 4/2-way valves with two pistons do not require a leakage-oil port (see topic 106).

[105] 4/2-way valve, two pistons (2)

The 4/2-way valve is actuated, and there is flow from P to A and from B to T.

→ 4/2-way valves are also available which are normally open from P to A and from B to T.
This 4/2-way valve has two working ports A and B, a supply port P and a tank port T. The supply port is always connected to one of the working ports, while the second working port is routed to the tank. In the neutral position, there is flow from P to B and from A to T.

4/2-way valves with three pistons require a leakage-oil port, since hydraulic fluid would otherwise be trapped within the valve.

The 4/2-way valve is actuated, and there is flow from P to A and from B to T.

The circuit shows the 4/2-way valve in functional representation as a final control element of a double acting cylinder.

The non-return valve protects the pump in cases where the piston rod of the cylinder is subject to an external load.

The illustration shows the same circuit as the previous illustration, but with the 4/2-way valve as a circuit symbol.

From the logic point of view, 4/3-way valves are 4/2-way valves with an additional mid-position. There are various versions of this mid-position (in the mid-position in the example shown, the supply...
port P is directly connected to the tank T, see next illustration). In the switching position shown, there is flow from P to B and from A to T.

→ 4/3-way valves are easy to construct as slide valves and of complex design as poppet valves.

[111] 4/3-way valve with pump bypass (2)

The 4/3-way valve is in its mid-position; there is flow from P to T, while A and B are closed. Since the output from the pump flows to the tank, this switching position is called pump bypass or also pump recirculation.

→ In the case of pump bypass, the pump needs to operate only against the resistance of the valve, which has a favorable effect on the power balance.

[112] 4/3-way valve with pump bypass (3)

The valve is in its left-hand switching position; there is flow from P to A and from B to T.

[113] 4/3-way valve with pump bypass (4)

The circuit shows the 4/3-way valve in functional representation as a final control element of a double acting cylinder. The valve is in its mid-position; the pump delivery flows via the by-pass line within the pilot piston to the tank.

→ The non-return valve protects the pump in cases where the piston rod of the cylinder is subject to an external load.

[114] Circuit diagram: 4/3-way valve with pump bypass

The illustration shows the same circuit as the previous illustration, but with the 4/3-way valve as a circuit symbol.
The animations show the switching of the 4/3-way valve into the three switching positions and the corresponding cylinder movements. During the advance stroke, movement can be halted by switching to the mid-position.

→ As appropriate to the application in question, a circuit of this kind must be equipped with a brake valve to prevent damage to the installation when the valve is switched to the mid-position (see also topic 64).

**[116] 4/3-way valve with closed mid-position (1)**

From the logic point of view, 4/3-way valves are 4/2-way valves with an additional mid-position. There are various versions of this mid-position (in the mid-position in the example shown, all ports are closed in the mid-position, see next illustration). In the switching position shown, there is flow from P to B and from A to T.

**[117] 4/3-way valve with closed mid-position (2)**

The 4/3-way valve is in its mid-position; all ports apart from the leakage-oil port are closed.

→ In this mid-position, the pump is operating against the system pressure set on the pressure relief valve.

**[118] 4/3-way valve with closed mid-position (3)**

The valve is in its left-hand switching position; there is flow from P to A and from B to T.
[119] 4/3-way valve with closed mid-position (4)

The circuit shows the 4/3-way valve in functional representation as a final control element of a double acting cylinder. The valve is in its mid-position; the pump is operating against the system pressure set on the PRV.

→ If, with an operational installation, it is desired to switch to pump recirculation, this can be achieved by using an additional 2/2-way valve as a changeover valve (see part circuit-diagram in topic 94).

[120] Circuit diagram: 4/3-way valve with closed mid-position

The illustration shows the same circuit as the previous illustration, but with the 4/3-way valve as a circuit symbol.

[121] 4/3-way valve: overlap positions (1)

The illustration shows the left-hand overlap position of a 4/3-way valve with positive overlap in the mid-position (closed mid-position). This overlap position is a mixture of positive and negative overlap; P is connected to A, B and T are closed.

→ With 4/3-way valves, the types of overlap positions is generally specified in the data sheet.

[122] 4/3-way valve: overlap positions (2)

The illustration shows the “right-hand” overlap position of a 4/3-way valve with positive overlap in the mid-position (closed mid-position). This overlap position, too, is a mixture of positive and negative overlap; P is connected to B, A and T are closed.
23.9 Shutoff Valves

[123] Way valve

Actual photograph of a directional control valve with lever actuation.

[124] 4/3-way module

This 4/3-way module with hand-lever actuation is used in vertical interconnection systems (“modular hydraulics”).

→ See also the illustration in topic 58.

[125] Non-return valve (1)

Non-return valves block flow in one direction and allow free flow in the other. In the direction of flow shown, the sealing element is pressed against a seat by a spring and the hydraulic fluid.

→ These valves are also available in designs without springs. Since there must be no leaks in the closed position, these valves are generally of poppet design.

[126] Non-return valve (2)

In the direction of flow shown, the valve is opened by the hydraulic fluid, which lifts the sealing element from the seat.
[127] Circuit diagram: Pump protection

In this circuit, the non-return valve is used to protect the pump. This prevents a load pressure from driving the pump in reverse when the electric motor is switched off. Pressure peaks do not affect the pump but are discharged via the pressure relief valve.

[128] Graetz block (1)

In the Graetz rectifier circuit (Graetz block), four non-return valves are combined to form a function unit. The circuit diagram shows how this operates in conjunction with a flow control valve; flow passes through this valve from left to right during both the advance and return strokes of the cylinder. The situation during the advance stroke is shown.

→ During the advance stroke shown here, flow control is carried out on the inlet side.

[129] Graetz block (2)

The cylinder is on its return stroke. The rectifier circuit means that flow once again passes through the flow control valve from left to right.

→ During the return stroke shown here, flow control is carried out on the outlet side.

[130] Graetz block

The animation shows the actuation and spring return of a 4/2-way valve and the flow through the Graetz block during the advance and return strokes.

→ Similar rectifier circuits are also used in conjunction with line filters or brake valves.
[131] **Delockable non-return valve (1)**

In the cases of delockable non-return valves, flow in the closed direction can be released by means of an additional pilot port (X). The illustration shows the valve in its normal position; flow from B to A is closed.

[132] **Delockable non-return valve (2)**

The released piston is pressurized via pilot port X. This lifts the sealing element from its seat and releases flow from B to A.

→ In order to release the valve reliably, the effective area of the pilot piston must always be greater than the effective area of the sealing element. Piloted non-return valves are also available with lockable non-return function.

[133] **Delockable non-return valve (3)**

The model circuit diagram shows how a load can be positioned by holding a cylinder using a suitable delockable non-return valve. The valve becomes active in the return stroke whereby the restriction on the piston side is released by actuation of the 3/2-way valve.

→ See also the animation 135 on this topic.

[134] **Circuit diagram: Delockable non-return valve**

The illustration shows the same circuit as the previous illustration, but with the piloted non-return valve as a circuit symbol.
[135] Delockable non-return valve

The 4/2-way valve is actuated, the hydraulic fluid passes through the non-return valve against the force of the return spring and the piston rod advances. When the 4/2-way valve is reset, the outlet on the piston side is closed by the non-return valve, and the cylinder remains advanced. The 3/2-way valve is now actuated, the pilot piston is reversed and the outlet flow released; the piston rod begins to retract. During the return stroke, the 3/2-way valve is brought temporarily into its normal position. This causes the outlet to be closed again, and the piston rod and load remain in their current position. When the 3/2-way valve is actuated again, the piston rod travels to its retracted end position.

[136] Delockable double non-return valve (1)

Delockable double non-return valves allow a load to be positioned reliably with the cylinder at a standstill, even if eternal leaks exist around the cylinder piston. When, as in the case, neither of the inlets A_1 or A_2 is pressurized, B_1 and B_2 are closed.

[137] Delockable double non-return valve (2)

When A_1 is pressurized, the left-hand sealing element is lifted from its seat, enabling flow to B_1. At the same time, the pilot piston is displaced to the right, releasing flow from B_2 to A_2.

→ The opposite is true when inlet A_2 is pressurized.

[138] Delockable double non-return valve (3)

The model circuit diagram shows a delockable double non-return valve used in conjunction with a 4/3-way valve to allow the vertical positioning of a load. In the mid-position of the final control element shown, ports A and B are connected to the tank. This means...
that the inlets A_1 and A_2 of the double non-return valve are pressure-less and both cylinder supply lines are closed.

[139] Circuit diagram: Delockable double non-return valve

The illustration shows the same circuit as the previous illustration, but with the delockable double non-return valve as a circuit symbol.

23.10 Flow Valves

[140] Needle restrictor

Throttle and orifice valves are used to achieve a certain pressure drop. This is done by creating a specific flow resistance. The needle flow control valve shown generates considerable friction due to its long narrowing. This means that the action of the flow control valve is difficult to adjust due to the fact that a small adjustment produces a large change in cross-section.

→ One advantage is the simple and inexpensive design. Needle flow control valves can be used if the above-mentioned negative properties can be ignored for the purposes of a given control task.

[141] Gap restrictor with helix

Its short narrowing means that the action of this gap flow control valve is virtually independent of viscosity. The helix provides precise adjustability, since adjustment from fully open to fully closed requires a 360° turn. The helix is, however, very costly to produce.
[142] Circuit diagram: Flow division using restrictor

Throttle and orifice valves control the volumetric flow rate in conjunction with a pressure relief valve. The PRV opens when the resistance of the flow control valve becomes greater than that of the opening pressure set on the PRV. This produces a division of flow.

→ The volumetric flow to the load device varies, i.e. the action of flow control valves is load-dependent.

[143] Throttle valve

Actual photograph of a flow control valve.

[144] One-way flow control valve (1)

The one-way flow control valve is a combination of an orifice or throttle valve and a non-return valve. In the closed direction shown of the non-return valve, the volumetric flow passes via the variable throttle gap, which creates a considerable resistance.

→ Speed reduction can be achieved by using a one-way flow control valve in conjunction with a pressure relief valve or a variable-delivery pump. The pressure rises upstream of the flow control valve until the PRV opens and routes part of the flow to the tank.

[145] One-way flow control valve (2)

In the reverse direction, from B to A, flow is unrestricted, since the ball in the one-way flow control valve allows free flow (non-return function).

→ One-way flow control valves are available with a fixed restrictor and with variable flow control.
[146] 2-way flow control valve (1)

Flow control valves have the task of providing constant volumetric flow independently of pressure changes at the inlet or outlet of the valve. This is achieved firstly by means of an adjustable restrictor which is set to the desired volumetric flow. In order to keep the pressure drop across the throttle point constant, a second regulating restrictor (pressure compensator) is also required. The illustration shows the valve in its normal position.

→ 2-way flow control valves always operate in conjunction with a pressure relief valve. The part of the flow which is not required is discharged via the PRV.

[147] 2-way flow control valve (2)

When fluid flows through the valve, the pressure drop across the adjustable restrictor is kept constant by the pressure compensator, which varies the resistance at the upper throttle point in accordance with the load at the inlet or outlet.

→ See also the animation 150 for this topic.

[148] 2-way flow control valve (3)

In the case of this flow control valve, the pressure difference is kept constant by a adjustable restrictor, i.e. between $p_1$ and $p_2$. If the pressure $p_3$ rises as the result of an external load, the overall resistance of the valve is reduced by opening the regulating restrictor.

[149] Circuit diagram: 2-way flow control valve

The model circuit diagram shows the arrangement of a 2-way flow control valve in the piston-side supply line in order to achieve a constant feed speed even under varying load. A non-return valve
is fitted in the by-pass to allow the flow control valve to be by-passed on the return stroke.

23.11 Hydraulic Cylinders and Motors

[150] 2-way flow control valve

The advancing piston rod encounters a load half-way through its stroke. The flow control valve nonetheless ensures that the advance speed remains constant. From 0 to 2 seconds (shown at bottom right) the piston rod is unloaded and the pressure conditions remain constant. When the piston rod encounters the load, the pressure $p_3$ rises at the outlet of the flow control valve. (In order to allow the rapid control operations to be shown more clearly, the time scale now changes to 1/100ths of a second.) The flow control valve briefly raises the pressure $p_2$ downstream of the adjustable restrictor. Following this, the regulating restrictor moves to the left, and $p_2$ falls back to its original value, i.e. the pressure difference between $p_1$ and $p_2$ remains constant. The regulating operation shown is repeated a number of times, as the result of which $p_3$ increases to 2.5 MPa (25 bar) in several steps and the regulating restrictor opens more and more. (At the point at which 2.5 MPa (25 bar) is reached, the time scale changes back to 0.1 seconds.) The piston rod now travels under load just as fast as previously without load.

[151] Single acting cylinder

In the case of a single acting cylinder, only the piston side is pressurized with hydraulic fluid. The cylinder can thus carry out work only in one direction. The fluid which flows into the piston chamber causes a pressure to build up the surface of the piston. The piston travels into its forward end position. The return stroke is effected by a spring, the dead weight of the piston rod or an external load.
[152] Plunger cylinder

In the case of plunger cylinders, the piston and rod form a single component. Due to the design of the cylinder, the return stroke can only be effected by external forces. The cylinders can therefore generally be installed only vertically.

[153] Double acting cylinder

In the case of double acting cylinders, both piston surfaces can be pressurized. A working movement can thus be performed in both directions.

With double acting cylinders with a single-sided piston rod, different forces and speeds are obtained on the advance and return strokes due to the difference in area between the piston surface and annular piston surface.

[154] Double acting cylinder with end position cushioning

Cylinder with end position cushioning are used to brake high stroke speeds smoothly and prevent hard impacts at the end of the stroke. Shortly before the end position is reached, the cross-section for the outflow of fluid is reduced by the built-in cushioning pistons and then finally closed. The hydraulic fluid is then forced to escape through a flow control valve.

[155] End position cushioning (1)

The piston is a short distance before its end position; the hydraulic fluid on the piston-rod side must escape via the adjustable flow control valve above the piston rod.
This type of end position cushioning is used for stroke speed between 6 m/min and 20 m/min. At higher speed, additional cushioning or braking devices must be used.

**[156] End position cushioning (2)**

The piston rod is on its return stroke; in this flow direction, the non-return valve below the piston rod is opened, thus by-passing the flow control valve. The piston rod retracts at maximum speed.

**[157] End position cushioning**

The illustration shows first the advance of the piston rod from a mid-position to the forward end position, with cushioning at the end of the advance movement. The non-return valve is open during the return stroke.

In addition the animation shows the opening of the pressure limiter after a certain pressure has been built up on the outlet side by the cushioning piston.

**[158] Double acting cylinder**

Actual photograph of a double acting cylinder.

**[159] Automatic bleed valve**

When the cylinder is retracted, the piston of the bleed valve is closed. It is lifted as the piston rod advances. Air can then escape via the bleed hole until the hydraulic fluid reaches the piston and pushes it upwards. In the forward end position, the piston is pushed fully upwards by the hydraulic fluid and thus provides an external seal.

Bleed valves should be fitted at the highest point in a piping system, since this is where any trapped air will collect.
23.12 Gauges

[160] Piston pressure gauge

Pressure gauges operate on the principle that pressure acting on a given area will produce a given force. In the case of piston pressure gauges, the pressure acts on a piston against the force of a spring. The pressure value is now shown on a scale either by the piston itself or by a pointer driven magnetically by the piston.

[161] Bourdon-tube pressure gauge

Most pressure gauges operate on the principle of a Bourdon tube. When hydraulic fluid flows into the tube, an identical pressure is produced throughout. Due to the difference in area between the outer and inner curved surfaces, the tube is bent. This movement is transferred to a pointer.

→ This type of gauge is not protected against overload. A cushioning restrictor must be installed in the inlet connection to prevent pressure surges from damaging the tube.

[162] Flow meter

The flow of oil to be measured passes through a movable orifice. The orifice consists of a fixed cone and a hollow piston mounted on a spring. The piston is pressed against the spring in proportion to the flow rate concerned. The measuring error of this type of flow meter is approx. 4%. Measuring turbines, oval disk meters or toothed-wheel gauges are used when higher accuracy is required.
23.13 Exercises

[163] Exercise: Horizontal grinding machine (pump delivery)

The slide on a horizontal grinding machine is hydraulically actuated. A machine operator determines that the reciprocating movement of the machine is no longer reaching the desired speed. A possible cause of this is reduced pump delivery. To investigate this, it is necessary to plot a characteristic curve for the pump and compare this with the values achieved during initial commissioning. As an additional exercise, the circuit diagram and parts list for the necessary test assembly should be prepared.

In order to draw the characteristic curve for the pump, the volumetric flow of hydraulic fluid delivered by the pump (Q) is plotted against the operating pressure achieved (p). The manufacturer's characteristic curve exhibits a slight downward gradient, since the new pump manifests increasing internal leakage losses as necessary to provide internal lubrication. The newly-plotted curve shows a clear deviation; the leakage oil losses have become greater at higher operating pressures, the volumetric efficiency has become worse. The main reason for this is pump wear. Regarding the circuit diagram for the test assembly: The adjustable flow control valve 1V3 is adjusted in such a way that the pressure gauge 1Z1 shows the desired system pressure. The pressure relief valve 1V2 is used to limit the system pressure, while valve 1V1 acts as a safety valve for the pump.

→ The measured values taken as the basis for this exercise do not allow for the characteristic curve of the electric motor. The motor characteristic thus forms part of the calculated error.
Exercise: Bending machine (directly-controlled pressure relief valve)

A bending machine is used to bend steel plates. The bending tools are driven by hydraulic cylinders. It is now desired to use the bending machine for considerably thicker steel plates than before. This requires a hydraulic system pressure of 45 bar against the previous 30 bar. According to the manufacturer’s data, the pump used is suitable for the higher operating pressure. Testing reveals, however, that the bending process is now much too slow. In this case, leakage losses in the piping or directional control valve are ruled out as the cause of the problem. A directly-controlled pressure relief valve (PRV) is installed as a safety valve. Measurements of the volumetric flow (Q) as a function of pressure (p) are available for this valve. A characteristic curve can then be used to determine whether the loss of speed in the bending process is due to the PRV.

The volumetric flow which is discharged to the tank when the PRV opens is entered on the horizontal axis. The characteristic curve shows that the opening point of the PRV is 44 bar, although it is set to 50 bar. This means that part of the pump delivery is diverted at pressures greater than 44 bar. Pressures of more than 44 bar are achieved during the bending process. Since, however, the flow is divided from 44 bar onwards, the volumetric flow to the cylinder is reduced from this point and the bending process slows down. Measure to be taken: The PRTV can be set to 60 bar if the overall installation has been designed for this higher pressure. Flow diversion will then take place from a pressure of 54 bar onwards.

An alternative solution would be to use a valve with a different response pressure.

Exercise: Roller conveyor (flow resistance)

Steel blocks are transported on a roller conveyor. A hydraulic transfer station makes it possible to transfer blocks from one track
to another. A pressure of at least 30 bar is required for the transfer of blocks by means of hydraulic cylinders. Every component through which the hydraulic fluid flows represents a resistance and causes a constant pressure loss. The question is, what pressure is to be set at the pressure relief valve.

The total resistance is the sum of all the individual resistances. The resistance must be determined separately for the advance and return strokes. The overall balances do not include data for the pressure losses at the 4/2-way valve. These can be determined from the flow characteristic for the 4/2-way valve, based on a volumetric flow of 8 l/min. In the calculation, allowance must be made for the resistance of the directional control valve on the inlet and outlet sides respectively. Allowance must also be made for the pressure intensification factor of 2:1 in the case of the differential cylinder. This enables values to be calculated as shown in the solution figure. In the case of the advance stroke, 6 bar hysteresis for the PRV (see exercise 164) must be added to the calculated 42.5 bar in order to ensure that the opening pressure is higher than the required operating pressure. The value finally chosen is 50 bar in order to make allowance for unknown variables such as pipe elbows and the static friction in the cylinder.

In order to keep pressure losses in large installations to a minimum, it is advisable to select valves on the basis of their flow characteristics. It is better to select a valve which is one size too large than to accept large pressure losses. This furthermore reduces wear resulting from cavitation in the valves.

Exercise: Embossing press (activation of a single acting cylinder)

Additional hydraulic components are to be added to an embossing press to eject the finished workpieces. A single acting cylinder (1A) is to be fitted for this purpose. A proposed solution in the form of a circuit diagram with a 2/2-way valve is to be examined to see if it is suitable for this control problem. Following this, a circuit diagram with a 3/2-way valve as final control element is to be developed
and a parts list prepared. A comparison is to be made of the behavior of these two circuits during the advance and return strokes.

When a 2/2-way valve is used to activate a single acting cylinder, the final control element must be reversed and the hydraulic power unit switched off in order to retract the piston rod. The load acting on the piston rod must be larger than the resistance of the directional control valve. This solution cannot be used due to the presence of the second control chain (embossing cylinder). If a 3/2-way valve is used, a direct switch-over can be made from the advance stroke to the return stroke without switching off the hydraulic power unit. Halting at overlap positions, on the other hand (which are not required here), would be possible only by switching off the hydraulic power unit.

→ The non-return valve fitted in each case protects the pump against oil back-pressure. This is necessary in case the hydraulic power unit is switched off with the cylinder advanced and under load.

[167] Exercise: Ladle (activation of a double acting cylinder)

Liquid aluminum is transferred from a holding furnace into a channel leading to a die-casting machine. A ladle is required for this. A double acting cylinder is used to enable the ladle to carry out the appropriate movements. A circuit diagram is provided for the activation of the cylinder with a 4/2-way valve as final control element. This must be examined to see if it is suitable for the control task concerned. The ladle must not be allowed to dip into the furnace when the valve is not actuated. A circuit diagram with a back-pressure valve must be developed to cater for the case in which the ladle is very heavy.

The requirements of the exercise are met by the first circuit diagram only if the ladle represents a light load. If the ladle is very heavy, the advance speed could rise to an unacceptably high level during the advance stroke of the piston rod (ladle moving towards furnace), and the ladle could as a result plunge too quickly into the
molten metal. This can be prevented by installing a back-pressure valve in the B line between the valve and cylinder (tractive load).

→ If, as is required in this exercise, the power component must positively assume a defined end position when the installation is at rest, valves with spring return must be used, as in this case. Here, a 4/2-way valve with spring return has been used, since this ensures that the cylinder remains in the desired position if the hydraulic power unit is switched on unexpectedly. The required cylinder diameter and the return speed of the piston rod can also be calculated as additional optional tasks in the exercise: see the model calculations in the textbook.

[168] Exercise: Paint drying oven (4/3-way valve)

Workpieces are fed continuously through a paint drying oven on a conveyor belt. In order to minimize the heat loss through the door, this should be opened only as much as required by the height of the workpieces. The hydraulic control system should be designed so that the door can be held reliably in position for a long period of time without slipping down. Firstly, a 4/3-way valve with suitable mid-position functions should be selected as a final control element. Secondly, a delockable non-return valve should be provided in the circuit diagram to act as a hydraulic safety device to prevent slippage of the door under load (i.e. its own weight) over a long period of time as the result of leakage losses in the directional control valve. The question is, which type of 4/3-way valve has a suitable mid-position function?

A 4/3-way valve with an “all ports closed” mid-position will solve the problem only if a poppet valve is used. If a slide valve would be used, the oven door would slip down slowly as the result of internal leakage losses.

→ The second solution would be to fit a delockable non-return valve in the supply line to the piston rod side of the cylinder downstream of the directional control valve. In order to ensure that the non-return valve closes immediately when the door
stops, both the outlets A and B of the directional control valve to the tank must be de-pressurized (A, B and T connected, P closed).

[169] Exercise: Clamping device (closing speed)

Workpieces are clamped by a hydraulic cylinder. The closing speed must be reduced in order to prevent damage to the workpieces. The opening speed must, however, be maintained. The question here is how to incorporate the necessary one-way flow control valve in the circuit. Possible solutions must be examined to see what thermal side-effects occur and to determine the pressure load placed on the components concerned.

The advance stroke can as a general principle be made slower by using either inlet or outlet flow control. Either solution can be used in this control; in comparison with outlet flow control, inlet flow control has the advantage that no pressure intensification will take place. The oil heated at the throttle point will, however, then pass through the power component. The resulting expansion of material is not, however, of significance for this simple vice. If the solution with outlet flow control is selected, it should be borne in mind that pressure intensification will take place in accordance with the area ratio of the differential cylinder of 2:1. The pressure relief valve will respond, i.e. flow division will occur, only when a pressure has built up on the piston-rod side which is approximately twice as high as the system pressure set on the PRV. The cylinder, flow control valve and connectors used must therefore be suitable for this intensified pressure.

→ Precision drives for machine tools are a good example of cases in which it is essential to make allowance for expansion of the material of power components due to the passage through these of heated oil.
[170] **Exercise: Hydraulic crane (speed reduction)**

Press tools of varying weights are inserted into a press by means of a hydraulic crane. A double acting cylinder raises and lowers the load. During the commissioning of the hydraulic crane, it has become apparent that the advance speed of the piston rod is too high. The solutions have been proposed to reduce this speed; a circuit with exhaust flow control and a circuit with a back-pressure valve. A suitable solution must be selected and reasons stated for this choice. Since the second solution is not capable of operating in this form, this must be rectified by correcting the circuit diagram.

If the solution with exhaust flow control is selected, it must be borne in mind that the cylinder, flow control valve and connectors must be suitable for this intensified pressure. The solution chosen is the circuit with the back-pressure valve; in this case, the load is clamped hydraulically and a pressure-intensification effect does not occur, since the pressure can be adjustable by means of the pressure relief valve as appropriate to the load. A non-return valve must be installed to provide a by-pass on the return stroke.

→ Inlet flow control cannot be used to control a tractive load; the load forces oil out of the piston-rod chamber faster than oil can flow into the piston chamber. Vacuum is created and air will escape.

[171] **Exercise: Feed control for a lathe (speed control)**

The feed movement of a lathe has previously been carried out manually. In future, this is to be performed automatically by a hydraulic control system. The feed movement must be adjustable and remain constant even with changing tool loads. Since a simple throttle valve is not able to provide a constant feed speed under changing load, a 2-way flow control valve must be used. On the basis of a circuit diagram with data for the no-load situation, values for pressures, pressure differences and feed speed under load
must be added. The circuit diagram must be modified to ensure that the flow control valve is not operative on the return stroke. Finally, the relationship must be investigated between \( Q \) of the PRV and the feed speed and between \( \Delta p_2 \) and the volumetric flow to the load device.

In order to prevent the flow control valve from acting as a resistance on the return stroke, a non-return valve is installed parallel to this as a by-pass. The pressure at the PRV remains constant despite the effect of the load. The outlet flow from this is therefore a constant 7 l/min. A constant volumetric flow \( Q \) at the PRV in turn means a constant volumetric flow to the load device and thus constant feed speed. Regarding the last question: No matter whether operation is with or without a load, the pressure drop \( \Delta p_2 \) at the adjustable throttle remains constant. A constant pressure drop means a constant volumetric flow.

\[ \Rightarrow \text{Regarding the necessity for the non-return valve in the by-pass:} \]
\[ \text{When flow passes through 2-way flow control valves in the reverse direction, they act either as flow control valves if the regulating restrictor is fully open or non-return valves if the regulating restrictor is closed.} \]

**[172] Exercise: Planing machine (by-pass circuit)**

The sliding bed of a parallel planing machine is actuated with the aid of a hydraulic control system. The power section of this hydraulic control system consists of a double acting differential cylinder. The area ratio of the full piston surface of this cylinder to the annular piston surface is 2:1. Since the piston-rod chamber is only half the volume of the piston chamber, the return stroke is twice as fast as the advance stroke. Machining has previously been carried out only during the advance stroke. In future, working movements are to be carried out in both directions. To make this possible, the hydraulic control system must be modified so that forward and return strokes are at the same speed. The speed should now also be adjustable. The connecting lines should be added to the given circuit diagram. The mode of operation of the circuit in the three
switching positions should be described and the various piston speeds and forces compared.

In order to achieve the same speed on the advance and return strokes, a differential circuit (by-pass circuit) can be used with differential cylinders with an area ratio of 2:1. Picture 116.2 The second picture shows the principle of a by-pass circuit with a 3/2-way valve. In the case of the parallel planing machine, the necessary differential circuit can be achieved by using the mid-position of a 4/3-way valve (A, B and P connected, T closed). In this switching position (advance stroke), the piston speed and force are twice as high as in the right-hand switching position (return stroke). In the left-hand switching position, on the other hand, the advance stroke is half as fast and the force twice as great as in the other two switching positions. The speed for the advance and return strokes can be adjusted by means of a flow control valve fitted upstream.

It should also be noted that only half the force is available on the advance stroke at the mid-position. In the case of a tractive load, the by-pass position has the advantage that the piston is hydraulically clamped. Differential circuits are used not only as synchronization circuits but also as rapid-traverse circuits when, for example, different speeds are required in the same direction with constant pump delivery. If it is desired to calculate forces and piston speeds using concrete values, the model values given in the TP 501 textbook can be used for this purpose.

[173] Exercise: Drilling machine (pressure regulator)

The drill feed and clamping device of a drilling machine are hydraulically actuated. The hydraulic control system contains two cylinders, a clamping cylinder 1A and a feed cylinder 2A. The clamping pressure at cylinder 1A must be adjustable, since different workpiece clamping forces are required. A pressure regulator is used for this. The return stroke of the clamping cylinder must be at maximum speed. The drilling feed must be adjustable for various feed speeds, which must however remain constant under varying
load. It should also be noted that the drive spindle fitted to the piston rod of the drilling cylinder acts as a tractive load. The return stroke of the drilling cylinder should also be at maximum speed. A circuit should be drafted with the above-mentioned characteristics.

Pressure regulators can as general principle be used to reduce the general system pressure in a part of a hydraulic installation. If we consider the two control chains for the drilling machine without pressure regulation, we can observe the following undesirable effects: When 1V1 is actuated, the workpiece is first clamped at full system pressure. If 2V1 is now actuated, the system pressure will drop to the operating pressure of the drilling cylinder. The same applies to the pressure at the clamping cylinder. If the circuit is expanded to include the pressure regulator 1V3, this enables the clamping pressure to be adjusted. The system pressure upstream of the PRV will, however, continue to fall during the advance stroke of 2A. In order to maintain the preset clamping pressure at outlet A of the PRV reliably, the pressure at inlet P must be higher than this. This can be achieved by fitting the additional flow control valve 0V2 upstream of the final control element 2V1. Maximum return-stroke speed is achieved for the clamping cylinder by means of 1V2, which is used to by-pass 1V3. The flow control valve 2V3 means that the advance-stroke speed of the drilling cylinder is independent of load and adjustable. Due to the tractive load of the attached spindle, however, an additional PRV must be fitted as a back-pressure valve. The non-return valves 2V2 and 2V5 provide a by-pass during the return stroke and allow maximum speed to be achieved during this.

→ A parts list can be specified to help in the drafting of this circuit.
23.14 Educational Films

23.14.1 Educational Films

<table>
<thead>
<tr>
<th>No.</th>
<th>Title</th>
<th>Length</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Introduction</td>
<td>3:20</td>
</tr>
<tr>
<td>2</td>
<td>Fundamentals: Pressure fluids</td>
<td>2:02</td>
</tr>
<tr>
<td>3</td>
<td>Fundamentals: Pressure and Flow Rate</td>
<td>2:41</td>
</tr>
<tr>
<td>4</td>
<td>Fundamentals: Transmission of Force and Displacement</td>
<td>1:35</td>
</tr>
<tr>
<td>5</td>
<td>Fundamentals: Pressure Transmission</td>
<td>0:53</td>
</tr>
<tr>
<td>6</td>
<td>Fundamentals: Types of Flow</td>
<td>2:10</td>
</tr>
<tr>
<td>7</td>
<td>Basic Design of Hydraulic Systems</td>
<td>1:13</td>
</tr>
<tr>
<td>8</td>
<td>The Hydraulic Power Unit</td>
<td>3:26</td>
</tr>
<tr>
<td>9</td>
<td>Hydraulic Drives</td>
<td>6:58</td>
</tr>
<tr>
<td>10</td>
<td>Valves</td>
<td>3:12</td>
</tr>
<tr>
<td>11</td>
<td>Valves: Directional Control Valves</td>
<td>10:39</td>
</tr>
<tr>
<td>12</td>
<td>Valves: Non-Return Valves</td>
<td>1:59</td>
</tr>
<tr>
<td>13</td>
<td>Valves: Pressure Control Valves</td>
<td>4:24</td>
</tr>
<tr>
<td>14</td>
<td>Valves: Flow Control Valves</td>
<td>4:23</td>
</tr>
<tr>
<td>15</td>
<td>Representation of Hydraulic Systems in Circuit Diagrams</td>
<td>2:58</td>
</tr>
</tbody>
</table>

23.15 Standard Presentations

For several topics useful presentations have been provided within FluidSIM. The following table lists the titles of the predefined presentations.
23.15.1 Presentations

<table>
<thead>
<tr>
<th>Presentation Title</th>
</tr>
</thead>
<tbody>
<tr>
<td>All topics sorted by number</td>
</tr>
<tr>
<td>Applications</td>
</tr>
<tr>
<td>Components of a hydraulic system</td>
</tr>
<tr>
<td>Graphic and circuit symbols</td>
</tr>
<tr>
<td>Fundamental physical principles</td>
</tr>
<tr>
<td>Components of the power supply section</td>
</tr>
<tr>
<td>Valves in general</td>
</tr>
<tr>
<td>Pressure valves</td>
</tr>
<tr>
<td>Directional control valves</td>
</tr>
<tr>
<td>Non-return valves</td>
</tr>
<tr>
<td>Flow control valves</td>
</tr>
<tr>
<td>Hydraulic cylinders and motors</td>
</tr>
<tr>
<td>Measuring devices</td>
</tr>
<tr>
<td>Exercises</td>
</tr>
<tr>
<td>Section</td>
</tr>
<tr>
<td>---------</td>
</tr>
<tr>
<td>3/2-way valve</td>
</tr>
<tr>
<td>4/2-way valve</td>
</tr>
<tr>
<td>4/3-way valve</td>
</tr>
<tr>
<td>5/2-way valve</td>
</tr>
<tr>
<td>5/3-way valve</td>
</tr>
<tr>
<td>Accessories</td>
</tr>
<tr>
<td>Action (stored effective)</td>
</tr>
<tr>
<td>Activation</td>
</tr>
<tr>
<td>Air drying</td>
</tr>
<tr>
<td>Air lubricator</td>
</tr>
<tr>
<td>Air motor</td>
</tr>
<tr>
<td>Air service unit</td>
</tr>
<tr>
<td>Alignment</td>
</tr>
<tr>
<td>Alignment lines</td>
</tr>
<tr>
<td>Analyses</td>
</tr>
<tr>
<td>Archiving</td>
</tr>
</tbody>
</table>

© Festo Didactic GmbH & Co. KG • Art Systems GmbH • FluidSIM
Attribute link: 135

Backup copies: 201
Blanking plugs: 44
BMP export: 197

Cable: 169, 172
manage: 173
Cable list: 176
Cable List: 177
Cable map: 174
Cable Map: 175
Check:

drawing: 88
Circle: 83
Circuit check: 26
input: 195
nodes: 151
open: 151
output: 195
print: 195
properties: 151, 155
XML file: 26
circuit diagram:
bistable valve: 457, 458
direct control: 459
indirect control: 459
pressure sequence valve: 471
quick exhaust valve: 467
sequential control: 475
shuttle valve: 464, 465
signal overlap: 476, 477
time delay valve: 473
two pressure valve: 462, 463

Circuit menu: 219
component
animation: 421
description: 413
sectional view component
usage in circuit didactics

sectional view___________________________416
Component attributes __________________________________________117
compressed air filter filter ______________________________________441
compressed air supply
  axial flow compressor axial flow compressor____________________444
  delivery _____________________________________________________443
  distribution ________________________________________________444
  piston compressor piston compressor __________________________444
Compression
  files ________________________________________________________201
Conduction lines ______________________________________________165
Configurable cylinder _________________________________________49
Configurable way valves ______________________________________47
Connector
  connect _____________________________33
  define ______________________________46
  delete ______________________________47
  identification ______________________44
  properties __________________________44
  seal ________________________________44
Connector Labels ______________________________________________130
Contact __________________________________________________________________________127
Contact images __________________________________________________________194
Create drawing frame __________________________________________56
Cross Reference Representation ______________________________47
Cross-reference
  create from symbol __________________________________________71
cylinder
  control cylinder
    double acting ______________________________________________447
    single acting ______________________________________________446
  double acting ____________________________________________447, 448
  mounting arrangements ______________________________________448
  seals _______________________________________________________448
  single acting ______________________________________________446
  tandem double acting ________________________________________449
Cylinder
  configure __________________________________________________50
Cylinder editor ____________________________________________ 50

**D**

Define page dividers ______________________________________ 61
Delay Switches____________________________________________ 363, 377
Delete
  line ______________________________________________________ 44
Designation conventions ____________________________________ 110
Designations
  number __________________________________________________ 112
diagram symbol
  designation of connections........................................ 450
  directional valve .................................................... 450
  flow control valve .................................................. 468
  linear actuator ...................................................... 445
  method of actuation ................................................. 451
  non-return valve diagram symbol
    check valve ........................................................ 461
  numbering system .................................................. 439
  pressure control valve ............................................. 470
  rotary actuator ..................................................... 445
  supply component .................................................. 440
Dialog window
  cable ___________________________________________________ 169, 172
  Cable List ________________________________________________ 177
  Cable Map ______________________________________________ 175
  circle __________________________________________________ 83
  circuit __________________________________________________ 155
  Circuit________________________________________________ 18
  component ______________________________________________ 118
  connector _______________________________________________ 45
  contact __________________________________________________ 127
Cross Reference Representation _______________________________ 71
diagram properties _________________________________________ 230
diagram size ______________________________________________ 18
dimensioning ______________________________________________ 108
drawing areas ______________________________________________ 233
drawing frame ______________________________________________ 58, 60
drawing layers ______________________________________________ 67
electric line ________________________________________________ 43
electric terminal ____________________________________________ 180
ellipse _____________________________________________________ 85
export parts list ____________________________________________ 148
Functional diagram _________________________________________ 229
shutoff valves 461, 512
supply elements 440
symbols 483
time delay valve 472
tutorial tutorial 422
valves 494
way valves 503
Digital Basic Functions 397
Digital Components 395
Digital Special Functions 399
Digitale Constants 395
Dimension 107
Dimensioning 107
DIN standard 414
distance-step diagram 475
Dongle 15
Draw menu 218
Drawing element 72
Drawing frame 56, 57
import 56
insert 57
label 56
Drawing level 66
Druckschalter 368
DXF
export 197
DXF file
import 197

E

Edit

circuit 29
Edit menu 213
Electric line 76
electrical components
american standard 376
ladder diagram style 376
Electrical Components 355
electronic components 382
Ellipse 84
Equipment identifications 110
exercise
bending machine 524
clamping device 528
drilling machine

drying oven

embossing press

feed control

grinding machine

hydraulic crane

ladle

planing machine

roller conveyor

Export

F

Festo product catalogue

File menu

Find target

function illustration

        general sectional view

G

GIF

        export

GRAFCET

        Action

        Action (stored effective)

        Admissible characters

        Boolean value of an assertion

        Checking the entries

        Compulsory command

        Delay GRAFCET

        Time limit

        Electrical part

        Enclosing step GRAFCET

        Step Enclosing step

        Functions GRAFCET

        Formula entry

        Initialization

        Labels

        Macro-step

        Partial GRAFCETs

        Reference

        Sequence rules

        Sequence selection

        Step Step
Synchronization

Target information GRAFCET
Operative connection

Transition
Variable names
Variable value

GRAFCET Elements
Graphical element
Grid
Grid dimension
Grid options
Group
create
delete
Guides

H
Hide
automatic
Hide window

I
Image
Image file
Insert
Symbol
Insert menu
Insert T distributor
Installation
license connector
Interruption

J
JPG
export
## L

<table>
<thead>
<tr>
<th>Term</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>ladder diagram</td>
<td>376</td>
</tr>
<tr>
<td>Layer</td>
<td>66</td>
</tr>
<tr>
<td>Libraries</td>
<td>21</td>
</tr>
<tr>
<td>Library</td>
<td>24, 27</td>
</tr>
<tr>
<td>Library menu</td>
<td>224</td>
</tr>
<tr>
<td>Library window</td>
<td>27</td>
</tr>
<tr>
<td>Limit Switches</td>
<td>364, 378</td>
</tr>
<tr>
<td>Line</td>
<td>78</td>
</tr>
<tr>
<td>delete</td>
<td>44</td>
</tr>
<tr>
<td>electric</td>
<td>76</td>
</tr>
<tr>
<td>move</td>
<td>39</td>
</tr>
<tr>
<td>pneumatic</td>
<td>76</td>
</tr>
<tr>
<td>Line segment</td>
<td>39</td>
</tr>
<tr>
<td>Line type</td>
<td>42</td>
</tr>
<tr>
<td>set</td>
<td>135</td>
</tr>
<tr>
<td>Links</td>
<td>190</td>
</tr>
</tbody>
</table>

## M

<table>
<thead>
<tr>
<th>Term</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Macro object</td>
<td></td>
</tr>
<tr>
<td>create</td>
<td>51</td>
</tr>
<tr>
<td>delete</td>
<td>52</td>
</tr>
<tr>
<td>Manage Cross References...</td>
<td>72</td>
</tr>
<tr>
<td>measuring devices</td>
<td>298</td>
</tr>
<tr>
<td>measuring instruments</td>
<td>353</td>
</tr>
<tr>
<td>menu</td>
<td></td>
</tr>
<tr>
<td>context sensitive</td>
<td>413</td>
</tr>
<tr>
<td>Menu</td>
<td></td>
</tr>
<tr>
<td>circuit</td>
<td>219</td>
</tr>
<tr>
<td>draw</td>
<td>218</td>
</tr>
<tr>
<td>edit</td>
<td>213</td>
</tr>
<tr>
<td>file</td>
<td>210</td>
</tr>
<tr>
<td>insert</td>
<td>210</td>
</tr>
<tr>
<td>library</td>
<td>216</td>
</tr>
<tr>
<td>project</td>
<td>224</td>
</tr>
<tr>
<td>tools</td>
<td>220</td>
</tr>
<tr>
<td>view</td>
<td>221</td>
</tr>
<tr>
<td>window</td>
<td>226</td>
</tr>
<tr>
<td>Section</td>
<td>Page</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Menu</td>
<td>227</td>
</tr>
<tr>
<td>Mirror</td>
<td>52, 54</td>
</tr>
<tr>
<td>Miscellaneous</td>
<td>408</td>
</tr>
<tr>
<td>N</td>
<td></td>
</tr>
<tr>
<td>non return valve</td>
<td>462</td>
</tr>
<tr>
<td>O</td>
<td></td>
</tr>
<tr>
<td>Object snap</td>
<td>65</td>
</tr>
<tr>
<td>one-way flow control valve</td>
<td>468, 469</td>
</tr>
<tr>
<td>Options</td>
<td></td>
</tr>
<tr>
<td>Automatic Updates</td>
<td>208</td>
</tr>
<tr>
<td>Connector Links</td>
<td>206</td>
</tr>
<tr>
<td>Cross Reference Representation</td>
<td>205</td>
</tr>
<tr>
<td>Designation Conventions</td>
<td>204</td>
</tr>
<tr>
<td>Dimension</td>
<td>203</td>
</tr>
<tr>
<td>Folder Locations</td>
<td>201</td>
</tr>
<tr>
<td>General</td>
<td>199</td>
</tr>
<tr>
<td>Grid</td>
<td>200</td>
</tr>
<tr>
<td>Language</td>
<td>202</td>
</tr>
<tr>
<td>Save</td>
<td>200</td>
</tr>
<tr>
<td>text fields</td>
<td>200</td>
</tr>
<tr>
<td>Text Sizes</td>
<td>209</td>
</tr>
<tr>
<td>Warnings</td>
<td>207</td>
</tr>
<tr>
<td>P</td>
<td></td>
</tr>
<tr>
<td>Page dividers</td>
<td>159</td>
</tr>
<tr>
<td>Parts list</td>
<td>142</td>
</tr>
<tr>
<td>display</td>
<td>143</td>
</tr>
<tr>
<td>edit</td>
<td>143</td>
</tr>
<tr>
<td>export</td>
<td>147</td>
</tr>
<tr>
<td>find components</td>
<td>143</td>
</tr>
<tr>
<td>find target</td>
<td>143</td>
</tr>
<tr>
<td>nodes</td>
<td>151</td>
</tr>
<tr>
<td>open</td>
<td>151</td>
</tr>
<tr>
<td>print</td>
<td>195</td>
</tr>
<tr>
<td>properties</td>
<td>145</td>
</tr>
<tr>
<td>sort</td>
<td>143</td>
</tr>
<tr>
<td>Pilot line</td>
<td>42</td>
</tr>
<tr>
<td>Pneumatic Components</td>
<td>301</td>
</tr>
<tr>
<td>Pneumatic line</td>
<td>76</td>
</tr>
<tr>
<td>PNG</td>
<td></td>
</tr>
<tr>
<td>export</td>
<td>197</td>
</tr>
<tr>
<td>Topic</td>
<td>Page</td>
</tr>
<tr>
<td>-------</td>
<td>------</td>
</tr>
<tr>
<td>Polygonal chain</td>
<td>80</td>
</tr>
<tr>
<td>Polyline</td>
<td>80</td>
</tr>
<tr>
<td>Port connect</td>
<td>33</td>
</tr>
<tr>
<td>Potential</td>
<td>74</td>
</tr>
<tr>
<td>Potentials</td>
<td>165</td>
</tr>
<tr>
<td>Predefined attributes</td>
<td>158</td>
</tr>
<tr>
<td>Predefined placeholders</td>
<td>158</td>
</tr>
<tr>
<td>Predefined variables</td>
<td>158</td>
</tr>
<tr>
<td>Presentation creation</td>
<td>432</td>
</tr>
<tr>
<td>Presentation edit</td>
<td>432</td>
</tr>
<tr>
<td>Pressure absolute pressure atmospheric</td>
<td>445</td>
</tr>
<tr>
<td>Pressure control valve</td>
<td>443</td>
</tr>
<tr>
<td>Pressure switches</td>
<td>283</td>
</tr>
<tr>
<td>Pressure Switches</td>
<td>380</td>
</tr>
<tr>
<td>Print</td>
<td>195</td>
</tr>
<tr>
<td>Product catalogue</td>
<td>29</td>
</tr>
<tr>
<td>Project add</td>
<td>27, 149</td>
</tr>
<tr>
<td>Project node</td>
<td>150</td>
</tr>
<tr>
<td>Project print</td>
<td>195</td>
</tr>
<tr>
<td>Project properties</td>
<td>155</td>
</tr>
<tr>
<td>Project remove</td>
<td>150</td>
</tr>
<tr>
<td>Project archiving</td>
<td>151</td>
</tr>
<tr>
<td>Project menu</td>
<td>220</td>
</tr>
<tr>
<td>Project window</td>
<td>27</td>
</tr>
<tr>
<td>Properties</td>
<td>155</td>
</tr>
<tr>
<td>Properties dialog window</td>
<td>18</td>
</tr>
<tr>
<td>Cable</td>
<td>172</td>
</tr>
<tr>
<td>Cable List</td>
<td>177</td>
</tr>
<tr>
<td>Cable Map</td>
<td>175</td>
</tr>
<tr>
<td>Cable symbol</td>
<td>169</td>
</tr>
<tr>
<td>Circle</td>
<td>83</td>
</tr>
<tr>
<td>Circuit</td>
<td>155</td>
</tr>
<tr>
<td>Component</td>
<td>118</td>
</tr>
<tr>
<td>Connector</td>
<td>45</td>
</tr>
<tr>
<td>Contact</td>
<td>127</td>
</tr>
<tr>
<td>Cross Reference Representation</td>
<td>71</td>
</tr>
<tr>
<td>Cylinder</td>
<td>50</td>
</tr>
<tr>
<td>Dimensioning</td>
<td>108</td>
</tr>
<tr>
<td>Drawing layers</td>
<td>67</td>
</tr>
<tr>
<td>Electric line</td>
<td>43</td>
</tr>
</tbody>
</table>
electric terminal ________________________________ 180
ellipse ________________________________ 85
image ________________________________ 87
line ________________________________ 43, 79
Manage Cross References... ____________________________ 72
pneumatic line ________________________________ 43
polygonal chain ________________________________ 80
polyline ________________________________ 80
project ________________________________ 155
rectangle ________________________________ 82
secondary component ________________________________ 127
set multiple terminals ________________________________ 182
set of connected lines ________________________________ 80
Terminal diagram - Properties ____________________________ 187
text ________________________________ 133
way valve ________________________________ 48
wiring ________________________________ 169
Proximity Switches ________________________________ 369

Q
quick exhaust valve ________________________________ 466

R
Rectangle ________________________________ 81
Rotate ________________________________ 53

S
Scale ________________________________ 54
Search
   Symbol ________________________________ 23
Secondary component ________________________________ 127
semi-rotary actuator ________________________________ 449
sequence valve ________________________________ 470, 471
Service Components ________________________________ 243
Set of connected lines ________________________________ 80
Show
   automatic ________________________________ 27
Show window ________________________________ 27
shuttle valve ________________________________ 464
signal flow ________________________________ 438
signal flow component
   numbering scheme ________________________________ 438
Silencers ................................................................. 44
Snap ........................................................................... 65
Storage locations ....................................................... 201
supply air throttling exhaust air throttling .................... 469
supply elements ......................................................... 301
switch
  pressure operated .................................................. 334
Symbol
  align ........................................................................ 52
  group ......................................................................... 51
  insert ......................................................................... 29
  mirror ......................................................................... 52, 54
  move ........................................................................... 29
  rotate ......................................................................... 53
  scale ......................................................................... 54
Symbol library .......................................................... 24
Symbols ..................................................................... 21

T
T distributor
  set ........................................................................... 46
Terminal ...................................................................... 180
Terminal diagram - Properties ..................................... 187
Terminals ................................................................. 182
Text ........................................................................... 86
Text attribute ............................................................ 135
Text components ....................................................... 132
Text link .................................................................... 135
Throttle valve .......................................................... 469
TIF
  export ....................................................................... 197
Tiles
  Printout .................................................................... 18
time delay valve delay valve ........................................ 472, 473
Toolbar
  drawing ...................................................................... 72
Tools menu ........................................... 225
Transient sequence Unstable step Virtual triggering ........ 100
Transition .............................................. 92
two pressure valve .................................... 462

V
Valve editor ............................................. 48
valves
  configurable ............................................ 250, 307
directional ............................................. 255
directional valves .................................... 312
flow control ........................................... 284
flow control valves ................................... 328
groups ..................................................... 341
pressure .................................................. 272
shutoff .................................................... 268
shutoff valves ......................................... 328
way valves ............................................... 250, 307

View menu .............................................. 221

W
Way valve
  configure ............................................... 48

Window menu ......................................... 226

Wiring ..................................................... 169

WMF
  export ................................................ 197

Working line .......................................... 42

X
XML file ................................................ 26

© Festo Didactic GmbH & Co. KG • Art Systems GmbH • FluidSIM